
© 2019 Sony Corporation

Solid-State Memory Camcorder

Instrucciones de funcionamiento 

PXW-FX9V/PXW-FX9VK 
PXW-FX9T/PXW-FX9TK
Versión de software 2.1

5-011-867-53 (1)

ES



2

1. Descripción general

Configuración del sistema................................. 3

Ubicación y función de los componentes.......... 4

Uso del panel táctil.......................................... 10

Visualización de la pantalla.............................. 11

2. Preparación

Fuente de alimentación....................................18

Acople de dispositivos..................................... 20

Configuración del funcionamiento básico del 
camcorder................................................. 27

Utilización de tarjetas de memoria XQD.......... 28

Utilización de una tarjeta UTILITY SD/MS.........31

3. Filmación

Procedimiento básico de funcionamiento....... 32

Ajuste del enfoque.......................................... 34

Ajuste del brillo................................................40

Ajuste de colores naturales (balance de 
blancos)..................................................... 43

Especificación del audio que se va a grabar....44

Funciones útiles...............................................46

Grabación de proxy.......................................... 54

Grabación de vídeo RAW................................. 55

4. Funciones de red

Conexión a otros dispositivos a través de una 
LAN............................................................ 56

Conexión a Internet..........................................60

Carga de archivos............................................. 62

Uso del modo de cliente de red.......................64

Uso del control remoto web.............................66

5. Pantalla de imágenes en miniatura

Pantalla de imágenes en miniatura................. 70

Reproducción de clips.......................................71

Operaciones con clips...................................... 72

6. Pantalla de menús y ajustes

Configuración del menú de ajustes y 
jerarquía.................................................... 73

Operaciones del menú de configuración......... 75

Menú User.........................................................77

Menú Edit User................................................. 78

Menú Shooting................................................ 79

Menú Project....................................................88

Menú Paint....................................................... 95

Menú TC/Media...............................................99

Menú Monitoring............................................ 101

Menú Audio................................................... 104

Menú Thumbnail........................................... 106

Menú Technical.............................................. 108

Menú Network.................................................111

Menú Maintenance......................................... 116

Guardar y cargar datos de configuración........ 117

7. Conexión de dispositivos externos

Conexión de dispositivos de grabación y 
monitores externos.................................. 119

Sincronización externa....................................120

Gestión/Edición de clips con un ordenador.... 121

8. Apéndice

Precauciones de uso.......................................122

Limitaciones y formatos de salida..................124

Resolución de problemas...............................126

Advertencias de funcionamiento....................128

Elementos guardados en Files........................ 131

Diagramas de bloques.................................... 141

Actualización del software del objetivo de 
montura E................................................ 144

Licencias..........................................................145

Especificaciones............................................. 148

Lista de contenidos



3 1. Descripción general

Configuración del sistema

Sintonizador de diversidad 
sintetizado para UHF 
URX-S03D
Receptor inalámbrico digital 
DWR-S02DN

Paquete de 
micrófono 
inalámbrico 
UWP-D21 
UWP-D22 
UWP-D26 
(Receptor: 
URX-P40)

Receptor de 
micrófono 
inalámbrico 
URX-P03D

Adaptador de 
la zapata de 
interfaces 
múltiples 
SMAD-P3D

Adaptador de la 
zapata de interfaces 
múltiples 
SMAD-P5

Adaptador de 
montura A 
LA-EA3 
LA-EA4

Objetivo de 
montura E

Micrófono 
ECM-VG1 
ECM-MS2

Unidad de control 
remoto 
RM-30BP

Control remoto de la 
empuñadura (suministrado)

PXW-FX9V/PXW-FX9VK
PXW-FX9T/PXW-FX9TK

Adaptador para los 
hombros 
VCT-FS7

Kit de 
Adaptador de 
XLR 
XLR-K2M 
XLR-K3M

Luz de vídeo 
HVL-LBPC

Tarjeta de memoria XQD 
series S/N/M/H/G

Batería 
BP-U35, BP-U60, 
BP-U70, BP-U90

Adaptador de CA 
(suministrado)

Módulo de 
ampliación 
XDCA-FX9

Lector de tarjetas XQD 
MRW-E80, MRW-E90

Cargador de batería 
BC-U1A, BC-U2A

Multi Camera Live 
Producer 
MCX-500
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Ubicación y función de los componentes

Lado izquierdo, cara frontal y asa
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1.	 Asa (página 5)

2.	 Antena Wi-Fi (página 56)

3.	 Salida de aire

[Nota]

No cubra la salida de aire.

4.	 Conector del visor (página 20)

5.	 Conector REMOTE
Conéctelo al accesorio de conector LANC de 
uso general.

6.	 USB/conector múltiple (página 23)

7.	 Interruptor INPUT1 (LINE/MIC/MIC+48V) 
(página 44)

8.	 Acolchado para el hombro (página 24)

9.	 Interruptor INPUT2 (LINE/MIC/MIC+48V) 
(página 44)

10.	Acoplamiento de la empuñadura 
(página 23)

11.	Gancho para cinta métrica
El gancho para cinta métrica está situado en 
el mismo plano que el sensor de imagen. 
Para medir la distancia entre el camcorder y 
el sujeto de forma precisa, utilice este gancho 
como punto de referencia. Puede unir el 
extremo de la cinta métrica al gancho para 
medir la distancia desde el sujeto.

12.	Lámpara indicadora/indicador de 
grabación (parte delantera) (página 32)

Parpadea cuando la capacidad restante del 
soporte de grabación o de la batería es baja.

13.	Pieza de cierre del anillo de bloqueo del 
objetivo (página 22)

14.	Sensor de imagen

15.	Dial multifunción (página 46)
Presione cuando vea la imagen en el visor 
para mostrar y utilizar el menú directo.
Gire el dial cuando aparezca un menú en 
el visor para mover el cursor hacia arriba/
abajo para seleccionar elementos o ajustes 
del menú. Pulse para aplicar el elemento 
seleccionado.
Si no se muestra el menú, el dial también 
puede funcionar como dial asignable.

16.	Contactos de señal del objetivo
Conecte un objetivo de montura E.

17.	Botón WB SET (ajuste del balance de 
blancos) (página 43)

18.	Pasador de bloqueo del objetivo 
(página 22)

19.	Anillo de bloqueo del objetivo 
(página 22)

20.	Antena de módulo GPS
La antena GPS y los circuitos periféricos están 
integrados.

21.	Zapata para accesorios (página 4)

22.	Botón de grabación del asa START/STOP
El botón de grabación no se puede utilizar 
cuando la palanca de bloqueo está en la 
posición de bloqueo.

23.	Palanca de zoom del asa (página 108)

24.	Zapata de interfaz múltiple

Para obtener más información acerca de 
los accesorios compatibles con la zapata de 
interfaz múltiple, póngase en contacto con su 
representante de ventas.

Acople de la zapata para accesorios

1	 Levante el borde delantero del muelle de 
la zapata y tire del muelle en la dirección 
opuesta a la flecha que se encuentra 
grabada en este.

Muelle de la zapata

Zapata para accesorios

1

2	 Sitúe la zapata para accesorios en la 
montura de la zapata para accesorios, 
alineando los salientes de la zapata con 
los puntos correspondientes de la 
montura, y apriete los cuatro tornillos.

3	 Introduzca el muelle de la zapata en la 
dirección de la flecha de modo que la 
parte en forma de U encaje en el extremo 
de la zapata para accesorios.
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Muelle de la 
zapata

Zapata para 
accesorios

Extracción de la zapata para accesorios

Extraiga la zapata para accesorios tal y como 
se describe en el paso 1 de la sección “Acople 
de la zapata para accesorios”, afloje los cuatro 
tornillos y extraiga la zapata para accesorios.

Extracción del asa

Retire los cuatro tornillos de acoplamiento del 
asa y extraiga el asa del camcorder.

Colocación de la tapa protectora del 
conector del asa (suministrada)

Cuando utilice el camcorder sin el asa, 
proteja el conector con la tapa protectora del 
conector.

Protección de los terminales de los 
conectores

Acople la cubierta en conectores que no se 
utilicen para proteger los terminales de los 
conectores.

Parte superior

1

3

2

1.	 Orificios para los tornillos de extensión 
(3/8 pulgadas)

Compatible con tornillos 3/8-16 UNC (longitud 
de 10,0 mm o inferior).

2.	 Orificios para los tornillos de extensión 
(1/4 pulgadas)

Compatible con tornillos 1/4-20 UNC (longitud 
de 7,0 mm o inferior).

3.	 Conector del asa
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Lado derecho (frontal/superior/inferior)
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Lateral derecho (trasero) 
(página 7)

1.	 Altavoz integrado (página 32)

2.	 Botones VOLUME (ajuste de volumen del 
monitor)

Ajusta el volumen del monitor y el volumen de 
la alarma.

3.	  (Marca N)
ˎˎ Toque un smartphone equipado con la 
función NFC con la unidad para establecer 
una conexión inalámbrica (página 56).  
Es posible que algunos smartphones que 
admiten sistemas de pago inalámbricos no 
admitan NFC. Para obtener más información, 
consulte el manual de funcionamiento del 
smartphone.
ˎˎ NFC (Near Field Communication) es 
un protocolo de comunicaciones 
internacionales para la comunicación 
inalámbrica entre objetos cercanos.

4.	 Interruptor HOLD (página 108)
Deshabilita el funcionamiento de la unidad 
(estado en espera).

5.	 Botón/indicador START/STOP de 
grabación (página 32)

6.	 Dial ND VARIABLE (página 41)

7.	 Interruptor ND PRESET/VARIABLE 
(página 41)

8.	 Botones arriba/abajo de ND FILTER 
POSITION (página 41)

9.	 Indicador ND CLEAR (página 41)

10.	Botón ND VARIABLE AUTO (página 41)

11.	Botón STATUS (página 14)
Muestra los ajustes principales de la unidad. 
Pueden cambiarse los ajustes de algunos 
elementos.

12.	Indicador FOCUS AUTO (página 34)

13.	Interruptor FOCUS (página 34)

14.	Botón PUSH AUTO FOCUS (página 37)

15.	Botón de función IRIS (página 40)

16.	Botón PUSH AUTO IRIS (página 40)

17.	Botón de función ISO/GAIN (página 40)

18.	Interruptor ISO/GAIN (ganancia 
seleccionada) (página 40)

19.	Botón ASSIGN (asignable) 9 (página 46)

20.	Botón de función WHT BAL (balance de 
blancos) (página 43)

21.	Interruptor WHT BAL (selección de 
memoria de balance de blancos) 
(página 43)

22.	Botón de función SHUTTER (página 41)

23.	Entrada de aire

[Nota]
No cubra la entrada de aire.

24.	Indicador POWER (página 32)

25.	Interruptor POWER (página 32)
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Lateral derecho (trasero)

MENU

THUMBNAIL

EXT

MI SHOE MAN

INT AUTO

SLOT SELECT  

AUDIO LEVEL

CANCEL/
BACK

DISPLAY

S&Q

1

3

EXT

MI SHOE MAN

INT AUTO

7 8

CH-1

CH-2

CH-3

CH-42

1 2

1415 13
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3
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7
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1.	 Botones ASSIGN (asignables) del 1 al 3, 
del 7 al 8 (página 46)

2.	 Botón SLOT SELECT (selección de la tarjeta 
de memoria XQD) (página 32)

3.	 Interruptor de selección CH1 INPUT 
(página 44)

4.	 Interruptor CH1 (AUTO/MAN) 
(página 44)

5.	 Dial AUDIO LEVEL (CH1) (página 44)

6.	 Dial AUDIO LEVEL (CH3) (página 44)

7.	 Interruptor de selección CH2 INPUT 
(página 44)

8.	 Interruptor CH2 (AUTO/MAN) 
(página 44)

9.	 Dial AUDIO LEVEL (CH2) (página 44)

10.	Dial AUDIO LEVEL (CH4) (página 44)

11.	Botón CANCEL/BACK (página 71)

12.	Flechas (///) y botón SET 
(página 71)

13.	Botón MENU (página 73)

14.	Botón THUMBNAIL (página 70)

15.	Botón DISPLAY (visualización de la 
pantalla) (página 11)
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Ranura de tarjetas, parte posterior y terminales
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1.	 Ranura A de la tarjeta XQD(página 28)

2.	 Indicador de acceso XQD (A) 
(página 29)

3.	 Ranura B de la tarjeta XQD (página 29)

4.	 Indicador de acceso XQD (B) 
(página 29)

5.	 Toma de auriculares (página 32)

6.	 Indicador de acceso de la tarjeta SD 
(página 31)

7.	 Ranura de tarjetas UTILITY SD/MS 
(página 31)

8.	 Conector de la unidad de extensión 
(interno) (página 25)

9.	 Conector DC IN (página 19)

10.	Lámpara indicadora/indicador de 
grabación (parte trasera) (página 32)

11.	Botón BATT RELEASE (página 18)

12.	Batería (página 18)

13.	Acoplamiento de la batería (página 18)

14.	Entrada de aire

[Nota]

No cubra la entrada de aire.

15.	Micrófono interno (página 44)
Micrófono de narración para grabar el sonido 
ambiental.

16.	Conector SDI OUT 1 (página 119)

17.	Conector INPUT1 (entrada de audio 1) 
(página 44)

18.	Conector INPUT2 (entrada de audio 2) 
(página 44)

19.	Conector SDI OUT 2 (página 119)

20.	Interruptor de selección IN/OUT 
(página 120)

21.	Conector TC IN/TC OUT (entrada/salida de 
código de tiempo) (página 120)

22.	Conector GENLOCK IN (entrada de 
genlock)/REF OUT (salida de señal de 
sincronización) (página 120)

23.	Conector HDMI OUT (página 119)

Parte inferior

1

1.	 Orificios para los tornillos del trípode 
(1/4 pulgadas, 3/8 pulgadas)

Acople la unidad a un trípode (opcional, 
longitud de tornillos 5,5 mm o inferior) que 
admite tornillos 1/4-20 UNC o 3/8-16 UNC.

Visor

Para obtener más información acerca de la 
conexión del visor (suministrado), consulte la 
página 20.

1
2
3

4 65

1.	 Botón PEAKING

2.	 Botón ZEBRA

3.	 Botón ASSIGN (asignable) 10 (página 46)

4.	 Interruptor MIRROR

5.	 Ganchos de conexión del ocular

6.	 Panel táctil
Las operaciones táctiles se pueden 
deshabilitar mediante un botón asignable o 
con el menú (página 10).
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Ocular

Para obtener más información acerca de la 
conexión del ocular (suministrado), consulte la 
página 22.

1 2

1.	 Dial de ajuste dióptrico

2.	 Copa ocular

Control remoto de la empuñadura

Para obtener más información acerca 
de la conexión del control remoto de la 
empuñadura (suministrado), consulte la 
página 23.

1
2
3

4

5
6
7
8

1.	 Palanca de zoom

2.	 Botón ASSIGN (asignable) 4

3.	 Dial asignable

4.	 Botón ASSIGN (asignable) 6

5.	 Palanca de rotación de la empuñadura

6.	 Botón START/STOP de grabación

7.	 Selector múltiple (pad D de 8 formas y 
botón SET)

8.	 Botón ASSIGN (asignable) 5 

Módulo de ampliación XDCA-FX9 
(opcional)

Para obtener más información sobre la 
conexión de un módulo de ampliación 
XDCA‑FX9 (opcional), consulte la página 25.

Vista frontal

1

2
3

1.	 Ranura de inserción de receptor 
inalámbrico

Acople un sintonizador inalámbrico portátil 
cuando utilice un micrófono inalámbrico.

2.	 Conector DC OUT (tipo redondo de 4 
contactos)

Conector de salida de alimentación de 12 V CC.

3.	 Conector LIGHT (2 contactos)
Conector de salida de alimentación de 12 V CC.

Vista posterior

2

1

4

6

3

5

7 8

1.	 Conectores USB (tipo A)

2.	 Palanca de liberación de la batería

3.	 Terminal de acoplamiento de la batería

4.	 Conector TC OUT (tipo BNC)

5.	 Conector REF OUT (tipo BNC)

6.	 Conector DC IN (tipo XLR, 4 contactos)

7.	 Conector RAW OUT (tipo BNC)

8.	 Conector LAN
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Precauciones de uso del panel 
táctil

El visor de la unidad es un panel táctil que se 
controla directamente tocándolo con el dedo.
ˎˎ El panel táctil está diseñado para tocarse 
ligeramente con el dedo. No presione el 
panel con fuerza ni lo toque con objetos 
afilados o puntiagudos (uña, bolígrafo, 
alfiler, etc.)
ˎˎ Es posible que el panel táctil no responda 
si se toca en las siguientes circunstancias. 
También se podría producir un fallo de 
funcionamiento.
ˎˎ Funcionamiento con la punta de las 
uñas de los dedos
ˎˎ Funcionamiento mientras la superficie 
está en contacto con otros objetos
ˎˎ Funcionamiento con una lámina o un 
adhesivo de protección colocados
ˎˎ Funcionamiento con gotas de agua o 
condensación en la pantalla
ˎˎ Funcionamiento con los dedos mojados 
o sudados
ˎˎ Funcionamiento en el agua

Gestos del panel táctil

Pulsar
Toque ligeramente un elemento, como un 
icono, con el dedo y luego retire el dedo 
inmediatamente.

Arrastrar
Toque la pantalla y deslice el dedo hasta 
la posición deseada de la pantalla. A 
continuación, retire el dedo.

Desplazar/deslizar
Toque la pantalla y desplace/deslice 
rápidamente el dedo hacia arriba, abajo, 
izquierda o derecha.

[Consejo]
Si el contenido de la pantalla continúa sobresaliendo de 
los bordes de la pantalla, puede arrastrar o desplazar el 
contenido de la pantalla.

Configuración del panel táctil

El funcionamiento del panel táctil se puede 
activar/desactivar mediante Touch Operation 
(página 76) en el menú Technical.

Uso del panel táctil
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Visualización de la pantalla
Durante la filmación (grabación/en espera) y la reproducción, el estado y la configuración del 
camcorder se superponen sobre la imagen mostrada en el visor.
Puede mostrar/ocultar la información con el botón DISPLAY.
También puede elegir si desea mostrar u ocultar cada elemento independientemente 
(página 101).

Información mostrada en la pantalla durante la filmación
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1.	 Indicador de estado de red (página 13)
Muestra el estado de conexión de red a través 
de un icono.

2.	 Indicador de carga/indicador de archivos 
restantes (página 62)

3.	 Indicador del estado en modo Cliente en 
red (página 13)

Muestra el estado de conexión en el modo 
Cliente en red.

4.	 Indicador de estado de flujo

5.	 Indicador de área de enfoque 
(página 34)

Muestra el área de enfoque para el enfoque 
automático.

6.	 Modo de grabación, ranura A/B, indicador 
de intervalo de grabación Interval Rec 
(página 48)

Pantalla Significado

Rec Grabación

Stby Grabación en espera

7.	 Indicador de profundidad de campo

8.	 Indicador de modo de escaneado de la 
cámara (página 27)

Se muestra una marca  si hay una 
discrepancia entre el tamaño del círculo de 
la imagen del objetivo y el ajuste del modo 
de escaneado de la cámara del tamaño de 
imagen efectivo.

9.	 Indicador de estado de funcionamiento 
de la salida RAW (página 55)

Muestra el estado de salida de la señal RAW.

10.	Indicador de estado de serie UWP-D 
(página 13)

Muestra la intensidad de la señal de nivel RF 
utilizando un icono cuando se conecta un 
dispositivo de la serie UWP-D a una zapata 
MI configurada para la transferencia de audio 
digital.

11.	 Indicador de la velocidad de fotogramas 
con Slow & Quick Motion (página 47)

12.	Indicador de capacidad de batería 
restante/tensión de DC IN (página 18)

13.	Indicador de modo de enfoque 
(página 38)

Significado Pantalla

Modo Focus Hold Focus Hold

Modo MF MF

Modo AF AF

AF de detección de caras/ojos (AF/ /Only/ /
)

Icono de detección de 
caras/ojos

Icono de AF de detección 
de caras/ojos

Only

Icono de cara registrada  

Icono de pausa AF durante 
el AF de detección de 
caras/ojos1)

1)	 Aparece cuando no hay una cara registrada y no se 
detecta una cara, o cuando hay una cara registrada y 
no se detecta la cara registrada.

14.	Indicador de posición del zoom
Muestra la posición del zoom en el rango de 
0 (gran angular) a 99 (telefoto) (si se acopla 
un objetivo compatible con la pantalla de 
configuración de zoom).

La pantalla se puede cambiar a un indicador 
de barra o indicador de distancia focal 
(página 109).

15.	Indicador de estado GPS (página 52)
Muestra el estado del GPS.

16.	Indicador de modo de estabilización de la 
imagen

17.	 Indicador de estado de Rec Control de 
salida SDI/HDMI (página 119)

Muestra el estado de salida de la señal de 
control REC.

18.	Indicador de enfoque (página 37)

19.	Indicador de capacidad restante de los 
soportes

20.	Indicador de modo de balance de blancos

Pantalla Significado

Modo Auto

 Hold Modo Auto pausado

W:P Modo predeterminado

W:A Modo de Memoria A

W:B Modo de Memoria B

21.	Indicador de bloqueo de código de 
tiempo externo/pantalla de datos sobre 
el tiempo (página 32)

Muestra “EXT-LK” cuando está bloqueado con 
el código de tiempo de un dispositivo externo.

22.	Indicador del filtro ND (página 41)

23.	Indicador de archivos de escena 
(página 117)

24.	Indicador de diafragma
Muestra la posición del diafragma (valor F o 
T) si se acopla un objetivo compatible con la 
pantalla de configuración del diafragma.

25.	Indicador del advertencia del nivel de 
vídeo
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26.	Indicador de ganancia (página 40)
Se muestra como valor EI cuando Base Setting 
>Shooting Mode (página 88) en el menú 
Project está ajustado en Cine EI.

Pantalla Significado

Modo Auto

H Modo H predeterminado

M Modo M predeterminado

L Modo L predeterminado

Modo de ajuste temporal

27.	Visualización del nombre del clip 
(página 70)

28.	Indicador de obturación (página 41)

29.	Indicador de modo AE/nivel AE 
(página 40)

30.	Indicador de nivel de burbuja
Muestra el nivel horizontal en intervalos de ±1° 
hasta ±15°.

31.	Medidor del nivel de audio
Muestra el nivel de audio de CH1 y CH2.
CH3 y CH4 se pueden controlar en la pantalla 
de estado.

32.	Monitor de señal de vídeo (página 51)
Muestra una forma de onda, un vectorscopio y 
un histograma.
El tipo de LUT de monitor de la señal 
monitorizada se muestra cuando Base Setting 
>Shooting Mode (página 88) en el menú 
Project está configurado en Cine EI.

33.	Indicador de formato de grabación 
(códec) (página 88)

Muestra el nombre del formato de grabación 
en tarjetas de memoria XQD.

34.	Indicador de Base Sensitivity/indicador 
de Base ISO (página 40)

Cuando Base Setting >Shooting Mode 
(página 88) en el menú Project está 
configurado en SDR o HDR, muestra la 

sensibilidad básica establecida usando ISO/
Gain/EI >Base Sensitivity en el menú Shooting.
Cuando Base Setting >Shooting Mode 
(página 88) en el menú Project está 
configurado en Cine EI, muestra la sensibilidad 
ISO básica establecida usando ISO/Gain/EI 
>Base ISO en el menú Shooting.

35.	Indicador de la pantalla asistida de 
gamma/LUT de monitor

Muestra el estado de la pantalla asistida de 
gamma. La función de la pantalla asistida 
de gamma se puede activar/desactivar 
asignando Gamma Display Assist a un botón 
asignable (página 46).
Muestra la configuración LUT del monitor 
cuando Base Setting >Shooting Mode 
(página 88) en el menú Project está 
configurado en Cine EI (página 86).

36.	Indicador de gamma (página 95)
Muestra el ajuste gamma de la imagen 
grabada en tarjetas de memoria XQD.

37.	Indicador de estado de proxy

38.	Indicador de grabación 4K & HD (Sub)

39.	Indicador de formato de grabación 
(velocidad de fotogramas y método de 
exploración)

40.	Indicador de formato de grabación 
(tamaño de imagen) (página 88)

Muestra el tamaño de imagen para 
grabaciones en tarjetas de memoria XQD.

Información mostrada en la pantalla durante la reproducción

La siguiente información se superpone sobre la imagen reproducida.

1

11 12 13 14 15 16

2 3 4 5 6 7 8 9 10

1.	 Indicador de estado de red

2.	 Indicador de carga/indicador de archivos 
restantes

3.	 Número del clip/número total de clips

4.	 Indicador de estado de reproducción

5.	 Indicador de formato de reproducción 
(velocidad de fotogramas y método de 
exploración)

6.	 Indicador del estado en modo Cliente en 
red

7.	 Indicador de estado de flujo

8.	 Indicador de formato de reproducción 
(tamaño de imagen)

9.	 Indicador de capacidad de batería 
restante/tensión de DC IN

10.	Indicador de formato de reproducción 
(códec)

11.	 Indicador de soporte
Si la tarjeta de memoria está protegida contra 
escritura, aparece un icono .

12.	Visualización de datos de tiempo

13.	Visualización del nombre del clip

14.	Indicador de la pantalla asistida de 
gamma

15.	Medidor del nivel de audio
Muestra el nivel de grabación de audio.

16.	Indicador de gamma
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Visualización de iconos

Visualización de iconos de conexión de red

Modo de red Estado de conexión Icono

Modo de punto de acceso Funciona como un punto de acceso

Error de funcionamiento de punto de 
acceso

Modo de estación Conexión Wi-Fi
El icono cambia según la intensidad de 
la señal (4 pasos)

   

Wi-Fi desconectado (incluso cuando se 
establece la conexión)

Error al conectarse al Wi-Fi

Módem 1) El icono cambia según la intensidad de 
la señal de conexión 3G/4G (5 pasos)
El icono para la intensidad de la señal 3 
se muestra para los módems que no 
informan la intensidad de la señal.

Conexión 3G

 – 

Conexión 4G

 – 

Conexión de red donde no 
se puede distinguir 3G/4G

 – 

3G/4G desconectado (incluso cuando 
se establece la conexión)

Error al conectarse al 3G/4G

1)	 Se pueden conectar dos módems cuando se conecta un XDCA-FX9 (opcional) a la videocámara. Cuando se 
conectan dos módems, los Iconos cambian según el estado del módem de la siguiente manera.

Estado de conexión Icono

Dos módems conectados, solo módem 1 en uso 	

Dos módems conectados, solo módem 2 en uso 	

Dos módems conectados, ambos en uso 	

Visualización del icono del modo Cliente de red

Estado de conexión del modo Cliente en red Icono

Estado conectado del modo Cliente en red

Estado de espera de conexión del modo Cliente en red

Estado de error de conexión del modo Cliente en red

Visualización de iconos de la serie UWP-D

Estado del transmisor Estado de recepción Icono

Apagado Sin recepción

Estado de transmisión normal Recibiendo
 –   

(nivel de recepción (4 pasos))

Estado de silenciación Recibiendo (en silencio)

Estado de advertencia de capacidad 
restante de la batería

Recibiendo
 (Icono parpadeando)

Estado de advertencia de capacidad 
restante de la batería y silenciación

Recibiendo
 (Icono parpadeando)
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Pantalla de estado

Puede comprobar la capacidad restante de 
la videocámara en la pantalla de estado. Los 
ajustes de los elementos marcados con un 
asterisco (*) se pueden cambiar.
La pantalla de estado admite el 
funcionamiento táctil.

Para mostrar la pantalla de estado
ˎˎ Pulse el botón STATUS.

Para cambiar la pantalla de estado
ˎˎ Gire el dial multifunción.
ˎˎ Pulse los botones de flechas /.
ˎˎ Deslice la pantalla de estado hacia arriba/
abajo.

Para ocultar la pantalla de estado
ˎˎ Pulse el botón STATUS.

Para cambiar un ajuste

Cuando se muestre la pantalla de estado, 
pulse el dial multifunción o el selector múltiple 
para permitir la selección de un elemento de 
configuración en una página. Seleccione un 
número de página y pulse para cambiar de 
página. También puede seleccionar elementos 
directamente con el funcionamiento táctil.

[Consejo]
Puede deshabilitar los cambios en la pantalla de 
estado ajustando Menu Settings >User Menu Only 
(página 108) en el menú Technical en On.

Pantalla Main Status

Muestra las funciones principales de la cámara 
y el espacio libre en los soportes.

Elemento de la 
pantalla

Descripción

S&Q Frame Rate Configuración de velocidad 
de fotogramas para disparos 
en Slow & Quick Motion

Frequency/Scan* Frecuencia del sistema y 
ajustes del método de 
escaneado

Imager Scan* Modo de escaneado del 
sensor de imagen

Media Remain 
(A)

Espacio libre restante en los 
soportes de la ranura A

ND Filter Ajustes del filtro ND

ISO/Gain/EI Ajuste de ISO/Gain/
Exposure Index

Base ISO/
Sensitivity*

Ajuste de Base ISO/Base 
Sensitivity

Codec* Ajuste de códec para 
grabación y activación/
desactivación de la salida 
RAW

Media Remain (B) Espacio libre restante en los 
soportes de la ranura B

Scene File* Archivo de escena en uso y 
su ajuste de File ID

Monitor LUT* Ajuste de Monitor LUT

Shutter Velocidad de obturación o 
ajuste del ángulo de 
obturación

Iris Ajuste del diafragma

Video Format* Tamaño de imagen para 
grabaciones en tarjetas de 
memoria XQD

RAW Output 
Format*

Tamaño de imagen de la 
salida RAW

White Balance Ajuste del balance de 
blancos

Pantalla Camera Status

Muestra el estado de diferentes preajustes de 
la cámara.

Elemento de la 
pantalla

Descripción

White Switch<B> Ajuste de la memoria B del 
balance de blancos

White Switch<A> Ajuste de la memoria A del 
balance de blancos

White Switch<P> Ajuste de Preset White

ND<Preset> ND Filter Preset1 a 3 ajustes

ISO / Gain<L>* Ajuste ISO/Gain<L>

ISO / Gain<M>* Ajuste ISO/Gain<M>

ISO / Gain<H>* Ajuste ISO/Gain<H>

Base ISO/
Sensitivity*

Ajuste de Base ISO/Base 
Sensitivity

Zebra1 Ajuste Zebra1 On/Off y nivel

Zebra2 Ajuste Zebra2 On/Off y nivel

VF Gamma/
Gamma

Categoría gamma y curva

Scene File* Archivo de escena en uso y 
su ajuste de File ID

Pantalla Audio Status

Muestra el ajuste de entrada, el medidor 
del nivel de audio y el ajuste del monitor de 
volumen para cada canal.

Elemento de la 
pantalla

Descripción

CH1 Level Control Estado de activación/
desactivación del ajuste 
automático

Level Meter Medidor del nivel de 
audio

Source* Fuente de entrada

Ref./Sens.* Nivel de referencia de 
entrada

Wind Filter* Ajuste del filtro de 
reducción del ruido del 
viento en el micrófono

Elemento de la 
pantalla

Descripción

CH2 Level Control Estado de activación/
desactivación del ajuste 
automático

Level Meter Medidor del nivel de 
audio

Source* Fuente de entrada

Ref./Sens.* Nivel de referencia de 
entrada

Wind Filter* Ajuste del filtro de 
reducción del ruido del 
viento en el micrófono

CH3 Level Control* Estado de activación/
desactivación del ajuste 
automático

Level Meter Medidor del nivel de audio

Source* Fuente de entrada

Ref./Sens.* Nivel de referencia de 
entrada

Wind Filter* Ajuste del filtro de 
reducción del ruido del 
viento en el micrófono

CH4 Level Control* Estado de activación/
desactivación del ajuste 
automático

Level Meter Medidor del nivel de audio

Source* Fuente de entrada

Ref./Sens.* Nivel de referencia de 
entrada

Wind Filter* Ajuste del filtro de 
reducción del ruido del 
viento en el micrófono

Audio Input Level* Ajuste del nivel de 
entrada de audio maestro

HDMI Output CH* Ajuste del canal de audio 
de salida HDMI

Headphone Out* Ajuste del tipo de salida 
de auriculares

Monitor CH* Ajuste del canal del 
monitor
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[Nota]
Los ajustes de Source para CH1 y CH2 se seleccionan 
mediante el interruptor de selección CH1 INPUT 
(página 7) y el interruptor de selección CH2 INPUT 
(página 7) en el lateral derecho de la unidad. 
Puede ajustar Source para CH1 y CH2 cuando utilice 
un sintonizador inalámbrico portátil (página 25). 
También puede ajustar Source para CH2 cuando el 
interruptor de selección CH2 INPUT esté ajustado en EXT.

Pantalla de estado de Project

Muestra los ajustes básicos relacionados con 
el proyecto de filmación.

Elemento de la 
pantalla

Descripción

Frequency/Scan* Frecuencia del sistema y 
ajustes del método de 
escaneado

Codec* Ajustes de códec para 
grabación

Rec Function Se habilita un formato de 
grabación y unos ajustes 
especiales

Simul Rec* Estado y ajuste de 
activación/desactivación de 
la función de grabación 
simultánea en 2 ranuras

Title Prefix Parte del título del nombre 
del clip

Imager Scan* Modo de escaneado del 
sensor de imagen

Video Format* Tamaño de imagen para 
grabaciones en tarjetas de 
memoria XQD

Picture Cache 
Rec*

Estado de encendido/
apagado y configuración de 
la función de grabación de 
memoria intermedia

Number Sufijo numérico del nombre 
del clip

Shooting Mode* Ajuste del modo de disparo

RAW Output 
Format*

Tamaño de imagen de la 
salida RAW

Elemento de la 
pantalla

Descripción

4K & HD (Sub) 
Rec*

Estado de encendido/
apagado de la función de 
grabación 4K & HD (Sub)

Proxy Rec* Estado de encendido/
apagado y configuración de 
la función de grabación 
proxy

Genlock Estado de Genlock

Pantalla Monitoring Status

Muestra los ajustes de salida de vídeo, SDI y 
HDMI.

Elemento de la 
pantalla

Descripción

SDI1 Signal* Tamaño de la imagen 
de salida

Info. Disp* Ajuste de activación/
desactivación de la 
pantalla de salida

Color 
Gamut*

Ajuste del espacio de 
color/estado de 
Monitor LUT

SDI2 Signal* Tamaño de la imagen 
de salida

Info. Disp* Ajuste de activación/
desactivación de la 
pantalla de salida

Color 
Gamut*

Ajuste del espacio de 
color/estado de 
Monitor LUT

HDMI Signal* Tamaño de la imagen 
de salida

Info. Disp* Ajuste de activación/
desactivación de la 
pantalla de salida

Color 
Gamut*

Ajuste del espacio de 
color/estado de 
Monitor LUT

Elemento de la 
pantalla

Descripción

Stream Signal Tamaño de la imagen 
de salida

Info. Disp Pantalla de salida (Off 
(fijo))

Color 
Gamut*

Ajuste del espacio de 
color/estado de 
Monitor LUT

RAW Tamaño de imagen de 
la salida RAW

Monitor LUT* Ajuste de Monitor LUT

VF* Ajuste de pantalla 
asistida de gamma/
estado de Monitor 
LUT/ajuste del espacio 
de color

[Nota]
La configuración LUT del monitor se vincula a todos 
los sistemas de salida, incluido el visor. Solo el ajuste 
de pantalla asistida de gamma está disponible para la 
pantalla del visor.

Pantalla Assignable Button Status

Muestra las funciones asignadas a cada uno 
de los botones asignables.

Elemento de la 
pantalla

Descripción

1 Función asignada al botón 
ASSIGN 1

2 Función asignada al botón 
ASSIGN 2

3 Función asignada al botón 
ASSIGN 3

4 Función asignada al botón 
ASSIGN 4

5 Función asignada al botón 
ASSIGN 5

6 Función asignada al botón 
ASSIGN 6

7 Función asignada al botón 
ASSIGN 7

Elemento de la 
pantalla

Descripción

8 Función asignada al botón 
ASSIGN 8

9 Función asignada al botón 
ASSIGN 9

10 Función asignada al botón 
ASSIGN 10

Focus Hold 
Button

Función asignada al botón 
Focus Hold del objetivo

Multi Function 
Dial

Función asignada al dial 
multifunción

Assignable Dial Función asignada al dial 
asignable

Pantalla Battery Status

Muestra información sobre la batería y sobre la 
fuente DC IN.

Elemento de la 
pantalla

Descripción

Detected Battery Tipo de batería

Remaining Capacidad restante (%)

Charge Count Número de recargas

Capacity Capacidad restante (Ah)

Voltage Tensión (V)

Manufacture 
Date

Fecha de fabricación de la 
batería

Video Light 
Remaining

Muestra la capacidad 
restante de la batería de la 
luz de vídeo.

Power Source Fuente de alimentación

Supplied Voltage Tensión de la fuente de 
alimentación

Pantalla Media Status

Muestra la capacidad y el tiempo de grabación 
restantes de los soportes de grabación.
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Elemento de la 
pantalla

Descripción

Información del 
soporte A

Muestra el icono del soporte 
cuando el soporte de 
grabación se ha introducido 
en la ranura A.

Medidor de la 
capacidad 
restante del 
soporte A

Muestra la capacidad de 
grabación restante del 
soporte de grabación 
introducido en la ranura A, 
expresado en forma de 
porcentaje en un gráfico de 
barras.

Tiempo de 
grabación 
restante del 
soporte A

Muestra un cálculo del 
tiempo de grabación 
restante del soporte de 
grabación introducido en la 
ranura A, expresado en 
minutos según las 
condiciones de grabación 
actuales.

Información del 
soporte B

Muestra el icono del soporte 
cuando el soporte de 
grabación se ha introducido 
en la ranura B.

Medidor de la 
capacidad 
restante B

Muestra la capacidad de 
grabación restante del 
soporte de grabación 
introducido en la ranura B, 
expresado en forma de 
porcentaje en un gráfico de 
barras.

Tiempo de 
grabación 
restante del 
soporte B

Muestra un cálculo del 
tiempo de grabación 
restante del soporte de 
grabación introducido en la 
ranura B, expresado en 
minutos según las 
condiciones de grabación 
actuales.

Información de la 
tarjeta SD

Muestra el icono de 
soportes cuando se ha 
introducido alguno en la 
ranura de la tarjeta UTILITY 
SD/MS.

Elemento de la 
pantalla

Descripción

Protección de la 
tarjeta SD

Muestra el icono de bloqueo 
cuando el soporte 
introducido en la ranura de 
la tarjeta UTILITY SD/MS está 
protegido (bloqueado).

Medidor de la 
capacidad 
restante de la 
tarjeta SD

Muestra la capacidad 
restante del soporte 
introducido en la ranura de 
la tarjeta UTILITY SD/MS, 
expresado en forma de 
porcentaje en un gráfico de 
barras.

Capacidad 
restante de la 
tarjeta SD

Muestra una estimación del 
tiempo de grabación 
restante de los soportes de 
grabación insertados en la 
ranura de la tarjeta UTILITY 
SD/MS en unidades de 
minutos, o muestra la 
capacidad restante en 
unidades de GB.

Pantalla GPS Status

Muestra el estado y la información del 
posicionamiento GPS.

Elemento de la 
pantalla

Descripción

GPS Estado del posicionamiento 
y la señal GPS

Dilution Of 
Precision

Información de precisión de 
posicionamiento

Latitude Información de latitud

Longitude Información de longitud

Altitude Información de altitud

Positioning date 
and time

Fecha y hora del 
posicionamiento

Current date and 
time

Fecha y hora actuales

Time Zone Ajustes de Time Zone

Pantalla Network Status

Muestra el estado de conexión de red.

Elemento de la 
pantalla

Descripción

Wireless LAN Configuración de red 
inalámbrica y estado de 
conexión

Wired LAN Configuración de red LAN 
con cable y estado de 
conexión

Modem 1 Configuración de red 
inalámbrica y estado de 
conexión del módem 
(opcional)

Modem 2 Configuración de red 
inalámbrica y estado de 
conexión del módem 
(opcional)

Pantalla NCM/Streaming Status

Muestra el estado de la conexión en modo 
Cliente en red y el estado de transmisión.

Elemento de la 
pantalla

Descripción

Network Client 
Mode Status

Estado en modo Cliente en 
red

CCM Name Nombre del CCM conectado 
en el modo Cliente en red

CCM Address Dirección del CCM 
conectado en el modo 
Cliente en red

QoS Streaming1 
Bit Rate

Velocidad de bits de 
transmisión 1

QoS Streaming2 
Bit Rate

Velocidad de bits de 
transmisión 2

Streaming Status Estado de la transmisión

Streaming Type Tipo de transmisión 
seleccionado actualmente

Pantalla File Transfer Status

Muestra información sobre la transferencia de 
archivos.

Elemento de la 
pantalla

Descripción

Auto Upload 
(Proxy)

Estado On/Off de la función 
Auto Upload (Proxy)

Job Status 
(Remain/Total)

Número restante de trabajos 
y número total de trabajos

Total Transfer 
Progress

Progreso de transferencia de 
todos los trabajos

Default Upload 
Server

Nombre del servidor de 
destino de carga automática 
(Proxy)

Current File 
Transfer Progress

Progreso de transferencia de 
la transferencia de archivos 
actual

Current 
Transferring File 
Name

Nombre del archivo que se 
está transfiriendo en estos 
momentos

Server Address Dirección del servidor de 
destino de transferencia de 
archivos

Destination 
Directory

Directorio de destino del 
servidor de transferencia de 
archivos
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Uso de las pantallas de configuración táctiles

Diseño de la pantalla

Elemento Botón Set

Marca indicadora 
del ajuste actual

Cursor de selección de 
ajuste (cuadro naranja)

Nombre del elemento

Opciones de selección

Funcionamiento

1	 Pulse un elemento de configuración.

Pulsar

Aparecen las opciones de selección del 
valor.

2	 Toque un valor directamente o arrastre/
pulse para mover el valor deseado a la 
posición del cursor.

Desplazar

3	 Pulse el botón SET o el cursor de selección 
de valor.
El valor se aplica y se vuelve a visualizar la 
pantalla anterior.

[Consejos]
ˎˎ También puede pulsar el botón de la flecha  para 

aplicar el valor.
ˎˎ 	Pulse el botón de CANCEL/BACK para volver al valor 

anterior.

ˎˎ 	También puede usar el dial multifunción o el selector 
múltiple.
ˎˎ 	Las operaciones táctiles también se pueden 

desactivar (página 10).
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Fuente de alimentación
Puede utilizar una batería o una fuente de 
alimentación de CA mediante un adaptador 
de CA.
Por su seguridad, utilice sólo las baterías y los 
adaptadores de CA Sony que se enumeran a 
continuación.

Baterías de iones de litio
BP-U35 (suministrado)
BP-U60
BP-U70
BP-U90
BP-U100

Cargadores de baterías
BC-U1A (suministrado)
BC-U2A

Adaptador de CA (suministrado)

Se puede usar una batería de zapata en V 
cuando se conecta un módulo de ampliación 
XDCA-FX9.
Por su seguridad, utilice sólo las baterías y los 
adaptadores de CA Sony que se enumeran a 
continuación.

Baterías de iones de litio
BP-GL95B

Adaptador de CA
AC-DN10A

[PRECAUCIÓN]

No guarde las baterías en lugares expuestos 
a la luz solar directa, cerca de fuegos ni a 
temperatura elevadas.

[Notas]
ˎˎ Cuando se utilice conectado a una fuente de 

alimentación de CA, utilice el adaptador de CA 
suministrado.
ˎˎ Ajuste siempre el interruptor POWER (Alimentación) 

en la posición de apagado antes de desconectar 
o conectar una batería o un adaptador de CA. En 
determinados casos, si el dispositivo se desconecta o 
se conecta con el interruptor POWER (Alimentación) 

en la posición de encendido, es posible que 
la videocámara no sea capaz de iniciarse. Si la 
videocámara no se puede iniciar, ajuste el interruptor 
POWER en la posición de Off y extraiga la batería 
o desconecte el adaptador de CA temporalmente; 
a continuación, espere unos 30 segundos antes 
de volver a intentar conectarlos. (Si el adaptador 
de CA está desconectado o conectado mientras la 
videocámara funciona gracias a la batería, o viceversa, 
el dispositivo se puede desconectar o conectar con el 
interruptor POWER (Alimentación) en la posición de 
encendido sin problemas).
ˎˎ Al utilizar un adaptador AC-DN10A y conectar 

dispositivos periféricos a la videocámara, asegúrese 
de que el consumo energético total de los 
dispositivos periféricos es menor que 25 W.

Utilización de una batería

Para colocar la batería, conéctela en el 
acoplamiento (página 8) empujándolo 
hasta el tope y a continuación deslícela 
hacia abajo para que quede bloqueada en la 
posición final.

Para extraer la batería, mantenga pulsado el 
botón BATT RELEASE (página 8), deslícela 
hacia arriba y a continuación, tire de ella para 
sacarla del acoplamiento.

Botón BATT 
RELEASE

[Notas]
ˎˎ Antes de colocar una batería, cárguela con los 

cargadores de baterías BC-U1A o BC-U2A específicos.
ˎˎ Si carga la batería mientras está caliente (por ejemplo, 

inmediatamente después de utilizarla), es posible que 
no se recargue completamente.

Comprobación de la capacidad restante

Durante la filmación y la reproducción con 
batería, la capacidad de batería restante se 
muestra en el visor (página 11).

Icono Significado

Entre 91% y 100%

Entre 71% y 90%

Entre 51% y 70%

Entre 31% y 50%

Entre 11% y 30%

Entre 0% y 10%

La videocámara indica la capacidad restante 
al calcular el tiempo de uso disponible con la 
batería si el uso es continuado y con el ritmo 
de consumo de energía actual.

Uso de Módulo de ampliación

Cuando se utiliza Módulo de ampliación 
XDCA-FX9, se muestra la tensión de la batería 
o la capacidad de batería restante en función 
de la batería usada.

[Nota]
La batería de la videocámara no se puede conectar 
cuando un módulo XDCA-FX9 también está conectada a 
la videocámara. Deberá acoplar la batería a la XDCA-FX9 
o conectar la videocámara a una toma de alimentación 
externa.

Si el nivel de carga de la batería es bajo

Si la carga restante de la batería desciende 
por debajo de un nivel determinado durante 
el funcionamiento (estado Low Battery), 
aparecerá un mensaje de batería baja, la 
lámpara indicadora/indicador de grabación 
comenzará a parpadear y se escuchará un 
pitido de advertencia.
Si la carga restante de batería desciende por 
debajo del nivel al que el funcionamiento ya 
no puede continuar (estado Battery Empty), 
aparecerá un mensaje de batería agotada.
Sustituya la batería por una batería cargada.

Cambio de los niveles de voltaje de 
advertencia

El nivel Low Battery está ajustado en el 10% 
de la carga total de la batería y el nivel de 
Battery Empty está ajustado en el 3% de 
manera predeterminada. Puede cambiar la 
configuración del nivel de advertencia en 
Camera Battery Alarm (página 110) en el 
menú Technical.
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Utilización de la alimentación por 
CA

Si la videocámara se conecta a una fuente de 
alimentación de CA este se podrá utilizar sin 
preocuparse de la necesidad de recargar la 
batería.

Conector DC IN

Adaptador de CA

Cable de alimentación

Conecte el adaptador de CA al conector DC IN 
de la videocámara y, a continuación, conecte 
el cable de alimentación (suministrado) a una 
fuente de alimentación de CA.

Si disminuye la tensión de salida del 
adaptador de CA

Si la tensión de salida del adaptador de CA 
desciende por debajo de un determinado 
nivel durante el funcionamiento (DC Low 
Voltage1 state), aparecerá un mensaje 
informándole de que la tensión ha disminuido, 
la lámpara indicadora/indicador de grabación 
comenzará a parpadear y se escuchará un 
pitido.
Si la tensión de salida del adaptador de 
CA desciende por debajo del nivel mínimo 

requerido para el funcionamiento (DC Low 
Voltage2 state), aparecerá un mensaje 
informándole de que la tensión de salida del 
adaptador de CA es demasiado baja.
En ese caso, es posible que el adaptador de 
CA esté defectuoso. Si es necesario, verifique 
el adaptador de CA.

[Consejo]
Si se utiliza una fuente de alimentación de CA mientras 
esté conectada la batería, la videocámara cambiará 
automáticamente a la alimentación por batería si baja la 
tensión de salida del adaptador de CA.

Cambio de los niveles de advertencia

El nivel DC Low Voltage1 está ajustado en 
16,5 V y el nivel DC Low Voltage2 está ajustado 
en 15,5 V de manera predeterminada de 
fábrica. Puede cambiar la configuración del 
nivel de advertencia en Camera DC IN Alarm 
(página 110) en el menú Technical.

Adaptador de CA

ˎˎ No conecte ni utilice un adaptador de CA 
en espacios reducidos, como por ejemplo, 
entre una pared y un mueble.
ˎˎ Conecte el adaptador de CA a la fuente 
de alimentación de CA más cercana. Si se 
produce algún problema durante el uso, 
desconecte inmediatamente el cable de 
alimentación de la fuente de alimentación 
de CA.
ˎˎ No provoque un cortocircuito en las piezas 
metálicas del enchufe del adaptador 
de CA. Si lo hace, provocará un fallo de 
funcionamiento.
ˎˎ La batería no se puede cargar mientras 
está conectada al camcorder aunque el 
adaptador de CA esté conectado.
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Acople de dispositivos

Funcionamiento de la palanca de 
la abrazadera

Utilice las palancas de la abrazadera cuando 
conecte/retire o ajuste la posición del 
micrófono y el visor. 
Al conectar, gire la palanca de la abrazadera 
en el sentido de las agujas del reloj para 
asegurar la varilla.
Cuando retire o ajuste la posición, gire la 
palanca de la abrazadera en el sentido 
contrario a las agujas del reloj para aflojarla.
Si una palanca de la abrazadera está en una 
posición que dificulta el giro, tire de ella y 
gírela en un ángulo que facilite su uso. A 
continuación, vuelva a colocar la palanca de la 
abrazadera.

Palanca de la abrazadera

Ajuste de la posición del soporte 
del micrófono

Afloje la palanca de la abrazadera y gire el 
soporte del micrófono para moverlo hacia 
delante o hacia atrás con el fin de ajustar la 
posición. 

Palanca de la abrazadera

Orientación del soporte del micrófono y 
el micrófono

Acóplelo de manera que el soporte del 
micrófono y el micrófono estén orientados 
como se indica en el siguiente diagrama.

Sustitución de la varilla del 
micrófono

[Notas]
ˎˎ La varilla del micrófono viene acoplada de fábrica.
ˎˎ Acople o retire la varilla del micrófono mientras la 

videocámara está apagado.
ˎˎ Acople o retire la varilla del micrófono con la tapa del 

cuerpo acoplada de manera que no se dañe el sensor 
de imagen.

1	 Afloje el tornillo.

2	 Retire la varilla del micrófono.

3	 Fije la varilla del micrófono en la 
secuencia inversa.

Acople del visor

[Nota]
Acople o retire el visor mientras la videocámara esté 
apagado. Si se extrae el visor mientras la videocámara 
está encendida, esta se reiniciará automáticamente.

1	 Afloje la palanca de la abrazadera del 
visor e inserte el visor en la varilla del 
micrófono.

Palanca de la 
abrazadera

	 [Nota]
Al colocar el visor, acople la abrazadera de bloqueo 
a la varilla del micrófono de modo que las partes 
queden colocadas como se muestra en el siguiente 
diagrama.
–– Palanca de bloqueo de la abrazadera colocada 

entre la varilla del visor y el asa
–– Varilla del visor colocada sobre la varilla del 

micrófono

Asa

Palanca de 
bloqueo de la 

abrazadera

Varilla del 
visor

Varilla del 
micrófono

Abrazadera 
de la varilla
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2	 Ajuste la posición izquierda/derecha del 
visor, apriete la palanca de la abrazadera, 
conecte el cable del visor al conector del 
visor de la videocámara y fije el cable del 
visor en la abrazadera del cable.

Abrazadera del 
cable

	 [Notas]
ˎˎ 	Acople el visor de modo que la varilla del visor 

quede colocada sobre la palanca de bloqueo de 
la abrazadera del visor.

Varilla del visor

Palanca de bloqueo 
de la abrazadera

Abrazadera del 
visor

Visor

ˎˎ Compruebe que el visor esté conectado de forma 
segura. El visor puede caerse durante la filmación 
si la palanca de la abrazadera está suelta.

Ajuste de la orientación del visor

Incline el visor hacia arriba/abajo para ajustar 
el ángulo del visor.

Puede ajustar el ángulo de manera que 
el visor esté orientado hacia el sujeto. Si 
se ajusta el interruptor MIRROR en B/T, se 
invierten los lados izquierdo y derecho de la 
imagen en la pantalla LCD, pero la imagen se 
grabará en la orientación correcta.

Ajuste de la posición del visor

Ajuste de un ángulo de 90°
Si se acopla un espaciador de abrazadera 
cuadrado a la junta de conexión de la 
varilla, puede ajustar la posición del visor en 
incrementos de 90°.
Retire temporalmente el visor para ajustar el 
ángulo y, a continuación, vuelva a acoplar el 
visor.

Ajuste de ángulo arbitrario
Si se acopla un espaciador de abrazadera 
circular a la junta de conexión de la varilla, 

puede girar el visor en la varilla para ajustar la 
posición del visor.

Si el visor se gira 180° como se muestra en 
el siguiente diagrama, coloque el interruptor 
MIRROR en la posición ROT para voltear la 
visualización de la imagen y la visualización 
del texto horizontal y verticalmente.

[Nota]
Cuando acople un espaciador de abrazadera circular, 
acóplelo a una varilla comercial de 15 mm de diámetro.

[Consejo]
De fábrica, se ajustan espaciadores de abrazadera 
circulares.

Cambio del espaciador de la abrazadera

Retire el espaciador de la abrazadera como 
se indica en el siguiente diagrama, alinee el 
saliente del espaciador cuadrado o circular 
con la ranura de la abrazadera e inserte el 
espaciador.

Saliente

Saliente

Ranura

Ranura

[Nota]
Coloque siempre una arandela. Si no se acopla una 
arandela, la fuerza de sujeción de la varilla puede ser 
insuficiente y hacer que el visor se caiga.

Puede determinar la forma del espaciador 
como se indica en los siguientes diagramas.

Espaciador de abrazadera cuadrado

Marca 
cuadrada
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Espaciador de abrazadera circular

Marca circular

Extracción del visor

Afloje la palanca de la abrazadera del visor 
y siga los pasos del procedimiento de 
acoplamiento del visor en orden inverso.

Acople del ocular

[Nota]
Acople o retire el ocular mientras el camcorder está 
apagado.

1	 Acople el gancho de la parte superior del 
ocular al gancho de la parte superior del 
visor y acople la abrazadera de metal de 
la parte inferior del ocular al gancho de la 
parte inferior del visor.

Ganchos de conexión

2	 Pulse la placa de fijación en la parte 
inferior del ocular en la dirección de la 
flecha para fijar el ocular en posición.

Placa de 
fijación

Apertura del ocular

Pulse el botón indicado por la flecha.

Abra el ocular hacia arriba cuando se 
desconecta el bloqueo. El visor se puede ver 
directamente cuando el ocular se abre.

Extracción de la parte trasera del ocular

Con el ocular abierto hacia arriba, suelte el 
bloqueo del ocular en la dirección de la flecha 
() y deslice la parte posterior del ocular en la 
dirección de la flecha (). Cuando se retira la 
parte trasera del ocular, la parte frontal de este 
se puede usar en lugar de una cubierta.

Colocación de la parte trasera del ocular
Al colocar la parte posterior del ocular, alinee 
la proyección de la bisagra con la ranura de 
guía y empújela en la dirección de la flecha en 
el siguiente diagrama hasta que se bloquee.

Ranura guía Saliente

Extracción del ocular

Desconecte el bloqueo del ocular y extraiga el 
ocular del visor.

Acople de un objetivo

[PRECAUCIÓN]
No deje el objetivo orientado directamente al sol. La 
luz directa del sol puede penetrar a través del objetivo, 
enfocarse en el camcorder y provocar un incendio.

[Notas]
ˎˎ Acople o retire los objetivos mientras el camcorder 

esté apagado.
ˎˎ Los objetivos son componentes de precisión. No 

coloque los objetivos sobre una superficie dejando 
la montura de estos orientada hacia abajo. Acople la 
tapa de la montura del objetivo suministrada.

[Consejo]
Para obtener más información acerca de los objetivos 
compatibles con el camcorder, póngase en contacto con 
el servicio de asistencia técnica de Sony.

Acople de un objetivo de montura E

1	 Retire la cubierta del objetivo.

2	 Suelte la pieza de cierre del anillo de 
bloqueo del objetivo, gire el anillo de 
bloqueo del objetivo en el sentido de las 
agujas del reloj y extraiga la tapa del 
cuerpo del camcorder.
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Anillo de 
bloqueo 
del 
objetivo

Pieza de 
cierre del 
anillo de 
bloqueo del 
objetivo

3	 Alinee la marca de la montura del objetivo 
(blanca) con el camcorder, introduzca con 
cuidado el objetivo y, a continuación, gire 
lentamente el objetivo en el sentido 
contrario a las agujas del reloj para fijar el 
objetivo.

Marcas de la montura (blancas)

[Notas]
ˎˎ Si la pieza de cierre del anillo de bloqueo del objetivo 

no vuelve a la posición de bloqueo al acoplar el 
objetivo, desplácela hasta esa posición de forma 
manual.
ˎˎ Cuando fije un objetivo, alinee la marca de la montura 

(blanca) del anillo de bloqueo del objetivo con la 
marca de la montura (blanca) del camcorder.

Acople de un objetivo de montura A

Para utilizar un objetivo de montura A, acople 
un adaptador de montura de objetivos 
(opcional) y, a continuación, acople el objetivo 
de montura A.

[Nota]
Cuando se usa un objetivo con montura A, el diafragma 
se establece manualmente y el enfoque se establece 
en MF.

Extracción de un objetivo

Extraiga un objetivo a través del siguiente 
procedimiento.

1	 Suelte la pieza de cierre del anillo de 
bloqueo del objetivo y gire el anillo de 
bloqueo del objetivo en el sentido de las 
agujas del reloj mientras sujeta con 
firmeza el objetivo.

2	 Tire del objetivo hacia afuera en dirección 
de avance.

[Notas]
ˎˎ Cuando extraiga un objetivo, alinee la marca de la 

montura del anillo de bloqueo del objetivo con la 
marca de la montura del camcorder.
ˎˎ Sujete el objetivo con firmeza para impedir que caiga.
ˎˎ Si no se acopla otro objetivo inmediatamente, 

coloque siempre la tapa del cuerpo.

Ajustes de diafragma para objetivos con 
interruptor Auto Iris

ˎˎ Cuando la función Auto Iris del objetivo 
se ajusta en AUTO, el diafragma se ajusta 
automáticamente y también se puede 
ajustar manualmente desde el camcorder.
ˎˎ Cuando la función Auto Iris del objetivo se 
ajusta en MANUAL, el diafragma solo se 
puede ajustar usando el anillo del objetivo. 
El funcionamiento del diafragma desde el 
camcorder no tiene ningún efecto.

Ajustes de enfoque para objetivos con 
interruptor FOCUS

ˎˎ Cuando el interruptor de enfoque del 
objetivo se ajusta en AF/MF o AF, el enfoque 
se ajusta automáticamente y también se 

puede ajustar manualmente desde una 
unidad de control remoto.
ˎˎ Cuando el interruptor de enfoque del 
objetivo está configurado en MF, el enfoque 
se ajusta con el anillo del objetivo y también 
se puede ajustar manualmente desde una 
unidad de control remoto.

	 [Nota]
Cuando se usa un objetivo con montura A, el ajuste 
manual de una unidad de control remoto puede no 
estar disponible.

ˎˎ Cuando el interruptor de enfoque del 
objetivo se ajusta en Full MF, el enfoque 
solo se puede ajustar usando el anillo del 
objetivo. El funcionamiento del enfoque 
desde el camcorder no tiene ningún efecto.

Acoplamiento en un trípode

Utilice los orificios para los tornillos del trípode 
del camcorder cuando la acople a un trípode. 
Utilizar el soporte para trípode en el objetivo 
podría ocasionar daños.

Acople del control remoto de la 
empuñadura

[Nota]
Acople o retire el control remoto de la empuñadura 
mientras el camcorder esté apagado.

1	 Conecte el brazo al acoplamiento de la 
empuñadura y apriete el tornillo.

2	 Conecte el cable del control remoto de la 
empuñadura al conector USB/múltiple de 
la videocámara y fije el cable del visor en 
la abrazadera del cable.
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Abrazadera

[Notas]
ˎˎ Al conectar el cable del control remoto de la 

empuñadura, fije el cable del visor en la abrazadera 
del cable para evitar dañarlo.
ˎˎ Compruebe que el brazo esté acoplado de forma 

segura al camcorder. Es posible que el camcorder se 
caiga si el tornillo no está bien apretado.
ˎˎ No apoye el peso del camcorder sujetando solamente 

el control remoto de la empuñadura.
ˎˎ Después de conectar el cable de control remoto 

de la empuñadura, siempre bloquee el cable en la 
abrazadera. Tirar del cable con fuerza durante el uso 
puede dañar el conector.
ˎˎ Si el cable de la empuñadura se interpone, asegúrelo 

con la abrazadera de cable en el centro del brazo.

Ajuste de la posición del control remoto 
de la empuñadura

ˎˎ Afloje el tornillo de montaje del brazo, 
ajuste el ángulo del brazo (1) y, a 
continuación, apriete el tornillo.
ˎˎ Afloje el tornillo de extensión del brazo, 
ajuste la longitud del brazo (2) y, a 
continuación, apriete el tornillo.

ˎˎ Pulse la palanca de rotación de la empuñadura 
(página 9) para ajustar el ángulo del 
control remoto de la empuñadura (3).

2

3

1

Acople del cierre de la empuñadura al 
camcorder

1	 Retire el tornillo de montaje del brazo (1).

2	 Afloje el tornillo de extensión del brazo (2) 
y extienda el brazo hasta que se vea el 
orificio (3).

1

2

3

	 [Nota]
Después de extender el brazo, apriete bien el 
tornillo.

3	 Conecte el cable del control remoto de la 
empuñadura al conector USB/múltiple de 
la videocámara.

4	 Alinee el saliente del brazo con la ranura 
del punto de acoplamiento de la 
empuñadura y fíjelo en posición con el 
tornillo extraído en el paso 1.

Ajuste de la posición del 
acolchado para el hombro

Puede deslizar el acolchado para el hombro 
hacia delante y hacia atrás. Ajuste la posición 
del acolchado para el hombro para que 
facilitar el uso del camcorder cuando esté 
colocado en su hombro.

2

1 3

1 3 1 3

Acolchado para el hombro

1	 Afloje los tres tornillos del acolchado para 
el hombro.

2	 Deslice el acolchado para el hombro hacia 
delante o hacia atrás hasta la posición 
deseada.

3	 Apriete bien los tornillos.
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Acople de la XDCA-FX9

Puede agregar funciones a la videocámara, 
como una batería de zapata tipo V o una 
LAN con cable, conectando un módulo 
de ampliación XDCA-FX9 (opcional) a la 
videocámara.

[Notas]
ˎˎ La batería de la videocámara no se puede conectar 

cuando un módulo XDCA-FX9 también está 
conectada a la videocámara. Deberá acoplar la batería 
a la XDCA-FX9 o conectar la videocámara a una toma 
de alimentación externa.
ˎˎ Acople o retire el módulo XDCA-FX9 mientras la 

videocámara esté apagada.

1	 Extraiga la batería (página 18) acoplada 
a la videocámara.

2	 Retire los dos tornillos y la cubierta del 
bloque conector de el módulo de 
ampliación de la videocámara.

3	 Alinee los salientes de la XDCA-FX9 con 
las ranuras izquierda y derecha de la 
videocámara y deslícela completamente 
hacia adentro y, posteriormente, hacia 
abajo en el bloque conector.

Ranuras Salientes

4	 Apriete los dos tornillos situados en la 
parte superior del XDCA-FX9 para 
asegurar el módulo.

Extracción de la XDCA-FX9

Afloje los dos tornillos de la parte superior 
del XDCA-FX9 y retire el módulo de la 
videocámara.

Colocación de una batería de 
zapata en V

Introduzca la batería de zapata en V en el 
acople de esta en la XDCA-FX9.

Extracción de una batería de zapata en V

Tire de la batería de zapata en V hacia afuera 
del acople de esta en la XDCA-FX9 mientras 
mantiene pulsada la palanca de liberación de 
la batería.

Colocación de la protección de la 
clave electrónica

Puede colocar un protector de la clave 
electrónica para proteger un módem u otro 
dispositivo USB conectado a un conector USB.
Fije el protector de la clave electrónica y 
el soporte de montaje del protector de la 
clave electrónica a el módulo de ampliación, 
y asegúrelo en su posición utilizando los 
tornillos del soporte de montaje.

Placa de montaje de 
protección de la clave 
electrónica

Fijación con correa de sujeción

Fije la correa de sujeción al protector de la 
clave electrónica para asegurar un dispositivo 
USB en su lugar.
Coloque la presilla de la correa en la parte 
posterior de la protección de la clave 
electrónica y pase la correa sobre la protección 
como se muestra a continuación.

Correa de cierre

Presilla

Acople un sintonizador 
inalámbrico portátil (cuando se 
utiliza un micrófono inalámbrico)

Cuando utilice un micrófono inalámbrico, 
puede acoplar uno de los siguientes 
sintonizadores inalámbricos portátiles con la 
videocámara apagada.
ˎˎ Sintonizador de diversidad sintetizado para 
UHF URX-S03D
ˎˎ Receptor inalámbrico digital DWR-S02DN

Consulte también el manual de instrucciones del 
sintonizador inalámbrico portátil.

[Nota]
Los sintonizadores inalámbricos compatibles varían 
en función de la región y de la banda de frecuencia 
correspondiente. Póngase en contacto con su 
distribuidor Sony o con su representante de ventas de 
Sony para conocer los sintonizadores inalámbricos que 
se pueden utilizar con esta unidad.
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1	 Quite los cuatro tornillos que fijan la 
cubierta de la ranura de inserción y retire 
la cubierta.

2	 Inserte el DWR-S02DN o el URX-S03D en la 
ranura de alojamiento y apriete los cuatro 
tornillos.

DWR-S02DN o 
URX-S03D

3	 Realice uno de los siguientes ajustes.
Para la entrada CH1: ajuste el interruptor 

de selección CH1 INPUT en MI SHOE y 
ajuste Audio Input >CH1 MI SHOE Input 
Select en el menú Audio en Wireless.

Para la entrada CH2: ajuste el interruptor 
de selección CH2 INPUT en MI SHOE y 
ajuste Audio Input >CH2 MI SHOE Input 
Select en el menú Audio en Wireless.

Para las entradas CH3/CH4: ajuste Audio 
Input >CH3 Input Select o CH4 Input 
Select en el menú Audio en Wireless.
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Configuración del funcionamiento básico del camcorder
La pantalla de ajustes iniciales aparece en 
el visor la primera vez que se enciende el 
camcorder o después de que la batería de 
reserva se haya descargado completamente.
Ajuste la fecha y la hora del reloj interno en 
esta pantalla.
Antes de filmar, configure el funcionamiento 
básico del camcorder que mejor se adapte a 
su uso.

Time Zone
Time Zone ajusta la diferencia horaria desde 
UTC (Tiempo Universal Coordinado). Cambie el 
ajuste según sea necesario.

Ajuste de la fecha y la hora

Use los botones de flechas (página 7) 
o el dial multifunción (página 4) para 
seleccionar elementos y configuraciones y, a 
continuación, presione el botón SET o el dial 
multifunción para aplicar la configuración e 
iniciar el funcionamiento del reloj.
Después de cerrar la pantalla de ajustes, 
puede cambiar los ajustes de fecha, hora y 
zona horaria en Clock Set (página 116) en el 
menú Maintenance.

[Notas]
ˎˎ Si el ajuste del reloj se pierde debido a que la batería 

de reserva se descarga totalmente por el hecho 
de permanecer desconectado durante un período 
prolongado (sin batería ni fuente de alimentación 
DC IN), se mostrará la pantalla de ajustes iniciales la 
próxima vez que encienda el camcorder.
ˎˎ Mientras se muestra la pantalla de ajustes iniciales, 

no podrá realizar ninguna otra operación, excepto 
apagar el dispositivo, hasta que se completen los 
ajustes en esta pantalla.
ˎˎ El camcorder dispone de una batería recargable 

incorporada que almacena la fecha, la hora y otros 
ajustes incluso cuando está apagado. Si desea 
obtener más información acerca de la batería 
recargable incorporada, consulte la página 122.

Modo de filmación

Puede cambiar el modo de filmación entre 
el “modo SDR” (para crear imágenes de 
manera flexible in situ), el “modo HDR” (para 
filmar con un espacio de color y un rango 
dinámico amplios) y el “modo Cine EI” (donde 
el camcorder funciona de manera similar a 
una cámara de cine y el metraje se revela en 
postproducción).
Seleccione el modo en Base Setting* 
>Shooting Mode (página 88) en el menú 
Project.
*	 También se puede configurar en la pantalla de 

estado.

[Notas]
ˎˎ El modo Cine EI tiene las siguientes limitaciones.

ˎˎ Funciones que no se pueden ajustar de forma 
automática (corrección)
–– Balance de blancos
–– Ganancia
–– Obturador

ˎˎ Funciones que no se pueden configurar
–– Ganancia/sensibilidad ISO (establecida en la 

sensibilidad ISO base (fija))
–– Configuración del menú Paint (todos están 

deshabilitados)
–– Scene File (deshabilitado)

ˎˎ Las siguientes funciones solo están disponibles en 
modo Cine EI.

ˎˎ Exposure Index
ˎˎ Monitor LUT

Si el modo de filmación está ajustado en el 
modo Cine EI, seleccione el espacio de color 
base para la señal de grabación y la señal de 
salida. El espacio de color seleccionado aquí 
es el espacio de color de la salida de vídeo 
cuando MLUT se ajusta en Off.
Seleccione el espacio de color utilizando Cine 
EI Setting >Color Gamut (página 90) en el 
menú Project.
ˎˎ S-Gamut3.Cine/SLog3: gama de colores fácil 
de ajustar para el cine digital (DCI-P3).

ˎˎ 	S-Gamut3/SLog3: amplia gama de colores 
que ofrece compatibilidad con el ITU-R 
BT.2020 de Sony.

Frecuencia del sistema

Seleccione la frecuencia del sistema utilizando 
Rec Format >Frequency* (página 88) en 
el menú Project. La videocámara puede 
reiniciarse automáticamente después de 
cambiar, dependiendo del valor seleccionado.
*	 También se puede configurar en la pantalla de 

estado.

[Nota]
No puede cambiar la frecuencia del sistema durante una 
grabación o una reproducción.

Modo de escaneado de la cámara

Puede establecer el tamaño efectivo de la 
imagen y la resolución del sensor de imagen.
Seleccione el modo en Rec Format >Imager 
Scan Mode* (página 88) en el menú Project.
*	 También se puede configurar en la pantalla de 

estado.

ˎˎ FF 6K: tamaño de fotograma completo con 
resolución 6K.
ˎˎ FFcrop 5K: tamaño de fotograma completo 
recortado aproximadamente al 83% del 
tamaño para una resolución 5K.
ˎˎ S35 4K: tamaño Super 35mm a resolución 
4K.
ˎˎ FF 2K: tamaño de fotograma completo con 
resolución 2K.
ˎˎ S35 2K: tamaño Super 35mm a resolución 
2K.

[Notas]
ˎˎ No puede cambiar el modo de escaneado de la 

cámara durante una grabación o una reproducción.

ˎˎ Cuando el modo de escaneo de la cámara está 
configurado en FF 2K o S35 2K, la configuración 
del formato de grabación está restringida a una 
resolución de 1920×1080.

Códec

Seleccione el códec utilizando Rec Format 
>Codec* (página 88) en el menú Project.
*	 También se puede configurar en la pantalla de 

estado.

[Nota]
No puede cambiar el códec durante una grabación o 
una reproducción.

Formato de vídeo

Puede configurar el formato de vídeo para la 
grabación. Seleccione un formato mediante 
Rec Format >Video Format* (página 88) en 
el menú Project.
*	 También se puede configurar en la pantalla de 

estado.

[Notas]
ˎˎ No puede cambiar el formato de vídeo durante una 

grabación o una reproducción.
ˎˎ Se pueden aplicar restricciones a la señal de 

los conectores SDI OUT y HDMI OUT, según la 
configuración del formato de vídeo.
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Utilización de tarjetas de memoria XQD
El camcorder graba audio y vídeo en tarjetas de memoria XQD (disponibles por separado) 
introducidas en las ranuras para tarjetas.

Acerca de las tarjetas de memoria XQD

Utilice las siguientes tarjetas de memoria XQD de Sony en el camcorder.
Para obtener más información sobre las operaciones con soportes de otros fabricantes, consulte 
las instrucciones de funcionamiento de dichos soportes o la información del fabricante.
Tarjetas de memoria XQD serie S (QD-S64E/S32E/S64/S32)
Tarjetas de memoria XQD serie H (QD-H32/H16)
Tarjetas de memoria XQD serie N (QD-N64)
Tarjetas de memoria XQD serie M (QD-M128A/M64A/M32A)
Tarjetas de memoria XQD serie G (QD-G240F/G120F/G256E/G128E/G64E/G32E/G128A/G64A/
G32A)
No se garantiza el uso de otras tarjetas de memoria XQD que no sean de Sony.

[Consejo]
Para obtener más información acerca del uso de tarjetas de memoria XQD y las precauciones de uso, consulte las 
instrucciones de funcionamiento de las tarjetas de memoria XQD.

Soportes recomendados

Las condiciones de funcionamiento garantizadas variarán según los ajustes de Rec Format y 
Recording.
Sí: operación admitida
No: no se garantiza un funcionamiento normal

Formato de grabación Serie G
Serie S
(QD-S64E/S32E)

Serie N
Serie M

Serie H
Serie S
(QD-S64/S32)

XAVC Intra 
422

4096×2160 Modo 
normal o 
S&Q (60P o 
menos)

59.94P/ 
50P/ 
29.97P/ 
25P/ 
23.98P/ 
24P

Sí No No

3840×2160 Modo 
normal o 
S&Q (60P o 
menos)

59.94P/ 
50P/ 
29.97P/ 
25P/ 
23.98P

Sí No No

1920×1080 Modo 
normal o 
S&Q (60P o 
menos)

59.94P/ 
50P

Sí No No

59.94i/ 
50i/ 
29.97P/ 
25P/ 
23.98P

Sí Sí No

S&Q (más 
que 60P)

59.94P/ 
50P/ 
29.97P/ 
25P/ 
23.98P

Sí No No
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Formato de grabación Serie G
Serie S
(QD-S64E/S32E)

Serie N
Serie M

Serie H
Serie S
(QD-S64/S32)

XAVC Long 
422

3840×2160 Modo 
normal o 
S&Q (60P o 
menos)

59.94P/ 
50P/ 
29.97P/ 
25P/ 
23.98P

Sí Sí No

1920×1080 Modo 
normal o 
S&Q (60P o 
menos)

59.94P/ 
50P/ 
59.94i/ 
50i/ 
29.97P/ 
25P/ 
23.98P

Sí Sí Sí

S&Q (más 
que 60P)

59.94P/ 
50P

Sí Sí No

29.97P Sí 50 Mbps: No
35 Mbps: Sí

No

25P/ 
23.98P

Sí No No

MPEG2 HD 
422

1920×1080 Modo 
Normal

59.94i/ 
50i/ 
29.97P/ 
25P/ 
23.98P

Sí Sí Sí

Introducción de tarjetas de 
memoria XQD

1	 Abra la tapa de soportes de la sección de 
la ranura para tarjetas.

2	 Introduzca una tarjeta de memoria XQD 
con al etiqueta XQD orientada hacia la 
izquierda.
El indicador de acceso (página 8) se 
iluminará en rojo y, a continuación, 
cambiará a verde si la tarjeta se puede 
utilizar.

3	 Cierre la tapa de soportes.

[Notas]
ˎˎ La tarjeta de memoria, la ranura de la tarjeta de 

memoria y los datos de imagen de la tarjeta de 
memoria pueden resultar dañados si la tarjeta se 
introduce a la fuerza en la ranura en la orientación 
incorrecta.
ˎˎ Cuando grabe en los soportes utilizando ambas 

ranuras de tarjeta XQD, la A y la B, inserte los soportes 
en las dos ranuras que se recomiendan para su 
funcionamiento con el formato que desea grabar.

Extracción de tarjetas de memoria 
XQD

Abra la tapa de soportes de la sección de la 
ranura para tarjetas y presione ligeramente la 
tarjeta de memoria XQD para extraerla.

[Notas]
ˎˎ Si el camcorder está apagado o si se extrae la tarjeta 

de memoria mientras se está accediendo a esta, no 
se podrá garantizar la integridad de los datos de la 
tarjeta. Es posible que se pierdan todos los datos 
grabados en la tarjeta. Asegúrese de que el indicador 
de acceso esté siempre iluminado en color verde o 

apagado antes de apagar el camcorder o extraer la 
tarjeta de memoria.
ˎˎ Cuando extraiga una tarjeta de memoria XQD 

inmediatamente después de finalizar una grabación, 
es posible que la tarjeta de memoria XQD esté 
caliente pero esto no indica un problema.

Formateo (inicialización) de 
tarjetas de memoria XQD

Si se introduce una tarjeta de memoria 
XQD sin formatear o formateada con 
especificaciones diferentes, aparecerá en 
el visor el mensaje “Media Needs to be 
Formatted”.
Formatee la tarjeta mediante el siguiente 
procedimiento.

1	 Seleccione Format Media (página 100) 
en el menú TC/Media.

2	 Seleccione Media(A) (ranura A) o Media(B) 
(ranura B) y, a continuación, seleccione 
Execute.
Aparecerá un mensaje de confirmación.

3	 Seleccione Execute.
Se mostrará un mensaje durante el 
formateo y el indicador de acceso se 
iluminará en rojo.
Cuando se haya completado el formateo, 
se mostrará un mensaje de finalización. 
Pulse el botón SET o el dial multifunción 
para ignorar el mensaje.

[Nota]
Al formatear una tarjeta de memoria se borran todos los 
datos, incluidos los archivos de configuración y los datos 
de vídeos grabados.
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Si el formateo no se completa 
correctamente

Las tarjetas de memoria no compatibles con la 
videocámara no se podrán formatear.
Se mostrará un mensaje de advertencia. Siga 
las instrucciones para sustituir la tarjeta por 
una tarjeta de memoria XQD compatible.

Comprobación del tiempo de 
grabación restante

Durante la filmación (grabación/en espera), 
puede comprobar la capacidad restante de 
la tarjeta de memoria XQD en cada ranura 
mediante los indicadores de los soportes A/B 
restantes en el visor (página 11).
El tiempo de grabación restante se calcula a 
partir de la capacidad restante de los soportes 
en cada ranura y del formato de vídeo actual 
(velocidad de bits de grabación), y se mostrará 
en minutos.

Tiempo de cambio de tarjetas de 
memoria XQD

ˎˎ Cuando el tiempo de grabación restante 
total en las dos tarjetas de memoria es 
inferior a 5 minutos, aparece el mensaje 
“Media Near Full”, la lámpara indicadora/
indicador de grabación comienza a 
parpadear y se escucha un pitido (salida de 
auriculares) de advertencia.  
Introduzca algún soporte que disponga de 
espacio.
ˎˎ Si continúa grabando hasta que el tiempo 
restante de grabación total llegue a cero, 
el mensaje cambiará a “Media Full” y la 
grabación se detendrá.

[Nota]
En una tarjeta de memoria XQD se pueden grabar hasta 
600 clips aproximadamente.
Si el número de clips grabados alcanza el límite, el 
indicador de tiempo de grabación restante cambiará a 
“0” y también aparecerá un mensaje.

Restablecimiento de tarjetas de 
memoria XQD

Si, por alguna razón, se produjera un error 
en una tarjeta de memoria, esta debe 
restablecerse antes de usarla.
Si carga una tarjeta de memoria XQD que 
necesite restablecerse, aparecerá un mensaje 
en la pantalla del visor en el que se le 
preguntará si desea restablecerla.

Restablecer una tarjeta

Use los botones de flechas (página 7) 
o el dial multifunción (página 4) para 
seleccionar Execute y, a continuación, presione 
el botón SET o el dial multifunción.
Se mostrará un mensaje durante el formateo y 
el indicador de acceso se iluminará en rojo.
Cuando termine el restablecimiento, aparecerá 
un mensaje de finalización.

Si falla el restablecimiento

ˎˎ No se pueden restablecer las tarjetas de 
memoria XQD donde se haya producido 
un error. Se mostrará un mensaje de 
advertencia. Siga las instrucciones para 
sustituir la tarjeta de memoria XQD.
ˎˎ Las tarjetas de memoria XQD en las que se 
haya producido un error pueden volver a 
usarse si se vuelven a formatear.
ˎˎ Algunos clips pueden restablecerse, pero 
otros no. Los clips restablecidos pueden 
reproducirse con normalidad.

ˎˎ Si, tras restablecer varias veces, continúa 
apareciendo el mensaje “Could not Restore 
Some Clips”, es posible restablecer la tarjeta 
de memoria XQD mediante el siguiente 
procedimiento.
1	 Copie los clips requeridos a otra tarjeta 

de memoria XQD usando Copy Clip 
(página 106) en el menú Thumbnail.

2	 Formatee la tarjeta de memoria XQD 
inutilizable en la videocámara.

3	 Copie los clips necesarios de nuevo 
a la tarjeta de memoria XQD recién 
formateada.

[Notas]
ˎˎ Asegúrese de utilizar esta videocámara para 

restablecer los soportes grabados con ella.
ˎˎ Es posible que los soportes grabados con un 

dispositivo que no sea esta videocámara o con 
una videocámara de versión diferente (incluso del 
mismo modelo) no se restablezcan mediante esta 
videocámara.
ˎˎ Los clips de menos de 2 segundos no se pueden 

restablecer.
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Utilización de una tarjeta UTILITY SD/MS
La tarjeta UTILITY SD/MS se utiliza para grabar 
proxy y almacenar/cargar configuraciones. 
También se utiliza para actualizaciones futuras 
(actualización de software).

Tarjetas SD/MS compatibles

Tarjetas de memoria SDXC*
Tarjetas de memoria SDHC*
Tarjetas de memoria SD*
“Memory Stick PRO-HG Duo”**
“Memory Stick PRO Duo”**
*	 En este manual se denominan de manera general 

“tarjetas SD”.
**	En este manual se denominan como soporte 

“Memory Stick”.

[Nota]
La grabación proxy no es compatible con los soportes 
"Memory Stick".

Introducción de una tarjeta SD/MS

1	 Abra la tapa de soportes de la sección de 
la ranura para tarjetas.

2	 Inserte la tarjeta SD o el soporte “Memory 
Stick” en la ranura de tarjeta con la 
etiqueta orientada hacia la derecha.
El indicador de acceso (página 8) se 
iluminará en rojo y, a continuación, se 
apagará si la tarjeta se puede utilizar.

3	 Cierre la tapa de soportes.

Extracción de una tarjeta SD/MS

Abra la tapa de soportes de la sección de la 
ranura de la tarjeta y presione ligeramente la 
tarjeta SD o el soporte "Memory Stick" para 
expulsarla.

[Notas]
ˎˎ Si se apaga la videocámara o se extrae la tarjeta SD 

o el soporte "Memory Stick" mientras se accede a la 
tarjeta SD o al soporte "Memory Stick", no se puede 
garantizar la integridad de los datos. Es posible que 
se pierdan todos los datos grabados en la tarjeta. 
Asegúrese de que el indicador de acceso esté 
siempre apagado antes de apagar la videocámara o 
extraer la tarjeta SD o el soporte “Memory Stick”.
ˎˎ Tenga cuidado para evitar que la tarjeta SD o el 

soporte “Memory Stick” se caiga al introducirla o 
extraerla.

Formateo (inicialización) de 
tarjetas SD/MS

Es necesario formatear las tarjetas SD y los 
soportes “Memory Stick” la primera vez que se 
van a utilizar en la videocámara.
Las tarjetas SD o soportes “Memory Stick” que 
vayan a utilizarse con esta videocámara deben 
formatearse utilizando la función de formateo 
de esta videocámara.

1	 Seleccione Format Media (página 100) 
en el menú TC/Media.

2	 Especifique la Utilidad SD/MS y, a 
continuación, seleccione Execute.
Aparecerá un mensaje de confirmación.

3	 Seleccione Execute.
Se mostrará un mensaje y el estado de 
avance durante el formateo y el indicador 
de acceso se iluminará en rojo.

Cuando se haya completado el formateo, 
se mostrará un mensaje de finalización. 
Pulse el botón SET o el dial multifunción 
para ignorar el mensaje.

[Nota]
El formateo de la tarjeta SD o del soporte “Memory 
Stick” borra todos los datos. Los datos no se podrán 
restaurar.

Comprobación de la capacidad 
restante

Puede comprobar la capacidad restante de 
una tarjeta SD o de un soporte “Memory 
Stick”en la pantalla de estado de los soportes 
(página 15).
Al disparar (grabación/en espera) con la 
grabación proxy ajustada en On, puede 
monitorizar la capacidad restante de 
la tarjeta SD utilizando los indicadores 
multimedia restantes en la pantalla del visor 
(página 11).

[Nota]
Si la tarjeta SD está protegida se mostrará la marca .

Para utilizar una tarjeta SD formateada 
con el camcorder en la ranura de otro 
dispositivo

En primer lugar, realice una copia de 
seguridad de la tarjeta y, a continuación, 
vuelva a formatear la tarjeta en el dispositivo 
que se va a utilizar.
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Procedimiento básico de funcionamiento
La filmación básica se realiza mediante el 
siguiente procedimiento.

1	 Acople los dispositivos necesarios y 
compruebe que se suministra la 
alimentación necesaria.

2	 Introduzca las tarjetas de memoria.

3	 Coloque el interruptor POWER en la 
posición ON.
Se encenderá el indicador POWER y 
aparecerá en el visor la imagen de la 
cámara.

4	 Pulse el botón/indicador START/STOP de 
grabación (página 6).
El indicador de grabación/lámpara 
indicadora se enciende y se inicia la 
grabación.

5	 Para detener la grabación, pulse el botón/
indicador START/STOP de grabación 
(página 6) de nuevo.
La grabación se detendrá y la 
videocámara cambiará al modo STBY (en 
espera).

[Nota]
Si se pulsa el botón START/STOP de grabación pocos 
segundos después de encender la videocámara, el 
indicador de grabación/lámpara indicadora se iluminará 
para indicar que la unidad se encuentra en estado de 
grabación; pero es posible que la grabación en los 
soportes no se produzca durante los primeros segundos, 
según el formato de grabación seleccionado.

Intercambio de tarjetas de 
memoria XQD

Si introduce dos tarjetas de memoria XQD, 
pulse el botón SLOT SELECT (página 7) 
para intercambiar las tarjetas.
La grabación cambia automáticamente a 
la segunda tarjeta de memoria justo antes 
de que la capacidad restante en la primera 
tarjeta se reduzca a cero (grabación de 
retransmisión). Puede continuar grabando 
de forma continua al cambiar de tarjeta de 
memoria si sustituye la tarjeta de memoria 
llena por una nueva.

[Nota]
No se pueden intercambiar las tarjetas de memoria 
durante el modo de reproducción. Además, la 
reproducción continua de un soporte de duración de un 
clip en la ranura A y B no es compatible.

Clips (datos grabados)
Al dejar de grabar, el vídeo, el audio, y los 
datos que los acompañan desde el principio 
hasta el final de la grabación, se guardan 
como un solo “clip” en una tarjeta de memoria 
XQD.

Nombres de clips
A todos los clips grabados con esta 
videocámara se les asignará un nombre 
automáticamente usando el formato 
establecido en la opción Clip Name Format 
(página 99) del menú TC/Media.

Duración máxima de clip
Hasta 6 horas por clip.
La duración máxima de una grabación 
continua es la misma que la duración máxima 
de un clip. Si el tiempo de grabación supera 
la duración máxima de un clip, se crea un 
clip nuevo automáticamente y continúa la 
grabación. El nuevo clip aparece como un 

clip separado en la pantalla de imágenes en 
miniatura.

Se graban varios clips sucesivamente durante 
la grabación continua, pero la grabación se 
detendrá de manera automática transcurridas 
unas 24 horas.

[Notas]
ˎˎ No extraiga una tarjeta de memoria mientras se 

esté grabando en ella. Cambie solo las tarjetas de 
memoria en las ranuras cuyo indicador de acceso esté 
apagado.
ˎˎ Cuando la capacidad restante de la tarjeta de 

memoria en la que se está grabando es inferior a un 
minuto y en la otra ranura se ha insertado otra tarjeta 
de memoria en la que se puede grabar, aparecerá 
el mensaje “Will Switch Slots Soon”. El mensaje 
desaparecerá después de cambiar las ranuras de 
tarjeta de memoria.
ˎˎ Es posible que la grabación continua no funcione si 

la grabación comienza cuando la capacidad restante 
de la tarjeta de memoria es inferior a un minuto. Para 
una grabación continua correcta, compruebe que 
la capacidad restante de la tarjeta de memoria es 
superior a un minuto antes de comenzar a grabar.
ˎˎ Los vídeos creados con la función de grabación 

continua del camcorder no se pueden reproducir sin 
interrupciones en el camcorder.
ˎˎ Para combinar los vídeos creado con la función de 

grabación continua del camcorder, utilice el software 
“Catalyst Browse”.

Control del audio

Puede controlar el audio que se está grabando 
con los auriculares.
Al conectar unos auriculares a la toma de 
auriculares (página 8) podrá controlar 
el audio que se está grabando. También 
puede controlar el audio de reproducción 
(página 71) con el altavoz integrado 
(página 6) o con los auriculares.
Ajuste el volumen del audio monitorizado 
usando los botones VOLUME (página 6) 

(ajuste del volumen de monitorización de 
audio).
Puede seleccionar el canal de audio que desea 
supervisar usando Audio Output >Monitor CH* 
(página 105) en el menú Audio.
*	 También se puede configurar en la pantalla de 

estado.

Especificación de los datos de 
tiempo

Ajuste del código de tiempo

Ajuste el código de tiempo que se va a grabar 
mediante Timecode (página 99) en el menú 
TC/Media.

Ajuste de los bits del usuario

Puede añadir un número hexadecimal de 8 
dígitos a la imagen grabada como bits de 
usuario. También puede establecer los bits del 
usuario a la hora actual. Establezca el uso de 
Users Bit (página 99) en el menú TC/Media.

Visualización de los datos de tiempo

Ajuste el código de tiempo que se va a 
mostrar mediante TC Display (página 99) 
>Display Select en el menú TC/Media.
Si pulsa un botón asignable (página 46) 
al que se le haya asignado DURATION/TC/U-
BIT, cambiará la visualización entre código de 
tiempo, bits de usuario y duración de forma 
consecutiva.
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Cambio de la entrada/salida de código 
de tiempo

Puede cambiar la entrada/salida de código de 
tiempo con el interruptor de selección IN/OUT 
(página 8).
Para obtener más detalles, consulte la 
página 120.

Revisión de la grabación (Rec 
Review)

Puede revisar el último clip grabado en la 
pantalla (revisión de grabación).

[Nota]
Rec Review no es compatible si el formato de vídeo se 
cambia después de grabar un clip.

Método de revisión de la grabación

Asigne Rec Review a uno de los botones 
asignables primero.
Cuando detenga la grabación, pulse el botón 
asignable (página 46) al que se ha asignado 
la función Rec Review. La reproducción del 
último clip grabado se inicia.
El clip se reproduce hasta el final, Rec Review 
finaliza y el camcorder vuelve al modo STBY 
(en espera).

Para detener Rec Review

Presione el botón asignable con Rec Review 
asignado o presione el botón CANCEL/BACK.

Ajustes de revisión de grabación

Puede establecer el punto de inicio de 
la reproducción en uno de los siguientes 

mediante el ajuste Rec Review (página 108) 
en el menú Technical.
ˎˎ Últimos 3 segundos del clip
ˎˎ Últimos 10 segundos del clip
ˎˎ Inicio del clip

[Consejo]
Si desea revisar un clip específico después de grabar 
varios clips, presione el botón THUMBNAIL para mostrar 
la pantalla de miniaturas y seleccione el clip para 
comenzar la reproducción.
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Ajuste del enfoque
Puede ajustar el enfoque de forma automática 
o manual según las condiciones de disparo.

Ajuste manual del enfoque 
(Manual Focus)

Para ajustar el enfoque manualmente, ajuste 
el interruptor FOCUS (página 6) en la 
posición “MAN”.
Esto le permitirá ajustar el enfoque 
manualmente según las condiciones de 
filmación.
El enfoque manual resulta útil para los 
siguientes tipos de sujetos.
ˎˎ Sujetos en la parte más alejada de una 
ventana cubierta por gotas de agua
ˎˎ Sujetos con poco contraste con el fondo
ˎˎ Sujetos más alejados que otros más 
cercanos

Ajuste automático del enfoque 
(Auto Focus)

La videocámara utiliza AF de detección de 
fase para enfoque de alta velocidad y AF de 
contraste para enfoque de alta precisión.
La combinación de estos dos métodos AF 
proporciona un enfoque automático con alta 
velocidad y alta precisión.
Para ajustar el enfoque automáticamente, 
sitúe el interruptor FOCUS (página 6) de 
la videocámara en la posición “AUTO”. Si el 
objetivo dispone de interruptor de selección 
de enfoque, sitúe el interruptor en la posición 
“AF/MF” o “AF”. Si se ajusta el interruptor 
en la posición “Full MF” o “MF”, el enfoque 
del objetivo no se puede realizar con la 
videocámara (página 23).
En modo AF, el LED FOCUS AUTO está 
encendido.

[Consejo]
Cuando Focus >AF Assist (página 86) en el menú 
Shooting está ajustado en On, aún puede usar el 
anillo de enfoque en el objetivo durante el enfoque 
automático para ajustar el enfoque.

[Notas]
ˎˎ Se necesita un objetivo compatible con enfoque 

automático.
ˎˎ Es posible que no se obtenga precisión según las 

condiciones de disparo.
ˎˎ El enfoque no se puede ajustar de manera automática 

en un objetivo de montura A.

Especificación de la posición/área de 
enfoque automático (Focus Area)

Puede establecer el área de destino para el 
enfoque automático mediante Focus >Focus 
Area (página 86) en el menú Shooting.

Flexible Spot:
Enfoca una posición especificada en la 
imagen.

Cuando se selecciona, especifique la posición 
con los botones de flecha (página 7) o el 
selector múltiple (página 9).
Puede volver a la posición central 
manteniendo presionado el botón SET 
(página 7) o el selector múltiple.

Zone:
Busca automáticamente una posición de 
enfoque dentro de la zona especificada.
Cuando se selecciona, especifique la posición 
con los botones de flecha (página 7) o el 
selector múltiple (página 9).
Puede volver a la posición central 
manteniendo presionado el botón SET 
(página 7) o el selector múltiple.

Wide:
Busca un sujeto en un ángulo amplio de la 
imagen al enfocar. No se muestra un marco.

[Consejo]
Se admite la misma operación utilizando un botón 
asignable (página 46) asignado con Focus Area.
Puede mostrar/ocultar el marco del área de enfoque 
usando Display On/Off >Focus Area Indicator 
(página 101) en el menú de Monitoring.

[Nota]
El marco del área de enfoque no está oculto cuando se 
usa el botón DISPLAY.

Cambio del área de enfoque 
rápidamente (Focus Setting)

También puede cambiar la posición y el 
tamaño del área de enfoque automático 
rápidamente durante la grabación asignando 
Focus Setting a un botón asignable 
(página 46).
La operación varía según el ajuste del área del 
enfoque.

Cuando Focus >Focus Area (página 86) en 
el menú Shooting está fijado en Flexible Spot 
o Zone
Puede cambiar la posición del área de enfoque 
pulsando un botón asignable asignado con 
Focus Setting y realizando el ajuste con los 
botones de flechas (página 7), el selector 
múltiple (página 9) o el funcionamiento 
táctil (página 35).
Puede volver a la posición central del área 
del enfoque a la vez que ajusta la posición 
presionando el botón SET (página 7) o el 
selector múltiple.
Puede cambiar el tamaño del área de enfoque 
manteniendo pulsado un botón asignable 
asignado con Focus Setting.
Después de cambiar el tamaño, ajuste la 
posición del área del enfoque pulsando el 
botón SET o el selector múltiple.
Al finalizar, pulse el botón asignable asignado 
con Focus Setting para volver a la pantalla 
original.
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Cuando Focus >Focus Area (página 86) en 
el menú Shooting está fijado en Wide
Solo puede cambiar el tamaño del área de 
enfoque manteniendo pulsado un botón 
asignable asignado con Focus Setting. 
La posición también puede cambiarse 
modificando primero el tipo a Flexible Spot o 
Zone.

[Consejos]
ˎˎ El marco del área de enfoque se muestra de color 

naranja cuando la modificación de la posición del 
área de enfoque es posible.
ˎˎ Cuando Focus >Push AF Mode (página 86) en el 

menú Shooting está fijado en Single-shot AF(AF-S) 
puede cambiar la posición del área del enfoque con 
Focus Area(AF-S) (página 86).

Mover el marco del área de enfoque 
mediante el funcionamiento táctil (área 
de enfoque táctil)

Puede mover el área de enfoque con el 
funcionamiento táctil cuando el marco del 
área de enfoque se muestra de color naranja 
como resultado de ajustar Focus >Focus Area 
(página 86) en el menú Shooting a Flexible 
Spot o Zone, o pulsando un botón asignable 
asignado con la función Focus Setting.
Pulse la pantalla para mover el área de 
enfoque, con el área de enfoque centrada 
en la posición pulsada. Arrastre la pantalla 
para mover el área de enfoque a la posición 
indicada con el dedo (página 10).

Pulse cualquier posición

El área de enfoque se mueve y se centra en 
la posición pulsada.

Arrastre para mover el área de enfoque, 
indicando la posición con el dedo

[Notas]
ˎˎ 	Si pulsa una posición o arrastra el área de enfoque 

hasta una posición que supere el rango de ajuste, el 
área de enfoque se moverá al límite superior/inferior/
izquierdo/derecho del rango de ajuste.
ˎˎ 	Esta función no está disponible en las siguientes 

circunstancias.
–– Cuando Touch Operation (página 76) en el menú 

Technical está ajustado en Off
–– Cuando el área de enfoque aparece de color gris o 

no aparece

Ajuste del funcionamiento del enfoque 
automático (velocidad de transición AF, 
sensibilidad de desplazamiento del 
sujeto AF)

Velocidad de transición AF
Puede establecer la velocidad de la unidad de 
enfoque para cuando el sujeto cambia usando 
Focus >AF Transition Speed (página 86) en 
el menú Shooting.
Cuando se configura a baja velocidad, el 
enfoque se mueve lentamente cuando el 
sujeto que se enfoca se mueve, lo que permite 
tomar imágenes impresionantes.
Cuando se configura a alta velocidad, el 
enfoque alterna entre sujetos rápidamente. El 
sujeto que entra en el encuadre se enfoca al 
instante, lo que convierte este ajuste en ideal 
para la grabación documental que requiere un 
enfoque rápido.

Durante el cambio:
1(Slow): el enfoque funciona 
lentamente
.
.
.
7(Fast): el enfoque funciona 
rápidamente

Centrado en un sujeto lejano

Centrado en un sujeto cercano
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Sensibilidad de desplazamiento del sujeto AF
Puede establecer la sensibilidad para cambiar 
entre sujetos usando Focus >AF Subj. Shift 
Sens. (página 86) en el menú Shooting.
Cuando se establece en una sensibilidad 
baja, el enfoque no cambia fácilmente incluso 
cuando otro sujeto se mueve delante del 
sujeto enfocado. Cuando se establece en una 
sensibilidad alta, el enfoque cambia para dar 
prioridad al sujeto que se mueve al frente.

[Consejo]
Si asigna AF Speed/Sens. a un botón asignable, las 
barras de nivel para el ajuste de los valores se muestran 
en el siguiente orden cada vez que se presiona el botón, 
lo que le permite cambiar los ajustes de velocidad de 
transición AF y de sensibilidad de desplazamiento del 
sujeto AF.
Velocidad de transición AF  Sensibilidad de 
desplazamiento del sujeto AF  Sin visualización…

AF Subj. Shift Sens.: 1(Locked On) AF Subj. Shift Sens.: 5(Responsive)

Cambio del enfoque a otro sujeto lentamente Cambio del enfoque a otro sujeto rápidamente

Cambio del objetivo de enfoque 
manualmente (AF Assist)

Cuando Focus >AF Assist (página 86) 
en el menú Shooting está ajustado en On, 
puede seleccionar el destino para el enfoque 
automático durante el enfoque automático 
usando el anillo de enfoque en el objetivo.
El funcionamiento del enfoque automático se 
restaura cuando deja de utilizar el anillo de 
enfoque.
Ajustar Focus >AF Subj. Shift Sens. 
(página 86) en el menú Shooting en 
1(Locked On) resulta cómodo cuando 
desea que el funcionamiento del enfoque 
automático siga tal como está cuando la 
posición de enfoque se mueve a un sujeto a 
una distancia distinta.
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Uso del enfoque manual de forma 
temporal (Push Manual Focus)

Pulse el botón PUSH AUTO FOCUS 
(página 6) cuando está en modo 
de enfoque automático para enfocar 
manualmente mientras se presiona el botón.
El enfoque volverá al enfoque automático 
cuando suelte el botón.
Esto le permite detener temporalmente el 
enfoque automático y enfocar manualmente 
cuando algo que no es el sujeto de la 
filmación se cruza delante de este.

[Consejo]
La misma operación es compatible con un botón 
asignable (página 46) asignado con Push AF/Push 
MF.

Uso del enfoque automático de 
forma temporal (Push Auto Focus)

Cuando Focus >Push AF Mode 
(página 86) en el menú Shooting se 
configure en AF, presione el botón PUSH 
AUTO FOCUS (página 6) cuando esté 
en modo de enfoque manual para enfocar 
automáticamente mientras se presiona el 
botón.
El enfoque ocurre dentro del área de enfoque 
establecida usando Focus >Focus Area 
(página 86) en el menú Shooting.
El enfoque volverá al enfoque manual cuando 
suelte el botón.
Esto es útil cuando desea mover el enfoque 
lentamente de un sujeto a otro durante el 
enfoque manual.

[Consejos]
ˎˎ La misma operación es compatible con un botón 

asignable (página 46) asignado con Push AF/Push 
MF.
ˎˎ También puede asignar Push AF Mode a un botón 

asignable (página 46).

[Nota]
La función Push Auto Focus no se puede utilizar si el 
objetivo está ajustado en enfoque manual.

Uso de Enfoque automático de 
una sola toma (Push Auto Focus 
(AF-S))

Establezca Focus >Push AF Mode 
(página 86) en el menú Shooting en 
Single-shot AF(AF-S) y, a continuación, 
configure el área de enfoque utilizando Focus 
>Focus Area(AF-S) (página 86) en el menú 
Shooting.
Pulse el botón PUSH AUTO FOCUS cuando está 
en modo de enfoque manual para enfocar 
automáticamente a alta velocidad. El enfoque 
se detiene en cuanto suelta el botón.
El estado de enfoque se indica mediante el 
indicador de enfoque.
ˎˎ On: el enfoque está fijo en la posición de 
enfoque.
ˎˎ Parpadeando: fuera de enfoque. Debido a 
que el enfoque no es automático, cambie 
los ajustes de composición y enfoque para 
conseguir el enfoque.

El enfoque volverá al enfoque manual cuando 
suelte el botón.
Esto resulta útil cuando desea enfocar 
rápidamente a un sujeto antes de empezar a 
filmar.

[Consejos]
ˎˎ La misma operación es compatible con un botón 

asignable (página 46) asignado con Push AF/Push 
MF.
ˎˎ También puede asignar Push AF Mode a un botón 

asignable (página 46).
ˎˎ También puede asignar Focus Area(AF-S) a un botón 

asignable (página 46).
ˎˎ Puede mostrar/ocultar el marco del área de enfoque 

usando Display On/Off >Focus Area Ind.(AF-S) 
(página 101) en el menú de Monitoring.
ˎˎ Durante la ampliación del enfoque, el enfoque se 

ajusta para adaptarse a la posición de visualización 
ampliada.

[Notas]
ˎˎ La función Push Auto Focus no se puede utilizar si el 

objetivo está ajustado en enfoque manual.

ˎˎ El marco del área de enfoque no está oculto cuando 
se usa el botón DISPLAY.

Enfocar con una visualización 
aumentada (Focus Magnifier)

Según el ajuste predeterminado de fábrica, 
la función Focus Magnifier ×3/×6 se asigna 
al botón ASSIGN 4 en el control remoto de la 
empuñadura y el botón ASSIGN 10 en el visor 
(página 46).
Pulse el botón ASSIGN 4 o ASSIGN 10 para 
cambiar a la pantalla de ampliación del 
enfoque, con el centro ampliado unas tres 
veces aproximadamente. Pulse el botón de 
nuevo para incrementar el aumento hasta 
aproximadamente seis veces. Esta función 
resulta útil para comprobar el enfoque.
Pulse el botón de nuevo para volver a la 
pantalla normal.
Puede mover la posición para que se amplíe 
durante la ampliación del enfoque mediante 
los botones de flecha (página 7) o el 
selector múltiple (página 9). Puede volver 
a la posición central manteniendo presionado 
el botón SET (página 7) o el selector 
múltiple.
Cuando se usa el enfoque automático (AF) 
durante la ampliación del enfoque, el enfoque 
ocurre dentro del área de enfoque establecida 
usando Focus >Focus Area (página 86) en el 
menú Shooting.
Si se utiliza la función Push Auto Focus (AF-S) 
durante la ampliación del enfoque, el enfoque 
se ajusta para adaptarse a la posición de 
visualización ampliada.

[Notas]
ˎˎ La imagen grabada o la imagen de salida SDI/HDMI 

no aumenta cuando se aumenta el enfoque.
ˎˎ Durante la ampliación del enfoque, el botón STATUS y 

el botón MENU están desactivados.
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ˎˎ La posición de ampliación regresa al centro de la 
pantalla cuando se apaga el camcorder.

Enfoque usando Detección de 
caras y ojos (Face/Eye Detection 
AF)

La videocámara puede detectar las caras y los 
ojos de la gente y ajustar el enfoque en las 
caras y los ojos dentro del área de enfoque.
Esta función solo está disponible cuando 
el ajuste del enfoque está en el modo AF o 
durante el enfoque automático mediante una 
pulsación.
Cuando se detecta una cara, aparece un marco 
gris de detección de caras/ojos. Cuando es 
posible establecer el enfoque automático, 
el marco se vuelve de color blanco. Cuando 
se detectan ojos y se ajusta el enfoque, el 
marco de detección de caras/ojos aparece 
en los ojos. Cuando se detectan varios 
individuos, se determina el individuo principal 
automáticamente.

[Consejos]
ˎˎ Cuando el área de enfoque está configurada en Zone 

o en Flexible Spot y las caras o los ojos se superponen 
dentro del área de enfoque especificada, los marcos 
de detección de caras/ojos cambian a blanco y la 
videocámara enfoca esas caras/ojos.
ˎˎ Cuando se utiliza el enfoque automático mediante 

una pulsación (AF-S), los marcos de detección de 
caras/ojos de las caras/ojos enfocados cambian a 
verde.

Configure el funcionamiento del AF de 
detección de caras/ojos mediante Focus 
>Face Detection AF (página 86), en el menú 
Shooting.

Face/Eye Only AF:
La cámara detecta las caras/ojos de los 
sujetos (personas) y solo enfoca en las caras/

ojos. Si no se detecta ninguna cara ni ojo, el AF 
se detiene temporalmente (MF) y se muestra 
el icono de enfoque automático pausado del 
modo Face/Eye Only AF  (página 11). Este 
modo resulta eficaz cuando desea enfocar 
automáticamente únicamente las caras/ojos.

Face/Eye Priority AF:
La cámara detecta las caras/ojos de los 
sujetos (personas) y prioriza el enfoque en 
las caras/ojos. Cuando no se detecta ninguna 
cara ni ojo, el enfoque está en modo AF 
(ajuste predeterminado).

Off:
La función de AF de detección de caras/ojos 
está desactivada.

[Notas]
ˎˎ Durante el funcionamiento del enfoque automático 

mediante una pulsación, se activa Face/Eye Priority 
AF, aunque se haya seleccionado Face/Eye Only AF.
ˎˎ Cuando el interruptor FOCUS se ha establecido en 

MAN, se desactiva el AF de detección de caras/
ojos (salvo durante el funcionamiento del enfoque 
automático mediante una pulsación).
ˎˎ Si apaga la videocámara mientras Face/Eye Only AF 

está seleccionado, el modo cambia automáticamente 
a Face/Eye Priority AF cuando vuelva a encender la 
cámara.

Ocultar marcos de detección de caras/
ojos

Puede mostrar/ocultar los marcos de 
detección de caras/ojos mediante Display On/
Off >Face/Eye Detection Frame (página 101) 
en el menú Monitoring.

[Nota]
Se muestran marcos verdes de detección de caras/ojos 
para las caras y los ojos que están enfocados usando el 
enfoque automático mediante una pulsación (AF-S), y 
no se ocultan con el botón DISPLAY o cuando Face/Eye 
Detection Frame se establece en Off.

Enfoque en una cara registrada

Durante el funcionamiento del AF de 
detección caras/ojos, puede registrar la cara 
de un sujeto (persona) para realizar el enfoque 
en dicha cara.
Solo se puede registrar una cara. El registro de 
una cara sobrescribe el registro actual.
Cuando se registra una cara, el marco de 
detección de caras/ojos cambia a un marco 
doble (marco de cara registrada) y se muestra 
el icono de cara registrada  (página 11).
En el AF de detección de caras/ojos, las 
siguientes acciones tienen lugar dependiendo 
de si se ha registrado una cara y del modo de 
funcionamiento del AF de detección de caras/
ojos.

En el modo Face/Eye Priority AF:
Si la cámara detecta una cara registrada, la 
cámara la enfoca. Si no se detecta la cara 
registrada, el AF de detección de caras/ojos se 
desactiva.

En el modo Face/Eye Only AF:
Si la cámara detecta solo la cara registrada, 
la cámara enfoca dicha cara/ojo. Si no se 
detecta la cara registrada, el AF se detiene 
temporalmente (MF) y se muestra el icono 
de enfoque automático pausado del modo 
Face/Eye Only AF  (página 11). Este 
modo resulta eficaz cuando desea enfocar 
automáticamente solo la persona registrada.

Ajuste de la cara registrada
Mueva el cursor de selección de caras 
(destacado en naranja) a la cara que desea 
registrar usando los botones de flechas 
(página 7) o el selector múltiple 
(página 9), y presione el botón SET 
(página 7) o el selector múltiple.

Otros marcos de 
detección de 
cara (gris)

Marco de cara/ojo 
registrado (marco 
blanco doble)

Cursor de selección 
de cara (naranja)

Borrar la cara registrada
Mueva el cursor de selección de caras a 
la cara registrada usando los botones de 
flechas (página 7) o el selector múltiple 
(página 9), y presione el botón SET 
(página 7) o el selector múltiple.
La cara registrada se borra, el marco de 
detección de caras/ojos pasa a ser un marco 
único y el icono de cara registrada desaparece.
Cuando se detectan caras/ojos sin mostrar 
el marco de cara registrada y se muestra el 
cursor de selección de caras (naranja), puede 
borrar la cara registrada pulsando dos veces el 
botón SET o el selector múltiple.

[Notas]
ˎˎ Es posible que no se detecten las caras y los ojos 

a causa del entorno de grabación, la condición del 
sujeto o los ajustes.
ˎˎ Es posible que no pueda obtener el efecto adecuado 

o que se pueda detectar como una cara objetos que 
no sean caras de personas, en algunos entornos 
de grabación. En este caso, ajuste la función AF de 
detección de caras/ojos en Off.
ˎˎ Se recomienda el registro de la cara del individuo 

previsto para realizar el enfoque antes de filmar.
ˎˎ El registro de caras puede resultar incorrecto en 

función del estilo del pelo o la decoración facial o si 
no se mira directamente a la cámara. En este caso, el 
marco de detección de caras/ojos puede convertirse 
en un marco doble, pero el icono de cara registrada 
no se muestra y la cara no está registrada.
ˎˎ Si ya se ha registrado una cara, se recomienda borrar 

la cara existente y, a continuación, registrar la cara 
nueva.
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Cambio del funcionamiento del AF de 
detección de caras/ojos con un botón 
asignable

Asigne Face/Eye Detection AF a un botón 
asignable (página 46). Puede cambiar 
el funcionamiento del AF de detección de 
caras/ojos cada vez que pulse el botón, en el 
siguiente orden: Face/Eye Priority AF, Face/Eye 
Only AF y Off.

Ajuste mediante el menú directo

También se puede ajustar el funcionamiento 
del AF de detección de caras/ojos mediante el 
menú directo (página 46).
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Puede ajustar el brillo mediante la regulación 
del diafragma, la ganancia, la velocidad 
del obturador y el nivel de luz con los 
filtros ND. También puede realizar ajustes 
automáticamente.
El nivel deseado para el ajuste de brillo 
automático se establece con Auto Exposure 
(página 82) >Level en el menú Shooting. 
También puede asignar Auto Exposure Level a 
un botón asignable (página 46).

[Nota]
La ganancia no puede ajustarse en el modo Cine EI. 
La sensibilidad base está fija. Asimismo, el brillo no 
puede ajustarse automáticamente con la velocidad del 
obturador. Se puede ajustar automáticamente el brillo 
con el disfragma o el filtro ND.

Selección de la sensibilidad base

Puede seleccionar entre dos tipos de 
sensibilidad base en la videocámara.
En el modo SDR/HDR, puede configurar Base 
Sensitivity* en el menú Shooting en High o 
Low. En el modo Cine EI, puede configurar 
Base ISO* en el menú Shooting en ISO 4000 o 
ISO 800.
*	 También se puede configurar en la pantalla de 

estado.

Puede disparar con buen equilibrio, sin 
aumentar el ruido, seleccionando Low o 
ISO 800 en condiciones de iluminación 
normales o seleccionando High o ISO 4000 en 
condiciones de poca luz.

[Consejo]
También puede asignar Base ISO/Sensitivity a un botón 
asignable (página 46).

Ajuste del diafragma

Puede ajustar el diafragma para ajustar el 
brillo.

Ajuste automático del diafragma

Esta función ajusta el brillo según el sujeto. 
Se necesita un objetivo compatible con 
diafragma automático.

1	 Si se acopla un objetivo con interruptor 
Auto Iris, coloque el interruptor en AUTO.

2	 Mantenga presionado el botón de función 
IRIS (F) para mostrar el menú directo 
(página 46) y seleccione Auto.

	 [Consejo]
También puede asignar Auto Iris a un botón 
asignable (página 46).

	 [Nota]
El diafragma no se puede ajustar de manera 
automática en un objetivo de montura A.

Ajuste manual del diafragma

1	 Mantenga presionado el botón de función 
IRIS (F) para mostrar el menú directo 
(página 46) y seleccione Manual.

2	 Presione el botón de función IRIS (F) para 
que el valor del diafragma se muestre en 
un fondo blanco.

3	 Gire el dial multifunción para ajustar el 
valor.

	 [Consejos]
ˎˎ También puede operar el dial multifunción como 

un dial IRIS (página 46) asignando la función 
IRIS al dial multifunción.
ˎˎ También puede asignar la función IRIS a un dial 

asignable (página 46).

Ajuste temporal de forma automática

Pulse el botón PUSH AUTO IRIS (E) para ajustar 
automáticamente el iris temporalmente 
mientras está pulsado el botón.
El diafragma volverá al ajuste anterior cuando 
suelte el botón.

[Consejo]
También puede asignar Push Auto Iris a un botón 
asignable (página 46).

[Nota]
Cuando el interruptor Auto Iris del objetivo se ajusta 
en “MANUAL”, las funciones Auto Iris y Push Auto Iris 
del camcorder no tendrán ningún efecto. Los ajustes 
manuales de diafragma en el camcorder tampoco 
tendrán ningún efecto.

Ajuste de la ganancia

En el modo SDR/HDR, puede ajustar la 
ganancia para ajustar el brillo.

Ajuste automático de la ganancia

Mantenga presionado el botón de función 
ISO/GAIN (I) para mostrar el menú directo 
(página 46) y seleccione Auto.

[Consejos]
ˎˎ También puede realizar la misma acción configurando 

Auto Exposure (página 82) >AGC en el menú 
Shooting en On.
ˎˎ También puede asignar AGC a un botón asignable 

(página 46).

Ajuste manual de la ganancia

Puede controlar la ganancia cuando desee 
ajustar la exposición con un ajuste de 
diafragma fijo, o bien cuando desee evitar que 
la ganancia aumente debido al AGC.

1	 Mantenga presionado el botón de función 
ISO/GAIN (I) para mostrar el menú directo 
(página 46) y seleccione Manual.

2	 Ajuste el interruptor ISO/GAIN (J) en H, M 
o L.

[Consejo]
También puede asignar la función Push AGC a un botón 
asignable y activar AGC de forma temporal manteniendo 
pulsado el botón.

Control de la ganancia (ajuste fino)

1	 Presione el botón de función ISO/GAIN (I) 
para que el valor de ganancia se muestre 
en un fondo blanco.

2	 Gire el dial multifunción para ajustar el 
valor.

Ajuste del brillo
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[Consejo]
Cambie al valor preestablecido de ganancia de acuerdo 
con la configuración del interruptor ISO/GAIN (J).

Control de la ganancia temporalmente 
(ajuste fino)

Gire el dial asignable (página 46) asignado 
a la función ISO/Gain/EI, para ajustar el valor 
de ganancia establecido con el interruptor 
ISO/GAIN (J).
Esto es útil cuando desea ajustar la exposición 
en un nivel sin cambiar la profundidad de 
campo.
El valor de ganancia ajustado se puede 
cancelar con el interruptor ISO/GAIN (J). 
cambiando la sensibilidad básica, activando 
AGC o apagando el dispositivo.

[Consejo]
También puede asignar esta función al dial multifunción 
(página 46).

Ajuste del índice de exposición

En el modo Cine EI, se presupone que la 
salida de vídeo con MLUT establecido en Off 
se graba como la señal principal. Al cambiar 
el brillo de la imagen con MLUT On para que 
coincida con el valor EI, puede comprobar 
el resultado del ajuste de la sensibilidad de 
exposición postproducción a la vez que graba.
Puede cambiar el valor EI ajustando el 
interruptor ISO/GAIN (J) en H, M o L.

[Consejo]
Puede cambiar el valor EI de cada posición 
del interruptor usando ISO/Gain/EI >Exposure 
Index<H>/<M>/<L> (página 81) en el menú Shooting, 
o bien con la pantalla Camera Status (página 14).

Ajuste fino del índice de exposición

1	 Presione el botón de función ISO/GAIN (I) 
para que el valor EI se muestre en un 
fondo blanco.

2	 Gire el dial multifunción para ajustar el 
valor.

[Consejo]
Cambie al valor preestablecido EI de acuerdo con la 
configuración del interruptor ISO/GAIN (J).

Ajuste del obturador

Puede ajustar el obturador para ajustar el 
brillo.

Ajuste automático del obturador

Mantenga presionado el botón de función 
SHUTTER (G) para mostrar el menú directo 
(página 46) y seleccione Auto para ajustar 
la velocidad del obturador o el ángulo del 
obturador automáticamente en respuesta al 
brillo de la imagen.

[Consejo]
También puede realizar la misma acción configurando 
Auto Exposure (página 83) >Auto Shutter en el menú 
Shooting en On.

Ajuste manual del obturador

1	 Mantenga presionado el botón de función 
SHUTTER (G) para mostrar el menú directo 
(página 46) y seleccione Speed o Angle.

2	 Presione el botón de función SHUTTER (G) 
para que el valor del obturador se 
muestre en un fondo blanco.

3	 Gire el dial multifunción para ajustar la 
velocidad del obturador.

[Consejos]
ˎˎ Para ajustar el tiempo de exposición para que 

coincida con el intervalo de fotogramas, seleccione 
Off en el paso 1.
ˎˎ También puede ajustar el ángulo y la frecuencia 

(página 81).

Ajuste del nivel de luz (filtro ND)

En condiciones donde la luz es demasiado 
fuerte, puede ajustar el brillo adecuado si 
cambia el filtro ND.
El camcorder posee dos modos de filtro ND. 
Puede alternar entre los dos modos con el 
interruptor ND PRESET/VARIABLE.

Ajuste en el modo predeterminado

Ajuste el interruptor ND PRESET/VARIABLE 
(A) a la posición PRESET, y ajuste los botones 
arriba/abajo de ND FILTER POSITION (B) a uno 
de los siguientes ajustes.
Clear: sin filtro ND
1: Transmitancia ajustada mediante ND Filter 
>Preset1 (página 81) en el menú Shooting.
2: Transmitancia ajustada mediante ND Filter 
>Preset2 (página 81) en el menú Shooting.
3: Transmitancia ajustada mediante ND Filter 
>Preset3 (página 81) en el menú Shooting.

Ajuste en el modo variable

Ajuste el interruptor ND PRESET/VARIABLE (A) 
en la posición VARIABLE. Ajuste los botones 
arriba/abajo ND FILTER POSITION (B) entre 
CLEAR y On.

Ajuste automático del nivel de luz
Puede activar Auto ND Filter para habilitar el 
ajuste de exposición automática con el filtro 
ND.

1	 Presione el botón [+] de los botones 
subir/bajar ND FILTER POSITION (B) para 
activar la operación del filtro ND.

2	 Mantenga presionado el botón ND 
VARIABLE AUTO (C) hasta que se 
seleccione Auto.
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Ajuste manual del nivel de luz

1	 Presione el botón [+] de los botones 
subir/bajar ND FILTER POSITION (B) para 
activar la operación del filtro ND.

2	 Mantenga presionado el botón ND 
VARIABLE AUTO (C) hasta que se 
seleccione Manual.

3	 Gire el dial ND VARIABLE (D) para ajustar 
la transmitancia del filtro.

[Consejo]
También puede asignar la función ND Filter a un dial 
asignable (página 46).

Ajuste temporal de forma automática
Puede asignar la función Push Auto ND a un 
botón asignable (página 46) y activar Auto 
ND Filter de forma temporal manteniendo 
pulsado el botón. Al soltar el botón, se vuelve 
a desactivar la función Auto ND Filter.
Presione el botón [+] de los botones subir/
bajar ND FILTER POSITION (B) para activar la 
operación del filtro ND.

[Nota]
Cuando ND Filter se cambia a o desde CLEAR durante el 
disparo, el marco del filtro ND se muestra en la imagen y 
el sonido de funcionamiento se incluye en el audio.

[Consejos]
ˎˎ Puede establecer en CLEAR girando el dial ND 

VARIABLE (D) hacia abajo desde ND1/4. Girando el 
dial hacia arriba desde CLEAR establece ND1/4. Puede 
deshabilitar esta acción usando ND Dial >CLEAR with 
Dial (página 108) en el menú Technical.
ˎˎ También puede asignar ND Filter Position a un botón 

asignable (página 46) y pulsar el botón en lugar 
de utilizar los botones arriba/abajo de ND FILTER 
POSITION para cambiar el ajuste.  
Modo Preset: Clear  Preset1  Preset2  Preset3 
 Clear… 
Modo Variable: Clear  On  Clear…
ˎˎ También puede asignar la función Auto ND Filter a un 

botón asignable (página 46) y pulsar el botón para 
activar y desactivar Auto ND Filter.
ˎˎ Cuando se filma un sujeto con mucha luz, un cierre 

excesivo del diafragma puede causar borrosidad 

por difracción, lo que hace que la imagen empiece a 
desenfocarse (un fenómeno habitual en las cámaras 
de vídeo). Puede suprimir este efecto para obtener 
mejores resultados en la filmación con el filtro ND.
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Ajuste de colores naturales (balance de blancos)
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Puede seleccionar el modo de ajuste que 
mejor se adapte a las condiciones de 
filmación.

ATW (localización automática del 
balance de blancos)

Esta función ajusta el balance de blancos 
automáticamente en el nivel adecuado.
El balance de blancos se ajusta 
automáticamente cuando la temperatura de 
color de la fuente de luz cambia.
Mantenga presionado el botón de función 
WHT BAL (H) para mostrar el menú directo 
(página 46) y seleccione ATW.
Puede seleccionar la velocidad de ajuste 
(cinco pasos) mediante White Setting >ATW 
Speed (página 85) en el menú Shooting.

[Consejo]
Puede congelar el ajuste del balance de blancos actual 
si asigna la función ATW Hold a un botón asignable 
(página 46) y pulsa el botón asignable para pausar 
temporalmente el modo ATW.

[Notas]
ˎˎ ATW no se puede utilizar en el modo Cine EI.

ˎˎ Tal vez no sea posible ajustar el color adecuado con 
ATW, según las condiciones de iluminación y del 
sujeto. 
Ejemplos:
–– Cuando un único color domina el sujeto, como por 

ejemplo el cielo, el mar, la tierra o las flores.
–– Cuando la temperatura del color es 

extremadamente alta o extremadamente baja.
	 Si no se puede obtener el efecto adecuado porque 

la velocidad de corrección automática de ATW es 
demasiado lenta o por cualquier otro motivo, utilice el 
balance automático de blancos.

Ajuste manual del balance de 
blancos

1	 Cuando el balance de blancos se 
establece en modo ATW, mantenga 
presionado el botón de función WHT BAL 
(H) para mostrar el menú directo 
(página 46) y seleccione Manual.

2	 Seleccione B, A o PRESET con el 
interruptor WHT BAL (K).
B: modo memoria B
A: modo memoria A
PRESET: modo predeterminado

[Consejo]
ATW se puede habilitar para la memoria B configurando 
White Setting >White Switch<B> (página 85) en el 
menú Shooting en ATW.

Modo memoria A/memoria B
Este modo ajusta el balance de blancos en la 
configuración guardada en la memoria A o B 
respectivamente.

Modo predeterminado
Este modo ajusta la temperatura del 
color a un valor predeterminado (el valor 
predeterminado de fábrica es 3200K).

Cambio del valor preestablecido 
predeterminado

En el modo predefinido, puede cambiar 
directamente un valor predefinido existente.
Mantenga presionado el botón de función 
WHT BAL (H) y seleccione una de las opciones 
siguientes en el menú directo.
Modo SDR/HDR:  3200K, 4300K, 

5600K, 6300K
Modo Cine EI:  3200K,  4300K,  5500K

[Consejo]
También puede asignar Preset White Select a un botón 
asignable (página 46) y pulsar el botón para cambiar 
el ajuste.
Modo SDR/HDR: 3200K  4300K  5600K  6300K 
 3200K…

Modo Cine EI: 3200K  4300K  5500K  3200K…

Cambio de la temperatura del color

1	 Presione el botón de función WHT BAL (H) 
para que el valor de la temperatura de 
color se muestre en un fondo blanco.

2	 Gire el dial multifunción para ajustar el 
valor.

[Consejos]
ˎˎ En el modo preestablecido, puede establecer el valor 

en unidades de 100K.
ˎˎ En el modo de memoria, puede establecer el valor en 

unidades de 20K. También puede ajustar el valor de 
tinte usando White (página 84) >Tint en el menú 
Shooting.

Utilización del balance automático de 
blancos

El balance de blancos que está guardado 
en la memoria A/memoria B se configura 
automáticamente.

1	 Seleccione el modo memoria A o el modo 
memoria B.

2	 Coloque un papel blanco (u otro objeto) 
en un lugar con la misma fuente de 
iluminación y condiciones que el sujeto y, 
a continuación, utilice el zoom para 
acercarse al papel y así mostrar blanco en 
la pantalla.

3	 Ajuste el brillo.
Ajuste el diafragma con el procedimiento 
descrito en “Ajuste manual del diafragma” 
(página 40).

4	 Pulse el botón WB SET (página 4).
ˎˎ Si el balance automático de blancos se 
ejecuta en el modo de memoria, el valor 
de ajuste se guarda en la memoria (A o 
B) seleccionada en el paso 1.
ˎˎ Si el balance automático de blancos se 
ejecuta en el modo ATW, el ajuste del 
balance de blancos vuelve al balance de 
blancos del modo ATW cuando finaliza 
el ajuste.

[Nota]
Si el ajuste no se realiza correctamente, aparecerá 
un mensaje de error en la pantalla durante unos tres 
segundos. Si el mensaje de error continúa después 
de varios intentos repetidos de ajuste del balance 
de blancos, póngase en contacto con su servicio de 
asistencia técnica de Sony.
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Puede especificar el audio que se va a grabar 
con los conectores de entrada, interruptores y 
diales del camcorder.

Interruptores de selección y conectores 
de entrada de audio externa

Conector INPUT1 (página 8)
Conector INPUT2 (página 8)
Zapata de interfaz múltiple (página 4)
Interruptor de selección CH1 INPUT 
(página 7)
Interruptor de selección CH2 INPUT 
(página 7)
Interruptor INPUT1 (LINE/MIC/MIC+48V) 
(página 4)
Interruptor INPUT2 (LINE/MIC/MIC+48V) 
(página 4)

Interruptores para ajustar el nivel de 
audio

Interruptor CH1 (AUTO/MAN) (página 7)
Interruptor CH2 (AUTO/MAN) (página 7)
Dial AUDIO LEVEL (CH1) (página 7)
Dial AUDIO LEVEL (CH2) (página 7)
Dial AUDIO LEVEL (CH3) (página 7)
Dial AUDIO LEVEL (CH4) (página 7)

Selección del dispositivo de 
entrada de audio

1	 Seleccione el conector de entrada de 
audio.
Para CH1/CH2, seleccione la entrada de 
audio utilizando el interruptor de 
selección CH1 INPUT o el interruptor de 
selección CH2 INPUT.
Configure EXT para utilizar el conector 
INPUT1 o el conector INPUT2.
Si utiliza un micrófono de zapata, un 
adaptador XLR, un dispositivo UWP 
(micrófono inalámbrico UHF) o un 
sintonizador inalámbrico portátil, 
especifique MI SHOE de la misma manera. 
Para obtener más información acerca del 
adaptador de XLR, consulte “Adición de 
conectores de entrada de audio” 
(página 45).
Para obtener más información sobre 
sintonizadores inalámbricos portátiles, 
consulte “Uso de un sintonizador 
inalámbrico portátil” (página 45).
Para CH3/CH4, seleccione la entrada de 
audio usando Audio Input >CH3 Input 
Select* (página 104) y CH4 Input Select* 
(página 104) en el menú Audio.
*	 También se puede configurar en la pantalla de 

estado.

	 [Consejo]
Para CH2, también puede seleccionar INPUT1 
usando Audio Input >CH2 EXT Input Select* 
(página 104) en el menú Audio.
*	 También se puede configurar en la pantalla de 

estado.

	 [Nota]
La videocámara tiene un micrófono de narración 
integrado para grabar sonido ambiental. Se puede 
usar para realizar la sincronización con otros 
equipos. En tales casos, especifique INT o Internal 
MIC.

2	 Seleccione la fuente de entrada de audio.
Ajuste los interruptores INPUT1/INPUT2 
(LINE/MIC/MIC+48V) en los dispositivos 
conectados a los conectores INPUT1/
INPUT2 respectivamente.

Dispositivo conectado Posición del 
interruptor

Fuente externa de audio 
(por ejemplo, mezclador)

LINE

Micrófono dinámico, 
micrófono con batería

MIC

Micrófono con 
alimentación fantasma de 
+48 V

MIC+48V

ˎˎ Si selecciona MIC+48V y conecta un 
micrófono que no sea compatible con 
fuentes de +48V, es posible que dañe 
el dispositivo conectado. Compruebe el 
ajuste antes de conectar el dispositivo.
ˎˎ Si le preocupa el ruido en conectores 
que no tengan un dispositivo conectado, 
ajuste los interruptores INPUT1/INPUT2 
(LINE/MIC/MIC+48V) correspondientes 
en LINE.

Ajuste automático del nivel de 
grabación de audio

Ajuste los interruptores CH1/CH2 (AUTO/
MAN) para que los canales se ajusten 
automáticamente en AUTO.
Para CH3/CH4, ajuste Audio Input >CH3 Level 
Control* y CH4 Level Control* en el menú 
Audio en Auto (página 104).
*	 También se puede configurar en la pantalla de 

estado.

Ajuste manual del nivel de 
grabación de audio

Utilice el siguiente procedimiento para ajustar 
el nivel de grabación de audio de CH1/CH2.

1	 Ajuste los interruptores CH1/CH2 (AUTO/
MAN) para que los canales se ajusten 
automáticamente en MAN.

2	 Durante la filmación o en espera, gire los 
diales AUDIO LEVEL (CH1)/(CH2) hasta los 
canales correspondientes para ajustar el 
nivel de audio.
ˎˎ Para CH3/CH4, ajuste Audio Input 
>CH3 Level Control* y CH4 Level 
Control* en el menú Audio en Manual 
y, a continuación, ajuste el nivel de 
grabación de audio usando los diales 
AUDIO LEVEL(CH3)/(CH4).
ˎˎ Puede ajustar los niveles de CH1 a CH4 
como grupo. Puede ajustar el nivel de 
grabación usando un dial asignable 
(página 46) asignado con la función 
Audio Input Level, o usando Audio Input 
>Audio Input Level* en el menú Audio.

*	 También se puede configurar en la pantalla de 
estado.

[Consejo]
La pantalla Audio Status resulta cómoda para comprobar 
el nivel de entrada de audio (página 14).

[Notas]
ˎˎ Es posible que los ajustes de Audio Input Level 

estén desactivados, en función de la combinación 
de ajustes del menú Audio. Para obtener más 
información, consulte el diagrama en la página 141.
ˎˎ Si el interruptor de selección de CH1 INPUT o 

el interruptor de selección de CH2 INPUT están 
configurados en INT, CH2 cambia a automático/
manual junto con el interruptor CH1 (AUTO/MAN). 
Además, el nivel de grabación de audio CH2 se 
establece junto con el dial AUDIO LEVEL (CH1).
ˎˎ El camcorder admite combinaciones de diferentes 

ajustes. Para obtener más información, consulte el 
diagrama en la página 141.

Especificación del audio que se va a grabar
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Adición de conectores de entrada 
de audio

Puede conectar a la videocámara hasta cuatro 
canales de los dispositivos de audio XLR al 
mismo tiempo si utiliza un adaptador de XLR 
XLR-K2M (no suministrado) o un adaptador 
XLR K3M-XLR (no suministrado).
Acople el adaptador de XLR a la zapata de 
interfaz múltiple y, a continuación, ajuste 
Audio Input >CH3 Input Select* en Shoe CH1 
y CH4 Input Select* en Shoe CH2 en el menú 
Audio.
Las funciones la videocámara que se solapen 
se inhabilitarán para los canales en los que el 
adaptador de XLR se haya seleccionado como 
la entrada. Utilice los interruptores y los diales 
del adaptador de XLR para realizar los ajustes.
*	 También se puede configurar en la pantalla de 

estado.

[Notas]
ˎˎ La videocámara admite la interfaz de audio digital del 

XLR-K3M.
ˎˎ Si Audio Input >CH3 Level y CH4 Level se han 

establecido en “Audio Input Level” en el menú Audio, 
el Audio Input Level del camcorder se ajustará para 
que coincida con el nivel que se haya ajustado en el 
adaptador de XLR.  
Audio Input Level también se habilita cuando el dial 
del adaptador de XLR está ajustado en AUTO.  
Cuando se especifique “Through”, el audio se grabará 
en el nivel que se haya ajustado con el adaptador de 
XLR (página 142).
ˎˎ Para conectar un adaptador de XLR XLR-K2M (no 

suministrado) o un adaptador XLR K3M-XLR (no 
suministrado) a la videocámara, retire el soporte del 
micrófono de la videocámara.

Uso de un sintonizador 
inalámbrico portátil

Se requiere un módulo de ampliación 
XDCA‑FX9 (opcional). Para obtener más 
información sobre la conexión de un módulo 
XDCA-FX9, consulte la página 25.
Con un sintonizador inalámbrico portátil 
acoplado a la XDCA-FX9, establezca Audio 
Input (página 104) >CH1 MI SHOE Input 
Select*, CH2 MI SHOE Input Select*, CH3 Input 
Select* o CH4 Input Select* en Wireless en el 
menú Audio.
*	 También se puede configurar en la pantalla de 

estado.
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Funcionamiento del menú directo

Puede verificar el estado y la configuración de 
la videocámara que se muestra en la pantalla 
del visor, y seleccionar y cambiar directamente 
la configuración.
Estos son los elementos que pueden 
configurarse.
ˎˎ Face/Eye Detection AF
ˎˎ Steady Shot
ˎˎ White Mode
ˎˎ Color Temp
ˎˎ Scene File
ˎˎ ND Filter Position / Auto ND Filter
ˎˎ ND Filter Value
ˎˎ Auto Iris
ˎˎ Iris Value
ˎˎ AGC
ˎˎ Gain Value
ˎˎ ISO Value
ˎˎ EI Gain Value
ˎˎ Auto Shutter
ˎˎ Shutter Value
ˎˎ Auto Exposure Mode
ˎˎ Auto Exposure Level
ˎˎ S&Q Motion Frame Rate

1	 Presione el dial multifunción o un botón 
asignable asignado con la función Direct 
Menu.
Solo los elementos en la pantalla que se 
pueden configurar con el menú directo se 
pueden seleccionar con el cursor naranja.

2	 Gire el dial multifunción para mover el 
cursor hasta el elemento del menú que se 
desea ajustar y, a continuación, pulse el 
dial multifunción.
Se muestra un menú o el elemento sobre 
un fondo blanco.

3	 Gire el dial multifunción para seleccionar 
un ajuste y, a continuación, pulse el dial 
multifunción.
El menú o el fondo blanco desaparece y 
se muestra el nuevo ajuste con un cursor 
naranja.
Pulse de nuevo el botón asignable al que 
se ha asignado Direct Menu de nuevo o 
espere 3 segundos sin realizar ninguna 
acción para cerrar el menú directo.

	 [Consejos]
ˎˎ Los ajustes directos también se pueden 

configurar manteniendo presionado cada uno de 
los botones de función (página 6).
ˎˎ Cuando los elementos se muestran sobre un 

fondo blanco, el dial multifunción se puede usar 
como un dial asignable.
ˎˎ El selector múltiple (página 9) también se 

puede utilizar para operaciones de selección.

Botones/diales asignables

Existen diez botones asignables (página 6, 
9) en la videocámara a los que puede 
asignar diversas funciones.
También puede asignar funciones al dial 
asignable (página 9) en el control remoto 
de la empuñadura y al dial multifunción en la 
videocámara.

Cambio de función de los botones

Utilice Assignable Button (página 91) en el 
menú Project.
Puede visualizar las funciones asignadas 
en la pantalla Assignable Button Status 
(página 15).

Las funciones se asignan a cada botón 
asignable de manera predeterminada de 
fábrica
Botón 1	 S&Q Motion

Botón 2	 Off
Botón 3	 Off
Botón 4	 Focus Magnifier x3/x6
Botón 5	 Direct Menu
Botón 6	 Off
Botón 7	 Off
Botón 8	 Off
Botón 9	 Off
Botón 10	 Focus Magnifier x3/x6
Botón Focus Hold	 Focus Hold

Funciones asignables
ˎˎ Off
ˎˎ Base ISO/Sensitivity
ˎˎ AGC
ˎˎ Push AGC
ˎˎ ND Filter Position
ˎˎ Auto ND Filter
ˎˎ Push Auto ND
ˎˎ Auto Iris
ˎˎ Push Auto Iris
ˎˎ Auto Shutter
ˎˎ Auto Exposure Level
ˎˎ Backlight
ˎˎ Spotlight
ˎˎ Preset White Select
ˎˎ ATW
ˎˎ ATW Hold
ˎˎ AF Speed/Sens.
ˎˎ Focus Setting
ˎˎ Focus Area
ˎˎ Focus Area(AF-S)
ˎˎ Face/Eye Detection AF
ˎˎ Push AF Mode
ˎˎ Push AF/Push MF
ˎˎ Focus Hold
ˎˎ Focus Magnifier x3/x6
ˎˎ Focus Magnifier x3
ˎˎ Focus Magnifier x6
ˎˎ S&Q Motion
ˎˎ SteadyShot
ˎˎ Rec
ˎˎ Picture Cache Rec
ˎˎ Rec Review

ˎˎ Last Clip Del.
ˎˎ Shot Mark1
ˎˎ Shot Mark2
ˎˎ Clip Flag OK
ˎˎ Clip Flag NG
ˎˎ Clip Flag Keep
ˎˎ Color Bars
ˎˎ Tally [Front]
ˎˎ DURATION/TC/U-BIT
ˎˎ Display
ˎˎ Lens Info
ˎˎ Video Signal Monitor
ˎˎ Marker
ˎˎ VF Adjust
ˎˎ VF Mode
ˎˎ Gamma Display Assist
ˎˎ Peaking
ˎˎ Zebra
ˎˎ Thumbnail
ˎˎ Touch Operation
ˎˎ Handle Zoom
ˎˎ NFC
ˎˎ Network Client Mode
ˎˎ Auto Upload (Proxy)
ˎˎ Direct Menu
ˎˎ User Menu
ˎˎ Menu

Cambio de función de los diales

Puede cambiar la función del dial multifunción 
en la videocámara y el dial asignable en el 
control remoto de la empuñadura.
Para el dial multifunción, ajuste usando Multi 
Function Dial (página 93) >Default Function 
en el menú Project.
Off se asigna de manera predeterminada de 
fábrica.

Funciones asignables al dial multifunción
ˎˎ Off
ˎˎ IRIS
ˎˎ ISO/Gain/EI
ˎˎ Audio Input Level

Funciones útiles
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[Nota]
El ajuste se desactiva mientras se muestra el menú.

Para el dial asignable, ajuste usando 
Assignable Dial (página 93) en el menú 
Project.
IRIS se asigna de manera predeterminada de 
fábrica.

Funciones asignables al dial asignable
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Audio Input Level

Puede visualizar las funciones asignadas 
en la pantalla Assignable Button Status 
(página 15).

Slow & Quick Motion

Cuando el formato de grabación (página 88) se ajusta en los siguientes valores, puede 
especificar valores diferentes para la velocidad de fotogramas de grabación y la velocidad de 
fotogramas de reproducción.

Formato de grabación Velocidad de 
fotogramaFrecuencia del 

sistema
Modo de 
escaneado de la 
cámara

Codec Formato de vídeo

59.94/50 FFcrop 5K/S35 4K XAVC-I 4096×2160P 1–60

3840×2160P 1–60

1920×1080P 1–60

XAVC-L 3840×2160P 1–60

1920×1080P 1–60

FF 2K XAVC-I 1920×1080P 1–60, 100, 120, 150, 
180*1

XAVC-L 1920×1080P 1–60, 100, 120

S35 2K XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

29.97/25/23.98 FF 6K XAVC-I 4096×2160P 1-30

3840×2160P 1–30

1920×1080P 1–30

XAVC-L 3840×2160P 1–30

1920×1080P 1–30

FFcrop 5K/S35 4K XAVC-I 4096×2160P 1–60

3840×2160P 1–60

1920×1080P 1–60

XAVC-L 3840×2160P 1–60

1920×1080P 1–60

FF 2K XAVC-I 1920×1080P 1–60, 100, 120, 150, 
180*2

XAVC-L 1920×1080P 1–60, 100, 120

S35 2K XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

24 FF 6K XAVC-I 4096×2160P 1-30

FFcrop 5K/S35 4K XAVC-I 4096×2160P 1–60

*1	 Puede seleccionarse cuando la frecuencia del sistema es 59.94.
*2	 Puede seleccionarse cuando la frecuencia del sistema es 29.97/23.98.
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Formato de grabación Velocidad de 
fotogramaFrecuencia del 

sistema
Modo de 
escaneado de la 
cámara

Codec Formato RAW

59.94/50 FFcrop 5K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–60

S35 4K RAW 4096×2160 1–60

3840×2160 1–60, 100, 120

RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–60

FF 2K RAW/
RAW&XAVC-I*3

2048×1080 1–60, 100, 120, 150, 
180*1

RAW&XAVC-L*3 2048×1080 1–60, 100, 120

S35 2K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

2048×1080 1–60, 100, 120

29.97/25/23.98 FF 6K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–30

FFcrop 5K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–60

S35 4K RAW 4096×2160 1–60

3840×2160 1–60, 100, 120

RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–60

FF 2K RAW/
RAW&XAVC-I*3

2048×1080 1–60, 100, 120, 150, 
180*2

RAW&XAVC-L*3 2048×1080 1–60, 100, 120

S35 2K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

2048×1080 1–60, 100, 120

24 FF 6K RAW 4096×2160 1–30

FFcrop 5K/S35 4K RAW 4096×2160 1–60

*1	 Puede seleccionarse cuando la frecuencia del sistema es 59.94.
*2	 Puede seleccionarse cuando la frecuencia del sistema es 29.97/23.98.

*3	 El formato de vídeo se convierte en 1920×1080.

Puede activar/desactivar el modo Slow & 
Quick Motion presionando un botón asignable 
(página 46) asignado con la función S&Q 
Motion.
Puede establecer la velocidad de fotogramas 
para la grabación manteniendo presionado el 
botón.

[Notas]
ˎˎ La función Slow & Quick Motion no se puede ajustar 

durante la grabación, la reproducción ni durante la 
visualización de la pantalla de miniaturas.
ˎˎ La grabación de audio no es compatible con el modo 

Slow & Quick Motion.
ˎˎ La función de enfoque automático, diafragma 

automático y obturador automático se inhabilitan en 
el modo Slow & Quick Motion.
ˎˎ Para obtener más información sobre el uso de la 

salida RAW, consulte la página 55.

Grabación de vídeo de manera 
intermitente (Interval Rec)

La función Interval Rec del camcorder le 
permite capturar vídeos time-lapse en la 
memoria interna del camcorder. Esta función 
es una manera efectiva de filmar sujetos que 
se mueven lentamente.
Al iniciar la grabación, el camcorder graba 
automáticamente un número especificado 
de fotogramas (Number of Frames) en 
un intervalo de tiempo (Interval Time) 
especificado.

Intervalo de filmación (Interval Time)

Número de fotogramas en una toma
(Number of Frames)

Cuando Interval Rec está activado, la luz de 
vídeo del HVL-LBPC (opcional) se enciende 
automáticamente antes de que comience la 
grabación, lo que le permite grabar imágenes 
con una iluminación y unas condiciones de 
temperatura de color estables (función de 
preiluminación).

[Notas]
ˎˎ Solo se puede utilizar una función de grabación 

especial al mismo tiempo, como la grabación Interval 
Rec.



3. Filmación: Funciones útiles49

ˎˎ Si se activa otro modo de grabación especial mientras 
se está utilizando Interval Rec, se desactivará 
automáticamente Interval Rec.
ˎˎ El modo Interval Rec se desactiva automáticamente 

después de cambiar los ajustes del sistema, como el 
formato de vídeo.
ˎˎ No se pueden cambiar los ajustes de Interval Rec 

durante la grabación o la reproducción, ni cuando se 
muestre la pantalla de imágenes en miniatura.

Para ajustar Interval Rec

Ajuste Interval Rec (página 90) >Setting 
en el menú Project en On y ajuste Number of 
Frames e Interval Time.
Si utiliza la luz de vídeo del HVL-LBPC 
(opcional), ajuste el intervalo de tiempo 
para encender la luz de vídeo antes de que 
comience la grabación en Interval Rec >Pre-
Lighting en el menú Project, si es necesario.

[Notas]
ˎˎ Si desea encender la luz de vídeo antes de que 

comience la grabación, ajuste el interruptor de la luz 
de vídeo en AUTO. La luz de vídeo se enciende y se 
apaga automáticamente en función del ajuste de 
Video Light Set (página 109) en el menú Technical.
ˎˎ Si enciende la luz de vídeo, esta siempre estará 

iluminada (la luz de vídeo no se encenderá/apagará 
automáticamente).
ˎˎ Si la luz de vídeo está configurada para que se 

apague durante un período de 5 segundos o menos, 
la luz de vídeo no se apagará.

El camcorder sale del modo Interval Rec 
cuando se apaga, pero se mantienen los 
ajustes de Number of Frames, Interval Time 
y Pre-lighting. No es necesario volver a 
ajustarlos la próxima vez que filme en el modo 
Interval Rec.

Para filmar utilizando Interval Rec

Pulse el botón START/STOP de grabación para 
comenzar a grabar. “Int Rec” y “Int Stby” 
aparecen de manera alterna en el visor.
Si está utilizando la función de preiluminación, 
la luz de vídeo se enciende antes de que 
comience la grabación.

Para detener la filmación

Detenga la grabación.
Cuando la filmación finalice, los datos de 
vídeo almacenados en la memoria hasta ese 
punto se graban en el soporte.

Para salir del modo Interval Rec

Realice una de las siguientes acciones.
ˎˎ Ajuste el interruptor POWER en Off.
ˎˎ En el modo de espera de grabación, ajuste 
Interval Rec >Setting en el menú Project en 
Off.

Asimismo, el modo Interval Rec se desactivará 
automáticamente cuando se reinicie el 
camcorder.

Limitaciones durante la grabación

ˎˎ No se graba el audio.
ˎˎ No es posible revisar la grabación (Rec 
Review).
ˎˎ No se aplica el generador de sincronismo.

Si el camcorder se apaga durante la 
grabación

ˎˎ Si el interruptor POWER del camcorder 
está ajustado en la posición Off, se accede 
al soporte durante varios segundos 
para grabar las imágenes almacenadas 
en la memoria hasta ese momento y, a 
continuación, la alimentación se apaga 
automáticamente.
ˎˎ Si la unidad deja de recibir alimentación 
porque se ha extraído la batería, se ha 
desconectado el cable de alimentación de 
CC o se ha apagado la alimentación desde 
el adaptador de CA, los datos de audio y de 
vídeo filmados hasta ese punto se pueden 
perder (10 segundos como máximo). Se 
debe tener cuidado al cambiar la batería.

Grabación de imágenes en 
memoria intermedia (Picture 
Cache Rec)

La función de grabación de memoria 
intermedia de imágenes le permite capturar 
vídeo de forma retroactiva cuando empieza 
a grabar y después lo graba en tarjetas de 
memoria XQD; esto se consigue manteniendo 
una memoria intermedia de imágenes 
de una duración específica durante la 
filmación. Ajuste Picture Cache Rec >Setting* 
(página 91) en el menú Project en On. El 
tiempo de grabación de memoria intermedia 
se establece mediante Picture Cache Rec 
>Cache Rec Time (página 91) en el menú 
Project.
*	 También se puede configurar en la pantalla de 

estado.

Formatos de grabación compatibles

Codec Formato de 
vídeo

Frecuencia 
del 
sistema

Tiempo de 
memoria 
[s]

XAVC-I 4096×2160P 59.94 0–4 s

50

29.97

25 0–4/ 
4–8 s23.98

24

3840×2160P 59.94 0–4 s

50

29.97

25 0–4/ 
4–8 s23.98

Codec Formato de 
vídeo

Frecuencia 
del 
sistema

Tiempo de 
memoria 
[s]

XAVC-I 1920×1080P 59.94 0–4/ 
4–8 s50

29.97 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24 s

25

23.98 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

1920×1080i 59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20 s

1920×1080i 50 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24 s

XAVC-L 3840×2160P 59.94 0–4/ 
4–8/ 
8–12/ 
12–16 s

50

29.97 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

25

23.98
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Codec Formato de 
vídeo

Frecuencia 
del 
sistema

Tiempo de 
memoria 
[s]

XAVC-L 1920×1080P 
50

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

50

29.97

25

23.98

1920×1080P 
35

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

50

29.97

25

23.98

1920×1080i 
50

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

50

1920×1080i 
35

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

50

1920×1080i 
25

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

50

MPEG 
HD422

1920×1080i 
50

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

50

29.97

25

23.98

[Notas]
ˎˎ Picture Cache Rec no puede estar activado al mismo 

tiempo que Interval Rec o Slow & Quick Motion. 
Cuando Picture Cache Rec está activado, estos otros 
modos de grabación se apagan de forma forzosa.
ˎˎ El modo Picture Cache Rec no se puede seleccionar 

mientras se graba o cuando Rec Review está en 
proceso.
ˎˎ Cuando Picture Cache Rec está activado, el 

código de tiempo se graba en el modo Free Run 
independientemente del ajuste del menú TC/Media 
(página 99).
ˎˎ Es posible que el ajuste de Output Format no se 

pueda configurar en el modo Picture Cache Rec. Si 
esto sucede, ajuste temporalmente Picture Cache Rec 
en Off y, a continuación, cambie el ajuste.

Configuración antes de la filmación

Configure Picture Cache Rec (página 91) en 
el menú Project antes de filmar.
También puede asignar la función Picture 
Cache Rec a un botón asignable (página 46) 
y activar o desactivar Picture Cache Rec 
>Setting con el botón.
Cuando está configurado, el indicador “” ( 
es verde) aparece en el visor.

Inicio de la grabación de memoria 
intermedia de imágenes

Cuando pulsa el botón START/STOP de 
grabación, la grabación comienza y el vídeo 
se graba en las tarjetas de memoria XQD a 
partir del vídeo almacenado en la memoria 
intermedia.

Para cancelar Picture Cache Rec

Desactive el ajuste Picture Cache Rec >Setting 
en el menú Project o pulse un botón asignable 
que tenga asignada la función Picture Cache 
Rec.

[Notas]
ˎˎ El cambio del formato de grabación borra el vídeo de 

la memoria intermedia almacenado hasta ese punto y 
comienza a almacenar vídeo nuevo. En consecuencia, 
la grabación de memoria intermedia de imágenes 
no es posible antes de cambiar el formato, aunque 
empiece a grabar inmediatamente después de 
cambiar el formato.
ˎˎ Si Picture Cache Rec se activa/desactiva 

inmediatamente después de insertar una tarjeta de 
memoria XQD, los datos de la memoria intermedia 
pueden no grabarse en la tarjeta.
ˎˎ El vídeo se almacena en la memoria intermedia 

cuando la función Picture Cache Rec está activada. No 
se almacena en la memoria media el vídeo anterior a 
la activación de la función.
ˎˎ El vídeo no se almacena en la memoria intermedia 

durante el acceso a una tarjeta de memoria XQD; lo 
mismo ocurre durante la reproducción, Rec Review o 
la visualización de miniaturas en la pantalla. Durante 
ese intervalo, la grabación de memoria intermedia de 
imágenes de vídeo no es posible.

Grabación en la tarjetas de 
memoria A y B simultáneamente 
(2-slot Simul Rec)

Puede grabar simultáneamente en las tarjetas 
de memoria A y B ajustando Simul Rec 
>Setting* en el menú Project en On.
*	 También se puede configurar en la pantalla de 

estado.

[Nota]
La grabación simultánea no es compatible con el modo 
de Slow & Quick Motion (página 86) ni con el modo 
Picture Cache Rec (página 91). Además, la grabación 
simultánea no es compatible con los siguientes 
formatos de grabación (página 88).

XAVC-I
Formato de vídeo
4096×2160P, 3840×2160P

XAVC-L
Formato de vídeo
4096×2160P, 3840×2160P

Cambio de los ajustes de los 
botones de grabación START/
STOP en el camcorder y en el asa

Cuando se habilita la grabación simultánea 
(Simul Rec), puede iniciar y detener la 
grabación en cada tarjeta de memoria de 
forma independiente con los botones START/
STOP de grabación en el camcorder y en el 
asa.
Según el ajuste predeterminado de fábrica, 
ambos botones se han configurado para 
iniciar y detener la grabación simultánea en 
ambas tarjetas A y B.
ˎˎ “Rec Button [SlotA SlotB] Handle Rec Button 
[SlotA SlotB]”

Cuando los botones se establecen para 
controlar la grabación de diferentes tarjetas 
de memoria, SDI/HDMI Rec Control sigue el 
estado de grabación de la ranura A.

Para cambiar el ajuste

Seleccione Simul Rec > Rec Button Set en el 
menú Project.

Rec Button Set Botones y tarjetas de 
memoria

“Rec Button [SlotA 
SlotB] Handle Rec 
Button [SlotA SlotB]”

Inicia y detiene la 
grabación simultánea 
en las tarjetas de 
memoria A y B con 
cualquiera de los 
botones.
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Rec Button Set Botones y tarjetas de 
memoria

“Rec Button [SlotA] 
Handle Rec Button 
[SlotB]”

El botón START/STOP 
inicia y detiene la 
grabación en la tarjeta 
de memoria A, y el 
botón START/STOP de 
grabación del asa inicia 
y detiene la grabación 
en la tarjeta de 
memoria B.

“Rec Button [SlotB] 
Handle Rec Button 
[SlotA]”

El botón START/STOP 
inicia y detiene la 
grabación en la tarjeta 
de memoria B, y el 
botón START/STOP de 
grabación del asa inicia 
y detiene la grabación 
en la tarjeta de 
memoria A.

Grabación 4K & HD (Sub)

Puede grabar simultáneamente un vídeo 4K 
(QFHD) como clip principal y un vídeo MPEG 
HD422 como un subclip, que se puede usar 
para editar, en una sola tarjeta de memoria 
XQD.
Los siguientes formatos de grabación de 
tarjeta de memoria XQD se pueden usar para 
grabación 4K y HD (Sub).
El formato de grabación de subclips varía, 
dependiendo de la frecuencia del sistema del 
clip principal.

Formato de 
grabación de 
clip principal

Frecuencia 
del 
sistema

Formato de 
grabación de 
clip 
secundario

ˎˎ XAVC-I  
4096×2160P

ˎˎ XAVC-I  
3840×2160P

ˎˎ XAVC-L  
3840×2160P

29.97/25/ 
23.98

MPEG HD422 
1920×1080P

59.94/50 MPEG HD422 
1920×1080i

[Consejo]
Los clips secundarios pueden copiarse en otros 
soportes como clips principales usando Copy Sub Clip 
(página 106) en el menú Thumbnail.

Monitor de señal de vídeo

Puede establecer el tipo de señal de vídeo 
que desea visualizar en la pantalla del visor 
en forma de onda, vectorscopio o histograma 
mediante Display On/Off >Video Signal 
Monitor (página 102) en el menú Monitoring.
El monitor de señal de vídeo de la 
videocámara mide la señal de vídeo en la 
etapa de salida de vídeo. En consecuencia, si 
el vídeo de salida tiene los bordes recortados 
con respecto al vídeo grabado, la parte 
recortada no se medirá. Cuando ocurre esto, 
se muestra “EC” en la parte superior izquierda 
del monitor de señal de vídeo.

Monitorización de visualización del 
objetivo

En el modo Cine EI, la configuración 
del espacio de color (página 27) o la 
información de configuración del LUT de 
monitor (página 86) se muestra en la 
parte superior derecha del monitor de 
señal de vídeo para indicar el objetivo de la 
monitorización.

Filmación de alto rango dinámico 
(HDR)

Puede establecer el modo de alto rango 
dinámico (HDR) para grabar y emitir imágenes 
con un espacio de color equivalente a BT.2020 
y un mayor rango dinámico.

Ajuste del modo de alto rango dinámico

Ajuste Base Setting >Shooting Mode* 
(página 88) en el menú Project en HDR.

*	 También se puede configurar en la pantalla de 
estado.

Ajustar el tipo de HLG

Ajuste el tipo de HLG para el modo HDR 
usando HDR Paint Setting >HLG Look 
(página 95) en el menú Paint.

Ajuste de HLG 
Look

Descripción

Natural Característica conforme al 
ITU-R BT.2100(HLG).

Live Característica conforme 
a ITU-R BT.2100(HLG) 
que ofrece un mejor 
rendimiento de HDR. Sin 
embargo, el uso de este 
ajuste puede aumentar en 
nivel de ruido.

Ajuste de la función de asistencia de 
visualización de gamma

Ajuste Gamma Display Assist >Setting 
(página 103) en el menú Monitoring en On 
para ver una pantalla de asistencia en el visor 
para facilitar la filmación en el modo HDR.

*	 También se puede configurar en la pantalla de 
estado.

3D LUT del usuario

En el modo Cine EI, puede cargar un archivo 
CUBE (*.cube) para una LUT 3D de 17 o 33 
puntos creada con RAW Viewer o DaVinci 
Resolve (de Blackmagic Design Pty. Ltd.).

[Nota]
Guarde el archivo 3D LUT del usuario en el siguiente 
directorio en la tarjeta SD.
\PRIVATE\SONY\PRO\LUT\

El siguiente procedimiento es necesario para 
poder utilizar 3D LUT del usuario.

1	 Inserte la tarjeta SD en la ranura de tarjeta 
UTILITY SD/MS (página 8) con la 
etiqueta orientada hacia la derecha.
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2	 Seleccione Monitor 3D LUT >Load SD Card 
(página 87) en el menú Shooting.

3	 Seleccione un destino de carga.
Puede registrar hasta 16 archivos en la 
memoria interna de la unidad.

4	 Seleccione un archivo para cargar.

5	 Seleccione OK.
El archivo seleccionado se carga.

6	 Seleccione OK.

7	 Ajuste Monitor LUT >Category 
(página 86) en Shooting en User 3D 
LUT.

8	 Seleccione el 3D LUT del usuario que 
desea utilizar con Monitor LUT >User 3D 
LUT Select (página 87) en el menú 
Shooting.

Obtención de la información de 
ubicación (GPS)

Cuando la opción GPS del menú Technical 
esté activada, se mostrará  cuando 
la videocámara busque satélites de GPS. 
Cuando se establece el posicionamiento, la 
información de ubicación se graba mientras se 
filma el vídeo.

[Notas]
ˎˎ El ajuste de GPS no se puede establecer en On en 

el menú Technical cuando el asa no está acoplada, 
puesto que el receptor de GPS está integrado en el 
asa.
ˎˎ El icono que se muestra varía según la recepción de 

señal de los satélites GPS.
ˎˎ Si se agarra el asa durante el uso de la función 

GPS, se puede ver afectada la precisión del 
posicionamiento.

Estado de 
posicionamiento

Pantalla Estado de recepción de 
GPS

Off Sin 
visualización

GPS se ha ajustado en 
Off o se ha producido 
un error.

Ubicación 
no 
disponible

No se ha podido 
obtener la información 
de ubicación porque no 
se ha podido recibir la 
señal de GPS. 
Desplácese hasta una 
ubicación con una vista 
despejada del cielo.

Buscando 
satélites

Buscando satélites de 
GPS. Puede que tarde 
varios minutos en 
encontrar satélites.

Estado de 
posicionamiento

Pantalla Estado de recepción de 
GPS

Posicionamiento Se recibe una señal 
débil de GPS.

Se recibe una señal de 
GPS. Se puede 
conseguir la 
información de 
ubicación.

Se recibe una señal 
fuerte de GPS. Se 
puede conseguir la 
información de 
ubicación.

[Consejos]
ˎˎ GPS se ajusta en On de manera predeterminada de 

fábrica. La videocámara grabará la información de 
ubicación y de tiempo del vídeo grabado cuando el 
posicionamiento esté activado.
ˎˎ Si después de varios minutos no se muestra un 

icono de posicionamiento, es posible que exista un 
problema con la recepción de señal. Comience a 
filmar sin información de ubicación o desplácese a 
una zona con una vista clara del cielo. Si filma cuando 
no se muestra un icono de posicionamiento, la 
información de ubicación no se grabará.
ˎˎ Es posible que no se reciba señal de GPS cuando esté 

en interiores o cerca de estructuras altas. Desplácese 
hasta una ubicación con una vista despejada del 
cielo.
ˎˎ Es posible que se interrumpa la grabación de 

información de ubicación, según la fuerza de la 
señal recibida, incluso si se muestra el icono de 
posicionamiento.

Metadatos de planificación

Los metadatos de planificación son 
información acerca de los planes de toma de 
imágenes y grabación, grabados en un archivo 
XML.
Puede capturar imágenes mediante nombres 
de clips y nombres de marcas de toma 

definidos de antemano en un archivo de 
metadatos de planificación.
Puede enviar y recibir metadatos de 
planificación a través de una red con la 
aplicación “Content Browser Mobile”.

[Notas]
ˎˎ Cuando se abre la cubierta de la ranura de soportes, 

se interrumpe la transferencia de metadatos de 
planificación a través de la red. Los metadatos de 
planificación no se pueden transferir mientras la 
cubierta está abierta. La transferencia se reanuda 
cuando se cierra la cubierta.
ˎˎ Para definir nombres de clips o nombres de 

marcas de filmación, use un conjunto de fuentes 
para el idioma especificado usando Language 
>Select (página 116) en el menú Maintenance. Es 
posible que los caracteres de texto no se muestren 
correctamente si utiliza un idioma diferente del 
idioma de la videocámara.
ˎˎ Si define nombres de marcas de clip y de toma en 

francés, neerlandés o finlandés, algunos caracteres se 
visualizarán en una fuente similar pero diferente.

Carga de un archivo de metadatos de 
planificación

Para grabar metadatos de planificación con 
los clips, es necesario cargar un archivo de 
metadatos de planificación en la memoria de 
la videocámara de antemano.
Introduzca la tarjeta de memoria XQD con 
el archivo de metadatos de planificación 
(.xml) guardado en el siguiente directorio 
en la ranura de la tarjeta de memoria de la 
videocámara y, a continuación, seleccione 
y cargue el archivo a través de Planning 
Metadata (página 94) >Load Media(A) o 
Load Media(B) en el menú Project.
exFAT: XDROOT/General/Sony/Planning

Confirmación de la información detallada en 
los metadatos de planificación
Tras cargar los metadatos de planificación 
en la videocámara, puede comprobar la 
información detallada que contiene, como 
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nombres de archivos, fecha y hora de creación 
y títulos.
Seleccione Planning Metadata (página 94) 
>Properties >Execute en el menú Project.

Borrado de los metadatos de planificación 
cargados
Puede borrar los datos de planificación 
cargados en la memoria de la videocámara.
Seleccione Planning Metadata (página 94) 
>Clear Memory >Execute en el menú Project.

Definición del nombre de un clip en los 
metadatos de planificación

Es posible escribir los siguientes dos tipos de 
cadenas de nombre de clip en un archivo de 
metadatos de planificación.
ˎˎ Nombre en formato ASCII, que se muestra 
en la pantalla del visor
ˎˎ Nombre en formato UTF-8, que se registra 
como el nombre del clip

Cuando especifica el nombre de un clip en 
metadatos de planificación, el nombre se 
muestra en la indicación del estado de la 
operación en la pantalla del visor.

Ejemplo de cadenas de nombres de clip
Utilice un editor de texto para modificar 
la descripción de la etiqueta <Title> de los 
metadatos de planificación.
Los campos atenuados del ejemplo son 
cadenas de nombres de clips.
“Typhoon” es la descripción en el formato 
ASCII (con un máximo de 44 caracteres). 
“Typhoon_Strikes” es la descripción con el 
formato UTF-8 (con un máximo de 44 bytes).
“sp” hace referencia a un espacio y  indica un 
retorno de carro.

<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadataspxmlns="http://
xmlns.sony.net/pro/metadata/

planningmetadata" spassignId="
P0001" spcreationDate="
2011-08-20T17:00:00+09:00"sp

lastUpdate="
2011-09-28T10:30:00+09:00"sp

version="1.00">
<Properties sppropertyId="
assignment" spupdate="
2011-09-28T10:30:00+09:00"sp

modifiedBy="Chris">
<TitlespusAscii="Typhoon"sp

xml:lang="en">Typhoon_Strikes
</Title>

</Properties>
</PlanningMetadata>

[Notas]
ˎˎ Cuando cree un archivo, introduzca cada afirmación 

como una sola línea introduciendo un salto de línea 
mediante un corte de línea únicamente después del 
último carácter de la línea, y no introduzca espacios 
excepto en los lugares especificados mediante “sp”.
ˎˎ Una cadena de hasta 44 byte (o 44 caracteres) resulta 

válida como nombre de clip.  
Si la cadena de formato UTF-8 supera los 44 bytes, se 
utilizarán los primeros 44 bytes como nombre del clip.  
Si solo se especifica una cadena con formato ASCII 
, se utilizará como nombre de clip el nombre con 
formato ASCII con los primeros 44 caracteres.  
Si ni la cadena de nombre de formato ASCII ni la de 
formato UTF-8 es válida, se utilizará un nombre de 
clip de formato estándar.
ˎˎ Los siguientes caracteres no pueden utilizarse en los 

nombres de clip, que se verán reemplazados por un 
carácter de guion bajo (_).  
Caracteres no válidos: "*/:<>?\|

Utilización de un nombre de clip definido en 
los metadatos de planificación
Cargue un archivo de metadatos de 
planificación que contenga el nombre del 
clip en la memoria de la videocámara y, a 
continuación, seleccione Clip Name Format 
>Auto Naming (página 99) >Plan en el 
menú TC/Media.
Los nombres de los clips se generan 
añadiendo un guión bajo (_) y un número de 
serie de 5 dígitos (entre 00001 y 99999).

Ejemplo: Typhoon_Strikes_00001, Typhoon_
Strikes_00002, …
[Notas]
ˎˎ Si el número de serie llega a 99999, regresará a 00001 

en la siguiente grabación.
ˎˎ Si carga otro archivo de metadatos de planificación, el 

número de serie de 5 dígitos volverá a ser el 00001.

Definición de nombres de marcas de 
tomas en los metadatos de planificación

Cuando grabe la marca de toma 1 o la marca 
de toma 2, puede aplicar un nombre a dicha 
marca utilizando la cadena definida en los 
metadatos de planificación.

Ejemplo de cadenas de nombres de marca de 
toma
Utilice un editor de texto para modificar la 
descripción de la etiqueta <Meta name> de los 
metadatos de planificación.
Los campos atenuados del ejemplo son 
cadenas de nombres de marcas de toma.
Los nombres pueden tener formato ASCII 
(hasta 32 caracteres) o formato UTF-8 (hasta 
16 caracteres).
“sp” hace referencia a un espacio y  indica un 
retorno de carro.

[Nota]
Si una cadena de nombre contiene incluso un carácter 
no ASCII, la longitud máxima de dicha cadena está 
limitada a 16 caracteres.

<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadata xmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
H00123"spcreationDate="
2011-04-15T08:00:00Z"splastUpdate="
2011-04-15T15:00:00Z"spversion=
"1.00">
<PropertiessppropertyId=
"assignment"spclass="original"sp

update="2011-04-15T15:00:00Z"sp

modifiedBy="Chris">
<TitlespusAscii="Football
Game"spxml:lang="en">
Football Game 15/04/2011
</Title>

<Metaspname="_ShotMark1"sp

content="Goal"/>
<Metaspname="_ShotMark2"sp

content="Shoot"/>
</Properties>

</PlanningMetadata>

[Nota]
Cuando cree un archivo, introduzca cada afirmación 
como una sola línea introduciendo un salto de línea 
mediante un corte de línea únicamente después del 
último carácter de la línea, y no introduzca espacios 
excepto en los lugares especificados mediante “sp” fuera 
de las cadenas de nombre de marca de toma.
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Puede grabar datos proxy en una tarjeta SD 
al mismo tiempo que graba en una tarjeta de 
memoria XQD.

Para obtener detalles sobre las tarjetas SD compatibles, 
formatear las tarjetas SD y verificar la capacidad restante, 
consulte “Utilización de una tarjeta UTILITY SD/MS” 
(página 31).

Configuración antes de la 
filmación

1	 Ajuste Proxy Rec* >Setting en el menú 
Project en On.
*	 También se puede configurar en la pantalla de 

estado.

2	 Inserte la tarjeta SD en la ranura de tarjeta 
UTILITY SD/MS (página 8) con la 
etiqueta orientada hacia la derecha.

[Nota]
Proxy Rec no se puede establecer en On al mismo 
tiempo que S&Q Motion, Interval Rec, Picture Cache Rec, 
2-slot Simul Rec o 4K & HD (Sub) Rec. Cuando Proxy Rec 
se establece en On, estos otros modos de grabación se 
establecen de forma forzada en Off.

Grabación de un proxy

Presione el botón START/STOP de grabación 
para iniciar la grabación después de completar 
la configuración necesaria para el disparo.

[Notas]
ˎˎ Si la videocámara está apagada o si se extrae la 

tarjeta SD mientras se está accediendo a esta, no 
se podrá garantizar la integridad de los datos de la 
tarjeta. Es posible que se pierdan todos los datos 
grabados en la tarjeta. Asegúrese de que el indicador 
de acceso esté siempre apagado antes de apagar la 
videocámara o extraer la tarjeta SD.
ˎˎ Tenga cuidado para evitar que la tarjeta SD se caiga al 

introducirla o extraerla.

Para salir, detenga la grabación.
Una vez se haya detenido la grabación en una 
tarjeta de memoria XQD, la grabación de datos 
proxy también se detendrá.

Cambio en los ajustes de 
grabación de proxy

Ajuste del tamaño de la imagen

Seleccione Proxy Rec >Proxy Format 
(página 90) en el menú Project y establezca 
el tamaño de imagen.

Ajuste del canal de audio

Seleccione Proxy Rec >Audio Channel 
(página 90), en el menú Project, y configure 
el canal de imagen para la grabación de datos 
proxy.

Acerca del archivo grabado

La extensión del nombre del archivo es “.mp4”.
El código de tiempo también se graba 
simultáneamente.

Destino del almacenamiento del 
archivo grabado

El archivo grabado se almacenará en el 
directorio “/PRIVATE/PXROOT/Clip”.

Acerca del nombre del archivo

El nombre de archivo consiste en el nombre 
del archivo grabado en la tarjeta de memoria 
XQD y un sufijo numérico consecutivo.
En el modo 2-slot Simul Rec, el nombre del 
clip de la ranura A tiene prioridad.
El número consecutivo se mantiene, aunque 
se apague la videocámara. El número 
consecutivo regresa al 0001 al ejecutar All 
Reset.
Para más detalles sobres los nombres de clips, 
consulte Clip Name Format (página 99), en 
el menú TC/Media.

Grabación de proxy
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Puede grabar la señal de vídeo RAW 
emitida desde el conector RAW OUT de un 
módulo XDCA-FX9 (opcional) acoplado a la 
videocámara en una grabadora externa.

1	 Conecte una grabadora RAW externa al 
conector RAW OUT de la XDCA-FX9 
acoplada a la videocámara.

2	 Ajuste Base Setting >Shooting Mode* en 
el menú Project en Cine EI.

3	 Ajuste el códec en RAW usando Rec 
Format >Codec* en el menú Project.
Si selecciona RAW & XAVC-I, se grabará 
simultáneamente vídeo RAW en la 
grabadora RAW externa y vídeo HD en las 
tarjetas de memoria XQD de la 
videocámara.

4	 Seleccione la resolución y el modo de 
escaneo usando Rec Format >Imager Scan 
Mode* en el menú Project.

5	 Compruebe que la grabadora externa esté 
encendida y, a continuación, pulse el 
botón START/STOP de grabación en la 
videocámara. 

	 [Nota]
Cuando se inicia la grabación en una grabadora 
externa, sin usar el botón de grabación de la 
videocámara, es posible que los clips no se graben 
correctamente.

[Consejo]
Las funciones marcadas con un asterisco (*) también se 
pueden configurar en la pantalla de estado.

A continuación, se muestran los formatos de 
salida RAW compatibles.

Project >Rec Format

Frequency Codec Imager 
Scan 
Mode

RAW 
Output 
Format

59.94/50 RAW FFcrop 5K 4096×2160

S35 4K 4096×2160/ 
3840×2160

FF 2K/ 
S35 2K

2048×1080

RAW & 
XAVC-I/
RAW & 
XAVC-L/
RAW & 
MPEG 
HD 422

FFcrop 5K/ 
S35 4K

4096×2160

FF 2K/ 
S35 2K 

2048×1080

29.97/25/ 
23.98

RAW FF 6K/
FFcrop 5K

4096×2160

S35 4K 4096×2160/ 
3840×2160

FF 2K/ 
S35 2K

2048×1080

RAW & 
XAVC-I/
RAW & 
XAVC-L/
RAW & 
MPEG 
HD 422

FF 6K/
FFcrop 5K/ 
S35 4K

4096×2160

FF 2K/ 
S35 2K

2048×1080

24 RAW FF 6K/
FFcrop 5K/ 
S35 4K

4096×2160

Pantalla de estado de control de la 
grabación

Si Display On/Off (página 101) >RAW Output 
Control Status en el menú Monitoring se ajusta 
en On, se mostrará el estado de control de la 
grabación RAW en el visor mediante un icono.

[Nota]
La señal de control de grabación se emite desde el 
conector RAW OUT de la videocámara, pero no es 
posible obtener el estado de la grabadora externa. Por lo 
tanto, es posible que la videocámara indique que se está 
grabando vídeo RAW cuando en realidad la grabadora 
externa no está grabando. Compruebe el indicador 
en la grabadora externa para obtener el estado de 
funcionamiento correcto.

[Consejo]
También se muestra el valor de configuración de RAW 
Output Format.

Grabación Slow & Quick Motion

Si S&Q Motion >Setting en el menú Shooting 
se ajusta en On, se graba vídeo RAW en el 
modo Slow & Quick Motion.
Para obtener más información sobre las 
velocidades de fotogramas admitidas en la 
filmación, consulte la página 47.

Grabación de vídeo RAW
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Conexión a otros dispositivos a través de una LAN
La videocámara se puede conectar a 
smartphones, tablets y otros dispositivos a 
través de una conexión LAN.
El establecimiento de una conexión LAN entre 
un dispositivo y la videocámara le permite 
llevar a cabo lo siguiente mediante el control 
remoto web (página 66) o la aplicación 
“Content Browser Mobile”.
ˎˎ Metadatos de planificación (página 52) 
Envíe y reciba metadatos de planificación 
mediante un dispositivo y la videocámara.  
Puede enviar metadatos de planificación 
creados de antemano a la videocámara para 
especificar nombres de clip.
ˎˎ Funcionamiento remoto a través de una LAN 
Puede controlar la videocámara desde un 
smartphone, una tableta o un ordenador 
conectados a esta a través de una LAN.
ˎˎ Transferencia de archivos a través de una 
LAN 
Puede transferir un archivo de proxy (baja 
resolución) grabado en una tarjeta SD en 
la videocámara o el archivo original (alta 
resolución) que la videocámara graba para 
el servidor a través de una LAN.
ˎˎ Seguimiento de vídeo mediante una LAN 
Podrá crear una transmisión (H.264) a partir 
de la cámara o el vídeo de reproducción 
de la videocámara y seguir la transmisión 
mediante la aplicación “Content Browser 
Mobile” desde un dispositivo a través de 
una LAN.

Aplicación “Content Browser Mobile”

Puede controlar la videocámara de manera 
remota en la pantalla del dispositivo mientras 
monitoriza el vídeo de la videocámara y 
configurar los ajustes de la videocámara 
mediante la aplicación “Content Browser 
Mobile”.

Para obtener más información acerca de la aplicación 
“Content Browser Mobile”, póngase en contacto con el 
servicio de asistencia técnica o de ventas de Sony.

Transmisión en streaming de vídeo de 
alta calidad a través de la tecnología 
Sony QoS (página 64)

Puede transmitir vídeo de alta calidad en 
streaming mediante una estación RX de red 
de Sony (vendida por separado) o el XDCAM 
air* Connection Control Manager (CCM) 
conectado a la videocámara en el modo de 
cliente de red.
*	 XDCAM air es un servicio en la nube prestado por 

Sony.  
Para utilizar este servicio, es necesario registrarse.  
XDCAM air no está disponible en algunas regiones. 
Para obtener más información sobre las zonas en 
las que el servicio está disponible, visite el sitio web 
indicado a continuación.  
https://www.xdcam-air.com 
Además, consulte los siguientes sitios para conocer la 
política de privacidad de XDCAM air.
–– Términos de servicio 

https://www.xdcam-air.com/site/tos_eu.html
–– Política de privacidad de XDCAM air 

https://sony-imaging-products-solutions.co.jp/
pp/sips/en/index.html

–– Política de privacidad del ID profesional 
https://www.pro-id.sony.net/#/privacyPolicy

	 Si desea más información, póngase en contacto con 
un comercial de productos profesionales de Sony.

Establecimiento del nombre de 
usuario y la contraseña

Establezca el nombre de usuario y la 
contraseña de la videocámara para usar la 
función de red.

1	 Configure Access Authentication >User 
Name (página 111) en el menú Network.

2	 Configure Access Authentication 
>Password (página 111) en el menú 
Network.

Conexión con Wireless LAN Access 
Point Mode

La videocámara funciona como un punto de 
acceso y se conecta a un dispositivo a través 
de una red LAN inalámbrica.

Smartphone/
tablet

Ordenador

Conexión a un dispositivo compatible 
con NFC mediante un toque

Los dispositivos compatibles con NFC se 
pueden conectar (conexión con un toque) 
mediante NFC.

1	 Abra [Settings] en el dispositivo, 
seleccione [More] y marque la casilla de 
NFC.

2	 Encienda la videocámara.

3	 Active la función NFC.
Mantenga pulsado (durante 3 segundos) 
un botón asignable al que le haya 
asignado NFC o seleccione Wireless LAN 
>NFC, en el menú Network, para activar el 
modo de conexión NFC.
La función NFC se encuentra disponible 
cuando aparece  en la pantalla.

4	 Toque el camcorder con el dispositivo.
El dispositivo se conectará a la 
videocámara y se iniciará “Content 
Browser Mobile”.

	 [Notas]
ˎˎ Desactive previamente el modo de suspensión y 

el bloqueo de pantalla.
ˎˎ Toque sin soltar el dispositivo hasta que se inicie 

la aplicación “Content Browser Mobile” (1 o 2 
segundos).

https://www.xdcam-air.com
https://www.xdcam-air.com/site/tos_eu.html
https://sony-imaging-products-solutions.co.jp/pp/sips/en/index.html
https://sony-imaging-products-solutions.co.jp/pp/sips/en/index.html
https://www.pro-id.sony.net/#/privacyPolicy
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Conexión con un dispositivo compatible 
con WPS

Los dispositivos compatibles con WPS pueden 
conectarse mediante WPS.

1	 Seleccione Wireless LAN >Setting >Access 
Point Mode en el menú Network.

2	 Seleccione Wireless LAN >WPS >Execute 
en el menú Network.

3	 Abra Network Settings o Wi-Fi Settings en 
el dispositivo y active el Wi-Fi.

4	 Seleccione el SSID de la videocámara en la 
lista de SSID de Wi-Fi Network en el 
dispositivo y, a continuación, seleccione el 
pulsador WPS en Option, en el dispositivo, 
para conectarlo.

	 [Notas]
ˎˎ El método de funcionamiento varía en función 

del dispositivo.
ˎˎ Para obtener información acerca del SSID y la 

contraseña de la videocámara, consulte AP Mode 
Settings >Camera SSID & Password (página 111) 
en el menú Network.

5	 Visualización del control remoto web 
(página 66). O conexión con la 
aplicación Content Browser Mobile.

Conexión mediante la introducción de 
un SSID y una contraseña en un 
dispositivo

Puede conectar la videocámara a un 
dispositivo mediante la introducción de un 
SSID y una contraseña en un dispositivo.

1	 Seleccione Wireless LAN >Setting >Access 
Point Mode en el menú Network.

2	 Abra Network Settings o Wi-Fi Settings en 
el dispositivo y active el Wi-Fi.

3	 Conecte el dispositivo a la videocámara 
seleccionando el SSID de la videocámara 
en la lista de SSID de Wi-Fi Network e 
introduciendo la contraseña.
Para obtener información acerca del SSID 
y la contraseña de la videocámara, 
consulte AP Mode Settings >Camera SSID 
& Password (página 111) en el menú 
Network.

	 [Nota]
El método de funcionamiento varía en función del 
dispositivo.

4	 Visualización del control remoto web 
(página 66). O conexión con la 
aplicación Content Browser Mobile.

Conexión del modo de estación de 
LAN inalámbrica

La videocámara se conecta a un punto de 
acceso existente de la red LAN inalámbrica 
como cliente. La videocámara y el dispositivo 
se conectan a través del punto de acceso.
Los 10 puntos de acceso conectados más 
recientemente se mostrarán en el historial.
El historial de conexión se guarda en un 
archivo ALL, pero no se guardarán las 
contraseñas de acceso. Es obligatorio 
introducir la contraseña la próxima vez que se 
conecte después de cargar el archivo ALL.

Smartphone/
tablet

Punto de 
acceso

Ordenador

Conexión a un punto de acceso a través 
de WPS

Si el punto de acceso es compatible con la 
función WPS, puede conectarse al punto de 
acceso mediante ajustes sencillos.

1	 Active el punto de acceso.

2	 Encienda la videocámara.

3	 Seleccione Wireless LAN >Setting >Station 
Mode en el menú Network.

4	 Seleccione Wireless LAN >WPS >Execute 
en el menú Network.

5	 Pulse el botón WPS del punto de acceso.
Para obtener más información acerca de 
cómo utilizar el botón WPS, consulte las 
instrucciones de funcionamiento del 
punto de acceso.
Cuando la conexión se realiza 
correctamente, el icono indicador del 
estado de red mostrará una fuera de 1 o 
superior en la pantalla del visor.

	 [Nota]
En caso de que falle la conexión, vuelva a llevar a 
cabo los pasos a partir del 1.

6	 Conecte el dispositivo al punto de acceso.
Para obtener más información acerca de 
la conexión, consulte las instrucciones de 
funcionamiento del dispositivo.

7	 Visualización del control remoto web 
(página 66). O conexión con la 
aplicación Content Browser Mobile.
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Conexión a un punto de acceso 
mediante la detección automática de 
red o manualmente

Puede configurar la conexión a un punto 
de acceso deseado desde el menú de 
configuración.
Puede configurar la conexión a un punto de 
acceso deseado a través de la función de 
detección automática de red.

Conexión mediante la función de detección 
automática de red

1	 Siga los pasos de 1 a 3 en “Conexión a un 
punto de acceso a través de WPS” 
(página 57).

2	 Seleccione ST Mode Settings >Scan 
Networks (página 112) >Execute en el 
menú Network.
La videocámara comienza a detectar los 
destinos de conexión.
Los posibles destinos encontrados se 
muestran en una lista.

3	 Seleccione un destino de entre las 
opciones de la lista.
Aparecerá la pantalla de detalles de la red 
(punto de acceso). La conexión 
seleccionada se muestra en SSID.

4	 Seleccione Password y defina la 
contraseña en la pantalla de introducción 
de contraseña.
La selección de un SSID en el historial de 
conexiones configura automáticamente 
los ajustes, incluida la contraseña.
Establezca la contraseña para volver a la 
pantalla de detalles de red (punto de 
acceso).

5	 Configure los siguientes ajustes de 
conexión.
ˎˎ DHCP 
Establezca el ajuste DHCP.  
Cuando establezca el ajuste en On, la 
dirección IP se asignará a la videocámara 
automáticamente.  
Para asignar la dirección IP a la 
videocámara manualmente, establezca 
el ajuste Off.
ˎˎ IP Address 
Introduzca la dirección IP de la unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ Subnet Mask 
Introduzca la máscara de subred de la 
unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ Gateway 
Introduzca la puerta de enlace del punto 
de acceso.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ DNS Auto 
Establece si adquirir DNS 
automáticamente.  
Cuando se establece en On, se adquiere 
automáticamente la dirección del 
servidor DNS. Este ajuste está disponible 
únicamente si DHCP está ajustado en 
On.
ˎˎ Primary DNS Server 
Introduzca el servidor DNS principal del 
punto de acceso.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.
ˎˎ Secondary DNS Server 
Introduzca el servidor DNS secundario 
del punto de acceso.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.

6	 Cuando haya terminado, seleccione 
Connect para conectarse al punto de 
acceso.

Conexión manual

1	 Siga los pasos de 1 a 3 en “Conexión a un 
punto de acceso a través de WPS” 
(página 57).

2	 Seleccione ST Mode Settings >Manual 
Register (página 112) >Execute en el 
menú Network.
Aparecerá la pantalla de detalles de la red 
(punto de acceso) de forma momentánea.

3	 Configure los siguientes ajustes de 
conexión.
ˎˎ SSID 
Introduzca el SSID del punto de acceso.
ˎˎ Security 
Seleccione el método de cifrado.
ˎˎ Password 
Introduzca la contraseña del punto de 
acceso.
ˎˎ DHCP 
Establezca el ajuste DHCP.  
Cuando establezca el ajuste en On, la 
dirección IP se asignará a la videocámara 
automáticamente.  
Para asignar la dirección IP a la 
videocámara manualmente, establezca 
el ajuste Off.
ˎˎ IP Address 
Introduzca la dirección IP de la unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ Subnet Mask 
Introduzca la máscara de subred de la 
unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.

ˎˎ Gateway 
Introduzca la dirección de la puerta de 
enlace.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ DNS Auto 
Establece si adquirir DNS 
automáticamente.  
Cuando se establece en On, se adquiere 
automáticamente la dirección del 
servidor DNS. Este ajuste está disponible 
únicamente si DHCP está ajustado en 
On.
ˎˎ Primary DNS Server 
Indique la dirección del servidor DNS 
principal.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.
ˎˎ Secondary DNS Server 
Indique la dirección del servidor DNS 
secundario.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.

4	 Cuando haya terminado, seleccione 
Connect para conectarse al punto de 
acceso.

Conexión a un dispositivo a través 
de un cable LAN

Puede conectarse a un dispositivo si conecta 
el conector LAN con cable de la XDCA-FX9 
(página 25) acoplada a la videocámara a un 
interruptor LAN con un cable LAN.
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Ordenador

Interruptor LAN

Conexiones de cable LAN y ajustes del 
LAN con cable

1	 Conecte el LAN con cable de la XDCA-FX9 
a un interruptor LAN mediante un cable 
LAN.

2	 Encienda la videocámara.

3	 Ajuste Wired LAN >Setting (página 113) 
en el menú Network en On.

4	 Configure los ajustes de conexión usando 
Wired LAN >Detail Settings (página 113) 
en el menú Network.
ˎˎ DHCP 
Establezca el ajuste DHCP.  
Cuando establezca el ajuste en On, la 
dirección IP se asignará a la videocámara 
automáticamente.  

Para asignar la dirección IP a la 
videocámara manualmente, establezca 
el ajuste Off.
ˎˎ IP Address 
Introduzca la dirección IP de la unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ Subnet Mask 
Introduzca la máscara de subred de la 
unidad.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ Gateway 
Introduzca la dirección de la puerta de 
enlace.  
Este ajuste está disponible únicamente 
si DHCP está ajustado en Off.
ˎˎ DNS Auto 
Establece si adquirir DNS 
automáticamente.  
Cuando se establece en On, se adquiere 
automáticamente la dirección del 
servidor DNS. Este ajuste está disponible 
únicamente si DHCP está ajustado en 
On.
ˎˎ Primary DNS Server 
Indique la dirección del servidor DNS 
principal.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.
ˎˎ Secondary DNS Server 
Indique la dirección del servidor DNS 
secundario.  
Este ajuste está disponible únicamente 
si DNS Auto está ajustado en Off.

5	 Cuando haya terminado, seleccione Set 
para aplicar los ajustes.

[Nota]
Seleccione siempre Set tras cambiar los ajustes de 
conexión. No se aplicarán los ajustes si no se selecciona 
Set.
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Puede conectar la videocámara a Internet 
mediante un módem, LAN con cable o LAN 
inalámbrica.

Conexión a través de un módem

Puede conectar la videocámara a Internet 
a través de una red 3G/4G conectando una 
XDCA-FX9 (página 25) a la videocámara y 
un módem opcional a la XDCA-FX9.
Si conecta y usa más de un módem al mismo 
tiempo, se permite la transmisión de alta 
calidad en el modo de cliente de red, usando 
dos líneas para una transmisión de mayor 
calidad y redundancia de dispositivos.
Para obtener más información sobre 
los módems compatibles, póngase en 
contacto con su distribuidor Sony o con un 
representante del servicio técnico de Sony.

[Nota]
El módem no puede utilizarse simultáneamente como 
LAN con cable.

Acople de una XDCA-FX9 a la unidad

Conecte un módem que admita el estándar 
USB al conector USB (Tipo A) del módulo 
XDCA-FX9. Pueden utilizarse dos módems 
al mismo tiempo conectándolos a ambos 
conectores.

[Nota]
Instale/retire el módem con la videocámara apagada.

Conexión a una red

1	 Encienda la videocámara.

2	 Ajuste Modem >Setting en el menú 
Network en On.

	 [Nota]
Es posible que tarde un poco (aproximadamente 
1 minuto) en conectarse a una red 3G/4G. Espere 
hasta que el icono indicador del estado de red 
(página 11) del módem muestre una intensidad 
de 1 o superior en la pantalla del visor.

Conexión mediante anclaje USB

Puede conectar un smartphone mediante un 
cable USB a un módulo XDCA-FX9 acoplado a 
la videocámara y, a continuación, conectarse a 
Internet a través del smartphone.

Acople de un smartphone a la 
videocámara

Conecte un smartphone mediante un cable 
USB al conector USB (Tipo A) (página 4) 
de un módulo XDCA-FX9 acoplado a la 
videocámara.

[Notas]
ˎˎ 	Acople o retire el smartphone con la videocámara 

apagada.
ˎˎ 	El anclaje USB no se puede utilizar si el smartphone 

se conecta mediante un concentrador USB.

Conexión a una red

1	 Encienda la videocámara.

2	 Ajuste Modem >Setting en el menú 
Network en On.

Conexión del modo de estación de 
LAN inalámbrica

Puede conectar la videocámara a Internet 
en el modo de estación Wi-Fi a través de 
un router de LAN inalámbrica opcional o 
mediante el anclaje a la red a un dispositivo.

Smartphone/
tablet

Router de LAN 
inalámbrica

Ordenador

Internet

Smartphone/
tablet

Internet

Conéctese al router de LAN inalámbrica o 
dispositivo, tal como se describe en “Conexión 
del modo de estación de LAN inalámbrica” 
(página 57).

Conexión a Internet



4. Funciones de red: Conexión a Internet61

Conexión con un cable LAN

Puede conectarse a un dispositivo si conecta 
el conector LAN con cable de la XDCA-FX9 
(página 25) acoplada a la videocámara a un 
router de Internet con un cable LAN.

Ordenador

Router

Internet

Conéctese al router, tal como se describe en 
“Conexión a un dispositivo a través de un 
cable LAN” (página 58).
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Carga de archivos
Puede cargar un archivo proxy o un 
archivo original que se haya grabado en la 
videocámara a un servidor de Internet o a un 
servidor en una red local, a través una red 
3G/4G o un punto de acceso.

[Nota]
Cuando se abre la cubierta de la ranura de soportes, 
se interrumpe la transferencia de archivos a través de 
la red. Los archivos no se pueden transferir mientras 
la cubierta está abierta. La transferencia se reanuda 
cuando se cierra la cubierta.

Preparación

Conexión a una red

Conecte la videocámara a Internet o a la 
red local siguiendo el procedimiento que se 
detalla en “Conexión a Internet” (página 60) 
o “Conexión a otros dispositivos a través de 
una LAN” (página 56).

Registro de un destino de transferencia 
de archivo

Registre el servidor para la carga de 
antemano.

1	 Seleccione File Transfer >Server Settings1 
(o Server Settings2, Server Settings3) en el 
menú Network.
Aparecerá la pantalla de configuración de 
destino de la transferencia.

2	 Configure cada elemento de la pantalla 
de configuración de destino de la 
transferencia.
Display Name
Introduzca el nombre del servidor que 
desea visualizar en la lista de destino de 
la transferencia.

Service
Muestra el tipo de servidor.
“FTP”: servidor FTP
Host Name
Introduzca la dirección del servidor.
Port
Introduzca el nombre del servidor para 
conectarse.
User Name
Introduzca el nombre del usuario.
Password
Introduzca la contraseña.
Passive Mode
Active y desactive el modo pasivo.
Destination Directory
Introduzca el nombre del directorio en el 
servidor de destino.

	 [Notas]
ˎˎ Al editar, “” indica los caracteres que no 

podrán cambiarse. No se garantiza el correcto 
funcionamiento al editar un nombre de directorio 
que contenga estos caracteres.  
Si necesita realizar la edición, elimine todos los 
caracteres y vuelva a introducir un valor.
ˎˎ Si se introducen caracteres en el directorio de 

destino no válidos en el servidor de destino, los 
archivos se transferirán al directorio de inicio 
del usuario. Los caracteres no válidos variarán 
dependiendo del servidor.

Using Secure Protocol
Ajuste si desea llevar a cabo la carga a 
través de FTP segura.
Root Certificate
Cargue/borre un certificado.
ˎˎ Load 
Seleccione Set en el paso 3 para 
importar un certificado de CA.

*	 El certificado debe estar en formato PEM y 
debería grabarse en el directorio raíz de la tarjeta 
Utility SD con el nombre de archivo “certification.
pem”.

ˎˎ Clear 
Seleccione Set en el paso 3 y borre un 
certificado de CA.
ˎˎ None 
No cargue ni borre ningún certificado.

	 [Notas]
ˎˎ Ajuste el reloj de la videocámara a la hora 

correcta antes de importar un certificado CA.
ˎˎ Al grabar en XAVC-I 3840×2160P 59.94/50P, no se 

puede seleccionar Load.
ˎˎ En el estado de baja tensión, Load/Clear no 

podrán seleccionarse para un certificado de CA.

Root Certificate Status
Muestra el estado de carga del certificado.
Reset
Restablezca los ajustes predeterminados 
de Server Settings.

3	 Cuando haya terminado, seleccione Set 
para aplicar los ajustes.
Seleccione siempre Set tras cambiar los 
ajustes. No se aplicarán los ajustes si no 
se selecciona Set.

También puede registrar un servidor con el 
control remoto web “Registro de un servidor 
de destino” (página 67).

Selección de un archivo y carga

Cargue al servidor un archivo grabado en una 
tarjeta SD o un archivo original grabado en 
una tarjeta de memoria XQD.
Los archivos también se pueden cargar 
mediante un control remoto web. Para 
obtener más detalles, consulte “Transferencia 
de archivos (Slot A, Slot B, Slot SD/MS)” 
(página 68).

Carga de un archivo de proxy en una 
tarjeta SD desde la pantalla de 
imágenes en miniatura

1	 Conecte la videocámara y el dispositivo 
mediante una conexión de LAN 
(página 56).

2	 Seleccione Transfer Clip (Proxy) >Select 
Clip en el menú Thumbnail.
La pantalla cambia del menú de 
configuración a la pantalla de imágenes 
en miniatura.
Los clips se pueden transferir desde la 
pantalla de imágenes en miniatura o la 
pantalla de imágenes en miniatura de 
clips filtrados.

3	 Seleccione el clip que desea transferir y, a 
continuación, pulse el botón MENU.
Aparece una pantalla de confirmación de 
transferencia.

4	 Seleccione Execute.
El archivo proxy correspondiente al 
archivo seleccionado se registra como 
trabajo de transferencia y comienza la 
carga.
Cuando el trabajo de transferencia se 
registra correctamente, aparece la 
pantalla de resultados de la transferencia.

5	 Seleccione OK.

Para cargar todos los archivos
Seleccione All Clips en lugar de Select Clip en 
el paso 2 para transferir los archivos de proxy 
correspondientes a todos los archivos.

[Nota]
Se pueden transferir hasta 200 archivos.

Carga de un archivo original en una 
tarjeta XQD desde la pantalla de 
imágenes en miniatura

1	 Conecte la videocámara y el dispositivo 
mediante una conexión de LAN 
(página 56).
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2	 Seleccione Transfer Clip >Select Clip en el 
menú Thumbnail.
La pantalla cambia del menú de 
configuración a la pantalla de imágenes 
en miniatura.
Los clips se pueden transferir desde la 
pantalla de imágenes en miniatura o la 
pantalla de imágenes en miniatura de 
clips filtrados.

3	 Seleccione el clip que desea transferir y, a 
continuación, pulse el botón MENU.
Aparece una pantalla de confirmación de 
transferencia.

4	 Seleccione Execute.
El archivo seleccionado se registra como 
trabajo de transferencia y comienza la 
carga.
Cuando el trabajo de transferencia se 
registra correctamente, aparece la 
pantalla de resultados de la transferencia.

5	 Seleccione OK.

Para cargar todos los archivos
Seleccione All Clips en lugar de Select Clip en 
el paso 2 para transferir todos los archivos.

[Nota]
Se pueden transferir hasta 200 archivos.

Comprobación de la transferencia de 
archivos

Puede verificar el estado de la transferencia de 
archivos seleccionando File Transfer >View Job 
List (página 114) en el menú Network.
Puede comprobar el estado de la carga en la 
pantalla “Job List” que aparece al seleccionar 
Job List. en las pantallas SD Card, Slot A o Slot 
B (página 68).

[Consejos]
ˎˎ También puede verificar el estado de la transferencia 

de archivos desde la pantalla de control remoto web.
ˎˎ Si se ajusta File Transfer >Auto Upload (Proxy), en el 

menú Network, en On y existe una conexión de red, 
los archivos de proxy se cargarán automáticamente 
en el servidor especificado mediante Default Upload 
Server cuando acabe la grabación. Para obtener más 
detalles, consulte “Carga de un archivo de proxy 
automáticamente” (página 68).

[Notas]
ˎˎ Se pueden registrar hasta 200 trabajos de 

transferencia.
ˎˎ La lista de trabajos se conserva cuando la 

videocámara se apaga, pero es posible que se 
pierdan hasta 10 minutos de la información de 
progreso reciente si se extrae la batería o se apaga la 
videocámara sin ajustar primero el interruptor POWER 
en STANDBY.
ˎˎ Los trabajos añadidos después del estado de baja 

tensión de la batería no se guardan en la lista de 
trabajos.
ˎˎ Si se produce un error durante la transferencia de 

archivos, no se reanudará la transferencia de un 
clip con el mismo nombre que un clip transferido 
dependiendo de la configuración y el estado del 
servidor de destino de la transferencia. En este caso, 
compruebe la configuración y el estado del servidor 
de destino de la transferencia.

Carga a través de FTP segura

Puede cargar archivos cifrados mediante FTPS 
en el modo Explicit (FTPES) para conectarse 
con el servidor de archivos de destino.

Configuración de la transferencia de FTP 
segura

Para una transferencia de FTP segura, ajuste 
Using Secure Protocol, en el servidor de 
archivos de destino, en ON e importe un 
certificado.
Para obtener más detalles acerca de 
la configuración, consulte “Registro de 
un destino de transferencia de archivo” 
(página 62).
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La transmisión de alta calidad es posible al 
habilitar el modo de cliente de red y conectar 
una estación RX de red de Sony (opcional) 
como Connection Control Manager (CCM) o al 
conectarse a través de XDCAM air.

Configuración de la conexión del 
modo Cliente en red

Se pueden configurar hasta tres conexiones 
del modo Cliente en red como NCM Settings.

1	 Seleccione Network Client Mode >NCM 
Settings1 (o NCM Settings2, NCM 
Settings3) en el menú Network.
Aparecerá la pantalla de configuración de 
destino de conexión del modo Cliente en 
red.

2	 Configure cada elemento de la pantalla 
de configuración de destino de conexión.
Display Name
Establece el nombre para mostrar que 
aparece en el menú NCM Settings.
CCM Address
Introduzca la dirección del CCM para 
conectarse (nombre del host o dirección 
IP).
CCM Port
Introduzca el nombre del puerto del CCM 
para conectarse.
User Name
Introduzca el nombre del usuario.
Password
Introduzca la contraseña.
CCM Certificate
Se requiere un certificado raíz CCM para 
conectarse a un CCM o al XDCAM air. La 
videocámara contiene un certificado CCM 
raíz incorporado, que también se puede 
actualizar. Para actualizar el certificado 
raíz CCM, guarde el certificado en una 

tarjeta de memoria y, a continuación, 
importe el certificado desde la tarjeta de 
memoria.
ˎˎ Load 
Seleccione Set en el paso 3 para 
importar un certificado.

*	 El certificado debe estar en formato PEM y 
debería grabarse en el directorio raíz de la tarjeta 
SD con el nombre de archivo “CCM_certification.
pem”.

ˎˎ Clear 
Seleccione Set en el paso 3 para borrar 
un certificado.
ˎˎ None 
No cargue ni borre ningún certificado.

	 [Notas]
ˎˎ Ajuste el reloj de la videocámara a la hora 

correcta antes de cargar los certificados de 
conexión CCM y XDCAM air.
ˎˎ Al grabar en XAVC-I 3840×2160P 59.94/50P o 

XAVC-I 4096×2160P 59.94/50P, no se puede 
seleccionar Load.
ˎˎ En el estado de tensión baja, los certificados de 

conexión CCM y XDCAM air no pueden cargarse 
ni borrarse.

CCM Certificate Status
Muestra el estado de carga del certificado.
Camera Control
Active/desactive el control de la cámara 
cuando se conecta con un CCM.
Camera Setting
Active/desactive las operaciones de 
archivos ALL cuando se conecta con un 
CCM.
Reset
Restablezca los ajustes predeterminados 
de NCM Settings.

3	 Cuando haya terminado, seleccione Set 
para aplicar los ajustes.
Seleccione siempre Set tras cambiar los 
ajustes. No se aplicarán los ajustes si no 
se selecciona Set.

4	 Seleccione Network Client Mode >NCM 
Settings Select en el menú Network y, a 
continuación, seleccione la configuración 
de NCM (NCM Settings1, NCM Settings2, 
NCM Settings3) especificada en los pasos 
del 1 a 3.

Establecimiento de la calidad de 
transmisión

Ajuste Network Client Mode >Streaming 
Quality (página 114) en el menú Network en 
High para realizar una transmisión de calidad 
alta. Establezca Streaming Quality en Normal 
para realizar una transmisión de calidad 
media.

[Notas]
ˎˎ Streaming Quality no puede establecerse en High en 

los siguientes casos.
–– Cuando Proxy Rec >Setting (página 90) en el 

menú Project está fijado en On
–– Cuando 4K & HD (Sub) Rec >Setting (página 90) 

en el menú Project está fijado en On
–– Cuando Focus >Face/Eye Detection AF 

(página 86) en el menú Shooting no está 
ajustado en Off

ˎˎ Cuando Network Client Mode >Setting (página 114) 
en el menú Network está ajustado en On, Streaming 
Quality no puede modificarse.

Conexión en el modo Cliente en 
red

1	 Conecte la videocámara a Internet, tal 
como se describe en “Conexión a Internet” 
(página 60).

2	 Ajuste Network Client Mode >Setting en el 
menú Network en On.

El modo Cliente en red se activará y la 
videocámara se conectará a la estación RX 
de red o XDCAM air.
La transmisión de secuencias en directo 
comenzará en respuesta al 
funcionamiento de la estación RX de red. 
Para obtener más información sobre el 
funcionamiento, consulte el manual de 
instrucciones de la estación RX de red o la 
ayuda en línea de XDCAM air.
También puede ajustar Setting en On u 
Off si pulsa un botón asignable 
(página 46) al que haya asignado 
Network Client Mode.

[Notas]
ˎˎ La transmisión no comenzará con los siguientes 

ajustes.
–– Cuando S&Q Motion >Setting en el menú Shooting 

está On
–– Cuando Interval Rec >Setting en el menú Project 

está On
–– Cuando Simul Rec >Setting en el menú Project está 

On
ˎˎ Después de cambiar al modo de cliente de red, la 

supervisión de (página 67) no está disponible.
ˎˎ Si cambia al modo Cliente en red durante el 

seguimiento, este se detendrá.
ˎˎ No se pueden transferir archivos durante la 

transmisión en el modo Cliente en red. Puede 
transferir archivos tras detener la transmisión.
ˎˎ Si la transmisión en el modo Cliente en red comienza 

durante la transferencia de archivos, la transferencia 
de archivos se detendrá. La transferencia de archivos 
se reanudará tras detener la transmisión.
ˎˎ User Name, Password y los certificados no están 

guardados en un archivo ALL, por los que deberán 
configurarse de nuevo tras cargar un archivo ALL.
ˎˎ Si Setting se establece en Off mientras se transmite 

en el modo Cliente en red, la transmisión se detiene.
ˎˎ Cuando se transmite en modo de cliente de red, no se 

puede cambiar NCM Settings Select y la configuración 
de NCM Settings usando NCM Settings Select.
ˎˎ Durante la transmisión, la frecuencia de actualización 

de la información de la pantalla se ve reducida, pero 
esto no afecta al funcionamiento.
ˎˎ Los ajustes de grabación no se pueden cambiar 

durante la transmisión en el modo Cliente en red.
ˎˎ Los ajustes de la LAN con cable no se pueden 

modificar durante la transmisión en el modo de 
cliente en red.

Uso del modo de cliente de red
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ˎˎ La imagen puede detenerse temporalmente al 
cambiar a la ventana de miniatura o la ventana de 
reproducción durante la transmisión QoS.
ˎˎ Los formatos de distribución disponibles para la 

transmisión varían en función del ajuste Rec Format 
de la videocámara.

Transferencia de archivos en el 
modo Cliente en red

Puede transferir archivos a un servidor 
establecido por el CCM si conecta tanto una 
estación RX de red que actúe como CCM y 
como la videocámara en el modo Cliente en 
red.

1	 Seleccione el archivo que desea cargar en 
el CCM u otra fuente.
ˎˎ Para transferir un archivo de proxy 
Siga los pasos del 1 al 4 en “Carga de 
un archivo de proxy en una tarjeta SD” 
(página 68).
ˎˎ Para transferir un archivo original 
Siga los pasos del 1 al 4 en “Carga de 
un archivo original en una tarjeta de 
memoria XQD” (página 68).

[Nota]
También puede establecer el destino a “NCM: RX 
Server” cuando no esté en el modo Cliente en red. En 
ese caso, la transferencia permanecerá en espera y, 
a continuación, comenzará la transmisión al servidor 
especificado en el CCM tras conectarse al CCM en el 
modo Cliente en red.
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Uso del control remoto web
Puede acceder al control remoto web 
integrado en la videocámara desde una 
tableta o un ordenador con una conexión de 
red.
El control remoto web le permite utilizar 
la videocámara de forma remota. Puede 
iniciar/detener la grabación y establecer los 
ajustes de grabación mediante un dispositivo 
conectado. Esta función resulta útil para 
colocar la videocámara en un lugar remoto, 
como en la parte superior de una grúa, etc.

Pantalla Camera Control

Pantalla Main

ˎˎ Pantalla de estado
ˎˎ Botón Iniciar/Detener grabación
ˎˎ Control deslizante del filtro ND
ˎˎ Control deslizante Iris
ˎˎ Control deslizante Focus
ˎˎ Control deslizante Zoom
ˎˎ Ajustes de disparo (modo de disparo SDR o 
HDR (página 27)) 
S&Q Frame Rate, Shutter, Color Temp/Tint, 
Gain, Gamma, Shutter Category, White 
Mode, Base Sensitivity, Auto ND Filter, Auto 

Iris, AGC, Color Bars, Focus Mode, Auto 
White
ˎˎ Ajustes de disparo (modo de disparo Cine 
EI) 
S&Q Frame Rate, Shutter, Color Temp/Tint, 
Exposure Index, Color Gamut/Gamma, 
Shutter Category, White Mode, Base ISO, 
Auto ND Filter, Auto Iris, AGC, Color Bars, 
Focus Mode, Monitor LUT, Auto White

Pantalla Playback

ˎˎ Pantalla de estado
ˎˎ Botones de funcionamiento de reproducción 
F Rev, Play/Pause, F Fwd, Prev, Stop, Next

Pantalla Cursor

ˎˎ Pantalla de estado
ˎˎ Botones de control del cursor, menú/
pantalla de estado 
Arriba, izquierda, Set, derecha, abajo, 

Cancel/Back, Menu, User Menu, Thumbnail, 
Status

Pantalla Assign

ˎˎ Pantalla de estado
ˎˎ Visualización de los botones asignables 
Botones asignables de 1 a 10, botón Focus 
Hold

Visualización del control remoto 
web

1	 Conecte la videocámara y el dispositivo 
mediante una conexión de red 
(página 56).

2	 Ejecute un navegador en el dispositivo y, 
a continuación, acceda a “http://dirección 
IP de la videocámara/rm.html.”
Por ejemplo, si la dirección IP es 
192.168.122.1, introduzca 
“http://192.168.122.1/rm.html” en la barra 
de direcciones.
Puede comprobar la dirección IP de la 
videocámara en la pantalla de estado de 
red (página 16).

3	 Introduzca el nombre de usuario y la 
contraseña (Access Authentication >User 
Name y Password en el menú Network).

Cuando la conexión se realiza 
correctamente, en el dispositivo aparecerá 
la pantalla de control remoto web.
Puede utilizar la pantalla Wi-Fi Remote 
para controlar el camcorder.
Los botones dejan de estar disponibles 
cuando el interruptor Lock se arrastra 
hacia la derecha.

[Notas]
ˎˎ Es posible que la pantalla de control remoto no 

coincida con los ajustes de la videocámara en las 
siguientes circunstancias. Si esto ocurre, vuelva a 
cargar la ventana del navegador.
–– Si el camcorder se reinicia mientras está conectado
–– Si el camcorder se utiliza directamente mientras 

está conectado
–– Si el dispositivo se ha reconectado
–– Si se han utilizado los botones de Adelante/Atrás 

del navegador
ˎˎ Es posible que el control remoto web no funcione si la 

señal inalámbrica es débil.

Dispositivos compatibles con el 
control remoto web

Puede utilizar una tableta u ordenador para 
configurar y utilizar la videocámara.
En la siguiente se indican los dispositivos, 
sistemas operativos y navegadores 
compatibles.

Dispositivo SO Navegador

Tablet Android 7/8 Chrome

iOS 12 Safari

Ordenador Windows 
7/8.1/10

Chrome

macOS 
10.13/10.14

Safari

Para obtener más información acerca de los 
dispositivos compatibles con la aplicación 
“Content Browser Mobile”, póngase en 
contacto con el servicio de asistencia técnica o 
de ventas de Sony.

http://dirección IP de la videocámara/rm.html
http://dirección IP de la videocámara/rm.html
http://192.168.122.1/rm.html
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Menú Web Remote Control

Si pulsa  en la esquina superior izquierda de 
la pantalla, aparecerá el menú de selección de 
pantalla. Seleccione Monitoring Settings para 
mostrar la pantalla Monitoring Settings.
Si pulsa  en la esquina superior izquierda de 
la pantalla Monitoring Settings, aparecerá el 
menú de configuración de las tareas, como la 
transferencia de archivos.

Elementos de menú
ˎˎ Remote Control 
Camera Control
ˎˎ Monitoring 
Monitoring Settings
ˎˎ File Transfer 
Slot A 
Slot B 
Slot SD/MS 
Job List 
Upload Settings

Ajustes de supervisión de vídeo 
(Monitoring Settings)

Puede ajustar el formato cuando supervise un 
dispositivo.

Size
Ajusta el tamaño de imagen y la velocidad de 
bits del vídeo que se está supervisando.
ˎˎ 480×270(1Mbps)

ˎˎ 480×270(0.5Mbps)

Frame Rate
Muestra la velocidad de fotogramas del vídeo 
que está supervisando.

Ajustes de transferencia de archivos 
(Upload Settings)

Puede cambiar los ajustes del servidor para 
cargar un archivo proxy o un archivo original 
que se encuentre grabado en la videocámara.

Registro de un servidor de destino
Seleccione un servidor en la lista Upload 
Server y pulse Edit para mostrar la pantalla de 
configuración de servidores. A continuación, 
configure todos los elementos en los que 
desea registrar un servidor.
También puede registrar un servidor mediante 
File Transfer (página 114), en el menú 
Network.
Los servidores que se configuren aquí 
aparecerán en la lista de transferencia de 
archivos, en las pantallas Slot A, Slot B y Slot 
SD/MS, al cargar un archivo.

Pantalla Upload Server Edit

Pulse OK para aplicar los cambios. Pulse 
Cancel para cancelar los cambios.
Service
Muestra el tipo de servidor.
“FTP”: servidor FTP
Display Name
Introduzca el nombre del servidor que desea 
visualizar en la lista.
Host Name
Introduzca la dirección del servidor.
Port
Introduzca el nombre del servidor para 
conectarse.
User Name
Introduzca el nombre del usuario.
Password
Introduzca la contraseña.

[Notas]
ˎˎ La contraseña se elimina cuando la pantalla Edit se 

abre por motivos de seguridad. Vuelva a introducirla 
si ha cambiado la configuración del servidor.
ˎˎ Desde el punto de vista de la seguridad, se 

recomienda que establezca una contraseña con una 
cadena de caracteres suficientemente larga que sea 
difícil de adivinar por otros, y que la guarde de forma 
segura.

Display Password
Muestra u oculta la contraseña.

Cuando se establece en Off, la contraseña 
configurada no se muestra. Cuando se 
introduce una contraseña, todos los caracteres 
se muestran como asteriscos.
Cuando se establece en On, se muestra la 
contraseña configurada. Cuando se introduce 
una contraseña, se muestran todos los 
caracteres.
Passive Mode
Active y desactive el modo pasivo.
Destination Directory
Introduzca el directorio en el servidor de 
destino.

[Nota]
Si se introducen caracteres no válidos en el directorio 
de destino, los archivos se transferirán al directorio de 
inicio del usuario. Los caracteres no válidos variarán 
dependiendo del servidor.

Using Secure Protocol
Ajuste si desea llevar a cabo la carga a través 
de FTP segura. Al ajustarlo en ON, aparecerá el 
estado del certificado.
Para importar o borrar un certificado, pulse 
Select Function y seleccione una tarea en el 
menú que aparece.
ˎˎ Load 
Cargue un certificado de CA.

*	 El certificado debe estar en formato PEM y 
debería grabarse en el directorio raíz de la tarjeta 
SD con el nombre de archivo “certification.pem”.

ˎˎ Clear 
Borre el certificado de CA.
ˎˎ None 
No cargue ni borre ningún certificado.

[Nota]
Ajuste el reloj de la videocámara a la hora correcta antes 
de importar un certificado CA.

Cambio de los ajustes del servidor registrados
Seleccione el servidor cuyos ajustes desee 
cambiar en la pantalla Upload Settings, 
a continuación, pulse Edit. Cambie la 
configuración según sea necesario en la 
pantalla mostrada.
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También puede ajustar un servidor mediante 
File Transfer (página 114), en el menú 
Network.

Carga de un archivo de proxy 
automáticamente
Auto Upload On/Off
Si Auto Upload On/Off está ajustado en “On” 
y la videocámara está conectada a Internet, 
la videocámara cargará automáticamente un 
archivo de proxy al destino de transferencia 
establecido mediante Default Upload Server 
después de la grabación.
Default Upload Server
Seleccione el servidor de transferencia de 
archivos de destino predeterminado.

Gestión de transferencia de archivos 
(File Transfer)

Puede transferir los archivos originales 
grabados en una tarjeta de memoria XQD o 
los archivos de proxy grabados en una tarjeta 
SD, gestionar la transferencia de archivos 
y configurar el destino de los archivos de 
transferencia.

Transferencia de archivos (Slot A, Slot B, Slot 
SD/MS)
Puede mostrar una lista de clips grabados en 
el soporte insertado en la ranura A o B, o bien 
una lista de archivos de proxy grabados en 
el soporte insertado en la ranura de tarjeta 
UTILITY SD/MS.

Puede cargar un archivo que esté visualizando 
en un servidor de Internet.

Carga de un archivo de proxy en una tarjeta 
SD

1	 Conecte la videocámara y el dispositivo 
mediante una conexión de LAN 
(página 56).

2	 Abra un navegador en el dispositivo y 
visualice el control remoto de la web 
(página 66).

3	 Abra la pantalla de la lista de archivos 
para seleccionar un archivo.
Pulse  >File Transfer >Slot SD/MS.
Aparecerá una pantalla con la lista de 
archivos del soporte insertado en la 
ranura de tarjeta UTILITY SD/MS.

4	 Seleccione el archivo que desea cargar.
Pulse en el archivo para seleccionarlo. 
Para cancelar, pulse en el archivo de 
nuevo.
Puede pulsar dos veces en el archivo para 
reproducirlo y comprobar su contenido 
(solo tarjeta SD).

5	 Pulse Transfer.
A continuación, aparecerá el servidor 
establecido en Default Upload Server en 
“Registro de un servidor de destino” 
(página 67).

Para cambiar el servidor, pulse sobre él 
para mostrar la lista de servidores y, a 
continuación, seleccione un servidor.
Introduzca el nombre del directorio del 
servidor en Directory si es necesario.

6	 Pulse Transfer.
La videocámara comenzará a cargar el 
archivo seleccionado.
Para cancelar la carga, pulse en Cancel.

Carga de un archivo original en una tarjeta 
de memoria XQD

[Consejo]
La tapa de la ranura para tarjetas XQD debe cerrarse 
para ver la información de los archivos en la tarjeta de 
memoria XQD.

1	 Conecte la videocámara y el dispositivo 
mediante una conexión de LAN 
(página 56).

2	 Abra un navegador en el dispositivo y 
visualice el control remoto de la web 
(página 66).

3	 Abra la pantalla de la lista de archivos 
para seleccionar un archivo.
Pulse  >File Transfer >Slot A o Slot B.
Aparecerá una pantalla con la lista de 
archivos del soporte insertado en las 
ranuras A o B.
Ejemplo: pantalla Slot A

4	 Seleccione el archivo que desea cargar.
Pulse en el archivo para seleccionarlo. 
Para cancelar, pulse en el archivo de 
nuevo.

5	 Pulse Transfer.
A continuación, aparecerá el servidor 
establecido en Default Upload Server en 
“Registro de un servidor de destino” 
(página 67).
Para cambiar el servidor, pulse sobre él 
para mostrar la lista de servidores y, a 
continuación, seleccione un servidor.
Introduzca el nombre del directorio del 
servidor en Directory si es necesario.

6	 Pulse Transfer.
La videocámara comenzará a cargar el 
archivo seleccionado.
Para cancelar la carga, pulse en Cancel.

Comprobación de la transferencia de archivos 
(Job List)
Puede comprobar la lista de archivos a cargar, 
el archivo que se está cargando, cancelar 
o iniciar la carga de archivos y eliminar el 
archivo de la lista de archivos.
La videocámara es compatible con la función 
de reanudación de FTP (reanudación de la 
carga de archivos cuya transferencia se ha 
suspendido).
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ˎˎ Total: progreso de todos los archivos que 
van a cargarse.
ˎˎ Status: progreso del archivo que se está 
cargando actualmente.
ˎˎ Remain Time: tiempo restante de carga 
estimado.
ˎˎ Transfer data rate: indicación de velocidad 
de transferencia.

Para cancelar o iniciar una carga o para 
eliminar un archivo de la lista de archivos

1	 Seleccione un archivo.

2	 Pulse  en la esquina superior derecha 
de la pantalla, y seleccione un elemento.
ˎˎ Abort selected: cancela la carga del 
archivo seleccionado.
ˎˎ Delete from list: elimina el archivo 
seleccionado de la lista.
ˎˎ Start selected: inicia la carga del archivo 
seleccionado.
ˎˎ Clear completed: elimina la lista de 
todos los archivos cargados.
ˎˎ Select All: selecciona todos los archivos 
de la lista.
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Pantalla de imágenes en miniatura
La pantalla de imágenes en miniatura aparece si pulsa el botón THUMBNAIL (página 7). La pantalla de imágenes en miniatura muestra los clips almacenados en las tarjetas de memoria XQD 
como imágenes en miniatura (imágenes índice).
Puede seleccionar un clip en la pantalla de imágenes en miniatura e iniciar la reproducción de dicho clip. La imagen de reproducción se puede mostrar en el visor y en un monitor externo.
Si pulsa el botón THUMBNAIL de nuevo, se cierra la pantalla de imágenes en miniatura y vuelve a la imagen de la cámara.

[Nota]
Solo los clips grabados con el formato de grabación seleccionado actualmente se mostrarán en la pantalla de imágenes en miniatura. Si un clip grabado esperado no se muestra, compruebe el formato de grabación. Tenga en cuenta esto 
antes de formatear (inicializar) soportes.

Diseño de la pantalla

La información para el clip sobre el que se encuentra el cursor se muestra en la parte inferior de la pantalla.

4 5

6

3

1

2

Indicador de la tarjeta de memoria XQD seleccionada actualmente
(se muestra un icono de bloqueo si la tarjeta está protegida).

Cursor (amarillo)

Número del clip/Número total de clips

1.	 Miniaturas (imágenes índice)
Muestra la imagen índice de un clip. Cuando 
se graba un clip, su primer fotograma se ajusta 
automáticamente como imagen índice.
La información del clip/fotograma se 
muestra debajo de la imagen en miniatura. 
Puede cambiar la información mostrada en 

Customize View (página 107) >Thumbnail 
Caption en el menú Thumbnail.

2.	 Nombre del clip
Muestra el nombre del clip seleccionado.

3.	 Formato de grabación del vídeo
Muestra el formato de archivo del clip 
seleccionado.

4.	 Información del modo de grabación 
especial

Muestra el modo de grabación solo si el clip se 
grabó con un modo especial de grabación.
En clips con Slow & Quick Motion, la velocidad 
de fotogramas se muestra a la derecha.

5.	 Duración del clip

6.	 Fecha de creación
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Reproducción de clips

Reproducción de clips grabados

Puede reproducir clips grabados cuando el 
camcorder esté en modo de espera (Stby).

1	 Introduzca una tarjeta de memoria XQD 
para la reproducción.

2	 Pulse el botón THUMBNAIL.

3	 Use los botones de flecha (página 7) o 
el dial multifunción (página 4) para 
mover el cursor a la miniatura del clip que 
desea reproducir.

4	 Pulse el botón SET o el dial multifunción.
La reproducción comienza desde el 
principio del clip seleccionado.

Puede controlar la reproducción con los 
siguientes botones.
Pulse el botón SET o el dial multifunción: 

Detiene la reproducción.  
Pulse de nuevo para volver a la 
reproducción normal.

Pulse los botones de flecha izquierda/
derecha: 
Pasa al inicio del clip/inicio del siguiente 
clip.

Mantenga pulsados los botones de flecha 
izquierda/derecha: 
Rebobinado/avance rápido.  
Vuelve a la reproducción normal cuando 
suelta el botón.

Botón CANCEL/BACK: 
Detiene la reproducción y vuelve al modo 
de espera de grabación.

[Notas]
ˎˎ Pueden existir roturas momentáneas de imagen o 

visualizarse imágenes fijas en el cambio de un clip 
a otro. Durante este periodo no podrá utilizar el 
camcorder.
ˎˎ Cuando selecciona un clip en la pantalla de imágenes 

en miniatura y comienza la reproducción, pueden 

existir roturas momentáneas de imagen al principio 
del clip. Para iniciar la reproducción sin distorsión 
desde el comienzo del clip, pause la reproducción 
una vez después de comenzar, presione el botón 
de flecha izquierda para volver al inicio del clip y, a 
continuación, reinicie la reproducción.
ˎˎ También puede usar el selector múltiple 

(página 9).
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En la pantalla de imágenes en miniatura, 
puede utilizar los clips o comprobar sus 
propiedades a través del menú Thumbnail.
El menú Thumbnail (página 106) aparece 
cuando pulsa el botón MENU y selecciona 
Thumbnail.

Operaciones con el menú 
Thumbnail

Use los botones de flechas (página 7) 
o el dial multifunción (página 4) para 
seleccionar una función y, a continuación, 
presione el botón SET o el dial multifunción.
Pulse el botón de CANCEL/BACK 
(página 7) para volver a la pantalla 
anterior.

[Consejo]
También puede usar el selector múltiple (página 9).

[Nota]
Algunos elementos no pueden seleccionarse, 
dependiendo del estado, cuando se visualiza el menú.

Elementos de menú para 
operaciones de clip

ˎˎ Display Clip Properties
ˎˎ Set Shot Mark
ˎˎ Set Clip Flag
ˎˎ Lock/Unlock Clip
ˎˎ Delete Clip
ˎˎ Copy Clip
ˎˎ Copy Sub Clip
ˎˎ Transfer Clip
ˎˎ Transfer Clip (Proxy)
ˎˎ Set Index Picture
ˎˎ Thumbnail View
ˎˎ Filter Clips
ˎˎ Customize View

Para obtener más información sobre los 
elementos de menús de operaciones 
con clips, consulte el menú Thumbnail 
(página 106).

Visualización de propiedades de clips

Seleccione Display Clip Properties 
(página 106) en el menú Thumbnail para 
mostrar la pantalla de propiedades de los 
clips.

Visualización de la pantalla de 
imágenes en miniatura de marcadores

Seleccione Thumbnail View (página 107) 
>Essence Mark Thumbnail en el menú 
Thumbnail y seleccione el tipo de marcador 
para mostrar una visualización de imágenes 
en miniatura de los fotogramas que tienen los 
marcadores especificados.
Para visualizar todos los clips, ajuste 
Thumbnail View >Essence Mark Thumbnail en 
el menú Thumbnail en All.

Visualización de la pantalla de 
imágenes en miniatura de clips filtrados

Seleccione Filter Clips (página 107) en el 
menú Thumbnail y seleccione un tipo de 
marca para mostrar solo aquellos clips que 
tengan la marca especificada.
Para mostrar todos los clips, seleccione All.

[Consejo]
También puede cambiar los filtros en secuencia usando 
el botón DISPLAY.

Eliminación de clips

Puede eliminar clips de tarjetas de memoria 
XQD.
Seleccione Delete Clip >Select Clip o All Clips 
en el menú Thumbnail.
Select Clip: 

Elimina el clip seleccionado. Compatible 
con la selección de varios clips.

All Clips: 
Elimina todos los clips mostrados.

Cambio de la información mostrada en 
la pantalla de imágenes en miniatura

Puede cambiar la información de fotogramas/
clips que se muestra debajo de la imagen en 
miniatura.
Seleccione Customize View >Thumbnail 
Caption en el menú Thumbnail y seleccione la 
información que desea mostrar.
Date Time: 

Muestra la fecha y la hora de creación del 
clip y de su última modificación.

Time Code: 
Muestra el código de tiempo.

Duration: 
Muestra la duración del clip.

Sequential Number: 
Muestra el número secuencial de cada 
imagen en miniatura.

Operaciones con clips



73 6. Pantalla de menús y ajustes

Configuración del menú de ajustes y jerarquía
Pulse el botón MENU para mostrar el menú 
de configuración en el visor con el fin de 
especificar los distintos elementos para filmar, 
grabar y reproducir (el menú también se 
puede visualizar en un monitor externo). El 
menú de configuración incluye los siguientes 
menús.

Configuración del menú

Menú User
Contiene elementos del menú 
configurados por el usuario mediante Edit 
User Menu.

Menú Edit User
Contiene elementos del menú para editar 
el menú User.

Menú Shooting
Contiene ajustes relacionados con la 
filmación.

Menú Project
Contiene ajustes básicos del proyecto.

Menú Paint
Contiene ajustes relacionados con la 
calidad de la imagen.

Menú TC/Media
Contiene ajustes relacionados con 
códigos de tiempo y soportes de 
grabación.

Menú Monitoring
Contiene ajustes relacionados con la 
salida de vídeo y la pantalla del visor.

Menú Audio
Contiene ajustes relacionados con el 
audio.

Menú Thumbnail
Contiene ajustes relacionados con la 
pantalla de imágenes en miniatura.

Menú Technical
Contiene ajustes para elementos técnicos.

Menú Network
Contiene ajustes relacionados con las 
redes.

Menú Maintenance
Contiene ajustes de dispositivos, como el 
reloj y el idioma.

Jerarquía del menú de 
configuración

User 
(Ajustes de 
fábrica)

Base Setting

Rec Format

ISO/Gain/EI

Focus

S&Q Motion

Monitor LUT

Monitor LUT Setting

Simul Rec

4K & HD (Sub) Rec

Proxy Rec

Picture Cache Rec

Assignable Button

Assignable Dial

Multi Function Dial

All File

Clip Name Format

Format Media

Output Format

VF Setting

Menu Settings

Edit User Menu Add Item

Customize Reset

Shooting ISO/Gain/EI

ND Filter

Shutter

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

Monitor LUT

Monitor LUT Setting

Monitor 3D LUT

Noise Suppression

Flicker Reduce

SteadyShot

Auto Black Balance

Project Base Setting

Rec Format

Cine EI Setting

Simul Rec

4K & HD (Sub) Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Assignable Dial

Multi Function Dial

User File

All File

Planning Metadata

Paint HDR Paint Setting

Black

Gamma

Black Gamma

Knee

White Clip

Detail(4K/QFHD)

Detail(HD)

Skin Detail

Aperture

Matrix

Multi Matrix

Scene File

TC/Media Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Monitoring Output On/Off

Output Format

Output Setting

Output Display

Display On/Off

Marker

VF Setting

Gamma Display Assist

Peaking

Zebra

Audio Audio Input

Audio Output
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Thumbnail Display Clip Properties

Set Shot Mark

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Copy Clip

Copy Sub Clip

Transfer Clip

Transfer Clip (Proxy)

Set Index Picture

Thumbnail View

Filter Clips

Customize View

Technical Color Bars

Test Saw

ND Dial

Tally

HOLD Switch Setting

Touch Operation

Rec Review

Handle Zoom

GPS

Menu Settings

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DC IN Alarm

Ext. Unit Battery Alarm

Ext. Unit DC IN Alarm

Network Access Authentication

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

Modem

Network Client Mode

File Transfer

Network Reset

Maintenance Language

Clock Set

All Reset

Hours Meter

Version
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Operaciones del menú de configuración
Pulse el botón MENU para mostrar el menú 
de configuración en el visor con el fin de 
especificar los distintos elementos para filmar, 
grabar y reproducir (el menú también se 
puede visualizar en un monitor externo).

Controles del menú

Botón MENU (página 7)
Activa y desactiva el modo de menú para 
las operaciones del menú de 
configuración.

Botones ////SET (página 7)
Pulse los botones de flechas para mover 
el cursor hacia arriba, hacia abajo, hacia la 
izquierda o hacia la derecha y seleccionar 
elementos o ajustes del menú.
Pulse el botón SET para aplicar el 
elemento seleccionado.

	 [Consejo]
También puede usar el selector múltiple 
(página 9) de la misma manera.

Dial multifunción (página 4)
Gire el dial multifunción para mover el 
cursor hacia arriba y hacia abajo para 
seleccionar elementos o ajustes del menú.
Pulse el dial multifunción para aplicar el 
elemento seleccionado.

Botón CANCEL/BACK (página 7)
Púlselo para volver al menú anterior. Los 
cambios sin finalizar se cancelan.

[Notas]
ˎˎ El menú de configuración no se puede utilizar cuando 

el modo de ampliación de enfoque está activado 
(página 37).
ˎˎ Algunos elementos no pueden seleccionarse, 

dependiendo del estado, cuando se visualiza el 
menú.
ˎˎ El funcionamiento táctil no es compatible.

Elementos del menú de 
configuración

Presione los botones de flecha o gire el 
dial multifunción para mover el cursor al 
elemento del menú que desea configurar y, a 
continuación, presione el botón SET o el dial 
multifunción para seleccionar el elemento.
ˎˎ El área de selección de elementos del menú 
muestra hasta ocho líneas. Si las opciones 
disponibles para un elemento no se pueden 
mostrar al mismo tiempo, desplácese por 
la pantalla moviendo el cursor hacia arriba/
abajo.
ˎˎ En el caso de los subelementos con una 
amplia gama de opciones (por ejemplo, 
de –99 a +99), el área de configuración no 
se visualiza. El ajuste actual se resalta para 
indicar que el valor se puede cambiar.
ˎˎ Si selecciona [Execute] para una función, la 
función correspondiente se ejecutará.
ˎˎ Si selecciona un elemento que requiere 
confirmación antes de su ejecución, el menú 
se ocultará temporalmente y se mostrará 
un mensaje de confirmación. Compruebe 
el mensaje y a continuación selecciones si 
desea ejecutar o cancelar la función.

Introducción de una cadena de 
caracteres

Cuando selecciona un elemento, como por 
ejemplo un nombre de archivo, que requiere 
la introducción de caracteres, aparecerá la 
pantalla para introducir caracteres.

1

2 3

1	 Presione los botones de flecha o gire el 
dial multifunción para seleccionar un tipo 
de carácter y, a continuación, aplique la 
configuración.
ABC: caracteres alfabéticos en mayúsculas
abc: caracteres alfabéticos en minúsculas
123: caracteres numéricos
!#$: caracteres especiales

2	 Seleccione un carácter del tipo de carácter 
seleccionado y, a continuación, aplique el 
ajuste.
El cursor pasa al campo siguiente.

Space: introduce un carácter de espacio en 
la posición del cursor.

/: mueve la posición del cursor.
BS: elimina el carácter a la izquierda del 

cursos (retroceso).

3	 Cuando acabe, seleccione [Done] y 
aplique el ajuste.

La cadena de caracteres se confirma y la 
pantalla de introducción de caracteres 
desaparece.

Bloqueo y desbloqueo del menú

Puede bloquear el menú de configuración 
para que solo se muestre el menú User.
Tampoco es posible cambiar la configuración 
de la pantalla de estado.

Bloqueo del menú

1	 Mantenga pulsado el dial multifunción y 
pulse el botón MENU.

2	 Seleccione Menu Settings >User Menu 
with Lock en el menú Technical.

	 [Nota]
Cuando solo se pulsa el botón MENU para mostrar 
el menú de configuración normal, User Menu Only 
se muestra en Menu Settings, en el menú Technical. 
Mantenga pulsado el dial multifunción y pulse el 
botón MENU para mostrar User Menu with Lock.

3	 Ajústelo en On y pulse el botón SET o el 
dial multifunción.
La visualización de la pantalla del visor 
cambia a la pantalla de introducción del 
número del código de acceso.

4	 Introduzca un número arbitrario.
Introduzca un número de 4 dígitos que se 
encuentre entre 0000 y 9999. El valor 
predeterminado es 0000.
Introduzca un número y pulse el botón 
SET o el dial multifunción para mover el 
curso hasta el siguiente dígito.
Cuando haya introducido todos los 
dígitos, mueva el cursor hasta SET.
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5	 Pulse el botón SET o el dial multifunción.
Se aplica el número introducido.
Aparece un mensaje de confirmación y la 
pantalla cambia a la pantalla del menú 
User.

Desbloqueo del menú

1	 Mantenga pulsado el dial multifunción y 
pulse el botón MENU.

2	 Seleccione Menu Settings >User Menu 
with Lock en el menú User.

	 [Nota]
Cuando solo se pulsa el botón MENU para mostrar 
el menú de configuración normal, User Menu Only 
se muestra en Menu Settings, en el menú Technical. 
Mantenga pulsado el dial multifunción y pulse el 
botón MENU para mostrar User Menu with Lock.

3	 Ajústelo en Off y pulse el botón SET o el 
dial multifunción.
La visualización de la pantalla del visor 
cambia a la pantalla de introducción del 
número del código de acceso.

4	 Introduzca el número del código de 
acceso que se utilizó para bloquear el 
menú.
Introduzca un número y pulse el botón 
SET o el dial multifunción para mover el 
curso hasta el siguiente dígito.
Cuando haya introducido todos los 
dígitos, mueva el cursor hasta Set.

5	 Pulse el botón SET o el dial multifunción.
Se aplica el número introducido.
Si el número del código de acceso 
introducido coincide con el número del 
código de acceso que se utilizó para 
bloquear el menú, el menú se desbloquea 
y se muestra.

[Notas]
ˎˎ Si el número del código de acceso introducido no 

coincide con el número del código de acceso que 
se utilizó para bloquear el menú, el menú no se 
desbloquea.
ˎˎ Se recomienda que anote el número del código de 

acceso en un lugar cercano por si lo olvida. Si se 
olvida del número del código de acceso, póngase en 
contacto con su representante de atención al cliente 
de Sony.
ˎˎ Si el menú está bloqueado y no se han registrado 

elementos del menú de configuración de las 
siguientes tablas en el menú User, esas funciones no 
se pueden asignar a los botones asignables.
ˎˎ Si esas funciones ya estaban asignadas a botones 

asignables, cuando se bloquea el menú se fuerza la 
desactivación del ajuste asignable.

Elemento del menú de 
configuración

Selección de 
botones asignables

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI 
>Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

Shooting >Auto 
Exposure >Auto ND 
Filter

Auto ND Filter

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Spotlight

Shooting >White > 
Preset White

Preset White Select

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus > 
Focus Area

Focus Area

Shooting >Focus > 
Focus Area(AF-S)

Focus Area(AF-S)

Elemento del menú de 
configuración

Selección de 
botones asignables

Shooting >Focus > 
Face/Eye Detection AF

Face/Eye Detection 
AF

Shooting >Focus > 
Push AF Mode

Push AF Mode

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >SteadyShot 
>Setting

SteadyShot

Project >Picture Cache 
Rec >Setting

Picture Cache Rec

Technical >Rec Review 
>Setting

Rec Review

Thumbnail >Set Clip 
Flag >Add OK

Clip Flag OK

Thumbnail >Set Clip 
Flag >Add NG

Clip Flag NG

Thumbnail >Set Clip 
Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >VF Setting 
>Color Mode

VF Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Technical >Touch 
Operation >Setting

Touch Operation

Technical >Handle 
Zoom >Setting

Handle Zoom

Elemento del menú de 
configuración

Selección de 
botones asignables

Network >Wireless LAN 
>NFC

NFC

Network >Network 
Client Mode >Setting

Network Client 
Mode

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)

User User Menu
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Menú User
Esta sección describe la función y los ajustes de los elementos en cada menú.

User

Elemento Descripción

Base Setting Elemento de Project >Base Setting

Rec Format Elemento de Project >Rec Format

ISO/Gain/EI Elemento de Shooting >ISO/Gain/EI

Focus Elemento de Shooting >Focus

S&Q Motion Elemento de Shooting >S&Q Motion

Monitor LUT Elemento de Shooting >Monitor LUT

Monitor LUT Setting Elemento de Shooting >Monitor LUT Setting

Simul Rec Elemento de Project >Simul Rec

4K & HD (Sub) Rec Elemento de Project >4K & HD (Sub) Rec

Proxy Rec Elemento de Project >Proxy Rec

Picture Cache Rec Elemento de Project >Picture Cache Rec

Assignable Button Elemento de Project >Assignable Button

Assignable Dial Elemento de Project >Assignable Dial

Multi Function Dial Elemento de Project >Multi Function Dial

All File Elemento de Project >All File

Clip Name Format Elemento de TC/Media >Clip Name Format

Format Media Elemento de TC/Media >Format Media

Output Format Elemento de Monitoring >Output Format

VF Setting Elemento de Monitoring >VF Setting

Menu Settings Elemento de Technical >Menu Settings

Edit User Menu Muestra la pantalla del menú Edit User.

[Nota]
Puede agregar y eliminar elementos de menú en el menú User utilizando el menú Edit User. Se pueden configurar 
hasta 20 elementos. La videocámara está configurada con 20 elementos de forma predeterminada. Para agregar 
un elemento, primero debe eliminar un elemento existente mediante Delete en el menú Edit User y, a continuación, 
agregar un elemento mediante Add Item.
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Menú Edit User
El menú Edit User se muestra en el nivel superior cuando se selecciona Edit User Menu en el 
menú User.

Edit User

Elemento Ajuste de subelementos Descripción

Add Item
Adición de un elemento 
al menú User

Agrega un elemento del menú al 
menú User.

Customize Reset
Restablecimiento de los 
elementos en el menú 
User

Restaura los elementos del menú 
registrados en el menú User de 
manera predeterminada de fábrica.

Elemento de menú 
seleccionado durante la 
edición

Delete Elimina el elemento de menú 
registrado del menú User.

Move Reordena los elementos de menú 
registrados dentro del menú User.

Edit Sub Item Edita (registra/elimina) los 
subelementos de menú registrados 
en el menú User.
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Menú Shooting
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Shooting >ISO/Gain/EI
Configura los ajustes de ganancia.

Elemento Ajuste de subelementos Descripción

Mode ISO/dB Selecciona el modo de ajuste de 
ganancia.

ISO/Gain<H> Cuando Mode se establece en ISO con un 
rango dinámico de 460% y Base Sensitivity 
se establece en High:

ISO 1600 / ISO 2000 / ISO 2500 /  
ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000 /  
ISO 25600 / ISO 32000 / ISO 40000 /  
ISO 51200 / ISO 64000 / ISO 80000 /  
ISO 102400

Cuando Mode se establece en ISO con un 
rango dinámico de 460% y Base Sensitivity 
se establece en Low:

ISO 320 / ISO 400 / ISO 500 / ISO 640 / 
ISO 800 / ISO 1000 / ISO 1250 /  
ISO 1600 / ISO 2000 / ISO 2500 /  
ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000

Cuando Mode se establece en ISO con un 
rango dinámico de 800% y Base Sensitivity 
se establece en High:

ISO 2500 / ISO 3200 / ISO 4000 /  
ISO 5000 / ISO 6400 / ISO 8000 /  
ISO 10000 / ISO 12800 / ISO 16000 /  
ISO 20000 / ISO 25600 / ISO 32000 /  
ISO 40000 / ISO 51200 / ISO 64000 /  
ISO 80000 / ISO 102400

Cuando Mode se establece en ISO con un 
rango dinámico de 800% y Base Sensitivity 
se establece en Low:

ISO 500 / ISO 640 / ISO 800 / ISO 1000 / 
ISO 1250 / ISO 1600 / ISO 2000 /  
ISO 2500 / ISO 3200 / ISO 4000 /  
ISO 5000 / ISO 6400 / ISO 8000 /  
ISO 10000 / ISO 12800 / ISO 16000 /  
ISO 20000

Ajusta el valor predeterminado de 
ganancia <H>.

[Consejo]
El rango dinámico se determina por el gamma. 
El gamma en modo HDR es HLG.

Gamma Rango dinámico

STD / HG1 / HG2 /  
HG3 / HG4 / 
S-Cinetone

460%

HG7 / HG8 800%

S-Log3 / HLG 1300%

Shooting >ISO/Gain/EI
Configura los ajustes de ganancia.

Elemento Ajuste de subelementos Descripción

ISO/Gain<H> Cuando Mode se establece en ISO con un 
rango dinámico de 1300% y Base 
Sensitivity se establece en High:

ISO 4000 / ISO 5000 / ISO 6400 /  
ISO 8000 / ISO 10000 / ISO 12800 /  
ISO 16000 / ISO 20000 / ISO 25600 /  
ISO 32000 / ISO 40000 / ISO 51200 /  
ISO 64000 / ISO 80000 / ISO 102400

Cuando Mode se establece en ISO con un 
rango dinámico de 1300% y Base 
Sensitivity se establece en Low:

ISO 800 / ISO 1000 / ISO 1250 /  
ISO 1600 / ISO 2000 / ISO 2500 /  
ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000

Cuando Mode está ajustado en dB:
De –3 dB a 27 dB (12 dB) (incrementos 
de 1dB)
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Shooting >ISO/Gain/EI
Configura los ajustes de ganancia.

Elemento Ajuste de subelementos Descripción

ISO/Gain<M> (El mismo ajuste que ISO/Gain<H>)
A continuación se indican los valores 
predeterminados.
Cuando Mode se establece en ISO con un 
rango dinámico de 460% y Base Sensitivity 
se establece en High:

ISO 3200
Cuando Mode se establece en ISO con un 
rango dinámico de 460% y Base Sensitivity 
se establece en Low:

ISO 640
Cuando Mode se establece en ISO con un 
rango dinámico de 800% y Base Sensitivity 
se establece en High:

ISO 5000
Cuando Mode se establece en ISO con un 
rango dinámico de 800% y Base Sensitivity 
se establece en Low:

ISO 1000
Cuando Mode se establece en ISO con un 
rango dinámico de 1300% y Base 
Sensitivity se establece en High:

ISO 8000
Cuando Mode se establece en ISO con un 
rango dinámico de 1300% y Base 
Sensitivity se establece en Low:

ISO 1600
Cuando Mode está ajustado en dB:

6dB

Ajusta el valor predeterminado de 
ganancia <M>.

Shooting >ISO/Gain/EI
Configura los ajustes de ganancia.

Elemento Ajuste de subelementos Descripción

ISO/Gain<L> (El mismo ajuste que ISO/Gain<H>)
A continuación se indican los valores 
predeterminados.
Cuando Mode se establece en ISO con un 
rango dinámico de 460% y Base Sensitivity 
se establece en High:

ISO 1600
Cuando Mode se establece en ISO con un 
rango dinámico de 460% y Base Sensitivity 
se establece en Low:

ISO 320
Cuando Mode se establece en ISO con un 
rango dinámico de 800% y Base Sensitivity 
se establece en High:

ISO 2500
Cuando Mode se establece en ISO con un 
rango dinámico de 800% y Base Sensitivity 
se establece en Low:

ISO 500
Cuando Mode se establece en ISO con un 
rango dinámico de 1300% y Base 
Sensitivity se establece en High:

ISO 4000
Cuando Mode se establece en ISO con un 
rango dinámico de 1300% y Base 
Sensitivity se establece en Low:

ISO 800
Cuando Mode está ajustado en dB:

0dB

Ajusta el valor predeterminado de 
ganancia <L>.
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Shooting >ISO/Gain/EI
Configura los ajustes de ganancia.

Elemento Ajuste de subelementos Descripción

Exposure 
Index<H>

Cuando Base ISO se establece en ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Cuando Base ISO se establece en ISO 
4000:

1000EI / 4.0E
1250EI / 4.3E
1600EI / 4.7E
2000EI / 5.0E
2500EI / 5.3E
3200EI / 5.7E
4000EI / 6.0E
5000EI / 6.3E
6400EI / 6.7E
8000EI / 7.0E
10000EI / 7.3E
12800EI / 7.7E
16000EI / 8.0E

Ajusta el valor del índice de exposición 
<H>.
Disponible solo en modo Cine EI.

Exposure 
Index<M>

(El mismo ajuste que Exposure Index<H>)
Cuando Base ISO se establece en ISO 800:

1000EI / 6.3E
Cuando Base ISO se establece en ISO 
4000:

5000EI / 6.3E

Ajusta el valor del índice de exposición 
<M>.

Exposure 
Index<L>

(El mismo ajuste que Exposure Index<H>)
Cuando Base ISO se establece en ISO 800:

800EI / 6.0E
Cuando Base ISO se establece en ISO 
4000:

4000EI / 6.0E

Ajusta el valor del índice de exposición 
<L>.

Shooting >ISO/Gain/EI
Configura los ajustes de ganancia.

Elemento Ajuste de subelementos Descripción

Shockless 
Gain

On / Off Activa y desactiva la función de ganancia 
sin vibraciones.

Base 
Sensitivity

High / Low Establece la sensibilidad base para el 
modo SDR/HDR.

Base ISO ISO 4000 / ISO 800 Establece la sensibilidad ISO base para el 
modo Cine EI.

Shooting >ND Filter
Ajuste los valores predeterminados del filtro ND.

Elemento Ajuste de subelementos Descripción

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Ajusta el valor predeterminado 1 del filtro 
ND.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Ajusta el valor predeterminado 2 del filtro 
ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Ajusta el valor predeterminado 3 del filtro 
ND.

Shooting >Shutter
Ajusta las condiciones operativas del obturador electrónico.

Elemento Ajuste de subelementos Descripción

Mode Speed / Angle Selecciona el modo de operación del 
obturador electrónico.
Se utiliza para filmar con claridad sujetos 
que se mueven rápidamente. Selecciona 
el modo para ajustar la velocidad del 
obturador en segundos (Speed) o como 
el ángulo del obturador (Angle).

Shutter 
Speed On/
Off

On / Off Establece si el tiempo de exposición 
cuando se selecciona el modo Speed 
sigue el valor de Shutter Speed o se 
establece para exposición completa.
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Shooting >Shutter
Ajusta las condiciones operativas del obturador electrónico.

Elemento Ajuste de subelementos Descripción

Shutter 
Speed

64F a 1/8000
Los ajustes disponibles dependen de la 
frecuencia de fotogramas del formato de 
vídeo seleccionado.
59.94P / 59.94i: 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P / 50i: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Ajusta la velocidad del obturador cuando 
Mode está ajustado en Speed.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /  
3F / 2F / 360.0° / 300.0° / 270.0° /  
240.0° / 216.0° / 210.0° / 180.0° / 172.8° / 
150.0° / 144.0° / 120.0° / 90.0° / 86.4° / 
72.0° / 45.0° / 30.0° / 22.5° / 11.25° / 5.6°

Ajusta el ángulo del obturador cuando 
Mode está ajustado en Angle.

ECS On/Off On / Off Activa y desactiva la función Extended 
Clear Scan.

Shooting >Shutter
Ajusta las condiciones operativas del obturador electrónico.

Elemento Ajuste de subelementos Descripción

ECS 
Frequency

De 23.99 a 8000
Los ajustes disponibles dependen de la 
frecuencia de fotogramas del formato de 
vídeo seleccionado.
A continuación se indican los valores 
predeterminados.
59.94P: 60.00
59.94i: 60.00
50P: 50.00
50i: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Ajusta la frecuencia ECS cuando Mode 
está ajustado en ECS.

Shooting >Auto Exposure
Configura los ajustes de la exposición automática.

Elemento Ajuste de subelementos Descripción

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 /  
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / 
–3.0

Establece el nivel de brillo para la 
exposición detectada automáticamente.

Mode Backlight / Standard / Spotlight Establece el modo de funcionamiento del 
ajuste de exposición automática.
Backlight: 

Modo de retroiluminación (modo 
para reducir el oscurecimiento de un 
sujeto cuando dicho sujeto está 
retroiluminado)

Standard: 
Modo estándar

Spotlight: 
Modo de luz direccional (modo para 
reducir la sobreexposición de blancos 
cuando el sujeto recibe una 
iluminación direccional)

Speed De –99 a +99 (±0) Establece la velocidad de ajuste del 
ajuste de exposición automática.

AGC On / Off Activa y desactiva la función AGC (Control 
automático de ganancia).
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Shooting >Auto Exposure
Configura los ajustes de la exposición automática.

Elemento Ajuste de subelementos Descripción

AGC Limit Cuando ISO/Gain/EI >Mode está 
establecido en dB:

3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 
21dB / 24dB / 27dB

Cuando ISO/Gain/EI >Mode se establece 
en ISO con un rango dinámico de 460% y 
Base Sensitivity se establece en High:

ISO 2000 / ISO 2500 / ISO 3200 /  
ISO 4000 / ISO 5000 / ISO 6400 /  
ISO 8000 / ISO 10000 / ISO 12800 /  
ISO 16000 / ISO 20000 / ISO 25600 /  
ISO 32000 / ISO 40000 / ISO 51200 /  
ISO 64000 / ISO 80000 / ISO 102400

Cuando ISO/Gain/EI >Mode se establece 
en ISO con un rango dinámico de 460% y 
Base Sensitivity se establece en Low:

ISO 400 / ISO 500 / ISO 640 / ISO 800 / 
ISO 1000 / ISO 1250 / ISO 1600 /  
ISO 2000 / ISO 2500 / ISO 3200 /  
ISO 4000 / ISO 5000 / ISO 6400 /  
ISO 8000 / ISO 10000 / ISO 12800 /  
ISO 16000 / ISO 20000

Cuando ISO/Gain/EI >Mode se establece 
en ISO con un rango dinámico de 800% y 
Base Sensitivity se establece en High:

ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000 /  
ISO 25600 / ISO 32000 / ISO 40000 /  
ISO 51200 / ISO 64000 / ISO 80000 /  
ISO 102400

Cuando ISO/Gain/EI >Mode se establece 
en ISO con un rango dinámico de 800% y 
Base Sensitivity se establece en Low:

ISO 640 / ISO 800 / ISO 1000 / ISO 1250 / 
ISO 1600 / ISO 2000 / ISO 2500 /  
ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000

Ajusta la ganancia máxima de la función 
AGC.

Shooting >Auto Exposure
Configura los ajustes de la exposición automática.

Elemento Ajuste de subelementos Descripción

AGC Limit Cuando ISO/Gain/EI >Mode se establece 
en ISO con un rango dinámico de 1300% y 
Base Sensitivity se establece en High:

ISO 5000 / ISO 6400 / ISO 8000 /  
ISO 10000 / ISO 12800 / ISO 16000 /  
ISO 20000 / ISO 25600 / ISO 32000 /  
ISO 40000 / ISO 51200 / ISO 64000 /  
ISO 80000 / ISO 102400

Cuando ISO/Gain/EI >Mode se establece 
en ISO con un rango dinámico de 1300% y 
Base Sensitivity se establece en Low:

ISO 1000 / ISO 1250 / ISO 1600 /  
ISO 2000 / ISO 2500 / ISO 3200 /  
ISO 4000 / ISO 5000 / ISO 6400 /  
ISO 8000 / ISO 10000 / ISO 12800 /  
ISO 16000 / ISO 20000

AGC Point Cuando Lens >Iris Display en el menú 
Technical está ajustado en F-Number, o 
cuando Iris Display está ajustado en Auto y 
no se puede obtener la información del 
valor T del objetivo acoplado:

F2.8 / F4 / F5.6
Cuando Lens >Iris Display en el menú 
Technical está ajustado en Auto y no se 
puede obtener la información del valor T 
del objetivo acoplado:

T2.8 / T4 / T5.6

Establece el valor F-stop de los iris si la 
operación AGC empieza cuando la 
función AGC está ajustada en On.

Auto Shutter On / Off Activa y desactiva la función de control 
del obturador automático.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Ajusta la velocidad más rápida del 
obturador en la función de obturador 
automático.



6. Pantalla de menús y ajustes: Menú Shooting84

Shooting >Auto Exposure
Configura los ajustes de la exposición automática.

Elemento Ajuste de subelementos Descripción

A.SHT Point Cuando Lens >Iris Display en el menú 
Technical está ajustado en F-Number, o 
cuando Iris Display está ajustado en Auto y 
no se puede obtener la información del 
valor T del objetivo acoplado:

F5.6 / F8 / F11 / F16
Cuando Lens >Iris Display en el menú 
Technical está ajustado en Auto y no se 
puede obtener la información del valor T 
del objetivo acoplado:

T5.6 / T8 / T11 / T16

Establece el valor F-stop de los iris si se 
inicia la operación de obturación 
automática.

Clip High 
light

On / Off Activa y desactiva la función que ignora 
las zonas más iluminadas para 
proporcionar una respuesta menor a la 
luminosidad alta.

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Ajusta el rango del medidor de luz para 
ajustar automáticamente la exposición 
de acuerdo con la luminosidad del sujeto. 
(No disponible cuando se ajusta la 
exposición manualmente)

Detect 
Window 
Indication

On / Off Activa/desactiva la indicación del rango 
del medidor de luz.

Average Peak 
Level Ratio

De –99 a +99 (±0) Establece la relación entre el valor 
promedio y la señal de nitidez de vídeo 
utilizada para la detección de Auto 
Exposure.

Custom 
Width

De 40 a 999 (500) Establece el ancho del rango del medidor 
de luz.

Custom 
Height

De 70 a 999 (500) Establece la altura del rango del medidor 
de luz.

Custom H 
Position

De –479 a +479 (±0) Ajusta la posición horizontal del rango 
del medidor de luz.

Custom V 
Position

De –464 a +464 (±0) Ajusta la posición vertical del rango del 
medidor de luz.

Shooting >White
Configura los ajustes del balance de blancos.

Elemento Ajuste de subelementos Descripción

Preset White De 2000K a 15000K (3200K) Ajusta el valor predeterminado del 
balance de blancos.

Color Temp 
<A>

De 2000K a 15000K (3200K) Establece la temperatura de color del 
balance de blancos que está guardada 
en la memoria A.

[Nota]
Dado que Color Temp se recorta a 2000K y 
15000K durante la operación R/B Gain, es 
posible que no se pueda mostrar el valor 
correcto de Color Temp para el valor R/B Gain.

Tint<A> De –99 a +99 (±0) Establece el valor de matiz del balance 
de blancos guardado en la memoria 
blanca A.

[Nota]
Dado que Tint se recorta a ±99 durante la 
operación R/B Gain, es posible que no se 
pueda mostrar el valor correcto de Tint para el 
valor R/B Gain.

R Gain <A> De –99.0 a +99.0 (±0.0) Ajusta la ganancia R del balance de 
blancos que está guardada en la 
memoria A.

B Gain <A> De –99.0 a +99.0 (±0.0) Ajusta la ganancia B del balance de 
blancos que está guardada en la 
memoria A.

Color Temp 
<B>

De 2000K a 15000K (3200K) Establece la temperatura de color del 
balance de blancos que está guardada 
en la memoria B.

[Nota]
Dado que Color Temp se recorta a 2000K y 
15000K durante la operación R/B Gain, es 
posible que no se pueda mostrar el valor 
correcto de Color Temp para el valor R/B Gain.

Tint<B> De –99 a +99 (±0) Establece el valor de matiz del balance 
de blancos guardado en la memoria 
blanca B.

[Nota]
Dado que Tint se recorta a ±99 durante la 
operación R/B Gain, es posible que no se 
pueda mostrar el valor correcto de Tint para el 
valor R/B Gain.

R Gain <B> De –99.0 a +99.0 (±0.0) Ajusta la ganancia R del balance de 
blancos que está guardada en la 
memoria B.
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Shooting >White
Configura los ajustes del balance de blancos.

Elemento Ajuste de subelementos Descripción

B Gain <B> De –99.0 a +99.0 (±0.0) Ajusta la ganancia B del balance de 
blancos que está guardada en la 
memoria B.

Shooting >White Setting
Ajusta los ajustes del balance de blancos.

Elemento Ajuste de subelementos Descripción

Shockless 
White

Off / 1 / 2 / 3 Ajusta la velocidad de respuesta del 
balance de blancos cuando se cambia el 
modo de balance de blancos.
Off: cambia instantáneamente.
De 1 a 3: cambia más lentamente cuanto 

mayor es el número.

ATW Speed 1 / 2 / 3 / 4 / 5 Ajusta la velocidad de respuesta en el 
modo ATW.
1: Velocidad de respuesta más rápida

White 
Switch<B>

Memory / ATW Selecciona el modo de ajuste de balance 
de blancos seleccionado cuando el 
interruptor WHT BAL está ajustado en B.

Filter White 
Memory

On / Off Activa y desactiva la función que ajusta el 
área de memoria del balance de blancos 
para cada filtro ND.
On: ajusta la memoria de alance de 

blancos para cada filtro ND.

	 [Consejo]
En el modo predeterminado hay cuatro 
ajustes (CLEAR /1 / 2 / 3). En el modo 
variable hay dos ajustes (CLEAR / On).

Off: ajusta la memoria de alance de 
blancos común a todos los filtros ND.

Shooting >Offset White
Configura los ajustes de desviación del balance de blancos.

Elemento Ajuste de subelementos Descripción

Offset White 
<A>

On / Off Selecciona si se debe (On) o no se debe 
(Off) añadir un valor de desviación al 
balance de blancos especificado en la 
memoria A.

Shooting >Offset White
Configura los ajustes de desviación del balance de blancos.

Elemento Ajuste de subelementos Descripción

Offset Color 
Temp<A>

De –99 a +99 (±0) Ajusta la desviación de la temperatura de 
color que se añadirá al balance de 
blancos en la memoria A cuando Offset 
White <A> está ajustado en On.

[Nota]
Dado que Offset Color Temp se recorta a ±99 
durante la operación R/B Gain, es posible que 
no se pueda mostrar el valor correcto de Offset 
Color Temp para el valor R/B Gain.

Offset 
Tint<A>

De –99 a +99 (±0) Ajusta la desviación del valor de Tint que 
se añadirá al balance de blancos en la 
memoria A cuando Offset White <A> está 
ajustado en On.

[Nota]
Dado que Offset Tint se recorta a ±99 durante 
la operación R/B Gain, es posible que no se 
pueda mostrar el valor correcto de Offset Tint 
para el valor R/B Gain.

Offset White 
<B>

On / Off Selecciona si se debe (On) o no se debe 
(Off) añadir un valor de desviación al 
balance de blancos especificado en la 
memoria B.

Offset Color 
Temp<B>

De –99 a +99 (±0) Ajusta la desviación de la temperatura de 
color que se añadirá al balance de 
blancos en la memoria B cuando Offset 
White <B> está ajustado en On.

[Nota]
Dado que Offset Color Temp se recorta a ±99 
durante la operación R/B Gain, es posible que 
no se pueda mostrar el valor correcto de Offset 
Color Temp para el valor R/B Gain.

Offset 
Tint<B>

De –99 a +99 (±0) Ajusta la desviación del valor de Tint que 
se añadirá al balance de blancos en la 
memoria B cuando Offset White <B> está 
ajustado en On.

[Nota]
Dado que Offset Tint se recorta a ±99 durante 
la operación R/B Gain, es posible que no se 
pueda mostrar el valor correcto de Offset Tint 
para el valor R/B Gain.

Offset White 
<ATW>

On / Off Selecciona si se debe (On) o no se debe 
(Off) añadir un valor de desviación al 
balance de blancos ATW.
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Shooting >Offset White
Configura los ajustes de desviación del balance de blancos.

Elemento Ajuste de subelementos Descripción

Offset Color 
Temp<ATW>

De –99 a +99 (±0) Ajusta la desviación de la temperatura de 
color que se añadirá al balance de 
blancos ATW cuando Offset White <ATW> 
está ajustado en On.

Offset 
Tint<ATW>

De –99 a +99 (±0) Ajusta la desviación del valor de Tint que 
se añadirá al balance de blancos ATW 
cuando Offset White <ATW> está 
ajustado en On.

Shooting >Focus
Configura los ajustes de enfoque.

Elemento Ajuste de subelementos Descripción

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Establece la velocidad del enfoque para 
cuando el sujeto cambia durante el 
enfoque automático.

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Establece la sensibilidad para cambiar el 
enfoque del sujeto durante el enfoque 
automático.

Focus Area Wide / Zone / Flexible Spot Establece el área de destino para la 
función Auto Focus y Push Auto Focus 
(AF) (página 34).
Wide: 

Busca un sujeto en un ángulo amplio 
de la imagen al enfocar.

Zone: 
Busca automáticamente un punto de 
enfoque dentro de la zona 
especificada.

Flexible Spot: 
Enfoca una posición especificada en 
la imagen.

Focus Area 
(AF-S)

Flexible Spot Establece el área de destino para la 
función Push Auto Focus (AF-S).

Face/Eye 
Detection AF

Face/Eye Only AF / Face/Eye Priority AF / 
Off

Habilita/deshabilita el AF de detección 
de caras/ojos.

Push AF 
Mode

AF / Single-shot AF(AF-S) Ajusta el modo Push Auto Focus.

AF Assist On / Off Cuando está ajustado en On, le permite 
anular temporalmente el enfoque 
automático para ajustar el enfoque 
manualmente.

Shooting >S&Q Motion
Configura los ajustes del modo Slow & Quick Motion (página 47).

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el modo Slow & Quick 
Motion.
Cuando se ajusta en On, se inhabilitan las 
siguientes funciones.

ˎˎ Diafragma automático
ˎˎ Enfoque automático

Frame Rate 1fps a 60fps / 100fps / 120fps / 150fps / 
180fps

Ajusta la velocidad de fotogramas para la 
filmación con el modo Slow & Quick Motion.

[Nota]
Los ajustes disponibles dependen de la 
frecuencia del sistema, el códec y el formato de 
vídeo seleccionados.

Shooting >Monitor LUT
Configura los ajustes de LUT del monitor. Solo disponible cuando se filma en modo Cine EI.

Elemento Ajuste de subelementos Descripción

Category LUT / User 3D LUT Selecciona la categoría LUT del monitor.

LUT Select 709(800%) / HG8009G40 / HG8009G33 / 
S-Log3 / s709

Selecciona el tipo LUT del monitor.
709(800%): 

Señal con curva base ITU-R709 con 
rango dinámico ampliado hasta 
800%.

HG8009G40: 
Señal que utiliza HyperGamma con 
rango dinámico 800%, límite blanco 
109% y salida de vídeo de tarjeta gris 
18% de 40%.

HG8009G33: 
Señal que utiliza HyperGamma con 
rango dinámico 800%, límite blanco 
109% y salida de vídeo de tarjeta gris 
18% de 33%.

S-Log3: 
Señal de registro con rango dinámico 
1300% que imita las características de la 
película, similar a la curva Cineon Log.

s709: 
Color de Cine equivalente a 
709(800%).

[Nota]
Solo se puede configurar cuando Category está 
ajustado en LUT.
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Shooting >Monitor LUT
Configura los ajustes de LUT del monitor. Solo disponible cuando se filma en modo Cine EI.

Elemento Ajuste de subelementos Descripción

User 3D LUT 
Select

Nombre de archivo (de 01 a 16) de los 
archivos 3D LUT del usuario almacenados 
en la memoria interna

Selecciona el archivo 3D LUT del usuario.

[Nota]
Solo se puede configurar cuando Category está 
ajustado en User 3D LUT.

Shooting >Monitor LUT Setting
Ajusta los ajustes de LUT del monitor. Solo disponible cuando se filma en modo Cine EI.

Elemento Ajuste de subelementos Descripción

Internal Rec MLUT On / MLUT Off Selecciona si se va a aplicar el LUT de 
monitor al vídeo principal grabado en 
tarjetas de memoria XQD.

Monitor Out MLUT On / MLUT Off Selecciona si se aplica el monitor LUT a la 
salida de vídeo y al vídeo grabado, que 
no sea el vídeo principal grabado en las 
tarjetas de memoria XQD.

HD(Sub) Rec/
Proxy

Mostrar solo Muestra si el LUT de monitor se aplica al 
vídeo HD (Sub) y al vídeo de grabación 
proxy durante la grabación 4K y HD (Sub).

SDI1 Mostrar solo Muestra si se aplica el LUT de monitor al 
vídeo de salida de SDI1.

SDI2 Mostrar solo Muestra si se aplica el LUT de monitor al 
vídeo de salida de SDI2.

HDMI Mostrar solo Muestra si se aplica el LUT de monitor al 
vídeo de salida de HDMI.

VF/Streaming Mostrar solo Muestra si el LUT de monitor se aplica al 
visor y a la salida de transmisión de 
vídeo.

Shooting >Monitor 3D LUT
Establece los ajustes de 3D LUT del usuario.

Elemento Ajuste de subelementos Descripción

Load SD Card Carga los datos de 3D LUT del usuario 
desde una tarjeta SD.

Reset Restablece un ajuste de los datos de 3D 
LUT del usuario.

Reset All Execute / Cancel Restablece todos los ajustes de los datos 
de 3D LUT del usuario.
Execute: ejecuta la función.

Shooting >Noise Suppression
Configura los ajustes de supresión de ruido.

Elemento Ajuste de subelementos Descripción

Setting 
(SDR/HDR)

On / Off Activa y desactiva la función de 
supresión de ruido en los modos SDR y 
HDR.

Level 
(SDR/HDR)

Low / Mid / High Establece el nivel de supresión de ruido 
en los modos SDR y HDR.

Setting 
(Cine EI)

On / Off Activa y desactiva la función de 
supresión de ruido en el modo Cine EI.

Level 
(Cine EI)

Low / Mid / High Ajusta el nivel de supresión de ruido en 
el modo Cine EI.

Shooting >Flicker Reduce
Configura los ajustes de corrección de parpadeo.

Elemento Ajuste de subelementos Descripción

Mode Auto / On / Off Ajusta el modo de corrección de 
parpadeo.

Frequency 50Hz / 60Hz Ajusta la frecuencia de la fuente de 
alimentación que proporciona la 
iluminación causante del parpadeo.

Shooting >SteadyShot
Configura los ajustes de estabilización de la imagen.

Elemento Ajuste de subelementos Descripción

Setting Active / Standard / Off Activa y desactiva la función de 
estabilización de la imagen.

[Nota]
Habilitado cuando se acopla un objetivo 
compatible.

Shooting >Auto Black Balance
Configura los ajustes del balance automático de negros.

Elemento Ajuste de subelementos Descripción

Auto Black 
Balance

Execute / Cancel Ejecuta la función del balance de negros 
automático.

[Notas]
ˎˎ Ejecute la función de balance automático de 

negros con la tapa del objetivo acoplada.
ˎˎ No se puede ejecutar durante la grabación 

ni cuando se muestran las barras de colores.
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Menú Project
Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Project >Base Setting
Configura los ajustes básicos.

Elemento Ajuste de subelementos Descripción

Shooting 
Mode

SDR / HDR / Cine EI Ajusta el modo de filmación 
(página 27).

Project >Rec Format
Configura los ajustes del formato de grabación.

Elemento Ajuste de subelementos Descripción

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 Selecciona la frecuencia del sistema.

Imager Scan 
Mode

FF 6K / FFcrop 5K / S35 4K / FF 2K / S35 2K Establece la combinación del método de 
lectura de imágenes (todos los 
píxeles / agrupación de píxeles) y la 
configuración del tamaño de la imagen.

Codec RAW / RAW & XAVC-I / RAW & XAVC-L / 
RAW & MPEG HD 422 / XAVC-I / XAVC-L / 
MPEG HD 422

Ajusta el modo de grabación/
reproducción.

[Nota]
Los ajustes de RAW solo se muestran cuando 
hay un módulo de ampliación acoplado.

RAW Output 
Format

Los ajustes disponibles dependen de la 
configuración de Frequency, Imager Scan 
Mode y Codec (página 55).

Establece el formato de grabación de una 
grabadora RAW externa.

Project >Rec Format
Configura los ajustes del formato de grabación.

Elemento Ajuste de subelementos Descripción

Video Format Los ajustes disponibles dependen de la 
configuración de Frequency y Codec.

Ajusta el formato de grabación.

Frequency Codec Opciones de 
selección

59.94 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080i 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P
1920×1080i

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35
1920×1080i 50
1920×1080i 35
1920×1080i 25

MPEG 
HD422

1920×1080i 50
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Project >Rec Format
Configura los ajustes del formato de grabación.

Elemento Ajuste de subelementos Descripción

Video Format 50 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080i 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P
1920×1080i

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35
1920×1080i 50
1920×1080i 35
1920×1080i 25

MPEG 
HD422

1920×1080i 50

29.97 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080P 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35

MPEG 
HD422

1920×1080P 50

Project >Rec Format
Configura los ajustes del formato de grabación.

Elemento Ajuste de subelementos Descripción

Video Format 25 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080P 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35

MPEG 
HD422

1920×1080P 50

24 RAW –

XAVC-I 4096×2160P

23.98 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080P 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35

MPEG 
HD422

1920×1080P 50



6. Pantalla de menús y ajustes: Menú Project90

Project >Cine EI Setting
Configura los ajustes del modo Cine EI.

Elemento Ajuste de subelementos Descripción

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Ajusta el espacio de color en el modo 
Cine EI.
S-Gamut3/SLog3: 

Establece el espacio de color en el 
modo Cine EI en S-Gamut3.

S-Gamut3.Cine/SLog3: 
Establece el espacio de color en el 
modo Cine EI en S-Gamut3.Cine.

Project >Simul Rec
Ajusta el modo de grabación simultánea (página 50).

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de 
grabación simultánea y ajusta el soporte 
de destino de grabación.

Rec Button 
Set

Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB] / Rec Button:[SlotA] 
Handle Rec Button:[SlotB] / Rec 
Button:[SlotB] Handle Rec Button:[SlotA]

Asigna los botones de grabación 
utilizados para controlar cada soporte de 
grabación.

Project >4K & HD (Sub) Rec
Ajusta el modo de grabación 4K & HD (Sub).

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el modo de grabación 
4K & HD (Sub).

Project >Proxy Rec
Ajusta el modo de grabación de proxy.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el modo de grabación 
de proxy.

Project >Proxy Rec
Ajusta el modo de grabación de proxy.

Elemento Ajuste de subelementos Descripción

Proxy Format 1920×1080(9Mbps) / 1280×720(9Mbps) / 
1280×720(6Mbps) / 640×360(3Mbps)

Ajusta el tamaño de la imagen del 
archivo proxy.
Al establecer 1920×1080(9Mbps) y la 
frecuencia de sistema en 23.98, la 
grabación utiliza el escaneo progresivo. 
En el caso de que sean frecuencias de 
sistema distintas a 23.98, la grabación 
utiliza el escaneo entrelazado.
Para configuraciones distintas de 
1920×1080(9Mbps), la grabación siempre 
utiliza el escaneo progresivo, 
independientemente de la frecuencia del 
sistema.

Audio 
Channel

CH1/CH2 / CH3/CH4 Selecciona el canal de audio en el que se 
grabarán los datos de proxy.

Project >Interval Rec
Ajusta el modo de grabación de intervalos (página 48).

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el modo de grabación 
de intervalo. (Si se ajusta este modo en 
On, el resto de modos especiales se 
ajustará en Off).

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /  
20 / 30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (hora)

Ajusta el intervalo entre grabaciones en 
el modo de grabación Interval Rec 
(cuando Interval Rec está ajustado en 
On).

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
Los ajustes disponibles dependen de la 
frecuencia de fotogramas del formato de 
vídeo seleccionado.
50P/59.94P: 

2frames / 6frames / 12frames
23.98P/25P/29.97P/50i/59.94i: 

1frame / 3frames / 6frames / 9frames

Ajusta el número de fotogramas que se 
desea grabar por toma en el modo de 
grabación Interval Rec (cuando Interval 
Rec está ajustado en On).



6. Pantalla de menús y ajustes: Menú Project91

Project >Interval Rec
Ajusta el modo de grabación de intervalos (página 48).

Elemento Ajuste de subelementos Descripción

Pre-Lighting Off / 2sec / 5sec / 10sec Ajusta el número de segundos que se 
enciende la luz de vídeo antes de que se 
inicie la grabación en el modo de 
grabación Interval Rec.

[Consejo]
Disponible únicamente cuando se utiliza el 
HVL-LBPC (opcional).

Project >Picture Cache Rec
Configura los ajustes del modo Picture Cache Rec (página 49).

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el modo de grabación 
de memoria intermedia.

Cache Rec 
Time

Los ajustes varían en función del ajuste del 
formato de grabación.

Ajusta la hora de acumulación de las 
imágenes en la memoria intermedia de 
imágenes (hora de grabación de 
memoria intermedia de imágenes).

Project >SDI/HDMI Rec Control
Configura los ajustes de control de grabación SDI/HDMI.

Elemento Ajuste de subelementos Descripción

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Establece el control de inicio/parada de 
grabación de un dispositivo externo 
mediante la señal de salida SDI/HDMI.
Off: 

No usa el control remoto.
SDI/HDMI Remote I/F: 

Control de detención/inicio de 
grabación de un dispositivo externo 
conectado, cuando no hay ningún 
soporte insertado en la videocámara. 
No se ha sincronizado con la 
precisión de fotogramas para el 
soporte de la videocámara.

Parallel Rec: 
Control de detención/inicio de 
grabación de un dispositivo externo 
conectado, cuando hay un soporte 
insertado en la videocámara. 
Sincronizado con la precisión de 
fotogramas para el soporte de la 
videocámara.

Project >Assignable Button
Ajusta las asignaciones de funciones en los botones asignables.

Elemento Ajuste de subelementos Descripción

<1> a <10>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / Push 
AGC / ND Filter Position / Auto ND Filter / 
Push Auto ND / Auto Iris / Push Auto Iris / 
Auto Shutter / Auto Exposure Level / 
Backlight / Spotlight / Preset White 
Select / ATW / ATW Hold / AF Speed/
Sens. / Focus Setting / Focus Area / Focus 
Area(AF-S) / Face/Eye Detection AF / Push 
AF Mode / Push AF/Push MF / Focus 
Hold / Focus Magnifier x3/x6 / Focus 
Magnifier x3 / Focus Magnifier x6 / S&Q 
Motion / SteadyShot / Rec / Picture Cache 
Rec / Rec Review / Last Clip Del. / Shot 
Mark1 / Shot Mark2 / Clip Flag OK / Clip 
Flag NG / Clip Flag Keep / Color Bars / Tally 
[Front] / DURATION/TC/U-BIT / Display / 
Lens Info / Video Signal Monitor / Marker / 
VF Adjust / VF Mode / Gamma Display 
Assist / Peaking / Zebra / Thumbnail / 
Touch Operation / Handle Zoom / NFC / 
Network Client Mode / Auto Upload 
(Proxy) / Direct Menu / User Menu / Menu

Asigna funciones a los botones asignables.
Base ISO/Sensitivity: 

Cambia la sensibilidad base del 
sensor de imagen.

AGC: 
Activa y desactiva la función AGC.

Push AGC: 
Habilita la función AGC mientras se 
mantiene pulsado el botón.

ND Filter Position: 
Cambia los filtros ND.

Auto ND Filter: 
Activa y desactiva la función de filtro ND.

Push Auto ND: 
Habilita la función Auto ND Filter 
mientras se mantiene pulsado el botón.

Auto Iris: 
Activa y desactiva la función del 
diafragma.

Push Auto Iris: 
Habilita la función de diafragma 
automático mientras se mantenga 
pulsado el botón.

Auto Shutter: 
Activa y desactiva la función del 
obturador automático.

Auto Exposure Level: 
Muestra/sale del menú directo de 
Auto Exposure Level.

Backlight: 
Cambia entre retroiluminación y 
estándar.

Spotlight: 
Cambia entre luz direccional y estándar.

Preset White Select: 
Cambia el valor del modo 
predeterminado del balance de 
blancos.

ATW: 
Activa y desactiva la función ATW.

ATW Hold: 
Pausa la operación de la función ATW.
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Project >Assignable Button
Ajusta las asignaciones de funciones en los botones asignables.

Elemento Ajuste de subelementos Descripción

<1> a <10>, 
Focus Hold 
Button

AF Speed/Sens.: 
Cambia el ajuste de la velocidad de 
transición AF y el ajuste de la sensibilidad 
de desplazamiento del sujeto AF.

Focus Setting: 
Establece el área de enfoque.

Focus Area: 
Establece el área de enfoque para AF 
y Push AF.

Focus Area(AF-S): 
Establece el área de enfoque para 
Push AF (AF-S).

Face/Eye Detection AF: 
Cambia la configuración del AF de 
detección de caras/ojos.

Push AF Mode: 
Cambia la configuración del modo 
Push AF.

Push AF/Push MF: 
En el modo de enfoque MF, activa AF 
mientras se presiona el botón. 
En el modo de enfoque AF, activa MF 
mientras se presiona el botón.

Focus Hold: 
En el modo de enfoque AF, el enfoque 
se fija mientras se presiona el botón.

Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6: 

Activa y desactiva la función de 
ampliación de enfoque.

S&Q Motion: 
Activa y desactiva Slow & Quick 
Motion. 
Establece la velocidad de fotogramas 
de grabación si se mantiene pulsado.

SteadyShot: 
Cambia entre Active, Standard y Off.

Rec: 
Inicia y detiene la grabación.

Picture Cache Rec: 
Activa y desactiva el modo de 
grabación de memoria intermedia.

Project >Assignable Button
Ajusta las asignaciones de funciones en los botones asignables.

Elemento Ajuste de subelementos Descripción

<1> a <10>, 
Focus Hold 
Button

Rec Review: 
Activa y desactiva la función Rec 
Review.

Last Clip Del.: 
Ejecuta la última función de 
eliminación de clip (para repetir).

Shot Mark1: 
Ejecuta la función Add Shot Mark1.

Shot Mark2: 
Ejecuta la función Add Shot Mark2.

Clip Flag OK: 
Ejecuta la función Add OK. 
Pulse dos veces para ejecutar Delete 
Clip Flag.

Clip Flag NG: 
Ejecuta la función Add NG. 
Pulse dos veces para ejecutar Delete 
Clip Flag.

Clip Flag Keep: 
Ejecuta la función Add Keep. 
Pulse dos veces para ejecutar Delete 
Clip Flag.

Color Bars: 
Activa y desactiva las barras de colores.

Tally [Front]: 
Activa y desactiva la función de 
grabación/lámpara indicadora 
(frontal)/parpadeo.

DURATION/TC/U-BIT: 
Alterna entre Time Code, Users Bit y 
Duration.

Display: 
Activa y desactiva los indicadores de 
la pantalla.

Lens Info: 
Cambia el indicador de profundidad 
de campo.

Video Signal Monitor: 
Cambia el monitor de señal de vídeo 
(como un monitor de forma de onda).

Marker: 
Activa y desactiva la función de 
marcador.
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Project >Assignable Button
Ajusta las asignaciones de funciones en los botones asignables.

Elemento Ajuste de subelementos Descripción

<1> a <10>, 
Focus Hold 
Button

VF Adjust: 
Muestra las barras de nivel para el 
ajuste del brillo de la pantalla del 
visor.

VF Mode: 
Cambia la visualización del visor 
entre color y blanco y negro.

Gamma Display Assist: 
Cambia la función de asistencia de 
visualización de gamma.

Peaking: 
Activa y desactiva la función de 
nitidez.

Zebra: 
Activa y desactiva la función cebra.

Thumbnail: 
Muestra/sale de la pantalla de 
imágenes en miniatura.

Touch Operation: 
Activa y desactiva el funcionamiento 
táctil.

Handle Zoom: 
Cambia el funcionamiento del zoom 
del asa.

NFC: 
Ejecuta la función NFC.

Network Client Mode: 
Activa y desactiva el modo cliente en 
red.

Auto Upload (Proxy): 
Activa y desactiva la transferencia 
automática de los archivos proxy.

Direct Menu: 
Muestra/sale del menú directo.

User Menu: 
Muestra/sale del menú User.

Menu: 
Muestra/sale del menú de 
configuración.

Project >Assignable Dial
Establece las asignaciones de funciones para el dial asignable y ajusta el sentido de rotación.

Elemento Ajuste de subelementos Descripción

Assignable 
Dial

Off / ISO/Gain/EI / ND Filter / IRIS /  
Audio Input Level

Asigna funciones al dial asignable.
ISO/Gain/EI: 

Ajusta la ganancia o EI.
ND Filter: 

Ajusta el filtro ND.
IRIS: 

Ajusta el diafragma.
Audio Input Level: 

Ajusta el nivel de grabación de audio.

Assignable 
Dial Direction

Normal / Opposite Ajusta el sentido de rotación del dial 
asignable.
Normal: girar en sentido normal.
Opposite: Girar en sentido contrario.

Project >Multi Function Dial
Asigna funciones al dial multifunción.

Elemento Ajuste de subelementos Descripción

Default 
Function

Off / IRIS / ISO/Gain/EI / Audio Input Level Asigna la función predeterminada al dial 
multifunción.
IRIS: 

Ajusta el diafragma.
ISO/Gain/EI: 

Ajusta la ganancia o EI.
Audio Input Level: 

Ajusta el nivel de grabación de audio.

Project >User File
Establece configuraciones relacionadas con las operaciones de archivos de usuario.

Elemento Ajuste de subelementos Descripción

Load Utility 
SD/MS

Execute / Cancel Carga la configuración del archivo de 
usuario desde una tarjeta SD.
Execute: ejecuta la función.

Save Utility 
SD/MS

Execute / Cancel Guarda la configuración del archivo de 
usuario a una tarjeta SD.
Execute: ejecuta la función.

File ID Muestra una pantalla para mostrar/editar 
el identificador de archivo de los archivos 
de usuario.

Load 
Customize 
Data

On / Off Establece si desea cargar la información 
personalizada del menú User al ejecutar 
Load Utility SD/MS.
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Project >User File
Establece configuraciones relacionadas con las operaciones de archivos de usuario.

Elemento Ajuste de subelementos Descripción

Load White 
Data

On / Off Establece si desea cargar la información 
del balance de blancos al ejecutar Load 
Utility SD/MS.

Project >All File
Configura los ajustes relacionados con los archivos ALL.

Elemento Ajuste de subelementos Descripción

Load Utility 
SD/MS

Execute / Cancel Carga un archivo ALL.
Execute: ejecuta la función.

Save Utility 
SD/MS

Execute / Cancel Guarda un archivo ALL.
Execute: ejecuta la función.

File ID Asigna un nombre al archivo.

Load Network 
Data

On / Off Establece si desea cargar la información 
configurada del menú Network al 
ejecutar Load Utility SD/MS.

Project >Planning Metadata
Configura los ajustes relacionados con las operaciones de metadatos de planificación.

Elemento Ajuste de subelementos Descripción

Load 
Media(A) o 
Load 
Media(B)

Execute / Cancel Carga los metadatos de planificación 
desde la tarjeta de memoria situada en 
las ranuras A o B.
Seleccione Execute para que se muestre 
la lista de los archivos de metadatos de 
planificación almacenados en la tarjeta 
de memoria de la ranura A o B. 
Seleccione un archivo con Load y, a 
continuación, seleccione Execute para 
cargar el archivo.

[Notas]
ˎˎ 	En la lista de archivos se muestran hasta 

64 archivos. Aunque el número total de 
archivos de metadatos de planificación 
sea 64 o menos, es posible que no todos 
los archivos de metadatos de planificación 
aparezcan si el directorio en el que 
están ubicados en la tarjeta de memoria 
(XDROOT/General/Sony/Planning) contiene 
512 archivos o más.
ˎˎ 	En cuanto empiece a cargar, no retire la 

tarjeta de memoria hasta que se muestre el 
mensaje de finalización.

Project >Planning Metadata
Configura los ajustes relacionados con las operaciones de metadatos de planificación.

Elemento Ajuste de subelementos Descripción

Properties Execute / Cancel Seleccione Execute para mostrar las 
propiedades de los metadatos de 
planificación cargados en la memoria de 
la videocámara.
File Name: 

Nombre del archivo
Assign ID: 

ID asignado
Created: 

Hora y fecha de creación del archivo
Modified: 

Hora y fecha de la modificación del 
archivo más reciente

Modified by: 
Nombre de la persona que modificó 
el archivo

Title1: 
Title1 especificado en el archivo 
(nombre del clip en formato ASCII)

Title2: 
Title2 especificado en el archivo 
(nombre del clip en formato UTF-8)

Material Group: 
Número de grupos de material 
(grupos de clips grabados utilizando 
los mismos metadatos de 
planificación)

Shot Mark0 a 9: 
Nombres definidos para las marcas 
de disparo 0 a 9

Clear 
Memory

Execute / Cancel Seleccione Execute para borrar los 
metadatos de planificación cargados en 
la memoria de la videocámara.

Clip Name 
Display

Title1(ASCII) / Title2(UTF-8) Establece el modo de visualización del 
nombre del clip especificado en los 
metadatos de planificación.
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Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Paint >HDR Paint Setting
Configura los ajustes de High Dynamic Range (HDR).

Elemento Ajuste de subelementos Descripción

HLG Look Natural / Live Establece el tipo de HLG cuando 
Shooting Mode está ajustado en HDR.
Natural: 

Característica conforme a ITU-R 
BT.2100(HLG).

Live: 
Característica conforme a ITU-R 
BT.2100(HLG) que ofrece un mejor 
rendimiento de HDR.

[Nota]
El uso de la opción Live puede aumentar el 
nivel de ruido.

HDR Black 
Offset

De –95 a +103 (±0) Establece la desviación de negro de HDR 
en relación con el ajuste de SDR (Master 
Black) cuando Shooting Mode está 
ajustado en HDR.

HDR Knee On / Off Activa/desactiva la función de corrección 
de la inflexión de la señal HDR cuando 
Shooting Mode está ajustado en HDR.

HDR Knee 
Point

De –99 a +99 (±0) Establece el punto de inflexión de las 
señales HDR cuando HDR Knee está 
ajustado en On.

HDR Knee 
Slope

De –99 a +99 (±0) Establece la pendiente de inflexión de las 
señales HDR cuando HDR Knee está 
ajustado en On.

Paint >Black
Configura los ajustes de negro.

Elemento Ajuste de subelementos Descripción

Master Black De –99.0 a +99.0 (±0.0) Ajusta el nivel de negro maestro.

R Black De –99.0 a +99.0 (±0.0) Ajusta el nivel de negro R.

B Black De –99.0 a +99.0 (±0.0) Ajusta el nivel de negro B.

Paint >Gamma
Configura los ajustes de corrección de gamma.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de 
corrección gamma.

Step Gamma De 0.35 a 0.45 a 0.90 Ajusta un valor de corrección gamma en 
incrementos de 0,05.

Master 
Gamma

De –99 a +99 (±0) Ajusta el nivel de gamma maestro.

R Gamma De –99 a +99 (±0) Ajusta el nivel de gamma R.

G Gamma De –99 a +99 (±0) Ajusta el nivel de gamma G.

B Gamma De –99 a +99 (±0) Ajusta el nivel de gamma B.

Gamma 
Category

Original / STD / HG / S-Log3 Selecciona gamma original (Original), 
gamma estándar (STD), hipergamma 
(HG) o S-Log3.

Gamma 
Select

Cuando Gamma Category está ajustado en 
STD:

STD1 DVW / STD2 ×4.5 / STD3 ×3.5 / 
STD4 240M / STD5 R709 / STD6 ×5.0

Cuando Gamma Category está ajustado en 
HG:

HG1 3250G36 / HG2 4600G30 / HG3 
3259G40 / HG4 4609G33 / HG7 
8009G40 / HG8 8009G33

Cuando Gamma Category está ajustado en 
S-Log3:

S-Log3
Cuando Gamma Category está ajustado en 
Original:

S-Cinetone

Selecciona la tabla de gamma utilizada 
para la corrección gamma.
Consulte la tabla siguiente para obtener 
más información acerca de HyperGamma 
y S-Log3.

Nombre Rango 
dinámico

Límite 
blanco

Salida de 
vídeo de 
tarjeta gris 
18% (entrada 
de vídeo 
20%)

HG1 3250G36 325% 100% 36%

HG2 4600G30 460% 100% 30%

HG3 3259G40 325% 109% 40%

HG4 4609G33 460% 109% 33%

HG7 8009G40 800% 109% 40%

HG8 8009G33 800% 109% 33%

S-Log3 1300% – 41%

Menú Paint
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Paint >Black Gamma
Configura los ajustes de corrección de gamma de negro.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de 
corrección gamma de negro.
(Habilitado cuando Gamma >Gamma 
Category está ajustado en STD)

[Nota]
Las funciones Black Gamma y Knee 
>Knee Saturation no se pueden utilizar 
simultáneamente.

Range Low / L.Mid / H.Mid Selecciona el rango efectivo de 
corrección gamma del negro.

Master Black 
Gamma

De –99 a +99 (±0) Ajusta el nivel de gama del negro 
maestro.

Paint >Knee
Configura los ajustes de corrección de inflexión.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de 
corrección de inflexión.
(Habilitado cuando Gamma >Gamma 
Category está ajustado en STD)

Auto Knee On / Off Activa y desactiva la función de inflexión 
automática.

Point De 75% a 109% (90%) Ajusta el punto de inflexión.

Slope De –99 a +99 (±0) ajusta la pendiente de inflexión.

Knee 
Saturation

On / Off Habilita/inhabilita el ajuste de la 
saturación de inflexión (ajusta los colores 
por encima del punto de inflexión).

[Nota]
Las funciones Black Gamma y Knee 
>Knee Saturation no se pueden utilizar 
simultáneamente.

Knee 
Saturation 
Level

De –99 a +99 (±0) Ajusta el nivel de ajuste de colores por 
encima del punto de inflexión (saturación 
de inflexión).

Paint >White Clip
Configura los ajustes de ajuste de picos del blanco.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de ajuste de 
sobreexposición de blancos.
(Habilitado cuando Gamma >Gamma 
Category está ajustado en STD)

[Nota]
El ajuste se restablece en On cuando se apaga 
la videocámara. Para establecerlo en Off de 
manera permanente, ajuste Level en 109%.

Level De 90.0% a 109.0% Ajusta el nivel de limitación de picos del 
blanco.

Paint >Detail(4K/QFHD)
Configura las opciones de ajuste (4K/QFHD) de detalles.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de ajuste de 
detalles.

Level De –99 a +99 (±0) Ajusta el nivel de detalle.

H/V Ratio De –99 a +99 (±0) Ajusta la relación de mezcla entre el nivel 
de detalle H y el nivel de detalle V.

Crispening De –99 a +99 (±0) Establece el nivel de nitidez.

Frequency De –99 a +99 (±0) Ajusta la frecuencia central del detalle 
(grosor del detalle).
El detalle será más fino cuanto mayor sea 
la frecuencia central y será más grueso 
cuanto menor sea la frecuencia central.

Knee 
Aperture

On / Off Activa y desactiva la función de apertura 
de inflexión.

Knee 
Aperture 
Level

De –99 a +99 (±0) Establece el nivel de apertura de 
inflexión.

White Limit De –99 a +99 (±0) Ajusta el limitador del detalle de los 
blancos.

Black Limit De –99 a +99 (±0) Ajusta el limitador del detalle de los 
negros.

V Detail 
Creation

NAM / Y / G / G+R Ajusta la fuente de señal para crear el 
detalle V en NAM (G o R, el que sea 
mayor), Y, G o G+R.
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Paint >Detail(HD)
Configura los ajustes de ajuste (HD) de detalles.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de ajuste de 
detalles.

Level De –99 a +99 (±0) Ajusta el nivel de detalle.

H/V Ratio De –99 a +99 (±0) Ajusta la relación de mezcla entre el nivel 
de detalle H y el nivel de detalle V.

Crispening De –99 a +99 (±0) Establece el nivel de nitidez.

Frequency De –99 a +99 (±0) Ajusta la frecuencia central del detalle 
(grosor del detalle).
El detalle será más fino cuanto mayor sea 
la frecuencia central y será más grueso 
cuanto menor sea la frecuencia central.

Knee 
Aperture

On / Off Activa y desactiva la función de apertura 
de inflexión.

Knee 
Aperture 
Level

De –99 a +99 (±0) Establece el nivel de apertura de 
inflexión.

White Limit De –99 a +99 (±0) Ajusta el limitador del detalle de los 
blancos.

Black Limit De –99 a +99 (±0) Ajusta el limitador del detalle de los 
negros.

V Detail 
Creation

NAM / Y / G / G+R Ajusta la fuente de señal para crear el 
detalle V en NAM (G o R, el que sea 
mayor), Y, G o G+R.

Paint >Skin Detail
Configura los ajustes de corrección de las imperfecciones de la piel.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de 
corrección de las imperfecciones de la 
piel.

Area 
Detection

Execute / Cancel Detecta el color utilizado para la 
corrección de las imperfecciones de la 
piel.
Execute: ejecuta la función.

Area 
Indication

On / Off Activa y desactiva la función que muestra 
el patrón de cebra en el área de color de 
destino de la corrección de las 
imperfecciones de la piel.

Level De –99 a +99 (±0) Ajusta el nivel de detalle de la piel.

Paint >Skin Detail
Configura los ajustes de corrección de las imperfecciones de la piel.

Elemento Ajuste de subelementos Descripción

Saturation De –99 a +99 (±0) Ajusta la saturación del color que es 
objeto de la corrección de las 
imperfecciones de la piel.

Hue De 0 a 359 Ajusta el matiz del color que es objeto de 
la corrección de las imperfecciones de la 
piel.

Width De 0 a 90 (40) Ajusta el rango del matiz del color que es 
objeto de la corrección de las 
imperfecciones de la piel.

Paint >Aperture
Configura los ajustes de corrección de apertura.

Elemento Ajuste de subelementos Descripción

Setting On / Off Habilita/inhabilita la corrección de la 
apertura (procesamiento que mejora la 
resolución al añadir una señal de 
apertura de alta frecuencia a la señal de 
vídeo para corregir el deterioro producido 
por las características de alta frecuencia).

Level De –99 a +99 (±0) Establece el nivel de corrección de 
apertura.

Paint >Matrix
Configura los ajustes de corrección de matrices.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de 
corrección matricial.

Adaptive 
Matrix

On / Off Activa y desactiva la función de matriz 
adaptable.

Preset Matrix On / Off Activa y desactiva la función de matriz 
predeterminada.

Preset Select S-Cinetone / Standard / FL Light /  
Cinema / BT.709 / BT.2020

Selecciona una matriz predeterminada.

User Matrix On / Off Activa y desactiva la función de 
corrección matricial del usuario.

User Matrix 
Level

De –99 a +99 (±0) Ajusta la saturación de color de toda la 
imagen.

User Matrix 
Phase

De –99 a +99 (±0) Ajusta el tono de color (fase) de toda la 
imagen.
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Paint >Matrix
Configura los ajustes de corrección de matrices.

Elemento Ajuste de subelementos Descripción

User Matrix 
R-G

De –99 a +99 (±0) Ajusta una matriz del usuario R-G 
definida por el usuario.

User Matrix 
R-B

De –99 a +99 (±0) Ajusta una matriz del usuario R-B 
definida por el usuario.

User Matrix 
G-R

De –99 a +99 (±0) Ajusta una matriz del usuario G-R 
definida por el usuario.

User Matrix 
G-B

De –99 a +99 (±0) Ajusta una matriz del usuario G-B 
definida por el usuario.

User Matrix 
B-R

De –99 a +99 (±0) Ajusta una matriz del usuario B-R 
definida por el usuario.

User Matrix 
B-G

De –99 a +99 (±0) Ajusta una matriz del usuario B-G 
definida por el usuario.

Paint >Multi Matrix
Configura los ajustes de corrección de matrices múltiples.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de 
corrección de matrices múltiples.

Area 
Indication

On / Off Activa y desactiva la función de 
indicación de área.

Color 
Detection

Execute / Cancel Detecta el color utilizado para la 
corrección de matrices múltiples.

Reset Execute / Cancel Restablece el tono y la saturación de 
cada color de eje a los valores 
predeterminados.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Selecciona el eje.

Hue De –99 a +99 (±0) Ajusta el matiz del color utilizado para la 
corrección de matrices múltiples.

Saturation De –99 a +99 (±0) Ajusta la saturación del color utilizado 
para la corrección de matrices múltiples.

Paint >Scene File
Configura los ajustes relacionados con los archivos de escena.

Elemento Ajuste de subelementos Descripción

Recall 
Internal 
Memory

Carga un archivo de escena desde la 
memoria interna.

Paint >Scene File
Configura los ajustes relacionados con los archivos de escena.

Elemento Ajuste de subelementos Descripción

Store Internal 
Memory

Execute / Cancel Guarda un archivo de escena en la 
memoria interna.
Execute: ejecuta la función.

Load Utility 
SD/MS

Execute / Cancel Carga un archivo de escena desde una 
tarjeta SD.
Execute: ejecuta la función.

Save Utility 
SD/MS

Execute / Cancel Guarda un archivo de escena en una 
tarjeta SD.
Execute: ejecuta la función.

File ID Asigna un nombre al archivo.

Scene White 
Data

On / Off Ajusta si se deben aplicar los datos de 
balance de blancos cuando se cargan 
archivos de escena.
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Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

TC/Media >Timecode
Configura los ajustes de código de tiempo.

Elemento Ajuste de subelementos Descripción

Mode Preset / Regen / Clock Ajusta el modo de ejecución del código 
de tiempo.
Preset: 

Empieza a funcionar a partir de un 
valor preestablecido.

Regen: 
Empieza a funcionar a partir del 
código de tiempo del final del clip 
anterior.

Clock: 
Utiliza el reloj interno como código 
de tiempo.

Run Rec Run / Free Run Rec Run: Funciona solo durante la 
grabación.

Free Run: Funciona siempre, 
independientemente del 
funcionamiento del camcorder.

Setting Ajusta el código de tiempo en un valor 
arbitrario.
SET: Ajustar el valor.

Reset Execute / Cancel Restablece el valor del código de tiempo 
a 00:00:00:00.
Execute: ejecuta la función.

TC Format DF / NDF Ajusta el formato del código de tiempo.
DF: Omisión de fotograma
NDF: No omisión de fotograma

TC/Media >TC Display
Configura los ajustes de visualización de datos de tiempo.

Elemento Ajuste de subelementos Descripción

Display Select Timecode / Users Bit / Duration Cambia la visualización de datos de 
tiempo.

TC/Media >Users Bit
Configura los ajustes relacionados con los bits de usuario.

Elemento Ajuste de subelementos Descripción

Mode Fix / Time Ajusta el modo de bit de usuario.
Fix: Utiliza un valor fijo arbitrario en bits 

de usuario.
Time: Utiliza la hora actual en bits de 

usuario.

Setting Ajusta los bits de usuario en un valor 
arbitrario.

TC/Media >HDMI TC Out
Configura los ajustes relacionados con la salida de código de tiempo cuando se utiliza HDMI.

Elemento Ajuste de subelementos Descripción

Setting On / Off Ajusta si enviar la salida del código de 
tiempo a dispositivos con otros objetivos, 
mediante HDMI.

TC/Media >Clip Name Format
Configura los ajustes relacionados con el nombre y la eliminación de los clips.

Elemento Ajuste de subelementos Descripción

Auto Naming Title / Plan Selecciona el formato del nombre de los 
clips.
Title: 

Establece la nomenclatura 
especificada por el Title Prefix.

Plan: 
Utiliza un nombre de clip 
especificado en los metadatos de 
planificación, si está disponible. Si no 
se especifica ningún nombre en los 
metadatos de planificación, se 
utilizará el nombre especificado en 
Title Prefix.

Menú TC/Media
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TC/Media >Clip Name Format
Configura los ajustes relacionados con el nombre y la eliminación de los clips.

Elemento Ajuste de subelementos Descripción

Title Prefix nnn_ (nnn son los 3 últimos dígitos del 
número de serie)
(Visualización de un máximo de 7 dígitos)

Establece la parte del título (de 4 a 46 
caracteres) del nombre del clip.
Abre una pantalla de introducción de 
cadenas de caracteres.

Estructura de la pantalla de 
introducción de cadenas de caracteres
Área de selección de caracteres (3 líneas): 

Selecciona los caracteres que se van 
a introducir en la posición del cursor 
del área Title Prefix.  
!#$%()+.-.;=@[ ]^_~0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Área de operación del cursor (1 línea): 
Espacio: inserta un espacio en la 
posición del cursor.  
: mueve el cursor hacia la 
izquierda.  
: mueve el cursor hacia la derecha.  
BS: elimina el carácter situado a la 
izquierda del cursor.

Área de prefijo de título (1 línea): 
Área para indicar el título.

Para establecer el título
1.	 Seleccione el carácter que desea 

insertar en la posición del cursor en 
el área Title Prefix desde el área de 
selección de caracteres con los 
botones de flechas y pulse el botón 
SET. (Se inserta el carácter 
seleccionado y el cursor se mueve 
hacia la derecha).

2.	 Repita el paso 1 para establecer el 
título. (Utilice BS según sea 
necesario.)

3.	 Tras establecer el título, seleccione 
Done para cerrar la pantalla de 
introducción de caracteres.

TC/Media >Clip Name Format
Configura los ajustes relacionados con el nombre y la eliminación de los clips.

Elemento Ajuste de subelementos Descripción

Number Set Cuando Auto Naming se ajusta en Title: 
0001 a 9999

Cuando Auto Naming se ajusta en Plan: 
00001 a 99999

Establece el sufijo formado por un 
número de 4 dígitos del nombre del clip.
Establece un número de 5 dígitos si se 
utiliza un archivo de metadatos de 
planificación.

TC/Media >Update Media
Actualiza el archivo de gestión en las tarjetas de memoria.

Elemento Ajuste de subelementos Descripción

Media(A) Execute / Cancel Actualiza el archivo de gestión en la 
tarjeta de memoria XQD en la ranura A.
Execute: ejecuta la función.

Media(B) Execute / Cancel Actualiza el archivo de gestión en la 
tarjeta de memoria XQD en la ranura B.
Execute: ejecuta la función.

TC/Media >Format Media
Inicializa las tarjetas de memoria.

Elemento Ajuste de subelementos Descripción

Media(A) Execute / Cancel Inicializa la tarjeta de memoria XQD en la 
ranura A.
Execute: ejecuta la función.

Media(B) Execute / Cancel Inicializa la tarjeta de memoria XQD en la 
ranura B.
Execute: ejecuta la función.

Utility SD/MS Execute / Cancel Inicializa la tarjeta UTILITY SD.
Execute: ejecuta la función.
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Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Monitoring >Output On/Off
Configura los ajustes de salida de vídeo.

Elemento Ajuste de subelementos Descripción

SDI1 On / Off Activa y desactiva la salida SDI1.

SDI2 On / Off Activa y desactiva la salida SDI2.

HDMI On / Off Activa y desactiva la salida HDMI.

Monitoring >Output Format
Configura los ajustes del formato de salida.

Elemento Ajuste de subelementos Descripción

SDI1 Para obtener más detalles acerca de los 
ajustes, consulte “Limitaciones y formatos 
de salida” (página 124).

Ajusta la resolución de salida de SDI y 
HDMI.

[Nota]
Es posible que el ajuste de Output Format no 
se pueda configurar en el modo Picture Cache 
Rec. Si esto sucede, ajuste temporalmente 
Picture Cache Rec en Off y, a continuación, 
cambie el ajuste.

SDI2

HDMI

REF

Monitoring >Output Setting
Establece los ajustes del modo de conversión de salida.

Elemento Ajuste de subelementos Descripción

RAW to HD 
Conv.

Edge Crop / Letter Box Establece el modo de conversión de la 
salida de vídeo HD de vídeo 17:9.

Monitoring >Output Display
Configura los ajustes de la señal de salida.

Elemento Ajuste de subelementos Descripción

Setting On / Off Selecciona si se superponen los menús y 
los estados en la señal de salida de SDI y 
en la señal de salida de HDMI.

SDI1 Los ajustes dependen de la configuración 
de Output Format. Para obtener más 
detalles, consulte “Limitaciones y formatos 
de salida” (página 124).

Muestra si el menú y la información de 
estado están integrados en la señal de 
salida SDI1.

SDI2 Muestra si el menú y la información de 
estado están integrados en la señal de 
salida SDI2.

HDMI Muestra si el menú y la información de 
estado están integrados en la señal de 
salida HDMI.

Monitoring >Display On/Off
Configura los ajustes de los elementos de la pantalla.

Elemento Ajuste de subelementos Descripción

Network 
Status

On / Off Selecciona los elementos que se 
visualizan en el visor.

File Transfer 
Status

On / Off

NCM/
Streaming 
Status

On / Off

Rec/Play 
Status

On / Off

RAW Output 
Control 
Status

On / Off

Tally On / Off

Battery 
Remain

On / Off

Focus Mode On / Off

Focus 
Position

On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind.(AF-S)

On / Off

Face/Eye 
Detection 
Frame

On / Off

Lens Info On / Off

Imager Scan 
Mode

On / Off

Rec Format On / Off

Frame Rate On / Off

Zoom 
Position

On / Off

UWP RF Level On / Off

GPS On / Off

SteadyShot On / Off

Menú Monitoring
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Monitoring >Display On/Off
Configura los ajustes de los elementos de la pantalla.

Elemento Ajuste de subelementos Descripción

Gamma/LUT On / Off

SDI/HDMI 
Rec Control

On / Off

Gamma 
Display Assist

On / Off

Proxy Status On / Off

Base ISO/
Sensitivity

On / Off

Media Status On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Clip Name On / Off

White 
Balance

On / Off

Scene File On / Off

Focus 
Indicator

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

Timecode On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Shutter On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Configura los ajustes de visualización de marcadores.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la visualización de 
todos los marcadores.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Selecciona el color de la señal de los 
marcadores.

Center 
Marker

1 / 2 / 3 / 4 / Off Selecciona el marcador central.

Safety Zone On / Off Activa y desactiva el marcador de la zona 
de seguridad.

Safety Area 80% / 90% / 92.5% / 95% Selecciona el tamaño del marcador de la 
zona de seguridad (como un porcentaje 
del tamaño total de la pantalla).

Aspect 
Marker

Line / Mask / Off Selecciona el tipo de marcador de 
aspecto.

Aspect Mask De 0 a 15 (12) Ajusta el nivel de la señal de vídeo fuera 
del marcador.

Aspect Safety 
Zone

On / Off Activa y desactiva el marcador de la zona 
de seguridad de aspecto.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Selecciona el tamaño del marcador de la 
zona de seguridad de aspecto (como un 
porcentaje del tamaño total de la 
pantalla).

Aspect Select 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 /  
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1

Ajusta el modo cuando se muestra el 
marcador de aspecto.

Guide Frame On / Off Activa y desactiva la visualización del 
fotograma de la imagen.

100% Marker On / Off Activa y desactiva el marcador de 100%.

User Box On / Off Activa y desactiva la visualización del 
marcador de casilla del usuario.

User Box 
Width

De 3 a 479 (240) Ajusta la amplitud del marcador de 
casilla de usuario (distancia del centro a 
los bordes derecho e izquierdo).

User Box 
Height

De 3 a 269 (135) Ajusta la altura del marcador de casilla 
de usuario (distancia del centro a los 
bordes superior e inferior).

User Box H 
Position

De –476 a +476 (0) Establece la posición horizontal del 
centro del marcador de la casilla de 
usuario.

User Box V 
Position

De –266 a +266 (0) Establece la posición vertical del centro 
del marcador de la casilla de usuario.
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Monitoring >VF Setting
Configura los ajustes del visor.

Elemento Ajuste de subelementos Descripción

Contrast De –99 a +99 (±0) Ajusta el contraste (diferencia entre claro 
y oscuro) de la imagen del visor.

Brightness De –99 a +99 (±0) Ajusta el brillo de la imagen del visor.

Color Mode Color / B&W Selecciona el modo de visualización del 
visor en modo E-E/grabación.

Monitoring >Gamma Display Assist
Ajusta la asistencia de la visualización de gamma.

Elemento Ajuste de subelementos Descripción

Setting En los modos SDR o Cine EI:
On / Off

En el modo HDR:
On / Off

Activa y desactiva la función de 
asistencia de visualización de gamma.

Monitoring >Peaking
Configura los ajustes de nitidez.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función de nitidez.

Type Normal / Color Selecciona el tipo de nitidez.
Normal: Nitidez normal
Color: Nitidez del color

Normal 
Peaking 
Frequency

Normal / High Selecciona la frecuencia de nitidez.

Normal 
Peaking Level

De 0 a 99 (50) Ajusta el nivel de nitidez normal.

Color B&W / Red / Yellow / Blue Selecciona el color de la señal de nitidez 
de color.

Color Peaking 
Level

De 0 a 99 (50) Ajusta el nivel de nitidez de color.

Monitoring >Zebra
Configura los ajustes de los patrones de cebra.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función cebra.

Zebra Select 1 / 2 / Both Selecciona el tipo de patrón de cebra 
(Zebra 1, Zebra 2, Both).

Zebra1 Level De 0% a 107% (70%) Ajusta el nivel de visualización de Zebra 
1.

Monitoring >Zebra
Configura los ajustes de los patrones de cebra.

Elemento Ajuste de subelementos Descripción

Zebra1 
Aperture 
Level

De 1% a 20% (10%) Ajusta el nivel de apertura de Zebra 1.

Zebra2 Level De 0% a 109% (100%) Ajusta el nivel de visualización de Zebra 
2.
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Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).
Consulte “Diagramas de bloques” (página 141).

Audio >Audio Input
Configura los ajustes de entrada de audio.

Elemento Ajuste de subelementos Descripción

CH1 MI SHOE 
Input Select

Shoe CH1 / Wireless Configura la función de entrada externa 
cuando el interruptor de selección CH1 
INPUT (página 7) está ajustado en MI 
SHOE.

[Nota]
“Wireless” solo se muestra cuando hay un 
módulo de ampliación acoplado.

CH2 EXT 
Input Select

INPUT1 / INPUT2 Cambia la fuente de entrada externa para 
la grabación en el canal 2.

CH2 MI SHOE 
Input Select

Shoe CH2 / Wireless Configura la función de entrada externa 
cuando el interruptor de selección CH2 
INPUT (página 7) está ajustado en MI 
SHOE.

[Nota]
“Wireless” solo se muestra cuando hay un 
módulo de ampliación acoplado.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 / 
Wireless

Cambia la fuente de entrada para la 
grabación en el canal 3.

[Nota]
“Wireless” solo puede seleccionarse cuando 
hay un módulo de ampliación acoplado.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2 / Wireless

Cambia la fuente de entrada para la 
grabación en el canal 4.

[Nota]
“Wireless” solo puede seleccionarse cuando 
hay un módulo de ampliación acoplado.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Ajusta el nivel de la grabación de 
referencia para la entrada del micrófono 
XLR desde INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Ajusta el nivel de la grabación de 
referencia para la entrada del micrófono 
XLR desde INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Selecciona el nivel de entrada de 
referencia cuando los interruptores 
INPUT1/INPUT2 están ajustados en LINE.

Audio >Audio Input
Configura los ajustes de entrada de audio.

Elemento Ajuste de subelementos Descripción

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Selecciona el nivel de grabación de la 
señal del tono de referencia de 1 kHz.

CH1 Wind 
Filter

On / Off Habilita/inhabilita el filtro de reducción 
de ruido del viento para la grabación del 
canal 1.

CH2 Wind 
Filter

On / Off Habilita/inhabilita el filtro de reducción 
de ruido del viento para la grabación del 
canal 2.

CH3 Wind 
Filter

On / Off Habilita/inhabilita el filtro de reducción 
de ruido del viento para la grabación del 
canal 3.

CH4 Wind 
Filter

On / Off Habilita/inhabilita el filtro de reducción 
de ruido del viento para la grabación del 
canal 4.

CH3 Level 
Control

Auto / Manual Selecciona el ajuste de nivel de entrada 
de audio automático o el ajuste manual 
para el canal de grabación 3.

[Nota]
Si CH3 Input Select y CH4 Input Select están 
ajustados en Internal MIC, CH4 cambia a 
automático/manual junto con este ajuste.

CH4 Level 
Control

Auto / Manual Selecciona el ajuste de nivel de entrada 
de audio automático o el ajuste manual 
para el canal de grabación 4.

[Nota]
Si CH3 Input Select y CH4 Input Select están 
ajustados en Internal MIC, CH4 cambia a 
automático/manual junto con el ajuste CH3 
Level Control.

Audio Input 
Level

De 0 a 99 Ajusta el nivel de entrada de audio 
maestro.
Se puede utilizar como volumen maestro 
en función de los ajustes de CH1 Level a 
CH4 Level.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Selecciona la característica del limitador 
para señales de entrada grandes cuando 
está ajustado el nivel de entrada de 
audio manualmente.

Menú Audio
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Audio >Audio Input
Configura los ajustes de entrada de audio.

Elemento Ajuste de subelementos Descripción

CH1&2 AGC 
Mode

Mono / Stereo Establece el modo de ajuste de nivel 
automático para la grabación en el canal 
1 y en el canal 2. Cuando se selecciona 
Stereo, AGC se vincula entre los canales.

CH3&4 AGC 
Mode

Mono / Stereo Establece el modo de ajuste de nivel 
automático para la grabación en el canal 
3 y en el canal 4. Cuando se selecciona 
Stereo, AGC se vincula entre los canales.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Selecciona la característica AGC.

1kHz Tone on 
Color Bars

On / Off Activa y desactiva la señal de tono de 
referencia de 1 kHz cuando se muestran 
las barras de colores.

[Nota]
Cuando se ajusta en On, la señal de tono de 
referencia de 1 kHz se establece para grabar 
en el canal 3 y en el canal 4, aunque CH3 Input 
Select y CH4 Input Select estén ajustados en 
Off.

CH1 Level Entrada sin el adaptador de XLR
Audio Input Level / Side / Level+Side

Entrada con el adaptador de XLR 
(página 45)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel 
de entrada de audio habilitada para el 
canal de grabación 1.

[Nota]
“Side” hace referencia al dial AUDIO LEVEL 
(CH1) situado en el lateral de la videocámara. 
Cuando se selecciona Level+Side, el nivel de 
grabación de audio está determinado por la 
combinación de Audio Input Level y los ajustes 
del dial (página 141).

CH2 Level Entrada sin el adaptador de XLR
Audio Input Level / Side / Level+Side

Entrada con el adaptador de XLR 
(página 45)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel 
de entrada de audio habilitada para el 
canal de grabación 2.

[Nota]
“Side” hace referencia al dial AUDIO LEVEL 
(CH2) situado en el lateral de la videocámara. 
Cuando se selecciona Level+Side, el nivel de 
grabación de audio está determinado por la 
combinación de Audio Input Level y los ajustes 
del dial (página 141).

Audio >Audio Input
Configura los ajustes de entrada de audio.

Elemento Ajuste de subelementos Descripción

CH3 Level Entrada sin el adaptador de XLR
Audio Input Level / Side / Level+Side

Entrada con el adaptador de XLR 
(página 45)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel 
de entrada de audio habilitada para el 
canal de grabación 3.

[Nota]
“Side” hace referencia al dial AUDIO LEVEL 
(CH3) situado en el lateral de la videocámara. 
Cuando se selecciona Level+Side, el nivel de 
grabación de audio está determinado por la 
combinación de Audio Input Level y los ajustes 
del dial (página 142).

CH4 Level Entrada sin el adaptador de XLR
Audio Input Level / Side / Level+Side

Entrada con el adaptador de XLR 
(página 45)

Audio Input Level / Through

Ajusta la combinación de ajustes de nivel 
de entrada de audio habilitada para el 
canal de grabación 4.

[Nota]
“Side” hace referencia al dial AUDIO LEVEL 
(CH4) situado en el lateral de la videocámara. 
Cuando se selecciona Level+Side, el nivel de 
grabación de audio está determinado por la 
combinación de Audio Input Level y los ajustes 
del dial (página 142).

Audio >Audio Output
Configura los ajustes de salida de audio.

Elemento Ajuste de subelementos Descripción

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 /  
CH2 / CH3 / CH4

Selecciona la salida del canal de audio en 
la toma de auriculares y en el altavoz 
incorporado.

[Nota]
Si el audio de varios canales se establece para 
la salida simultánea, el nivel de salida de cada 
canal se reduce para la emisión con el fin de 
evitar la sobreexposición.

Headphone 
Out

Mono / Stereo Selecciona si la salida de la toma de 
auriculares es monoaural (Mono) o 
estéreo (Stereo).

Alarm Level De 0 a 7 (4) Ajusta el volumen de la alarma.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Ajusta la combinación de canales de 
audio en la salida HDMI.
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Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Thumbnail

Elemento Ajuste de subelementos Descripción

Display Clip 
Properties

Muestra la pantalla de propiedades de 
visualización de clips.

Thumbnail >Set Shot Mark
Configura los ajustes de marcas de filmación.

Elemento Ajuste de subelementos Descripción

Delete Shot 
Mark1

Elimina la marca de filmación 1.

Delete Shot 
Mark2

Elimina la marca de filmación 2.

Thumbnail >Set Clip Flag
Configura los ajustes de marca de clip.

Elemento Ajuste de subelementos Descripción

Add OK Agrega una marca OK.

Add NG Agrega una marca NG.

Add KEEP Agrega una marca Keep.

Delete Clip 
Flag

Elimina todas las marcas.

Thumbnail >Lock/Unlock Clip
Configura los ajustes de protección de clips.

Elemento Ajuste de subelementos Descripción

Select Clip Selecciona y bloque/desbloquea un clip.

Lock All Clips Bloquea todos los clips.

Unlock All 
Clips

Desbloquea todos los clips.

Thumbnail >Delete Clip
Elimina clips.

Elemento Ajuste de subelementos Descripción

Select Clip Elimina el clip seleccionado.

All Clips Elimina todos los clips.

Thumbnail >Copy Clip
Copia los clips.

Elemento Ajuste de subelementos Descripción

Select Clip Copia los clips seleccionados.

All Clips Copia todos los clips.

Thumbnail >Copy Sub Clip
Copia los clips secundarios.

Elemento Ajuste de subelementos Descripción

All Clips Copia todos los clips secundarios que se 
grabaron en el modo de grabación 4K & 
HD (Sub) en otro soporte como clips 
principales.

Thumbnail >Transfer Clip
Transfiere los clips.

[Nota]
Transfer Clip no se puede configurar si no se ha definido Access Authentication >Password en el menú Network.

Elemento Ajuste de subelementos Descripción

Select Clip Transfiere los clips seleccionados.

All Clips Transfiere todos los clips.

[Nota]
Se pueden transferir hasta 200 clips.

Thumbnail >Transfer Clip (Proxy)
Transfiere los clips de proxy.

[Nota]
Transfer Clip (Proxy) no se puede configurar si no se ha definido Access Authentication >Password en el menú 
Network.

Elemento Ajuste de subelementos Descripción

Select Clip Transfiere los clips de proxy 
correspondientes a los clips 
seleccionados.

All Clips Transfiere los clips de proxy 
correspondientes a todos los clips.

[Nota]
Se pueden transferir hasta 200 clips.

Thumbnail >Set Index Picture
Ajusta la imagen índice de un clip.

Elemento Ajuste de subelementos Descripción

Set Index 
Picture

Ajusta la imagen índice de un clip.

Menú Thumbnail
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Thumbnail >Thumbnail View
Configura los ajustes del formato de visualización de la pantalla de imágenes en miniatura.

Elemento Ajuste de subelementos Descripción

Essence Mark 
Thumbnail

All / Rec Start / Shot Mark1 / Shot Mark2 / 
Shot Mark3 / Shot Mark4 / Shot Mark5 / 
Shot Mark6 / Shot Mark7 / Shot Mark8 / 
Shot Mark9 / Shot Mark0

Muestra las imágenes en miniatura de 
fotogramas con marcadores.

Clip 
Thumbnail

Muestra las imágenes en miniatura de 
clips grabados.

Thumbnail >Filter Clips
Configura los ajustes de los clips que se van a visualizar.

Elemento Ajuste de subelementos Descripción

OK Muestra todos los clips con la marca OK.

NG Muestra todos los clips con la marca NG.

KEEP Muestra todos los clips con la marca 
Keep.

None Muestra solo los clips que no tienen 
marca.

All Muestra todos los clips, 
independientemente de si hay marcas.

Thumbnail >Customize View
Cambia la pantalla de imágenes en miniatura.

Elemento Ajuste de subelementos Descripción

Thumbnail 
Caption

Date Time / Time Code / Duration / 
Sequential Number

Cambia la información mostrada debajo 
de las imágenes en miniatura.
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Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Technical >Color Bars
Configura los ajustes de las barras de colores.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva las barras de colores.

[Nota]
No se puede ajustar en On cuando S&Q Motion 
>Setting (página 86) en el menú Shooting 
está ajustado en On.

Type ARIB / 100% / 75% / SMPTE Selecciona el tipo de barra de color.

Technical >Test Saw
Configura los ajustes de la señal de prueba.

Elemento Ajuste de subelementos Descripción

Test Saw On / Off Activa y desactiva la señal de prueba.

Technical >ND Dial
Configura los ajustes relacionados con las operaciones del dial ND VARIABLE.

Elemento Ajuste de subelementos Descripción

CLEAR with 
Dial

On / Off Establece si se habilita el cambio de 
estado ND (CLEAR  On) mediante la 
operación del dial ND VARIABLE.

Technical >Tally
Ajusta la lámpara indicadora/indicador de grabación.

Elemento Ajuste de subelementos Descripción

Front On / Off Enciende y apaga el indicador de 
grabación/lámpara indicadora (frontal).

Rear On / Off Enciende y apaga el indicador de 
grabación/lámpara indicadora (trasero).

Technical >HOLD Switch Setting
Configura los ajustes del interruptor Hold.

Elemento Ajuste de subelementos Descripción

with Rec 
Button

On / Off Ajusta si se bloquea el botón de 
grabación.

with Hand 
Grip Remote

On / Off Ajusta si se bloquea el funcionamiento 
del control remoto de la empuñadura.

Technical >Touch Operation
Configura los ajustes relacionados con las operaciones táctiles.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva el funcionamiento 
táctil.

Technical >Rec Review
Configura los ajustes de revisión de grabación.

Elemento Ajuste de subelementos Descripción

Setting 3sec / 10sec / Clip Selecciona la hora de reproducción de los 
clips recién grabados para revisar la 
grabación.

Technical >Handle Zoom
Configura los ajustes del zoom del asa.

Elemento Ajuste de subelementos Descripción

Setting Off / Low / High / Variable Ajusta la velocidad del zoom del asa.

High De 1 a 8 (8) Establece la velocidad del zoom de la 
palanca de zoom del asa cuando se 
selecciona la velocidad High del zoom 
del asa.

Low De 1 a 8 (3) Establece la velocidad del zoom de la 
palanca de zoom del asa cuando se 
selecciona la velocidad Low del zoom del 
asa.

[Nota]
Puede producirse un zoom desequilibrado 
cuando la velocidad de zoom se ajusta a un 
valor bajo.

Technical >GPS
Configura los ajustes de GPS.

Elemento Ajuste de subelementos Descripción

GPS On / Off Activa y desactiva la función GPS.

[Nota]
El módulo de GPS está integrado en el asa.

Technical >Menu Settings
Configura los ajustes relacionados con el menú.

Elemento Ajuste de subelementos Descripción

User Menu 
Only

On / Off Ajusta si solo se muestra el menú User 
(On) o si se muestra la lista del menú 
(Off) cuando la videocámara muestre el 
menú.

Menú Technical
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Technical >Menu Settings
Configura los ajustes relacionados con el menú.

Elemento Ajuste de subelementos Descripción

User Menu 
with Lock

On / Off Ajusta si se bloquea la pantalla del menú 
y se muestra solo el menú User.

[Nota]
Este elemento no se muestra durante el 
funcionamiento normal de la pantalla del 
menú. Para obtener más información acerca 
del funcionamiento de la pantalla del menú, 
consulte la página 75.

Technical >Fan Control
Configura los ajustes del modo de control del ventilador.

Elemento Ajuste de subelementos Descripción

Setting Auto / Minimum / Off in Rec Ajusta el modo de control del ventilador 
del camcorder.

[Nota]
Si la temperatura interna del camcorder 
asciende por encima de un valor determinado, 
el ventilador comenzará a funcionar, aunque 
esté seleccionada la opción Off in Rec.

Technical >Lens
Configura los ajustes relacionados con los objetivos.

Elemento Ajuste de subelementos Descripción

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Ajusta el sentido de funcionamiento del 
anillo del zoom.

[Nota]
Solo está habilitado cuando se utiliza un 
objetivo de montura E compatible con el 
cambio de dirección del anillo de zoom.

Shading 
Compensation

Auto / Off Activa/desactiva la compensación de 
sombreado automático.

[Nota]
La compensación de sombreado no se aplica 
cuando Imager Scan Mode está configurado 
en S35.

Chroma 
Aberration 
Comp.

Auto / Off Activa/desactiva la compensación de la 
aberración cromática automática.

[Nota]
La compensación de aberración cromática 
no se aplica cuando Imager Scan Mode está 
configurado en S35.

Technical >Lens
Configura los ajustes relacionados con los objetivos.

Elemento Ajuste de subelementos Descripción

Distortion 
Comp.

Auto / Off Activa y desactiva la compensación 
automática de la distorsión.

[Nota]
La compensación de distorsión no se aplica 
cuando Imager Scan Mode está configurado 
en S35.

Distance 
Display

Meter / Feet Establece las unidades de visualización 
para la información del objetivo y la 
posición de enfoque.

Zoom 
Position 
Display

Focal Length / Number / Bar Establece el formato de visualización 
para la posición del zoom.

Iris Display Auto / F-Number Establece las unidades de visualización 
del diafragma.
Auto: 

Muestra el valor T si dicha 
información se puede obtener del 
objetivo acoplado. De lo contrario, 
muestra el valor F.

F-Number: 
Siempre muestra el valor F.

Technical >Video Light Set
Ajusta el método de iluminación de la luz de vídeo. Disponible únicamente cuando se utiliza el 
HVL-LBPC (opcional).

Elemento Ajuste de subelementos Descripción

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Ajusta el método de control de 
iluminación para la luz de vídeo acoplada 
a la zapata de interfaces múltiples.
Power Link: 

Activa y desactiva la luz de vídeo 
cuando la videocámara se enciende/
apaga.

Rec Link: 
Activa y desactiva la luz de vídeo 
cuando la videocámara inicia/detiene 
la grabación.

Rec Link + Stby: 
Activa y habilita el modo de espera la 
luz de vídeo cuando la videocámara 
inicia/detiene la grabación.
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Technical >APR
Ejecuta APR.

Elemento Ajuste de subelementos Descripción

APR Execute / Cancel Ejecuta APR (restauración automática de 
píxeles) para ajustar automáticamente el 
sensor de imagen.
Execute: ejecuta la función.

[Nota]
Coloque siempre la tapa del objetivo antes de 
ejecutar APR.

Technical >Camera Battery Alarm
Configura los ajustes de la alarma de tensión baja en la batería.

Elemento Ajuste de subelementos Descripción

Low Battery 5% / 10% / 15% / … / 45% / 50% Ajusta el nivel de batería restante a partir 
del cual se mostrará una alarma de 
tensión baja en la batería (saltos de 5%).

Battery 
Empty

De 3% a 7% Ajusta el nivel de batería restante a partir 
del cual se mostrará una alarma de 
batería agotada.

Technical >Camera DC IN Alarm
Configura los ajustes de la alarma de tensión de entrada.

Elemento Ajuste de subelementos Descripción

DC Low 
Voltage1

De 16.0V a 19.0V (16.5V) Ajusta la tensión a partir de la cual se 
mostrará una alarma de tensión de 
entrada DC IN baja.

DC Low 
Voltage2

De 15.5V a 18.5V Ajusta la tensión a partir de la cual se 
mostrará una alarma de tensión de 
entrada DC IN insuficiente.

Technical >Ext. Unit Battery Alarm
Configura los ajustes de la batería XDCA-FX9.

Elemento Ajuste de subelementos Descripción

Near End:Info 
Battery

De 5% a 100% Ajusta el nivel de batería restante a partir 
del cual se mostrará una alarma de 
tensión baja en la batería de Info-Lithium 
(intervalos de 5%).

End:Info 
Battery

De 0% a 5% Ajusta el nivel de batería restante a partir 
del cual se mostrará una alarma de 
batería Info-Lithium agotada y se 
detendrá el acceso a los soportes.

Technical >Ext. Unit Battery Alarm
Configura los ajustes de la batería XDCA-FX9.

Elemento Ajuste de subelementos Descripción

Near 
End:Sony 
Battery

De 11.5V a 17.0V Ajusta el nivel de batería restante a partir 
del cual se mostrará una alarma de 
tensión baja en una batería que no sea 
Info-Lithium.

End:Sony 
Battery

De 11.0V a 14.0V Ajusta el nivel de batería restante a partir 
del cual se mostrará una alarma de 
batería que no sea Info-Lithium agotada 
y se detendrá el acceso a los soportes.

Near 
End:Other 
Battery

De 11.5V a 17.0V (11.8V) Ajusta el nivel de batería restante a partir 
del cual se mostrará una alarma de 
tensión baja en una batería Anton/Bauer.

End:Other 
Battery

De 11.0V a 14.0V Ajusta el nivel de batería restante a partir 
del cual se mostrará una alarma de 
batería Anton/Bauer agotada y se 
detendrá el acceso a los soportes.

Detected 
Battery

Muestra el tipo de fuente de 
alimentación conectada a la XDCA-FX9.
Si hay una batería conectada a la XDCA-
FX9, se mostrará “Info Battery”, “Sony 
Battery” u “Other Battery”. Si se ha 
conectado una fuente de alimentación 
de CC, se mostrará “DC IN”.
Si la alimentación se proporciona 
mediante una batería o una fuente de CC 
conectada al camcorder, se mostrará  
“ --- ”.

Technical >Ext. Unit DC IN Alarm
Configura los ajustes de alarma de tensión de entrada en XDCA-FX9.

Elemento Ajuste de subelementos Descripción

DC Low 
Voltage1

De 11.5V a 17.0V Ajusta la tensión a partir de la cual se 
mostrará una alarma de tensión de 
entrada DC IN baja.

DC Low 
Voltage2

De 11.0V a 14.0V Ajusta la tensión a partir de la cual se 
mostrará una alarma de tensión de 
entrada DC IN insuficiente.
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Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Network >Access Authentication
Configura los ajustes relacionados con la autenticación.

Elemento Ajuste de subelementos Descripción

User Name Establece el nombre del usuario para la 
autenticación de acceso.

Password Establece la contraseña para la 
autenticación de acceso.

Network >Wireless LAN
Establece la configuración relacionada con las conexiones LAN inalámbricas.

Elemento Ajuste de subelementos Descripción

Setting Access Point Mode / Station Mode / Off Selecciona el modo de funcionamiento 
de la conexión LAN inalámbrica.

WPS Execute / Cancel Establece una conexión mediante WPS 
(configuración Wi-Fi segura).
Execute: ejecuta la función.

NFC Execute / Cancel Establece una conexión mediante NFC 
(comunicación de campo cercano).
Execute: ejecuta la función.

MAC Address Muestra la dirección MAC de la interfaz 
LAN inalámbrica de la videocámara.

Network >AP Mode Settings
Establece la configuración relacionada con las conexiones de modo de punto de acceso.

Elemento Ajuste de subelementos Descripción

Channel Auto(5GHz) / Auto / CH1 / CH2 / CH3 / 
CH4 / CH5 / CH6 / CH7 / CH8 / CH9 /  
CH10 / CH11

Establece el canal de LAN inalámbrica.
Auto(5GHz) solo está disponible en la 
PXW-FX9V/VK.

Camera SSID 
& Password

Muestra el SSID y la contraseña de la 
videocámara.

Regenerate 
Password

Execute / Cancel Crea una nueva contraseña.
Execute: ejecuta la función.

IP Address Muestra la dirección IP de la videocámara 
en el modo de punto de acceso.

Subnet Mask Muestra la máscara de subred de la 
videocámara en el modo de punto de 
acceso.

Network >ST Mode Settings
Establece la configuración relacionada con las conexiones de modo de estación.

Elemento Ajuste de subelementos Descripción

Camera 
Remote 
Control

Enable / Disable Establece si se habilita el control remoto 
desde un dispositivo conectado a la 
videocámara mediante LAN inalámbrica 
en el modo de estación.

Connected 
Network

Muestra la red LAN inalámbrica 
conectada (punto de acceso).

SSID Muestra el SSID del punto de acceso que 
se va a conectar.

Security Muestra el tipo de seguridad del punto 
de acceso que se va a conectar.

Password Muestra la contraseña del punto de 
acceso que se va a conectar.
Cuando Security está ajustada en WEP o 

WPA: *******
Cuando Security está ajustada en None: 

(en blanco)

DHCP Muestra si DHCP está activado/
desactivado.

IP Address Muestra la dirección IP de la videocámara 
cuando DHCP está ajustado en Off.

Subnet Mask Muestra la máscara de subred de la 
videocámara cuando DHCP está ajustado 
en Off.

Gateway Muestra la puerta de enlace 
predeterminada de la videocámara 
cuando DHCP está ajustado en Off.

DNS Auto Muestra si la adquisición de DNS está 
activada/desactivada.

Primary DNS Server Muestra el servidor principal de DNS de 
la videocámara cuando DNS Auto está 
ajustado en Off.

Secondary DNS Server Muestra el servidor secundario de DNS 
de la videocámara cuando DNS Auto está 
ajustado en Off.

Menú Network
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Network >ST Mode Settings
Establece la configuración relacionada con las conexiones de modo de estación.

Elemento Ajuste de subelementos Descripción

Scan 
Networks

Detecta las redes LAN inalámbricas 
(puntos de acceso) y muestra una lista.
Seleccione un destino de entre las 
opciones de la lista para la realizar la 
conexión.

SSID Muestra el SSID del punto de acceso que 
se va a conectar.

Security Muestra el tipo de seguridad del punto 
de acceso que se va a conectar.

Password Introduzca la contraseña del punto de 
acceso que se va a conectar.

DHCP 
On / Off

Activa y desactiva DHCP.

IP Address Introduce la dirección IP de la 
videocámara cuando DHCP está ajustado 
en Off.

Subnet Mask Introduce la máscara de subred de la 
videocámara cuando DHCP está ajustado 
en Off.

Gateway Introduce la puerta de enlace 
predeterminada de la videocámara 
cuando DHCP está ajustado en Off.

DNS Auto 
On / Off

Activa y desactiva la adquisición 
automática de DNS.

Primary DNS Server Introduce el servidor principal de DNS de 
la videocámara cuando DNS Auto está 
ajustado en Off.

Secondary DNS Server Introduce el servidor secundario de DNS 
de la videocámara cuando DNS Auto está 
ajustado en Off.

Network >ST Mode Settings
Establece la configuración relacionada con las conexiones de modo de estación.

Elemento Ajuste de subelementos Descripción

Manual 
Register

Registra los ajustes para la conexión 
manual a un punto de acceso.

SSID Introduzca el SSID del punto de acceso 
que se va a conectar.

Security 
None / WEP / WPA

Ajusta el tipo de seguridad del punto de 
acceso que se va a conectar. Seleccione 
WPA si el tipo de seguridad del punto de 
acceso de destino es WPA o WPA2.

Password Introduzca la contraseña del punto de 
acceso que se va a conectar.

DHCP 
On / Off

Activa y desactiva DHCP.

IP Address Introduce la dirección IP de la 
videocámara cuando DHCP está ajustado 
en Off.

Subnet Mask Introduce la máscara de subred de la 
videocámara cuando DHCP está ajustado 
en Off.

Gateway Introduce la puerta de enlace 
predeterminada de la videocámara 
cuando DHCP está ajustado en Off.

DNS Auto 
On / Off

Activa y desactiva la adquisición 
automática de DNS.

Primary DNS Server Introduce el servidor principal de DNS 
cuando DNS Auto está ajustado en Off.

Secondary DNS Server Introduce el servidor secundario de DNS 
cuando DNS Auto está ajustado en Off.
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Network >Wired LAN
Establece la configuración relacionada con las conexiones LAN con cable.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la función LAN con 
cable.

Camera 
Remote 
Control

Enable / Disable Establece si se habilita el control remoto 
desde un dispositivo conectado a la 
videocámara mediante LAN con cable.

Detail 
Settings

Configura las propiedades de la conexión 
LAN con cable.

DHCP 
On / Off

Activa y desactiva DHCP.

IP Address Introduce la dirección IP de la 
videocámara cuando DHCP está ajustado 
en Off.

Subnet Mask Introduce la máscara de subred de la 
videocámara cuando DHCP está ajustado 
en Off.

Gateway Introduce la puerta de enlace 
predeterminada de la videocámara 
cuando DHCP está ajustado en Off.

DNS Auto 
On / Off

Activa y desactiva la adquisición 
automática de DNS.

Primary DNS Server Introduce el servidor principal de DNS 
cuando DNS Auto está ajustado en Off.

Secondary DNS Server Introduce el servidor secundario de DNS 
cuando DNS Auto está ajustado en Off.

Network >Modem
Configura los ajustes relacionados con los módems.

Elemento Ajuste de subelementos Descripción

Setting On / Off Activa y desactiva la conexión del 
módem.

Modem1 
Device Name

Muestra el nombre de dispositivo del 
módem 1.

Modem1 IP 
Address

Muestra la dirección IP del módem 1.

Modem1 
Subnet Mask

Muestra la máscara de subred del 
módem 1.

Modem2 
Device Name

Muestra el nombre de dispositivo del 
módem 2.

Modem2 IP 
Address

Muestra la dirección IP del módem 2.

Modem2 
Subnet Mask

Muestra la máscara de subred del 
módem 2.
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Network >Network Client Mode
Establece la configuración relacionada con el modo de cliente de red.

Elemento Ajuste de subelementos Descripción

Setting On / Off Inicia (On) o detiene (Off) el modo cliente 
en red.

NCM Settings 
Select

Selecciona los ajustes predeterminados 
(NCM Settings1/NCM Settings2/NCM 
Settings3) compuestos por los ajustes de 
conexión del modo cliente en red 
configurados con antelación.

NCM 
Settings1

Display Name Establece el nombre para mostrar que 
aparece en el menú NCM Settings.

CCM Address Establece la dirección del destino CCM al 
que se va a conectar.
Nombre de host o dirección IP

CCM Port (1 a 65535 (8443)) Establece el número de puerto del 
destino CCM al que se va a conectar.

User Name Establece el nombre del usuario para la 
autenticación de la conexión CCM.

Password Establece la contraseña de autenticación 
de la conexión CCM.

CCM Certificate 
Load / Clear / None

Carga un certificado cuando se conecta 
al CCM o a XDCAM air y borra los ajustes.

CCM Certificate Status 
Loaded / Default

Muestra el estado de carga del 
certificado cuando se conecta al CCM o a 
XDCAM air.

Camera Control 
Enable / Disable

Activa/desactiva el control de la cámara 
desde un CCM, cuando hay conectado un 
CCM, o desde XDCAM air.

Camera Setting 
Always / Onetime / Off

Activa/desactiva las operaciones de All 
File desde un CCM, cuando hay 
conectado un CCM, o desde XDCAM air.
Always: 

Activa las operaciones de All File desde 
un CCM o XDCAM air todo el tiempo.

Onetime: 
Activa las operaciones de All File desde 
un CCM o XDCAM air solo una vez.

Off: 
Desactiva las operaciones de All File 
desde un CCM o XDCAM air.

Reset 
Execute / Cancel

Restablece los ajustes predeterminados de 
NCM Settings. Execute: ejecuta la función.

Network >Network Client Mode
Establece la configuración relacionada con el modo de cliente de red.

Elemento Ajuste de subelementos Descripción

NCM 
Settings2

Igual que NCM Settings1.

NCM 
Settings3

Igual que NCM Settings1.

Streaming 
Quality

Normal / High Establece la calidad de transmisión.

[Nota]
Esta configuración también se restablece 
cuando se ejecuta All Reset >Reset without 
Network (página 116) en el menú 
Maintenance.

Network >File Transfer
Configura los ajustes relacionados con la transferencia de archivos.

Elemento Ajuste de subelementos Descripción

Auto Upload 
(Proxy)

On / Off Activa y desactiva la transferencia 
automática de los archivos proxy.

Default 
Upload 
Server

Selecciona el servidor de carga para los 
archivos. El servidor seleccionado aquí se 
convierte en el destino de carga 
automática para los archivos de proxy y 
el destino de carga para los archivos 
desde la pantalla de imágenes en 
miniatura.
Muestra el nombre para mostrar 
configurado en Server Settings (NCM) y 
Server Settings del 1 al 3.

Clear 
Completed 
Jobs

Execute / Cancel Borra de la lista los trabajos de 
transferencia finalizados.
Execute: ejecuta la función.

Clear All Jobs Execute / Cancel Borra de la lista todos los trabajos de 
transferencia.
Execute: ejecuta la función.

View Job List Muestra la lista de trabajos de 
transferencia.

Server 
Settings 
(NCM)

Muestra el nombre para mostrar del 
servidor NCM y el servicio (CCM).

Display Name Muestra el nombre para mostrar del 
servidor NCM.

Service Muestra el servicio.
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Network >File Transfer
Configura los ajustes relacionados con la transferencia de archivos.

Elemento Ajuste de subelementos Descripción

Server 
Settings1

Display Name Establece el nombre para mostrar que 
aparece en el menú de configuración del 
destino de la transferencia.

Service 
FTP

Muestra el tipo de servidor.

Host Name Establece el nombre de host del servidor 
de destino de la transferencia.

Port (1 a 65535 (21)) Establece el número de puerto del 
servidor de destino de la transferencia.

User Name Establece el nombre del usuario para la 
autenticación de la conexión del servidor 
de destino de la transferencia.

Password Establece la contraseña de autenticación 
de la conexión del servidor de destino de 
la transferencia.

Passive Mode 
On / Off

Activa y desactiva el modo PASV.

Destination Directory Introduzca el nombre del directorio de 
destino de la transferencia.

Using Secure Protocol 
On / Off

Establece si se utiliza (On) o no (Off) la 
transferencia FTP segura (modo FTPS 
explícito: FTPES).

Root Certificate 
Load / Clear / None

Carga un certificado raíz para la 
transferencia FTP segura y borra los 
ajustes.

Root Certificate Status 
Loaded / No Certificate

Muestra el estado de carga del 
certificado raíz para la transferencia FTP 
segura.

Reset 
Execute / Cancel

Restablece los ajustes predeterminados 
de Server Settings.
Execute: ejecuta la función.

Server 
Settings2

Igual que Server Settings1.

Server 
Settings3

Igual que Server Settings1.

Network >Network Reset
Restablece los ajustes de red.

Elemento Ajuste de subelementos Descripción

Reset Execute / Cancel Restablece los ajustes de red.
Execute: ejecuta la función.
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Esta sección describe la función y los ajustes de los elementos en cada menú.
Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 18dB ).

Maintenance >Language
Ajusta el idioma de visualización.

Elemento Ajuste de subelementos Descripción

Select Ajusta el idioma de visualización.
SET: Ajustar el lenguaje.

Maintenance >Clock Set
Configura los ajustes del reloj interno.

Elemento Ajuste de subelementos Descripción

Time Zone De UTC – 12:00 a UTC + 14:00 Ajusta la diferencia horaria desde UTC en 
intervalos de 30 minutos.

Date Mode YYMMDD / MMDDYY / DDMMYY Selecciona el formato de visualización de 
la fecha.
YYMMDD: Año, mes, día
MMDDYY: Mes, día, año
DDMMYY: Día, mes, año

12H/24H 12H / 24H Ajusta el formato de visualización del 
reloj.
12H: modo de 12 horas
24H: modo de 24 horas

Date Ajusta la fecha actual.
SET: Ajustar el valor.

Time Ajusta la hora actual.
SET: Ajustar el valor.

Maintenance >All Reset
Restablece los valores predeterminados de fábrica.

Elemento Ajuste de subelementos Descripción

Reset Execute / Cancel Restablece todos los ajustes a los valores 
predeterminados de fábrica.
Execute: ejecuta la función.

Reset without 
Network

Execute / Cancel Restablece los ajustes predeterminados 
del menú, con excepción de los ajustes 
del menú Network.

[Nota]
Network Client Mode >Streaming Quality 
(página 114) en el menú Network se 
restablece a la configuración predeterminada 
de fábrica.

Maintenance >Hours Meter
Muestra el tiempo de ejecución acumulado.

Elemento Ajuste de subelementos Descripción

Hours 
(System)

Muestra el número de horas acumuladas 
de uso (no se puede restablecer).

Hours (Reset) Muestra el número de horas acumuladas 
de uso (se puede restablecer).

Reset Execute / Cancel Restablece la visualización de Hours 
(Reset) a 0.
Execute: ejecuta la función.

Maintenance >Version
Muestra la información de versión.

Elemento Ajuste de subelementos Descripción

Version 
Number

Vx.xx Muestra la versión del software del 
camcorder.

Ext. Unit 
Version 
Number

Vx.xx Muestra la versión del software de 
XDCA-FX9.

Version Up Execute / Cancel Actualiza la videocámara.*

Execute: ejecuta la función.
*	 Esta función actualiza el software de la 

videocámara.

Lens Version 
Number

Vxx Muestra el número de la versión del 
software de un objetivo de montura E.

Menú Maintenance
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Datos de configuración

Puede guardar los ajustes del menú de 
configuración en la memoria interna de la 
videocámara o en una tarjeta SD y en un 
soporte “Memory Stick”. Le permitirá cargar 
rápidamente el conjunto de ajustes de menú 
apropiado para la situación actual.
Los datos de configuración se guardan en las 
categorías siguientes.

Archivos de usuario
Los archivos de usuario guardan los 
elementos de configuración del menú User 
personalizable.
Puede guardar hasta 64 archivos en una 
tarjeta SD o en un soporte “Memory Stick”.
Si carga este archivo en la memoria de 
la videocámara, puede personalizar la 
configuración del menú User.

Archivos ALL (todos los ajustes)
Los archivos ALL guardan los datos de 
configuración de todos los menús. Puede 
guardar hasta 64 archivos en una tarjeta SD o 
en un soporte “Memory Stick”.

[Nota]
Los datos específicos del dispositivo (sombreado, 
niveles de emisión y otros datos que requieran ajustes 
para el dispositivo en concreto) no se guardarán.

Archivos de escena
Los archivos de escena guardan los ajustes de 
los elementos de pintura configurados en las 
escenas. Puede guardar hasta 5 archivos en 
la memoria interna de la videocámara y hasta 
64 archivos en una tarjeta SD o en un soporte 
“Memory Stick”.

Guardar un archivo de usuario/un 
archivo ALL

1	 Inserte la tarjeta SD o el soporte 
“Memory Stick” en la ranura de tarjeta 
UTILITY SD/MS (página 8) con la 
etiqueta orientada hacia la derecha.

2	 Para un archivo de usuario, seleccione 
User File (página 93) >Save Utility SD/
MS >Execute en el menú Project.
Para un archivo ALL, seleccione All File 
>Save Utility SD/MS (página 94) 
>Execute en el menú Project.
Aparecerá una pantalla de destino de 
almacenamiento del archivo.

3	 Seleccione una fila “No File” en la pantalla 
de destino de almacenamiento.
Si selecciona una fila con una entrada de 
File ID, se sobrescribirá el archivo 
seleccionado.
File ID se genera automáticamente, pero 
puede modificarla.

4	 Seleccione Execute en la pantalla de 
confirmación.

Cargar un archivo de usuario/un 
archivo ALL

1	 Inserte la tarjeta SD o el soporte “Memory 
Stick” en el que ha guardado el archivo en 
la ranura de tarjeta UTILITY SD/MS 
(página 8) con la etiqueta orientada 
hacia la derecha.

2	 Para un archivo de usuario, seleccione 
User File (página 93) >Load Utility SD/
MS >Execute en el menú Project.
Para un archivo ALL, seleccione All File 
>Load Utility SD/MS (página 94) 
>Execute en el menú Project.
Aparecerá una pantalla con la lista de 
archivos.

3	 Seleccione un archivo para cargar.
Aparece una pantalla de confirmación.

4	 Seleccione Execute.

[Notas]
ˎˎ La unidad se reiniciará automáticamente después de 

cargar los datos de configuración.
ˎˎ Cuando se ajusta All File >Load Network Data, en el 

menú Project, en Off, se cargan todos los ajustes del 
archivo ALL, salvo los ajustes del menú Network.

Guardar un archivo de escena

Para guardarlo en la memoria interna

1	 Seleccione Scene File >Store Internal 
Memory >Execute en el menú Paint 
(página 98).
Aparecerá una pantalla con la lista de 
archivos de escena.
Si File ID está establecida en la 
destinación “Standard”, se guardarán los 
ajustes estándar preconfigurados.

2	 Seleccione un destino de 
almacenamiento.
El archivo de la escena se guardará en el 
destino seleccionado, sobrescribiendo 
cualquier archivo existente.

3	 Seleccione Execute en la pantalla de 
confirmación.

Para guardar en una tarjeta SD o en un 
soporte “Memory Stick”

1	 Inserte la tarjeta SD o el soporte 
“Memory Stick” en la ranura de tarjeta 
UTILITY SD/MS (página 8) con la 
etiqueta orientada hacia la derecha.

2	 Seleccione Scene File >Save Utility SD/MS 
>Execute en el menú Paint (página 98).
Aparecerá una pantalla de destino de 
almacenamiento del archivo de escena.

3	 Seleccione una fila “No File” en la pantalla 
de destino de almacenamiento.
Si selecciona una fila con una entrada de 
File ID, se sobrescribirá el archivo 
seleccionado.

Guardar y cargar datos de configuración
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File ID se genera automáticamente, pero 
puede modificarla.

4	 Seleccione Execute en la pantalla de 
confirmación.

Cargar un archivo de escena

Para cargar desde la memoria interna

1	 Seleccione Scene File >Recall Internal 
Memory >Execute en el menú Paint 
(página 98).
Aparecerá una pantalla con la lista de 
archivos de escena.

2	 Seleccione un archivo para cargar.
Aparece una pantalla de confirmación.

3	 Seleccione Execute.

	 [Consejo]
Los archivos de escena también pueden cargarse 
utilizando el menú directo (página 46).

Para cargar desde una tarjeta SD o en un 
soporte “Memory Stick”

1	 Inserte la tarjeta SD o el soporte “Memory 
Stick” en el que ha guardado el archivo de 
escena en la ranura de tarjeta UTILITY SD/
MS (página 8) con la etiqueta 
orientada hacia la derecha.

2	 Seleccione Scene File >Load Utility SD/MS 
>Execute en el menú Paint (página 98).
Aparecerá una pantalla con la lista de 
archivos de escena.

3	 Seleccione un archivo para cargar.
Aparece una pantalla de confirmación.

4	 Seleccione Execute.

Cambio del File ID

1	 Para un archivo de usuario, seleccione 
User File >File ID, en el menú Project 
(página 93).
Para un archivo ALL, seleccione All File 
>File ID, en el menú Project (página 94).
Para un archivo de escena, seleccione 
Scene File >File ID, en el menú Project 
(página 98).
Aparecerá una pantalla para editar File ID.

2	 Use los botones de flechas (página 7) 
o el dial multifunción (página 4) para 
seleccionar un carácter y, a continuación, 
presione el botón SET (página 7) o el 
dial multifunción.

3	 Repita el paso 2 según sea necesario.

4	 Al terminar de introducir los caracteres, 
seleccione Done.
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Conexión de dispositivos de grabación y monitores externos
Para mostrar imágenes de grabación 
o reproducción en un monitor externo, 
seleccione la señal de salida del camcorder 
y utilice un cable adecuado para conectar el 
monitor.
También puede conectar dispositivos de 
grabación, como una videograbadora y grabar 
la señal de salida desde el camcorder.
Puede mostrar la misma información que 
aparece en el visor, como por ejemplo, la 
información de estado y los menús, en un 
monitor externo. Ajuste Output Display 
(página 101) en el menú Monitoring en On 
para el tipo de señal correspondiente que se 
enviará al monitor.

Conector SDI OUT (tipo BNC)

Configure la activación/desactivación de la 
salida y el formato de salida desde el menú 
Monitoring (página 101).
Utilice un cable coaxial de 75 Ω disponible en 
el mercado para realizar la conexión.

[Nota]
Compruebe que la conexión entre el camcorder y el 
dispositivo externo está conectada a tierra antes de 
encender los dispositivos.

(Se recomienda que el camcorder y el 
dispositivo externo se enciendan después de 
conectar el cable coaxial de 75 Ω).
Si el dispositivo externo se debe conectar 
al camcorder mientras este está encendido, 
conecte primero el cable coaxial de 75 Ω 
al dispositivo externo y, a continuación, 
conéctelo al camcorder.

Para iniciar una grabación en el 
camcorder y en el dispositivo externo 
simultáneamente

Con la salida de señal SDI habilitada, ajuste 
SDI/HDMI Rec Control (página 91) >Setting 
en el menú Project en SDI/HDMI Remote I/F 
o Parallel Rec para habilitar la salida de una 
señal de activación REC hacia el dispositivo 
externo conectado en el conector SDI OUT. 
Esto sincronizará la grabación en el dispositivo 
externo con el camcorder.

[Notas]
ˎˎ Si el dispositivo externo conectado no es compatible 

con la señal de activación REC, el dispositivo no se 
podrá utilizar.
ˎˎ Cuando el botón de grabación START/STOP y la 

empuñadura de grabación START/STOP están 
establecidos para controlar diferentes soportes, se 
emite la señal de activación REC de acuerdo con la 
utilización de la ranura A.

Conector HDMI OUT (conector tipo 
A)

Configure la activación/desactivación de la 
salida y el formato de salida desde el menú 
Monitoring (página 101).
Utilice un cable HDMI de alta velocidad 
disponible en el mercado para realizar la 
conexión.
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Sincronización externa
Cuando se filma con varias videocámaras, 
se pueden sincronizar con una señal de 
referencia o un código de tiempo específico 
sincronizado a través del conector genlock de 
las videocámaras.

Sincronización de la fase de las 
señales de vídeo (Genlock)

Ajuste el interruptor de selección IN/
OUT (página 8) de la videocámara en 
la posición IN y suministre una señal de 
referencia al conector GENLOCK IN/REF OUT 
(página 8) para habilitar el genlock.
Las señales de referencia que se pueden 
utilizar varían según la frecuencia del sistema 
del formato de grabación seleccionado.

Frecuencia del 
sistema de 
formato de 
grabación

Señales de referencia 
válidas

59.94P 1920×1080 59.94i 
720×486 59.94i 
1280×720 59.94P

50P 1920×1080 50i 
720×576 50i 
1280×720 50P

29.97P 1920×1080 59.94i 
720×486 59.94i

25P 1920×1080 50i 
720×576 50i

24P 1920×1080 48i(24PsF)

23.98P 1920×1080 47.95i (23.98PsF)

59.94i 1920×1080 59.94i 
720×486 59.94i

50i 1920×1080 50i 
720×576 50i

[Notas]
ˎˎ Si la señal de referencia es inestable, no se podrá 

obtener el generador de sincronismo.
ˎˎ La subportadora no se sincronizará.

Bloqueo del código de tiempo en 
otros dispositivos

Ajuste la unidad que proporciona el código 
de tiempo en un modo en el que la salida 
del código de tiempo siga funcionando (por 
ejemplo, Free Run o Clock).

1	 Ajuste Timecode (página 99) en el 
menú TC/Media de la siguiente manera.
Mode: Preset
Run: Free Run

2	 Pulse el botón asignable (página 46) 
correspondiente a la función DURATION/
TC/UBIT para mostrar los códigos de 
tiempo en la pantalla.

3	 Compruebe que el interruptor de 
selección IN/OUT (página 8) esté en la 
posición IN y, a continuación, suministre 
una señal de vídeo de referencia HD o SD 
al conector GENLOCK IN/REF OUT y el 
código de tiempo de referencia al 
conector TC IN/OUT.

El generador de códigos de tiempo del 
camcorder se bloqueará con el código de 
tiempo de referencia y “EXT-LK” aparecerá en 
la pantalla.
Después de que hayan transcurrido diez 
segundos desde el bloqueo del código de 
tiempo, el estado de bloqueo externo se 
mantendrá incluso si se desconecta la fuente 
externa de códigos de tiempo.

[Notas]
ˎˎ Compruebe que el código de tiempo de referencia y 

la señal de vídeo de referencia suministrados tienen 
una relación de fase que cumple con el estándar 
SMPTE de códigos de tiempo.
ˎˎ Cuando se utiliza el bloqueo externo, el código de 

tiempo obtendrá el bloqueo con el código de tiempo 
externo de forma instantánea y el valor de este 
código de tiempo externo aparecerá en el área de 
visualización de datos. Sin embargo, no comience a 
grabar inmediatamente. Espere unos segundos antes 
de comenzar a grabar hasta que el generador de 
sincronización se estabilice.
ˎˎ Si la frecuencia de la señal del vídeo de referencia 

y la frecuencia de fotogramas en el camcorder no 
son iguales, no se podrá conseguir un bloqueo 
y el camcorder no funcionará correctamente. Si 
esto ocurre, el código de tiempo no conseguirá un 
bloqueo correcto con el código de tiempo externo.
ˎˎ Si la fuente del código de tiempo externo se 

desconecta, es posible que el código de tiempo 
cambie un fotograma por hora con respecto al código 
de tiempo de referencia.

Para liberar el bloqueo externo

Cambie el ajuste Timecode en el menú TC/
Media o apague la videocámara.
La sincronización externa también se libera si 
se cambia la frecuencia del sistema y cuando 
comienza a grabar en un modo de grabación 
especial (Slow & Quick Motion o Interval Rec).

Sincronización del código de 
tiempo de otro dispositivo con el 
código de tiempo del camcorder

Ajuste la unidad que proporciona el código 
de tiempo en un modo en el que la salida 
del código de tiempo siga funcionando (por 
ejemplo, Free Run o Clock).

1	 Ajuste el código de tiempo de la 
videocámara mediante Timecode 
(página 99) en el menú TC/Media.

2	 Compruebe que el interruptor de 
selección IN/OUT (página 8) esté 
ajustado en la posición OUT y conecte el 
conector TC IN/OUT y el conector 
GENLOCK IN/REF OUT a la entrada de 
código de tiempo y a la entrada de señal 
de referencia respectivamente, en el 
dispositivo que desea sincronizar.
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Gestión/Edición de clips con un ordenador

Conexión con un cable USB

Uso de un lector de tarjetas XQD 
(opcional)

Conecte un lector de tarjetas XQD mediante 
un cable USB e introduzca una tarjeta de 
memoria en la ranura. La tarjeta de memoria 
se reconocerá como una unidad de extensión 
del ordenador. En ordenadores compatibles, 
puede importar clips a alta velocidad 
utilizando el modo de almacenamiento 
masivo de la videocámara.

Uso del modo de almacenamiento 
masivo

Conecte la videocámara con un cable USB e 
inserte una tarjeta de memoria en la ranura 
para tarjeta XQD A o B. La tarjeta de memoria 
se reconoce como una unidad de extensión de 
ordenador.

1	 Retire el control remoto de la empuñadura 
de la videocámara y conecte el conector 
USB/múltiple (página 4) al ordenador 
con un cable USB.

2	 Sitúe el interruptor POWER del camcorder 
en la posición ON.
En la pantalla del visor aparecerá un 
mensaje que le preguntará si desea 
habilitar la conexión USB.

	 [Nota]
El mensaje de confirmación de la conexión USB 
no se muestra si en esos momentos aparece otro 
mensaje de confirmación o de proceso en curso, 
por ejemplo, cuando se formatea o se restaura un 
tarjeta de memoria XQD.
El mensaje de confirmación se mostrará cuando 
finalice el formateo o la restauración. El mensaje de 
confirmación de USB tampoco se muestra mientras 
aparece la pantalla de propiedades del clip. El 

mensaje se mostrará cuando el procesamiento 
finalice o cuando vuelva a la pantalla de imágenes 
en miniatura.

3	 Gire el dial multifunción para seleccionar 
Execute.

4	 En Windows, compruebe que la tarjeta se 
ha añadido como un disco extraíble en la 
ventana “Mi Equipo”.
En Macintosh, compruebe que se crea una 
carpeta “NO NAME” o “Untitled” (editable) 
en el escritorio.

[Notas]
ˎˎ No realice las siguientes operaciones si el indicador 

de acceso se ilumina en rojo.
–– Apague la unidad. Desconexión del cable de 

alimentación
–– Extraer la tarjeta de memoria XQD
–– Desconectar el cable USB

ˎˎ No se garantiza el funcionamiento en todos los 
ordenadores.

Uso de un sistema de edición no 
lineal

En un sistema de edición no lineal, es 
necesario disponer de software de edición 
(opcional) que sea compatible con los 
formatos grabados por el camcorder.
Utilice el software específico de aplicaciones 
para guardar previamente los clips que desee 
editar en el disco duro del ordenador.
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Precauciones de uso
Acerca de la condensación

Si la unidad se lleva de repente de un lugar 
frío a uno cálido o si la temperatura ambiente 
sufre un aumento repentino, es posible que 
se acumule humedad en la superficie exterior 
o interior de la unidad. Este fenómeno se 
conoce como condensación. Si se produce 
condensación, apague la unidad y espere a 
que se evapore antes de ponerla en marcha. 
No la utilice en ese estado, ya que podría 
dañarla.

Acerca de los paneles LCD

El panel LCD de esta unidad ha sido fabricado 
con tecnología de alta precisión y ofrece 
un índice de píxeles funcionales de al 
menos el 99,99%. Por ello, es posible que 
quede una pequeña proporción de píxeles 
“atascados”, o bien siempre apagados 
(negro), siempre encendidos (rojo, verde o 
azul), o parpadeando. Además, a lo largo 
de un amplio periodo de tiempo, esos 
píxeles “atascados” pueden ir apareciendo 
espontáneamente debido a las características 
de la pantalla de cristal líquido. Esto no 
significa que la unidad funcione mal. Tenga 
en cuenta que dichos problemas no producen 
efectos en los datos grabados.

Fenómenos del sensor de imagen CMOS 
de la cámara

[Nota]
Los siguientes fenómenos que podrían producirse en 
las imágenes están relacionados con los sensores de 
imagen. No indican que exista una avería.

Motas blancas
Aunque los sensores de imágenes se fabrican 
con tecnologías de alta precisión, es posible 
que se generen pequeñas motas blancas en 

la pantalla en casos excepcionales producidas 
por rayos cósmicos, etc.
Están relacionadas con el principio de los 
sensores de imágenes y no se trata de una 
avería.
Las motas blancas suelen verse especialmente 
en las siguientes situaciones:
ˎˎ Cuando la unidad se utiliza bajo una 
temperatura medioambiental alta
ˎˎ Cuando ha aumentado la ganancia 
(sensibilidad)

Parpadeo
Si captura imágenes bajo la luz producida por 
lámparas fluorescentes, lámparas de sodio, 
lámparas de vapor de mercurio o LED, es 
posible que la pantalla parpadee o que los 
colores varíen.

Acerca de los consumibles

ˎˎ El ventilador y la batería son consumibles 
que deben sustituirse periódicamente.  
Si utiliza la unidad a temperatura ambiente, 
el ciclo de sustitución normal será de 5 
años aproximadamente. Sin embargo, esto 
representa solo una directriz general y no 
constituye ninguna garantía de su vida útil. 
Para obtener más información acerca de la 
sustitución de componentes, póngase en 
contacto con el distribuidor.
ˎˎ La vida útil del adaptador de CA y del 
condensador electrolítico es de unos 5 años 
con las temperaturas de funcionamiento 
habituales y un uso normal (8 horas al 
día, 25 días al mes). Si el uso supera la 
frecuencia normal indicada, es posible que 
la vida útil se vea reducida.
ˎˎ La terminal de la batería de esta unidad 
(el conector para paquetes de pilas 
y adaptadores de CA) es una parte 
consumible.  
Puede que la unidad no funcione 
correctamente si los contactos de las pilas 

están doblados o deformados debido a 
algún golpe o a vibraciones o si se han 
corroído debido a un uso prolongado en el 
exterior.  
Se recomienda realizar inspecciones 
periódicas para que la unidad continúe 
funcionando correctamente y para 
prolongar su vida útil. Contacte con el 
servicio de asistencia técnica de Sony o con 
el responsable de ventas para obtener más 
información sobre las inspecciones.

Acerca de la batería recargable 
incorporada

El camcorder dispone de una batería 
recargable incorporada que almacena la fecha, 
la hora y otros ajustes incluso cuando está 
apagado. La batería recargable incorporada 
estará cargada a las 24 horas de conectarse 
la unidad a una toma de corriente con el 
adaptador de CA o si se coloca una batería 
completamente cargada, independientemente 
de que el camcorder esté encendido o 
apagado. La batería recargable tardará 
aproximadamente 3 meses en descargarse 
por completo si no se conecta el adaptador 
de CA o si se utiliza el camcorder sin la 
batería. Cargue la batería antes de utilizar el 
camcorder. Sin embargo, incluso si la batería 
recargable no está cargada, el funcionamiento 
de la videocámara no se verá afectado 
siempre que no necesite registrar la fecha.

Ajuste automático del sensor de imagen

Si no se ha ejecutado APR después de 
un tiempo transcurrido establecido tras 
configurar la hora y la fecha, se mostrará un 
mensaje solicitándole que ejecute APR.

Uso y ubicaciones de almacenamiento

Guarde la unidad en un lugar llano y ventilado.

Evite utilizar o guardar la unidad en los 
siguientes lugares.
ˎˎ En entornos excesivamente calientes o fríos 
(rango de temperatura de funcionamiento: 
de 0 °C a 40 °C)  
Recuerde que, en verano, en climas cálidos, 
la temperatura dentro de un coche con las 
ventanas subidas puede superar fácilmente 
los 50 °C.
ˎˎ En lugares húmedos o con polvo
ˎˎ Lugares donde la unidad pueda quedar 
expuesta a la lluvia
ˎˎ Lugares susceptibles de recibir vibraciones 
fuertes
ˎˎ Cerca de campos magnéticos potentes
ˎˎ Cerca de transmisores de radio o televisión 
que generen campos electromagnéticos 
potentes
ˎˎ En contacto directo con la luz sola o 
cerca de calefactores durante periodos 
prolongados

Cómo evitar interferencias 
electromagnéticas procedentes de 
dispositivos de comunicación portátiles

El uso de teléfonos móviles y otros 
dispositivos de comunicación cerca 
de la cámara puede producir averías e 
interferencias con las señales de audio y 
vídeo. Es recomendable que los dispositivos 
de comunicación portátiles que se encuentren 
cerca de la cámara estén apagados.

Nota sobre los rayos láser

Los rayos láser pueden dañar el sensor de 
imagen CMOS. Si filma una escena que 
incluya un rayo láser, evite que este se 
dirija directamente al objetivo de la unidad. 
Específicamente, los rayos láser de alta 
potencia procedentes de los dispositivos 
médicos o de otros dispositivos podrían 
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causar daños debido a los efectos de la luz 
reflejada y la luz dispersa.

Precauciones de seguridad

ˎˎ Úselo con un cortafuegos de diseño seguro. 
No conecte la unidad a una red donde exista 
la posibilidad de conectarse a dispositivos 
no fiables.
ˎˎ Si FTPS está disponible, use FTPS. El 
contenido, los nombres de usuario y las 
contraseñas no se cifran con FTP normal.
ˎˎ SONY NO SE HACE RESPONSABLE POR 
DAÑOS DE NINGÚN TIPO DEBIDOS 
A LA OMISIÓN DE LAS MEDIDAS 
DE SEGURIDAD ADECUADAS EN 
DISPOSITIVOS DE TRANSMISIÓN, FUGAS 
DE DATOS INEVITABLES DERIVADAS DE LAS 
ESPECIFICACIONES DE TRANSMISIÓN O 
PROBLEMAS DE SEGURIDAD DE CUALQUIER 
TIPO.
ˎˎ En función del entorno operativo, es posible 
que terceros no autorizados en la red 
puedan acceder a la unidad. Al conectar la 
unidad a la red, confirme siempre que la red 
está correctamente protegida.
ˎˎ Es posible que terceros no autorizados 
situados cerca de las señales puedan 
interceptar sin saberlo contenidos de la 
comunicación. Al utilizar la comunicación 
LAN inalámbrica, aplique medidas de 
seguridad para proteger los contenidos de 
la comunicación.
ˎˎ Desde el punto de vista de la seguridad, 
al utilizar la unidad conectada a la red, se 
recomienda encarecidamente modificar 
la limitación de acceso de los valores 
predeterminados de fábrica (página 111). 
Específicamente, tenga cuidado al 
conectarse a una red abierta.  
Asimismo, desde el punto de vista de la 
seguridad, se recomienda establecer una 
contraseña con una cadena de caracteres 
suficientemente larga, que sea difícil de 

adivinar por los demás, y que deberá 
guardar de forma segura.
ˎˎ No visite otros sitios web con el navegador 
web mientras ajuste la configuración o justo 
después.  
El navegador web recuerda los ajustes de 
inicio de sesión, por lo que debe cerrarlo 
al completar la configuración para evitar 
que terceros no autorizados utilicen la 
unidad o evitar la instalación de programas 
maliciosos.
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Los ajustes predeterminados de fábrica se muestran en negrita (por ejemplo, 1920×1080P (Level 
A)).

[Notas]
ˎˎ La resolución del formato de salida está limitada por la configuración de Rec Format >Frequency, Video Format y 

otros ajustes en el menú Project (página 88).
ˎˎ Si la resolución de la salida de vídeo es mayor que la resolución de la imagen, no se emite ninguna imagen 

reproducida.

Formatos de salida del conector SDI OUT/HDMI OUT

Frecuencia del 
sistema 
(Rec Format 
>Frequency en el 
menú Project)

Formato de vídeo 
(Rec Format 
>Video Format en 
el menú Project)

Formato de salida (Monitoring >Output Format)

SDI1 SDI2 HDMI

59.94 / 50 4096×2160P 4096×2160P – 4096×2160P

1920×1080P 
(Level A)

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level B)

1920×1080P 
(Level B)

–

1920×1080P 
(Level A)

1920×1080i 1920×1080i

1920×1080P 
(Level B)

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i

3840×2160P 3840×2160P – 3840×2160P

1920×1080P 
(Level A)

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level B)

1920×1080P 
(Level B)

–

1920×1080P 
(Level A)

1920×1080i 1920×1080i

1920×1080P 
(Level B)

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i

Frecuencia del 
sistema 
(Rec Format 
>Frequency en el 
menú Project)

Formato de vídeo 
(Rec Format 
>Video Format en 
el menú Project)

Formato de salida (Monitoring >Output Format)

SDI1 SDI2 HDMI

59.94 / 50 1920×1080P /  
Solo RAW1)

1920×1080P 
(Level A)

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level B)

1920×1080P 
(Level B)

–

1920×1080P 
(Level A)

1920×1080i 1920×1080i

1920×1080P 
(Level B)

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i 1920×1080i

– – 720×480P/ 
720×576P

29.97 / 25 4096×2160P 4096×2160P – 4096×2160P

1920×1080i(PsF) 1920×1080i(PsF) 1920×1080i(PsF)

3840×2160P 3840×2160P – 3840×2160P

1920×1080i(PsF) 1920×1080i(PsF) 1920×1080i(PsF)

1920×1080P /  
Solo RAW1)

1920×1080i(PsF) 1920×1080i(PsF) 1920×1080i(PsF)

24 4096×2160P 4096×2160P – 4096×2160P

1920×1080P 1920×1080P 1920×1080P

Solo RAW1) 1920×1080P 1920×1080P 1920×1080P

23.98 4096×2160P 4096×2160P – 4096×2160P

1920×1080P 1920×1080P 1920×1080P

3840×2160P 3840×2160P – 3840×2160P

1920×1080P 1920×1080P 1920×1080P

1920×1080P /  
Solo RAW1)

1920×1080P 1920×1080P 1920×1080P

1)	 Sin grabar internamente

Limitaciones y formatos de salida
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Limitaciones de LUT del monitor

La función LUT del monitor está disponible en modo Cine EI cuando la resolución de grabación 
es 4096×2160 o 3840×2160.
Cuando Monitor LUT Setting >Monitor Out en el menú Shooting se ajusta en MLUT On y la 
resolución de salida de la imagen es 1920×1080, el monitor LUT se aplica a la imagen de salida.
Cuando la resolución de la imagen de salida es 4096×2160 o 3840×2160, se emite la misma 
imagen que la imagen grabada.

Limitaciones de visualización de salida

El menú y el estado que se integran en cada señal de salida (SDI1, SDI2, HDMI) se determinan 
mediante la resolución de salida de Output Format y el ajuste Output Display >Setting en el 
menú Monitoring.

Resolución 
de salida

Output Display 
>Setting

Output Display 
>SDI1

Output Display 
>SDI2

Output Display 
>HDMI

4K On On – (salida Off) On

Off Off – (salida Off) Off

HD On Off On On

Off Off Off Off



8. Apéndice126

Fuente de alimentación

Síntoma Causa Solución

La videocámara no se 
enciende.

La batería no está colocada y 
no se está suministrando 
alimentación al conector DC 
IN.

Coloque una batería (página 18) o 
conecte la videocámara a la 
alimentación de CA con un adaptador 
de CA (página 19).

La batería está 
completamente agotada.

Sustituya la batería por una batería 
cargada por completo (página 18).

El suministro de 
alimentación se corta 
durante el funcionamiento.

La batería se agota por 
completo.

Sustituya la batería por una batería 
cargada por completo (página 18).

La batería se agota muy 
rápido.

La temperatura ambiente es 
muy baja.

Esto se debe a las características de la 
batería y no es un defecto.

No se ha cambiado la batería 
de forma adecuada.

Sustituya la batería (página 18).
Si la batería se agota pronto, incluso 
después de haberla cargado por 
completo, es posible que haya llegado 
al final de su vida útil. Sustitúyala por 
una nueva.

Grabación/reproducción

Síntoma Causa Solución

La grabación no comienza al 
pulsar el botón de grabación.

La tarjeta de memoria XQD 
está llena.

Sustituya la tarjeta de memoria XQD 
por otra con espacio suficiente.

Es necesario restablecer la 
tarjeta de memoria XQD.

Extraiga la tarjeta de memoria XQD 
(página 30).

No se puede grabar audio. Los diales AUDIO LEVEL 
(CH1/CH2/CH3/CH4) están 
establecidos al nivel mínimo.

Ajuste los niveles de grabación de 
audio con los diales AUDIO LEVEL (CH1/
CH2/CH3/CH4) (página 44).

El sonido grabado está 
distorsionado.

El nivel de audio es 
demasiado alto.

Ajuste los niveles de grabación de 
audio con los diales AUDIO LEVEL (CH1/
CH2/CH3/CH4) (página 44).

Síntoma Causa Solución

El sonido grabado tiene un 
alto nivel de ruido.

El nivel de audio es 
demasiado bajo.

Ajuste los niveles de grabación de 
audio con los diales AUDIO LEVEL (CH1/
CH2/CH3/CH4) (página 44).
Cuando se selecciona un micrófono 
externo, ajuste también la 
configuración de referencia INPUT MIC 
en Audio Input en el menú Audio 
(página 104).

No se pueden reproducir los 
clips.

Se está editando el clip. No se pueden reproducir los clips si ha 
modificado los nombres o las carpetas 
de archivo o si el clip se está utilizando 
en un ordenador. No se trata de un fallo 
de funcionamiento.

Se está grabando el clip en 
otro dispositivo.

Los clips grabados en otros dispositivos 
pueden no reproducirse o mostrarse en 
un tamaño incorrecto. No se trata de un 
fallo de funcionamiento.

Dispositivos externos

Síntoma Solución

El ordenador no reconoce la 
videocámara.

Desconecte el cable USB del ordenador y vuelva a conectarlo de 
forma segura.

Desconecte el cable USB del ordenador, reinícielo y vuelva a seguir 
los pasos en el orden correcto.

No se pueden cargar los clips en 
el ordenador.

Desconecte el cable USB del ordenador, reinicie la videocámara y 
vuelva a conectarlo.

Debe instalarse el software de aplicación para cargar los clips en 
su ordenador (página 121).

Resolución de problemas
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Conexión LAN inalámbrica

[Nota]
Las obstrucciones y la interferencia electromagnética entre la videocámara y el punto de acceso de LAN inalámbrico 
o el dispositivo del terminal, o bien el entorno ambiental (tal como los materiales de la pared) podrían acortar el 
rango de comunicación o impedir las conexiones por completo. Si experimenta estos problemas, verifique el estado 
de conexión/comunicación tras mover la videocámara a una nueva ubicación o tras acercarla al punto de acceso/
dispositivo del terminal.

Síntoma Solución

El dispositivo del terminal no 
puede acceder a la videocámara.

ˎˎ Compruebe la conexión LAN inalámbrica (dirección IP, etc.).
ˎˎ Es posible que el ajuste de comunicación entre el punto de 
acceso y el cliente no sea válido. Para obtener más información, 
remítase a las instrucciones de funcionamiento del punto de 
acceso.

No puede iniciar sesión en la 
videocámara.

Compruebe el nombre de usuario y la contraseña establecidos.

No aparece el control remoto por 
web.

Compruebe la configuración de la dirección IP.

Conexión a Internet

Síntoma Solución

Fallo al cargar un archivo. Es posible que el nombre de usuario y la contraseña del servidor 
no sean correctos.
Introduzca el nombre de usuario y la contraseña correctos.

La carga de archivos no está 
disponible.

Es posible que las condiciones de la señal 3G/4G sean deficientes.
Desplácese a otra ubicación e inténtelo de nuevo.

Al usar el Filtro ND

Síntoma Solución

El filtro ND no se mueve. Puede mover manualmente el filtro a la posición Clear mediante el 
siguiente procedimiento.

1	 Gire el interruptor POWER del camcorder hasta la posición OFF.

2	 Retire la tapa redonda de la parte inferior.

3	 Introduzca un destornillador en el orificio y gírelo en el sentido contrario a las agujas del 
reloj.
ˎˎ Para mover el filtro ND hasta la posición Clear, gírelo en el sentido contrario a las agujas del 
reloj. Siga girándolo hasta llegar a la posición Clear.
ˎˎ Utilice un destornillador de ø2,4 mm de diámetro o menos. La profundidad de inserción del 
destornillador es de unos 3,0 cm.

Orificio para el destornillador
(con la tapa quitada)

4	 Ajuste el interruptor ND PRESET/VARIABLE (página 6) a la posición PRESET, y ajuste los 
botones arriba/abajo de ND FILTER POSITION (página 6) a la posición CLEAR.

[Notas]
ˎˎ No utilice el procedimiento anterior durante el funcionamiento normal. Solo debe utilizar este procedimiento si no 

puede mover el filtro ND. El filtro ND puede sufrir daños si se utiliza este procedimiento durante el funcionamiento 
normal.
ˎˎ Después de utilizar el procedimiento anterior, consulte a un centro de servicio de Sony para que le reparen el 

camcorder.
ˎˎ Aunque siga apareciendo un mensaje de error después de realizar el procedimiento anterior, podrá filmar.
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Si en la videocámara se produce una condición de funcionamiento, precaución o advertencia 
que requiera confirmación, en el visor aparecerá un mensaje, la lámpara indicadora/indicador de 
grabación comenzará a parpadear y sonará un pitido de advertencia.
El pitido de advertencia se emite desde el altavoz incorporado y los auriculares conectados a la 
toma de auriculares.

Mensajes de error

El camcorder dejará de funcionar cuando se visualicen los siguientes mensajes.

Mensaje del visor Sonido de 
advertencia

Lámpara 
indicadora/
indicador 
de 
grabación

Causa y solución

E + Código de error Continuo Parpadeo 
rápido

Indica una anomalía en el camcorder. La 
grabación se detiene, incluso si REC se muestra 
en el visor.
Apague el camcorder y compruebe si existe algún 
problema con los dispositivos, cables o soportes 
conectados. Si el error continúa cuando el 
camcorder se vuelve a encender, póngase en 
contacto con el servicio de asistencia técnica de 
Sony.
(Si el camcorder no se apaga cuando el 
interruptor POWER se ajusta en OFF, extraiga la 
batería o desconecte la alimentación DC IN).
Es posible que no aparezca una pantalla de error 
o un sonido de advertencia dependiendo del 
estado de la videocámara.

Mensajes de advertencia

Siga las instrucciones proporcionadas si se muestran los siguientes mensajes.

Mensaje del visor Sonido de 
advertencia

Lámpara 
indicadora/
indicador 
de 
grabación

Causa y solución

Battery Near End Intermitente Parpadeo La capacidad restante de la batería se está 
agotando.
Recárguela en cuanto pueda.

Battery End Continuo Parpadeo 
rápido

La batería está agotada. La grabación se detiene.
Detenga el funcionamiento y sustituya la batería.

Temperature High Intermitente Parpadeo La temperatura interna es elevada.
Apague el camcorder y deje que se enfríe antes 
de volverlo a utilizar.

Voltage Low Intermitente Parpadeo La tensión de DC IN es baja (nivel 1). Compruebe 
la fuente de alimentación.

Insufficient Voltage Continuo Parpadeo 
rápido

La tensión de DC IN es demasiado baja (nivel 2). 
La grabación se detiene.
Conecte a una fuente de alimentación distinta.

Media Near Full Intermitente Parpadeo La capacidad restante de la tarjeta de memoria 
XQD se está agotando.
Sustitúyala en cuanto pueda.

Media Full Continuo Parpadeo 
rápido

Los clips no se pueden grabar o copiar porque no 
queda capacidad en la tarjeta de memoria XQD.
Sustitúyala inmediatamente.

Clips Near Full Intermitente Parpadeo El número de clips adicionales que pueden 
grabarse en la tarjeta de memoria XQD está 
alcanzando valores bajos.
Sustitúyala en cuanto pueda.

Clips Full Continuo Parpadeo 
rápido

Se ha alcanzado el número máximo de clips que 
pueden grabarse en la tarjeta de memoria XQD.
No se pueden grabar o copiar más clips. 
Sustitúyala inmediatamente.

Last Clip Recording Intermitente Parpadeo El clip que está grabando actualmente es el 
último que puede grabar, ya que ha alanzado el 
número máximo de clips.
Prepare una tarjeta de memoria XQD nueva.

Media(A)1) Near Full Intermitente Parpadeo Al utilizar la función Simul Rec

Media(A)1) Full Continuo Parpadeo 
rápido

Al utilizar la función Simul Rec

Advertencias de funcionamiento
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Mensaje del visor Sonido de 
advertencia

Lámpara 
indicadora/
indicador 
de 
grabación

Causa y solución

Media(A)1) Clips Near 
Full

Intermitente Parpadeo Al utilizar la función Simul Rec

Media(A)1) Clips Full Continuo Parpadeo 
rápido

Al utilizar la función Simul Rec

Media(A)1) Last Clip 
Rec

Intermitente Parpadeo Al utilizar la función Simul Rec

1)	 Se muestra “Media (B)” para la tarjeta de la ranura B.

Mensajes de precaución y de funcionamiento

Es posible que los siguientes mensajes de precaución y funcionamiento aparezcan en el 
centro de la pantalla. Siga las instrucciones proporcionadas para resolver el problema.

Mensaje de pantalla Causa y solución

Battery Error
Please Change Battery

Se ha detectado un error en la batería.
Sustitúyala por una batería normal.

Backup Battery End
Please Change

La capacidad restante de la batería de reserva es insuficiente.
Cargue la batería de reserva.

Unknown Media (A)1)

Please Change
Se ha introducido una tarjeta de memoria particionada o una 
tarjeta de memoria no compatible con la videocámara.
La tarjeta no se puede utilizar en la videocámara y se debe 
sustituir.

Cannot Use Media (A)1)

Unsupported File System
Se ha introducido una tarjeta que utiliza un sistema de archivos 
diferente o que no se ha formateado.
La tarjeta no se puede utilizar en la videocámara y se debe 
sustituir o formatear con la videocámara.

Media Needs to be Restored Se ha producido un error en la tarjeta de memoria y se debe 
restaurar.
Restaure la tarjeta de memoria.

Media Error
Cannot Record to Media (A)1)

Es posible que la tarjeta de memoria esté dañada y ya no se 
puede utilizar para la grabación.
La reproducción es posible, por tanto, se recomienda copiar y 
sustituir la tarjeta de memoria.

Mensaje de pantalla Causa y solución

Media Error
Cannot Use Media (A)1)

Es posible que la tarjeta de memoria esté dañada y ya no se 
puede utilizar para la grabación ni la reproducción.
La tarjeta no se puede utilizar en el camcorder y se debe sustituir.

Media (A)1) Error
Recording Halted
Playback Halted

La grabación y la reproducción se han detenido a causa de un 
error que se ha producido mientras se utilizaba la tarjeta de 
memoria.
Si el problema continúa, sustituya la tarjeta de memoria.

Media Reached Rewriting Limit
Change Media (A)1)

La tarjeta de memoria ha llegado al final de su vida útil.
Realice una copia de seguridad y sustituya la tarjeta 
inmediatamente. Si continúa utilizando la tarjeta, es posible que 
no pueda grabar o reproducir.
Para obtener más información, consulte las instrucciones de 
funcionamiento de la tarjeta de memoria.

Copy All Sub Clips
NG: Reached Clip Number Limit
NG: Same File Already Exists
NG: Not Enough Capacity

La copia de todos los subclips usando Copy All Sub Clips falló 
debido a la razón mostrada.

ˎˎ Se ha alcanzado el número máximo de clips.
ˎˎ Existe un archivo con el mismo nombre.
ˎˎ No hay capacidad suficiente para copiar.

Sustituya el soporte.

The specified address is invalid. La dirección especificada no es válida.
Compruebe que el ajuste sea correcto.

Cannot Use Specified Port 
Number

El número de puerto especificado no es válido.
Compruebe que el ajuste sea correcto.

Fan Stopped El ventilador incorporado se ha detenido.
Evite utilizar el camcorder con temperaturas elevadas, desconecte 
la alimentación y póngase en contacto con el servicio de asistencia 
técnica de Sony.

Invalid setting value was reset:
Media/Clip Naming/Camera 
Position
Please save All File again

El ajuste de formato para darle nombre al clip se ha restablecido 
porque se ha cargado un archivo ALL no válido.
Configure los ajustes de formato deseados e intente guardar el 
archivo ALL de nuevo.

Lens I/F Error(xx:xx) Se detectó un error de comunicación I/F con el objetivo al conectar 
un objetivo de montura E.
Verifique el estado de conexión con el objetivo de montura E.
Si el problema persiste, póngase en contacto con el servicio de 
asistencia técnica de Sony con el código de error (cinco caracteres 
entre paréntesis).

This Multi Term. acc is not 
supported by the device and 
cannot be used.
Please verify the compatibility.

Se detectó un accesorio incompatible.
El único accesorio de terminal múltiple compatible con la unidad 
es el control remoto de la empuñadura suministrado.
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Mensaje de pantalla Causa y solución

Failed Este error puede aparecer si no se puede obtener una dirección 
con el ajuste DHCP fijado en On.
Compruebe los ajustes de servidor de DHCP.

Cannot add auto upload job of 
Proxy file because maximum 
number of upload jobs was 
reached.

Se ha alcanzado el número máximo de trabajos de transferencia.
Borre los trabajos no deseados. Es posible que el ajuste de destino 
de carga automática para archivos de proxy también sea 
incorrecto. Compruebe que el ajuste sea correcto.

<SSID>Not found. No se pudo encontrar la red (punto de acceso) con el <SSID> 
especificado.
Compruebe que el ajuste sea correcto.

<SSID>Authentication Failed Fallo de autenticación de conexión en la red (punto de acceso) con 
el <SSID> especificado.
Compruebe que la contraseña y el resto de ajustes sean correctos.

An IP address conflict has 
occurred. Please check the 
network settings.

Existe un conflicto en las direcciones de red de LAN inalámbrica, 
LAN con cable, módem o entre módems.
Cambie la dirección de forma manual o cambie los ajustes del 
router de red.

The IP address of the Wireless 
LAN Access Point Mode has been 
changed due to an IP address 
conflict.

La dirección IP del modo de punto de acceso de LAN inalámbrica 
se cambió debido a un conflicto con las direcciones de red del 
modo de punto de acceso de LAN inalámbrica, LAN con cable o 
módem.
Compruebe la configuración de la dirección IP.

1)	 Se muestra “Media (B)” para la tarjeta de la ranura B.
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Elementos configurados en el menú de configuración

Sí: el elemento se guarda.
No: el elemento no se guarda.
–: no guardado (ajuste temporal)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/EI Mode Sí Sí

ISO/Gain<H> Sí Sí

ISO/Gain<M> Sí Sí

ISO/Gain<L> Sí Sí

Exposure Index<H> Sí Sí

Exposure Index<M> Sí Sí

Exposure Index<L> Sí Sí

Shockless Gain Sí Sí

Base Sensitivity Sí Sí

Base ISO Sí Sí

ND Filter Preset1 Sí Sí

Preset2 Sí Sí

Preset3 Sí Sí

Shutter Mode Sí Sí

Shutter Speed On/Off Sí Sí

Shutter Speed Sí Sí

Shutter Angle Sí Sí

ECS On/Off Sí Sí

ECS Frequency Sí Sí

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Auto Exposure Level Sí Sí

Mode Sí Sí

Speed Sí Sí

AGC Sí Sí

AGC Limit Sí Sí

AGC Point Sí Sí

Auto Shutter Sí Sí

A.SHT Limit Sí Sí

A.SHT Point Sí Sí

Clip High light Sí No

Detect Window Sí No

Detect Window Indication Sí Sí

Average Peak Level Ratio Sí No

Custom Width Sí No

Custom Height Sí No

Custom H Position Sí No

Custom V Position Sí No

White Preset White Sí No

Color Temp <A> Sí Sí*1

Tint<A> Sí Sí*1

R Gain <A> Sí Sí*1

B Gain <A> Sí Sí*1

Color Temp <B> Sí Sí*1

Tint<B> Sí Sí*1

R Gain <B> Sí Sí*1

B Gain <B> Sí Sí*1

White Setting Shockless White Sí No

ATW Speed Sí No

White Switch<B> Sí Sí

Filter White Memory Sí No

Elementos guardados en Files
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Offset White Offset White <A> Sí No

Offset Color Temp<A> Sí No

Offset Tint<A> Sí No

Offset White <B> Sí No

Offset Color Temp<B> Sí No

Offset Tint<B> Sí No

Offset White<ATW> Sí No

Offset Color Temp<ATW> Sí No

Offset Tint<ATW> Sí No

Focus AF Transition Speed Sí No

AF Subj. Shift Sens. Sí No

Focus Area Sí No

Focus Area (AF-S) Sí No

Face/Eye Detection AF Sí No

Push AF Mode Sí No

AF Assist Sí No

S&Q Motion Setting Sí No

Frame Rate Sí No

Monitor LUT Category Sí No

LUT Select Sí No

User 3D LUT Select Sí No

Monitor LUT Setting Internal Rec Sí No

Monitor Out Sí No

HD(Sub) Rec/Proxy – –

SDI1 – –

SDI2 – –

HDMI – –

VF/Streaming – –

Monitor 3D LUT Load SD Card – –

Reset – –

Reset All – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Noise Suppression Setting(SDR/HDR) Sí Sí

Level(SDR/HDR) Sí Sí

Setting(Cine EI) Sí No

Level(Cine EI) Sí No

Flicker Reduce Mode Sí No

Frequency Sí No

SteadyShot Setting Sí No

Auto Black Balance Auto Black Balance – –

Project Base Setting Shooting Mode Sí No

Rec Format Frequency Sí No

Imager Scan Mode Sí No

Codec Sí No

RAW Output Format Sí No

Video Format Sí No

Cine EI Setting Color Gamut Sí No

Simul Rec Setting Sí No

Rec Button Set Sí No

4K & HD (Sub) Rec Setting Sí No

Proxy Rec Setting Sí No

Proxy Format Sí No

Audio Channel Sí No

Interval Rec Setting No No

Interval Time Sí No

Number of Frames Sí No

Pre-Lighting Sí No

Picture Cache Rec Setting Sí No

Cache Rec Time Sí No

SDI/HDMI Rec Control Setting Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Assignable Button <1> Sí No

<2> Sí No

<3> Sí No

<4> Sí No

<5> Sí No

<6> Sí No

<7> Sí No

<8> Sí No

<9> Sí No

<10> Sí No

Focus Hold Button Sí No

Assignable Dial Assignable Dial Sí No

Assignable Dial Direction Sí No

Multi Function Dial Default Function Sí No

User File Load Utility SD/MS – –

Save Utility SD/MS – –

File ID No No

Load Customize Data Sí No

Load White Data Sí No

All File Load Utility SD/MS – –

Save Utility SD/MS – –

File ID Sí No

Load Network Data No No

Planning Metadata Load Media(A) – –

Load Media(B) – –

Properties – –

Clear Memory – –

Clip Name Display Sí No

Paint HDR Paint Setting HLG Look Sí Sí

HDR Black Offset Sí Sí

HDR Knee Sí Sí

HDR Knee Point Sí Sí

HDR Knee Slope Sí Sí

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint Black Master Black Sí Sí

R Black Sí Sí

B Black Sí Sí

Gamma Setting Sí Sí

Step Gamma Sí Sí

Master Gamma Sí Sí

R Gamma Sí Sí

G Gamma Sí Sí

B Gamma Sí Sí

Gamma Category Sí Sí

Gamma Select Sí Sí

Black Gamma Setting Sí Sí

Range Sí Sí

Master Black Gamma Sí Sí

Knee Setting Sí Sí

Auto Knee Sí Sí

Point Sí Sí

Slope Sí Sí

Knee Saturation Sí Sí

Knee Saturation Level Sí Sí

White Clip Setting No Sí

Level Sí Sí

Detail(4K/QFHD) Setting Sí Sí

Level Sí Sí

H/V Ratio Sí Sí

Crispening Sí Sí

Frequency Sí Sí

Knee Aperture Sí Sí

Knee Aperture Level Sí Sí

White Limit Sí Sí

Black Limit Sí Sí

V Detail Creation Sí Sí
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint Detail(HD) Setting Sí Sí

Level Sí Sí

H/V Ratio Sí Sí

Crispening Sí Sí

Frequency Sí Sí

Knee Aperture Sí Sí

Knee Aperture Level Sí Sí

White Limit Sí Sí

Black Limit Sí Sí

V Detail Creation Sí Sí

Skin Detail Setting Sí Sí

Area Detection – –

Area Indication No No

Level Sí Sí

Saturation Sí Sí

Hue Sí Sí

Width Sí Sí

Aperture Setting Sí Sí

Level Sí Sí

Matrix Setting Sí Sí

Adaptive Matrix Sí Sí

Preset Matrix Sí Sí

Preset Select Sí Sí

User Matrix Sí Sí

User Matrix Level Sí Sí

User Matrix Phase Sí Sí

User Matrix R-G Sí Sí

User Matrix R-B Sí Sí

User Matrix G-R Sí Sí

User Matrix G-B Sí Sí

User Matrix B-R Sí Sí

User Matrix B-G Sí Sí

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint Multi Matrix Setting Sí Sí

Area Indication No No

Color Detection – –

Reset – –

Axis No No

Hue Sí Sí

Saturation Sí Sí

Scene File Recall Internal Memory – –

Store Internal Memory – –

Load Utility SD/MS – –

Save Utility SD/MS – –

File ID No Sí

Scene White Data Sí No

TC/Media Timecode Mode Sí No

Run Sí No

Setting No No

Reset – –

TC Format Sí No

TC Display Display Select Sí No

Users Bit Mode Sí No

Setting No No

HDMI TC Out Setting Sí No

Clip Name Format Auto Naming Sí No

Title Prefix Sí No

Number Set No No

Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Utility SD/MS – –
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Output On/Off SDI1 Sí No

SDI2 Sí No

HDMI Sí No

Output Format SDI1 Sí No

SDI2 Sí No

HDMI Sí No

REF No No

Output Setting RAW to HD Conv. Sí No

Output Display Setting Sí No

SDI1 Sí No

SDI2 Sí No

HDMI Sí No

Display On/Off Network Status Sí No

File Transfer Status Sí No

NCM/Streaming Status Sí No

Rec/Play Status Sí No

RAW Output Control Status Sí No

Tally Sí No

Battery Remain Sí No

Focus Mode Sí No

Focus Position Sí No

Focus Area Indicator Sí No

Focus Area Ind.(AF-S) Sí No

Face/Eye Detection Frame Sí No

Lens Info Sí No

Imager Scan Mode Sí No

Rec Format Sí No

Frame Rate Sí No

Zoom Position Sí No

UWP RF Level Sí No

GPS Sí No

SteadyShot Sí No

Gamma/LUT Sí No

SDI/HDMI Rec Control Sí No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Gamma Display Assist Sí No

Proxy Status Sí No

Base ISO/Sensitivity Sí No

Media Status Sí No

Video Signal Monitor Sí No

Clip Name Sí No

White Balance Sí No

Scene File Sí No

Focus Indicator Sí No

Auto Exposure Mode Sí No

Auto Exposure Level Sí No

Timecode Sí No

ND Filter Sí No

Iris Sí No

ISO/Gain/EI Sí No

Shutter Sí No

Level Gauge Sí No

Audio Level Meter Sí No

Video Level Warning Sí No

Clip Number Sí No

Notice Message Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Marker Setting Sí No

Color Sí No

Center Marker Sí No

Safety Zone Sí No

Safety Area Sí No

Aspect Marker Sí No

Aspect Mask Sí No

Aspect Safety Zone Sí No

Aspect Safety Area Sí No

Aspect Select Sí No

Guide Frame Sí No

100% Marker Sí No

User Box Sí No

User Box Width Sí No

User Box Height Sí No

User Box H Position Sí No

User Box V Position Sí No

VF Setting Contrast Sí No

Brightness Sí No

Color Mode Sí No

Gamma Display Assist Setting Sí No

Peaking Setting Sí No

Type Sí No

Normal Peaking Frequency Sí No

Normal Peaking Level Sí No

Color Sí No

Color Peaking Level Sí No

Zebra Setting Sí No

Zebra Select Sí No

Zebra1 Level Sí No

Zebra1 Aperture Level Sí No

Zebra2 Level Sí No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Audio Audio Input CH1 MI SHOE Input Select Sí No

CH2 EXT Input Select Sí No

CH2 MI SHOE Input Select Sí No

CH3 Input Select Sí No

CH4 Input Select Sí No

INPUT1 MIC Reference Sí No

INPUT2 MIC Reference Sí No

Line Input Reference Sí No

Reference Level Sí No

CH1 Wind Filter Sí No

CH2 Wind Filter Sí No

CH3 Wind Filter Sí No

CH4 Wind Filter Sí No

CH3 Level Control Sí No

CH4 Level Control Sí No

Audio Input Level Sí No

Limiter Mode Sí No

CH1&2 AGC Mode Sí No

CH3&4 AGC Mode Sí No

AGC Spec Sí No

1kHz Tone on Color Bars Sí No

CH1 Level Sí No

CH2 Level Sí No

CH3 Level Sí No

CH4 Level Sí No

Audio Output Monitor CH Sí No

Headphone Out Sí No

Alarm Level Sí No

HDMI Output CH Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Thumbnail Display Clip Properties – –

Set Shot Mark Delete Shot Mark1 – –

Delete Shot Mark2 – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Copy Clip Select Clip – –

All Clips – –

Copy Sub Clip All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Set Index Picture – –

Thumbnail View Essence Mark Thumbnail – –

Clip Thumbnail – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Thumbnail Caption Sí No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Color Bars Setting No No

Type Sí No

Test Saw Test Saw Sí No

ND Dial CLEAR with Dial Sí No

Tally Front Sí No

Rear Sí No

HOLD Switch Setting with Rec Button Sí No

with Hand Grip Remote Sí No

Touch Operation Setting Sí No

Rec Review Setting Sí No

Handle Zoom Setting Sí No

High Sí No

Low Sí No

GPS GPS Sí No

Menu Settings User Menu Only Sí No

User Menu with Lock No No

Fan Control Setting Sí No

Lens Zoom Ring Direction Sí No

Shading Compensation Sí No

Chroma Aberration Comp. Sí No

Distortion Comp. Sí No

Distance Display Sí No

Zoom Position Display Sí No

Iris Display Sí No

Video Light Set Video Light Set Sí No

APR APR – –

Camera Battery Alarm Low Battery Sí No

Battery Empty Sí No

Camera DC IN Alarm DC Low Voltage1 Sí No

DC Low Voltage2 Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Ext. Unit Battery Alarm Near End:Info Battery Sí No

End:Info Battery Sí No

Near End:Sony Battery Sí No

End:Sony Battery Sí No

Near End:Other Battery Sí No

End:Other Battery Sí No

Detected Battery No No

Ext. Unit DC IN Alarm DC Low Voltage1 Sí No

DC Low Voltage2 Sí No

Network Access Authentication User Name No No

Password No No

Wireless LAN Setting Sí No

WPS – –

NFC – –

MAC Address – –

AP Mode Settings Channel Sí No

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network ST Mode Settings Camera Remote Control Sí No

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password No No

DHCP Sí No

IP Address Sí No

Subnet Mask Sí No

Gateway Sí No

DNS Auto Sí No

Primary DNS Server Sí No

Secondary DNS Server Sí No

Manual Register

SSID Sí No

Security Sí No

Password No No

DHCP Sí No

IP Address Sí No

Subnet Mask Sí No

Gateway Sí No

DNS Auto Sí No

Primary DNS Server Sí No

Secondary DNS Server Sí No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network Wired LAN Setting Sí No

Camera Remote Control Sí No

Detail Settings

DHCP Sí No

IP Address Sí No

Subnet Mask Sí No

Gateway Sí No

DNS Auto Sí No

Primary DNS Server Sí No

Secondary DNS Server Sí No

Modem Setting Sí No

Modem1 Device Name – –

Modem1 IP Address – –

Modem1 Subnet Mask – –

Modem2 Device Name – –

Modem2 IP Address – –

Modem2 Subnet Mask – –

Network Client Mode Setting Sí No

NCM Settings Select Sí No

NCM Settings1/NCM Settings2/NCM Settings3

Display Name Sí No

CCM Address Sí No

CCM Port Sí No

User Name No No

Password No No

CCM Certificate – –

CCM Certificate Status – –

Camera Control Sí No

Camera Setting No No

Reset – –

Streaming Quality Sí No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network File Transfer Auto Upload (Proxy) Sí No

Default Upload Server Sí No

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings(NCM) – –

Server Settings1/Server Settings2/Server Settings3

Display Name Sí No

Service Sí No

Host Name Sí No

Port Sí No

User Name No No

Password No No

Passive Mode Sí No

Destination Directory Sí No

Using Secure Protocol Sí No

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –

Maintenance Language Select Sí No

Clock Set Time Zone Sí No

Date Mode Sí No

12H/24H Sí No

Date No No

Time No No

All Reset Reset – –

Reset without Network – –

Hours Meter Hours (System) – –

Hours (Reset) – –

Reset – –

Version Version Number – –

Ext. Unit Version Number – –

Version Up – –

Lens Version Number – –

*1	 No se carga cuando Scene File >Scene White Data en el menú Paint está configurado en Off.
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Elementos configurados por botones asignables

Sí: el elemento se guarda.
No: el elemento no se guarda.
–: no guardado (ajuste temporal)

Selección de botones asignables All File Scene File

ND Filter Position Sí Sí

Auto Iris Sí Sí

ATW Sí Sí*1

Focus Setting Sí No

Display Sí No

VF Adjust Sí No

*1	 No se carga cuando Scene File >Scene White Data en el menú Paint está configurado en Off.

Elementos configurados por el dial asignable

Sí: el elemento se guarda.
No: el elemento no se guarda.
–: no guardado (ajuste temporal)

Selección de diales asignables All File Scene File

IRIS Sí Sí

ND Filter Sí Sí

Audio Input Level Sí No



8. Apéndice141

Consulte los elementos relacionados en “Especificación del audio que se va a grabar” (página 44) y “Menú Audio” (página 104).

Audio Input (CH1&CH2)

INPUT1

INPUT2

Shoe CH1

Shoe CH2

EXT. Unit CH1

EXT. Unit CH2

Internal MIC
(monaural)

CH1

[CH2 EXT Input Select]
INPUT1
INPUT2

<CH1 INPUT SELECT>
EXT
INT
MI SHOE

<CH2 INPUT SELECT>
EXT
INT
MI SHOE

[CH2 MI SHOE Input
Select]
Shoe CH2
Wireless

[CH1 MI SHOE Input Select]
Shoe CH1
Wireless

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ~ 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ~ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

*	 Ajústelo en Manual cuando el audio entre desde el adaptador XLR.

Diagramas de bloques
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Audio input (CH3&CH4)

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

<CH3 INPUT LEVEL>
0 ~ 10

CH4

<CH4 INPUT LEVEL>
0 ~ 10

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1
Wireless

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2
Wireless

INPUT1

INPUT2

Shoe CH1

Shoe CH2

EXT. Unit CH1

EXT. Unit CH2

Internal MIC
(monaural)

[CH3 Level]
Audio Input Level
Side
Level + Side
Through

[CH4 Level]
Audio Input Level
Side
Level + Side
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
*	 Ajústelo en Manual cuando el audio entre desde el adaptador XLR.
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Audio Output

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

<VOLUME>
0 ~ 50

L

R

[Alarm Level]
0 ~ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

QoS
Streaming

CH2

CH3

CH4
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Puede actualizar el software de un objetivo de 
montura E con el camcorder.
Consulte el sitio web del objetivo para saber 
qué objetivos pueden actualizarse y cuál es el 
firmware correspondiente.

Comprobación de la versión

1	 Acople un objetivo de montura E a la 
videocámara (página 22).

2	 Seleccione Version en el menú 
Maintenance para que se muestre Lens 
Version Number (página 116).
El número de versión del software del 
objetivo de montura E aparecerá en el 
lateral.

Actualización del software

Ajuste la videocámara en el modo de 
almacenamiento masivo (página 121).
Actualice el software siguiendo el 
procedimiento suministrado con el software 
del objetivo.

Actualización del software del objetivo de montura E
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Licencia de la cartera de patentes 
visuales de MPEG-4

ESTE PRODUCTO SE AUTORIZA BAJO LA 
LICENCIA DE CARTERA DE PATENTES VISUALES 
DE MPEG-4 QUE PERMITE AL CONSUMIDOR EL 
USO PERSONAL, PERO NO COMERCIAL, PARA:
(i)	 CODIFICAR VÍDEO QUE CUMPLA CON EL 

ESTÁNDAR VISUAL DE MPEG-4 (“MPEG-4 
VIDEO”) Y/O

(ii)	DECODIFICAR VÍDEO MPEG-4 CODIFICADO 
POR UN CONSUMIDOR DURANTE UNA 
ACTIVIDAD PERSONAL U OBTENIDO 
A TRAVÉS DE UN PROVEEDOR DE 
VÍDEO AUTORIZADO POR MPEG PARA 
SUMINISTRAR VÍDEO MPEG-4.

NO SE OTORGA NINGÚN TIPO DE LICENCIA O 
NO EXISTE NINGUNA LICENCIA IMPLÍCITA PARA 
NINGÚN OTRO USO. MPEG LA, LLC. PUEDE 
OBTENER INFORMACIÓN ADICIONAL, INCLUIDA 
LA RELACIONADA CON USOS PROMOCIONALES, 
INTERNOS Y COMERCIALES Y LICENCIAS. 
CONSULTE HTTP://WWW.MPEGLA.COM

Obtención del software con la 
licencia GPL/LGPL

Este producto utiliza un software al que se 
aplica la licencia GPL/LGPL. Esto le informa 
de que tiene derecho a acceder, modificar 
y redistribuir el código fuente de estos 
programas de software de acuerdo con las 
condiciones de la GPL/LGPL.
El código fuente se proporciona en Internet. 
Utilice la siguiente URL y siga las instrucciones 
de descarga.
https://oss.sony.net/Products/Linux/

Le rogamos que no se ponga en contacto con 
nosotros acerca de los contenidos del código 
fuente.

Las licencias (en inglés) se registran en la 
memoria interna del producto.
Establezca una conexión de almacenamiento 
masivo entre el producto y un ordenador para 
leer las licencias en la carpeta “PMHOME” - 
“LICENSE”.

CONTRATO DE LICENCIA DE 
USUARIO FINAL

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS 
END USER LICENSE AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS 
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, together 
with any updates/ upgrades provided by SONY, any 
printed, on-line or other electronic documentation for 
such software, and any data files created by operation of 
such software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU General 
Public license and Lesser/Library General Public License) 
shall be covered by such applicable separate end user 
license agreement in lieu of the terms of this EULA to 
the extent required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property 
laws and international treaties.

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, animation, 
video, audio, music, text and “applets” incorporated into 
the SOFTWARE) is owned by SONY or one or more of the 
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the wireless adapter and only 
for your individual use. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual property 
rights) in and to the SOFTWARE that this EULA does not 
specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt 
to derive source code, modify, reverse engineer, 
decompile, or disassemble any of the SOFTWARE, 
whether in whole or in part, or create any derivative 
works from or of the SOFTWARE unless such derivative 
works are intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. You 
may not bypass, modify, defeat or circumvent any of 
the functions or protections of the SOFTWARE or any 
mechanisms operatively linked to the SOFTWARE. You 
may not separate any individual component of the 
SOFTWARE for use on more than one wireless adapter 
unless expressly authorized to do so by SONY. You 
may not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not share, 
distribute, rent, lease, sublicense, assign, transfer or 
sell the SOFTWARE. The software, network services 
or other products other than SOFTWARE upon which 
the SOFTWARE’S performance depends might be 
interrupted or discontinued at the discretion of the 
suppliers (software suppliers, service suppliers, or 
SONY). SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other products 

will continue to be available, or will operate without 
interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, 
you acknowledge that the SOFTWARE may include 
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE 
may be covered by open source software licenses 
(“Open Source Components”), which means any 
software licenses approved as open source licenses by 
the Open Source Initiative or any substantially similar 
licenses, including but not limited to any license that, 
as a condition of distribution of the software licensed 
under such license, requires that the distributor make 
the software available in source code format. If and to 
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list 
of applicable OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the applicable 
terms and conditions governing its use. Such terms 
and conditions may be changed by the applicable 
third party at any time without liability to you. To the 
extent required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will apply in lieu 
of the terms of this EULA. To the extent the terms of the 
licenses applicable to EXCLUDED SOFTWARE prohibit 
any of the restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms 
of the licenses applicable to Open Source Components 
require SONY to make an offer to provide source code 
in connection with the SOFTWARE, such offer is hereby 
made. 

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you 
to view, store, process and/or use content created by 
you and/or third parties. Such content may be protected 
by copyright, other intellectual property laws, and/
or agreements. You agree to use the SOFTWARE only 
in compliance with all such laws and agreements that 
apply to such content. You acknowledge and agree 
that SONY may take appropriate measures to protect 
the copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 

Licencias

HTTP://WWW.MPEGLA.COM
https://oss.sony.net/Products/Linux/
www.sony.com/linux
www.sony.com/linux
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limited to, counting the frequency of your backup and 
restoration through certain SOFTWARE features, refusal 
to accept your request to enable restoration of data, and 
termination of this EULA in the event of your illegitimate 
use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES 
(“CONTENT SERVICE”). USE OF THE SERVICE AND THAT 
CONTENT IS SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU DECLINE TO ACCEPT 
THOSE TERMS, YOUR USE OF THE SOFTWARE WILL 
BE LIMITED. You acknowledge and agree that certain 
content and services available through the SOFTWARE 
may be provided by third parties over which SONY has 
no control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are 
solely responsible for payment of any third party fees 
associated with your Internet connection, including 
but not limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be limited 
or restricted depending on the capabilities, bandwidth 
or technical limitations of your Internet connection 
and service. The provision, quality and security of such 
Internet connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country 
in which you reside, and not to transfer, or authorize 
the transfer, of the SOFTWARE to a prohibited country 
or otherwise in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-
line control equipment in hazardous environments 
requiring fail-safe performance, such as in the 
operation of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, direct life 
support machines, or weapons systems, in which the 
failure of the SOFTWARE could lead to death, personal 
injury, or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective affiliates 
specifically disclaim any express or implied warranty, 
duty or condition of fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE 
is at your sole risk and that you are responsible for use 
of the SOFTWARE. The SOFTWARE is provided “AS IS,” 
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES 
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, NONINFRINGEMENT AND 
FITNESS FOR A PARTICULAR PURPOSE. SONY 
DOES NOT WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE FUNCTIONS 
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B) 
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS 
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL 
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 
THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE 
OF SONY SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THESE EXCLUSIONS MAY NOT 
APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER 
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE, 
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES 
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE, 
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR 
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER'S 
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, 
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO 
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION 
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but not 
limited to information about (i) the SOFTWARE and 
(ii) the software applications, contents and peripheral 
devices that interact with your wireless adapter and the 
SOFTWARE (“Information”). Information includes, but 
is not limited to: (1) unique identifiers relating to your 
wireless adapter and its components; (2) performance 

of the wireless adapter, the SOFTWARE and their 
components; (3) configurations of your wireless adapter, 
the SOFTWARE and the software applications, contents 
and peripheral devices that interact with the wireless 
adapter and the SOFTWARE; (4) use and frequency of 
use of the functions of (x) the SOFTWARE, and (y) the 
software applications, contents and peripheral devices 
that interact with the SOFTWARE; and (5) location data, 
as indicated below. SONY and its affiliates, partners 
and agents may use and disclose Information subject 
to applicable laws in order to improve its products and 
services or to provide products or services to you. Such 
uses include, but are not limited to: (a) administering 
the functionalities of the SOFTWARE; (b) to improve, 
service, update or upgrade the SOFTWARE; (c) 
improving, developing and enhancing the current and 
future products and services of SONY and other parties; 
(d) to provide you with information about the products 
and services offered by SONY and other parties; (e) 
complying with applicable laws or regulations; and (f) 
to the extent offered, providing you with location-based 
services of SONY and other parties, as indicated below. 
In addition, SONY retains the right to use Information 
to protect itself and third parties from illegal, criminal or 
harmful conduct.

Certain services available through the SOFTWARE may 
rely upon location information, including, but not limited 
to, the geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing such 
services, SONY, the THIRDPARTY SUPPLIERS or their 
partners may collect, archive, process and use such 
location data, and that such services are governed by 
the privacy policies of SONY or such third party. By 
reviewed the privacy policies applicable to such services 
and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify 
the owner or user of the SOFTWARE without your 
knowledge or consent. Any use of Information will be 
in accordance with the privacy policies of SONY or such 
third party. 

Please contact applicable contact address of each area or 
country for SONY’s current privacy policy. Please contact 
applicable third parties for privacy policies relating 
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to personally identifiable and other information you 
provide when you use or access third party software or 
services. 

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical and 
organizational steps to prevent unauthorized access to 
or disclosure of Information, but does not warrant it will 
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY SUPPLIERS 
may automatically update or otherwise modify the 
SOFTWARE, including, but not limited to, for purposes 
of enhancement of security functions, error correction 
and improvement of functions, at such time as you 
interact with SONY’s or third parties’ servers, or 
otherwise. Such updates or modifications may delete 
or change the nature of features or other aspects of the 
SOFTWARE, including, but not limited to, functions you 
may rely upon. You acknowledge and agree that such 
activities may occur at SONY’s sole discretion and that 
SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 
update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By acceptance of 
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY’s privacy policy, each as amended 
and modified from time to time, together constitute the 
entire agreement between you and SONY with respect 
to the SOFTWARE. The failure of SONY to exercise or 
enforce any right or provision of this EULA shall not 
constitute a waiver of such right or provision. If any part 
of this EULA is held invalid, illegal, or unenforceable, 
that provision shall be enforced to the maximum extent 
permissible so as to maintain the intent of this EULA, 
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 
This EULA shall be governed by the laws of Japan, 
without regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be subject to the 
exclusive venue of the Tokyo District Court in Japan, and 
the parties hereby consent to the venue and jurisdiction 
of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or noncompliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that SONY 
deems necessary or appropriate in such circumstances. 
SONY may also take any legal and technical remedies 
to prevent violation of and/or to enforce this EULA, 
including, but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any other 
remedies SONY may have at law, in equity or under 
contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its 
terms. In case of such termination, you must: (i) cease 
all use, and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section below 
entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED 
BY YOU, BY PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES 
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, you 
should promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective date 

of any such notice shall be deemed your agreement to 
be bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
thirdparty beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to the 
SOFTWARE of such party. 

Should you have any questions concerning this EULA, 
you may contact SONY by writing to SONY at applicable 
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Licencias de software de código 
abierto

En base a los contratos de licencia entre Sony 
y los propietarios del copyright del software, 
este producto utiliza software libre.
Para cumplir los requisitos de los propietarios 
del copyright del software, Sony se ve 
obligado a informarle acerca del contenido de 
estas licencias.
Las licencias (en inglés) se registran en la 
memoria interna del producto.
Establezca una conexión de almacenamiento 
masivo entre el producto y un ordenador para 
leer las licencias en la carpeta “PMHOME” - 
“LICENSE”.
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General

Peso	 Aprox. 2,3 kg (cuerpo, incluida asa)

Dimensiones

		  (Unidad: mm, cuerpo (incluida el 

asa))1)

159,5

246

142,5

146

257

216

229  
1)	 Los valores de las dimensiones son aproximados.

Requisitos de alimentación

		  19,5 V de CC (de 18,0 V a 20,5 V)

Consumo de energía

		  Aprox. 35,2 W (cuerpo, objetivo, 

grabación XAVC-I QFHD 59.94P, 

visor colocado, sin dispositivo 

externo conectado)

		  Aprox. 36,8 W (cuerpo, objetivo, 

grabación XAVC-I QFHD 59.94P, 

visor colocado, 3G-SDI×2, HDMI, 

dispositivo externo conectado)

Temperatura de funcionamiento

		  De 0 °C a 40 °C

Temperatura de almacenamiento

		  De –20 °C a +60 °C

Tiempo de funcionamiento continuo

		  Aprox. 54 minutos (con BP-U35) 

(cuerpo, objetivo, grabación 

XAVC-I QFHD 59.94P, visor 

colocado, sin dispositivo externo 

conectado)

Formato de grabación (vídeo)

	 XAVC Intra

		  Modo XAVC-I 4K/QFHD: VBR, 

velocidad de bits de 600 Mbps 

(máx), MPEG-4 AVC/H.264

		  Modo XAVC-I HD: CBG, velocidad de 

bits de 223 Mbps (máx), MPEG-4 

AVC/H.264

	 XAVC Long

		  Modo XAVC-L QFHD: VBR, velocidad 

de bits de 150 Mbps (máx), 

MPEG‑4 H.264/AVC

		  Modo XAVC-L HD 50: VBR, velocidad 

de bits de 50 Mbps (máx), 

MPEG‑4 H.264/AVC

		  Modo XAVC-L HD 35: VBR, velocidad 

de bits de 35 Mbps (máx), MPEG‑4 

H.264/AVC

		  Modo XAVC-L HD 25: VBR, velocidad 

de bits de 25 Mbps (máx), MPEG‑4 

H.264/AVC

	 MPEG-2 Long GOP

		  Modo MPEG HD422: CBR, velocidad 

de bits de 50 Mbps (máx.), 

MPEG‑2 422P@HL

Formato de grabación (audio)

	 LPCM de 24 bits, 48 kHz, 4 canales

Velocidad de fotogramas de grabación

	 XAVC Intra

		  Modo XAVC-I 4K: 4096×2160/59.94P, 

50P, 29.97P, 25P, 24P, 23.98P

		  Modo XAVC-I QFHD: 

3840×2160/59.94P, 50P, 29.97P, 

23.98P, 25P

		  Modo XAVC-I HD: 1920×1080/59.94P, 

50P, 59.94i, 50i, 29.97P, 23.98P, 

25P

	 XAVC Long

		  Modo XAVC-L QFHD: 

3840×2160/59.94P, 50P, 29.97P, 

23.98P, 25P

		  Modo XAVC-L HD 50: 

1920×1080/59.94P, 50P, 59.94i, 

50i, 29.97P, 23.98P, 25P

		  Modo XAVC-L HD 35: 

1920×1080/59.94P, 50P, 59.94i, 

50i, 29.97P, 23.98P, 25P

		  Modo XAVC-L HD 25: 

1920×1080/59.94i, 50i

	 MPEG-2 Long GOP

		  Modo MPEG HD422: 

1920×1080/59.94i, 50i, 29.97P, 

23.98P, 25P

Tiempo de grabación/reproducción

XAVC Intra

	 Modo XAVC-I 4K/QFHD:

		  59.94P

			   Aprox. 22 minutos  

(con QD-G128E/QD-G120F)

	 Modo XAVC-I HD:

		  59.94P

			   Aprox. 57 minutos  

(con QD-G128E/QD-G120F)

XAVC Long

	 Modo XAVC-L QFHD:

		  59.94P

			   Aprox. 86 minutos  

(con QD-G128E/G120F)

	 Modo XAVC-L HD 50:

		  59.94P

			   Aprox. 110 minutos  

(con QD-G64E)

	 Modo XAVC-L HD 35:

		  59.94P

			   Aprox. 150 minutos  

(con QD-G64E)

	 Modo XAVC-L HD 25:

		  59.94i

			   Aprox. 200 minutos  

(con QD-G64E)

MPEG-2 Long GOP

	 Modo MPEG HD422:

		  59.94i

			   Aprox. 105 minutos  

(con QD-G64E)

[Nota]
El tiempo de grabación/reproducción puede variar 
debido a las condiciones de uso y a las características de 
la memoria. Los tiempos de grabación y reproducción 
son para una grabación continua como un solo clip. Los 
tiempos reales pueden ser inferiores, dependiendo del 
número de clips grabados.

Sección de la cámara

Dispositivo de generación de imágenes (tipo)

	 Sensor de imagen CMOS de un solo chip de 

fotograma completo de 35 mm

Número de píxeles

	 20,5M (total)

Auto focus

	 Método de detección: detección de fase / 

detección de contraste

Filtros ND internos

	 CLEAR: OFF

	 1: 1/4ND

	 2: 1/16ND

	 3: 1/64ND

	 ND linealmente variable: de 1/4ND a 1/128ND

Sensibilidad ISO

	 ISO 800/4000 (modo Cine EI, fuente de luz 

D55)

Especificaciones
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Montura del objetivo

	 Montura E (de tipo palanca de bloqueo)

Latitud

	 Más de 15 paradas

Relación señal-ruido (S/N) de vídeo

	 57 dB (Y) (típico)

Velocidad del obturador

	 64F a 1/8000 de s (23.98P)

Ángulo del obturador

	 De 5,6° a 360°, de 2 a 64 fotogramas

Slow & Quick Motion

	 XAVC QFHD: de 1 a 60P, XAVC HD: de 1 a 120P

Balance de blancos

	 De 2000 K a 15000 K

Gain

	 De –3 dB a +27 dB (incrementos de 1 dB)

Curva Gamma

	 S-Cinetone, STD1, STD2, STD3, STD4, STD5, 

STD6, HG1, HG2, HG3, HG4, HG7, 

HG8, S-Log3, HLG

Sección de audio

Frecuencia de muestreo

	 48 kHz

Cuantificación

	 24 bits

Respuesta en frecuencia

	 Modo MIC de la entrada XLR: de 20 Hz a 

20 kHz (±3 dB o menos)

	 Modo LINE de la entrada XLR: de 20 Hz a 

20 kHz (±3 dB o menos)

Rango dinámico

	 Modo MIC de la entrada XLR: 80 dB (típico)

	 Modo LINE de la entrada XLR: 90 dB (típico)

Distorsión

	 Modo MIC de la entrada XLR: 0,08% o inferior 

(nivel de entrada de –40 dBu)

	 Modo LINE de la entrada XLR: 0,08% o inferior 

(nivel de entrada de +14 dBu)

Altavoz integrado

	 Monoaural

Micrófono interno

	 Monoaural

LAN inalámbrica

Estándares compatibles

	 IEEE 802.11a/b/g/n/ac

Banda de frecuencia

	 Banda de 2,4 GHz

	 Banda de 5,2/5,3/5,6/5,8 GHz  

(solo PXW-FX9V/VK)

Protocolos de seguridad compatibles

	 WEP/WPA-PSK/WPA2-PSK

	 Compatible con Etiqueta tipo 3 de NFC Forum

Sección de entrada/salida

Entradas
INPUT 1/2:

	 Tipo XLR, 3 contactos, hembra

	 Conmutable entre LINE / MIC / MIC+48V

	 MIC: de –30 dBu a –80 dBu de referencia

GENLOCK IN:

	 Tipo BNC

TC IN:

	 Tipo BNC

Salidas
SDI OUT1:

	 Tipo BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), 

HD-SDI

SDI OUT2:

	 Tipo BNC, 3G-SDI (Level A/B), HD-SDI

Auriculares (minitoma estéreo):

	 –16 dBu (salida del nivel de referencia, 

volumen máximo del monitor, 

carga de 16 Ω)

HDMI:

	 Tipo A, 19 contactos

REF OUT:

	 Tipo BNC

TC OUT:

	 Tipo BNC

Otras
DC IN:

	 Compatible con EIAJ, de 18 V a 20,5 V de CC

Conector de la unidad de extensión:

	 Específica (144 contactos)

Zapata de interfaz múltiple:

	 Específico (21 contactos)

REMOTE:

	 Tipo subminitoma de 3 polos y 2,5 mm

USB/múltiple:

	 Compatible con el estándar USB 2.0, tipo 

micro B para almacenamiento 

masivo (1)

VF:

	 Específico (40 contactos)

Sección de visualización

Visor (LCD)
Tamaño de la pantalla

	 Diagonal de 8,8 cm (3,5 pulgadas)

Relación de aspecto

	 16:9

Número de píxeles

	 1280 (H) × 720 (V)

Sección de la ranura multimedia

Ranuras de tarjetas XQD para grabación de vídeo 

(2)

Ranura de tarjetas UTILITY SD/MS (1)

Accesorios suministrados

Adaptador de CA (1)

Cable de alimentación (1)

Cargador de batería (1)

Batería (1)

Monitor LCD (incluidas la varilla y la abrazadera)

Ocular (1)

Cable USB (1)

Control remoto de la empuñadura (1)

Tapa de la montura del objetivo (1)

Tapa protectora del conector del asa (1)

Kit de zapata para accesorios (zapata para 

accesorios (1), placa de accesorios (1), tornillos (4))

Gancho para cinta métrica (1)

Espaciador de abrazadera circular (2)

Tornillos (5)

Antes de utilizar esta unidad (1)

Folleto de la garantía (1)
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El diseño y las especificaciones están sujetos a 
cambios sin previo aviso.

Notas
ˎˎ Haga siempre un ensayo de grabación 
y verifique que se grabó bien. SONY NO 
SE HACE RESPONSABLE POR DAÑOS DE 
NINGÚN TIPO, INCLUYENDO PERO NO 
LIMITADO A LA COMPENSACIÓN O PAGO 
POR FALLO EN HACER CUALQUIER TIPO 
DE CONTENIDO DE GRABACIÓN POR 
MEDIO DE ESTA UNIDAD O SU SOPORTE 
DE GRABACIÓN, SISTEMAS DE MEMORIA 
EXTERNA O CUALQUIER OTRO SOPORTE O 
SISTEMAS DE MEMORIA.
ˎˎ Verifique siempre que esta unidad 
funciona correctamente antes de utilizarla. 
SONY NO SE HACE RESPONSABLE POR 
DAÑOS DE NINGÚN TIPO, INCLUYENDO 
PERO NO LIMITADO A LA COMPENSACIÓN 
O PAGO POR LA PÉRDIDA DE GANANCIAS 
PRESENTES O FUTURAS DEBIDO AL FALLO 
DE ESTA UNIDAD, YA SEA DURANTE LA 
VIGENCIA DE LA GARANTÍA O DESPUÉS 
DEL VENCIMIENTO DE LA GARANTÍA NI 
POR CUALQUIER OTRA RAZÓN.
ˎˎ SONY NO SE HACE RESPONSABLE POR 
RECLAMACIONES DE NINGÚN TIPO 
REALIZADAS POR USUARIOS DE ESTA 
UNIDAD O POR TERCEROS.
ˎˎ SONY NO SE HACE RESPONSABLE POR LA 
PÉRDIDA, REPARACIÓN O REPRODUCCIÓN 
DE CUALQUIER DATO GRABADO EN 
EL SISTEMA DE ALMACENAMIENTO 
INTERNO, SOPORTES DE GRABACIÓN, 
SISTEMAS DE ALMACENAMIENTO 
EXTERNO O CUALQUIER OTRO SISTEMA DE 
ALMACENAMIENTO.
ˎˎ SONY NO SE HACE RESPONSABLE DE LA 
FINALIZACIÓN NI DE LA INTERRUPCIÓN, 
POR LA CIRCUNSTANCIA QUE FUERA, DE 
CUALQUIER SERVICIO RELACIONADO CON 
ESTA UNIDAD.

Descargas de software

Cuando utilice la unidad con una conexión 
de PC, descargue todos los controladores 
del dispositivo, los complementos y las 
aplicaciones de software que necesite de los 
siguientes sitios web.

Sitio web de productos de Sony Professional:

EE. UU.	 http://pro.sony.com
Canadá	 http://www.sonybiz.ca
Latinoamérica	 http://sonypro-latin.com
Europa	 http://www.pro.sony.eu/pro
Medio Este y África
	 http://sony-psmea.com
Rusia	 http://sony.ru/pro/
Brasil	 http://sonypro.com.br
Australia	 http://pro.sony.com.au
Nueva Zelanda	 http://pro.sony.co.nz
Japón	 http://www.sonybsc.com
Asia Pacífico	 http://pro.sony-asia.com
Corea	 http://bp.sony.co.kr
China	 http://pro.sony.com.cn
India	 http://pro.sony.co.in

Sony Creative Software, página de descarga 
de software
http://www.sonycreativesoftware.com/
download/software_for_sony_equipment

Marcas comerciales

ˎˎ XDCAM es una marca comercial de Sony 
Corporation.
ˎˎ XAVC y  son marcas comerciales 
registradas de Sony Corporation.
ˎˎ XQD y  son marcas comerciales 
registradas de Sony Corporation.
ˎˎ Los términos HDMI y HDMI High-
Definition Multimedia Interface, y el 
Logotipo HDMI son marcas comerciales 
o marcas registradas de HDMI Licensing 
Administrator, Inc. en los Estados Unidos y 
en otros países.
ˎˎ Microsoft y Windows son marcas 
comerciales o marcas comerciales 
registradas de Microsoft Corporation en 
Estados Unidos o en otros países.
ˎˎ Mac y Mac OS son marcas comerciales 
registradas de Apple Inc. en Estados Unidos 
y en otros países.
ˎˎ “Memory Stick”, “Memory Stick Duo”, 
“Memory Stick PRO Duo”, “Catalyst Browse”, 
“Content Browser Mobile” y el “Content 
Browser Mobile” son marcas comerciales 
registradas o marcas comerciales de Sony 
Corporation.
ˎˎ iOS es una marca comercial o marca 
comercial registrada de Cisco Systems, Inc. 
y/o sus afiliados en Estados Unidos y en 
otros países.
ˎˎ Android y Google Play son marcas 
comerciales de Google Inc.
ˎˎ Wi-Fi, el logotipo Wi-Fi y Wi-Fi PROTECTED 
SETUP son marcas comerciales o marcas 
comerciales registradas de Wi-Fi Alliance.
ˎˎ Marca N es una marca comercial o marca 
comercial registrada de NFC Forum en 
Estados Unidos y en otros países.

Todos los demás nombres de compañías y de 
productos son marcas comerciales registradas 
o marcas comerciales de sus respectivos 

propietarios. En este documento, no se utilizan 
los símbolos ™ o ® para indicar los elementos 
con marca registrada.

http://pro.sony.com
http://www.sonybiz.ca
http://sonypro-latin.com
http://www.pro.sony.eu/pro%20
http://sony-psmea.com
http://sony.ru/pro/
http://sonypro.com.br
http://pro.sony.com.au
http://pro.sony.co.nz
http://www.sonybsc.com
http://pro.sony-asia.com
http://bp.sony.co.kr
http://pro.sony.com.cn
http://pro.sony.co.in
http://www.sonycreativesoftware.com/download/software_for_sony_equipment
http://www.sonycreativesoftware.com/download/software_for_sony_equipment
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